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PREFACE

Thank you for purchasing the TalkSwitch phone system. Please read this section before you start 
installing the product.

TALKSWITCH USAGE

The TalkSwitch unit (part number CT.TS001.1) you have purchased is designed and supplied to 
meet the technical standards for use in specific countries and for connection to the major 
telephone service providers in those countries. It is subject to regulatory certification and 
compliances as detailed in the appendices. 

WHAT’S IN THIS GUIDE?

The TalkSwitch User Guide contains all the information you need, whether you are installing a 
single TalkSwitch unit or multiple VoIP enabled units. It is intended to be a complete reference 
accompanying the TalkSwitch Start Guide that ships with every TalkSwitch unit.

This preface contains important information to help you minimize your installation effort and to 
get the most out of the features and the flexibility of your TalkSwitch system. We strive to make 
your experience with installation and configuration the most rewarding possible.

We would ask you to read important information concerning power interruptions and safety 
precautions contained in the appendices in order to ensure your TalkSwitch equipment is set up 
in the safest way possible while avoiding equipment damage.

TalkSwitch cannot provide technical support and warranty for models exported and used 
outside their intended markets. For availability of TalkSwitch models in other markets please 
visit http://global.talkswitch.com
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WHAT YOU SHOULD KNOW

While TalkSwitch is customer installable, certain skills are required if you need to route cables or 
to configure a network. The following points will help you determine the required skills:

• Configuring the TalkSwitch system using the TalkSwitch management software can be 
performed by anyone with basic computer skills once the system is physically installed with 
proper networking equipment configurations (if two or more units are networked on a LAN).

• While most buildings are wired to accommodate TalkSwitch system setup, the need to route 
telephone and/or network cabling can occur occasionally. If your organization does not 
have someone with this skill set, we recommend the use of an outside telephony 
system technician.

• You may need to connect TalkSwitch to network equipment such as a router, switch or hub 
with a connection to the Internet, and to configure a firewall, computer and TalkSwitch for 
networked use internally and with Internet. If your organization does not have someone 
with this IT skill set, we recommend the use of an outside IT technician.

If you are installing a single, non-VoIP, TalkSwitch unit, anyone with basic computer skills can 
use the TalkSwitch Start Guide and this user guide to perform a full installation 
and configuration. 

TalkSwitch system installations can be categorized into some general configurations, such as 
single unit installation, networked units installation, VoIP or non-VoIP installation, etc. This 
section helps you determine your best possible plan of action using this guide, according to your 
installation type. While not every possible installation scenario is detailed below, determine 
which one better fits your situation and use its guidelines as a starting point. Chapter 6: 
Troubleshooting and Support on page 235 provides solutions for common problems and the index 
at the back is a means to quickly navigate to specific areas.

Single unit installation

When installing a single, non-VoIP TalkSwitch unit, you can skip the sections marked with the 
Networked and VoIP icons.

Networked units installation

When installing networked TalkSwitch units, you require the sections marked with the 
Networked icon.

VoIP installation

When installing a VoIP-enabled unit, you require the sections marked with the VoIP icon. 
Chapter 5: VoIP Information on page 211 provides an additional resource.

Connecting devices

When connecting the computer, telephone lines, local extensions and other devices to your 
TalkSwitch unit(s), Chapter 1: TalkSwitch Installation on page 1 provides the information 
you need.
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IMPORTANT INFORMATION 

Electrical shock

Do not open the enclosure, except as instructed to install an upgrade kit. When installing an 
upgrade kit, disconnect the power adapter before removing the enclosure cover, and replace the 
cover before reconnecting the power adapter.

Do not expose the TalkSwitch to any liquids; that can pose a risk of electrical shock.

Power and lightning surge protection

Surge protection devices are recommended to protect TalkSwitch in areas subject to lightning or 
power surges. Please consult your reseller for recommended surge protection devices.

If TalkSwitch has been supplied with surge protection devices to meet local regulatory 
requirements, these devices must be installed as described in their installation instructions.

Do not connect or disconnect any telephone lines during thunderstorms.

Power adapter and power cord

Use only the power adapter and power cord supplied with your TalkSwitch. Check the supply 
voltage matches the rating on the power adapter label. If your supply voltage does not match 
the power adapter rating, please consult your reseller.

For safe operation, the TalkSwitch power adapter must be connected to a power supply socket 
with a third pin (ground /earth).

Power failure

The equipment will not operate when mains power fails.

Please ensure a standard telephone that does not require mains power is connected to extension 
jack E4 for emergency use. During a power failure telephone line port L1 will connect to 
extension jack E4 (except–AU models).

Change password frequently

Setting and frequently changing the system password is recommended to avoid unauthorized 
changes to system configuration and settings.

PBX fraud

It is recommended that call bridge (DISA) and call back passwords are changed frequently to 
avoid unauthorized users making telephone calls through the TalkSwitch.

Emergency service numbers

Ensure emergency service numbers are not blocked by the toll restriction feature. Frequently 
used emergency service numbers are pre-programmed to avoid blocking, but other local numbers 
may be used in some locations.

Before routing any emergency service numbers to a VoIP service provider, check that they do 
handle emergency service calls and any conditions associated with this service.
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Call redirection and service provider billing advisory

Use of the automatic route selection, toll restriction and call detail recording features does not 
imply any guarantee whatsoever by regulatory authorities, telephone service provider(s), 
TalkSwitch or its distributors and resellers, with regard to the accuracy of these features and 
that the use of such features may not be considered by a telephone company in any disputes 
which may arise regarding the accuracy of any subscriber's telephone account.

Cleaning

Use a slightly moistened cloth or an anti-static cloth to clean TalkSwitch. Do not use any 
solvents. Never use a dry cloth; electrostatic charges could damage the electronics in the 
system. Ensure, however, that no moisture penetrates into TalkSwitch, which can result 
in damage.

FINDING THE INFORMATION YOU NEED

The following user guide functionality helps you find the information you need quickly and 
enables you to skip the information you don’t need. This will make your experience with this 
user guide and your TalkSwitch system installation and configuration much more efficient.

Using the table of contents and the index

The table of contents at the front of this user guide contains all of the section headings and 
page numbers throughout the manual. The index at the back of the user guide contains a 
keyword reference with page numbers. If you are using this guide online in PDF format, the 
headings and page numbers will contain hyperlinks, allowing you to quickly navigate to the 
sections you need.

Navigating with cross-references

Cross-references are contained throughout the user guide in order to help you access related 
information and illustrations quickly. As with the headings and keywords located in the table of 
contents and index, these cross-references contain hyperlinks, allowing you to quickly navigate 
to the sections you need.

Where to go for further information

The guides listed below and other guides can be found on the TalkSwitch software CD, in the 
TalkSwitch folder in the Windows Start menu once the software has been installed, and in the 
support section of our website at http://global.talkswitch.com.

• For basic installation and configuration instructions, refer to the TalkSwitch Start Guide that 
ships with every TalkSwitch unit.

• For information on setting up a TalkSwitch system to use VoIP, refer to the VoIP Network 
Configuration Guide.

• For instructions on configuring the TalkSwitch system to support an Internet Telephony 
Service Provider (ITSP), refer to the appropriate service configuration guide on our website.

• For instructions on installing and configuring IP phones, refer to Adding IP Phones 
to TalkSwitch.
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GUIDE CONVENTIONS

The TalkSwitch User Guide uses the following text elements and icons as visual aids, making the 
manual more accessible. 

Text elements

Italic Italicized text highlights labels within windows, references within the 
document, and references to other TalkSwitch documents.

Bold Bolded text highlights window names, button names, menu commands, 
links, telephone keys, and text you are asked to type.

“Italic” Italicized text in double quotes highlights TalkSwitch system voice prompts 
you hear from a telephone.

Icons

The Networked icon is used to mark sections with information pertaining 
to a setup where two or more TalkSwitch units are networked together on 
a LAN.

The VoIP icon is used to mark sections with information pertaining to a 
setup where VoIP is being used.

The IP extension icon is used to mark sections with information pertaining 
to the set-up and use of IP extensions.

The Alert icon is used to mark sections that are important. They may 
contain warnings or cautions alerting the user to pay special attention.
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TALKSWITCH INSTALLATION

TALKSWITCH PACKAGE CONTENTS

TalkSwitch units (part number CT.TS001.1) ship with everything you need to get started. A 
power adapter, cables, management software CD and documentation comes with every unit. 
Refer to the TalkSwitch Start Guide included with the unit to verify you have everything you 
need. The package for VoIP-enabled units also contains a VoIP Network Configuration Guide.

If any of these items are missing, please contact your TalkSwitch dealer. 

RECOMMENDED SYSTEM SPECIFICATIONS 

• Windows Vista (32-bit), XP or 2000 operating system (fully updated)

• 220 MB free hard disk space (only 100 MB necessary if Java Runtime Environment (JRE) is 
already available)

• 1 GHz CPU

• 1 GB RAM (Vista) or 512 MB RAM (XP or 2000)

• 1024 x 768 video resolution

Network equipment: If your system includes multiple TalkSwitch units, you will need an 
Ethernet switch. If you plan on using VoIP or configuring your system remotely, you will need 
an Ethernet switch (or router with an integrated switch) and a broadband Internet connection.

Caution: If TalkSwitch has been exposed to low temperatures prior to installation, wait until 
the system has reached room temperature before connecting the power cord to 
avoid condensation.
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UNIT FRONT PANEL

The front panel consists of a power button, four line lights, and the power/data light.

Figure 1: Front panel      

What the flashing lights mean

The TalkSwitch unit flashes the lights on the front panel in different patterns to show 
diagnostic states.

Line 1, 2, 3 and 4 lights flashing simultaneously 

The unit ID of this unit is in conflict with another unit on the same LAN.

1. Assign a different unit ID to each unit. For more information, see Setting or changing the 
unit ID on page 17.

Power/Data and Line 1, 2, 3 and 4 lights flashing simultaneously

The boot block is functioning, but the firmware needs to be updated or reloaded. Ensure you 
update the firmware with the latest version. Do not use the version on the installation CD, 
because there might be a newer version.

1. Choose Tools > Update Firmware.

Line 1 and 4 lights, then Line 2 and 3 lights flashing alternately

The prompts are corrupted or not loaded. Ensure you update the firmware with the latest 
version. Do not use the version on the installation CD, because there might be a newer version.

1. Choose Tools > Update Firmware. 

Light State Description
Line 1 to Line 4 On Line is in use.

Flickering Line is ringing.
Pulsing slowly Line caller is on hold.
Pulsing quickly Line is engaged by a device that is sharing the line 

with TalkSwitch.
Power/Data On TalkSwitch is powered on.

Flickering The TalkSwitch unit is exchanging data with the 
computer via USB. 

Pulsing slowly A voicemail message has been left in one of the 
mailboxes. This indicator is disabled by default, but 
can be enabled.

TalkSwitch models with eight telephone lines do not have lights for Lines 5 to 8.
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Line 1 and 3 lights, then Line 2 and 4 lights flashing alternately

The firmware and prompts have been updated, and the TalkSwitch unit needs to reboot.

1. Choose Tools > Reboot TalkSwitch or, on the front panel, turn the power button off and 
back on.

Line 2 and 3 lights flashing simultaneously

File system error. The stored greetings, music on hold, and voicemail messages may have 
exceeded the memory capacity of the TalkSwitch unit.

1. Choose Tools > Memory Usage. The Memory Usage window appears.

2. Check the Time Usage Summary area.

3. If the stored greetings, music on hold, and voicemail messages have exceeded the memory 
capacity, delete unnecessary files.

4. Choose Tools > Reboot TalkSwitch. The Reboot System window appears.

5. Select Lock down system and reboot when all calls are complete.

6. Click Reboot. The TalkSwitch system will reboot when all calls have been completed.

Line 1 and 4 lights flashing simultaneously

Voice mailbox error.

1. Choose Tools > Reboot TalkSwitch or, on the front panel, turn the power button off and 
back on.

Power/Data and Line 1, 2, 3 and 4 lights on steady

The boot block is corrupt.

1. Contact the Technical Support department at TalkSwitch.
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UNIT BACK PANEL

Figure 2: TalkSwitch 240vs, 244vs and 248vs

Figure 3: TalkSwitch 280vs, 284vs and 288vs      

Figure 4: TalkSwitch 480vs, 484vs and 488vs

Figure 5: TalkSwitch 840vs, 844vs and 848vs

The PF box between E4 and L1 represents power failure support. In the event of a power 
failure or loss of power to TalkSwitch, extension jack E4 is able to receive and make calls on 
Line 1.
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INSTALLING THE TALKSWITCH MANAGEMENT SOFTWARE

Installing the software

1. If the TalkSwitch unit is connected to a USB cable, disconnect the cable.

2. Turn on your computer and insert the TalkSwitch CD into your CD drive. The install program 
starts automatically. 

3. Click NEXT and follow the instructions.

4. If the TalkSwitch unit was connected to a USB cable, reconnect the cable.

If you are upgrading from TalkSwitch configuration software 5.00, this concludes the 
installation procedure.

If you are upgrading from TalkSwitch configuration software 4.10, the Found new hardware 
icon will appear, followed by the USB driver installation wizard.

a) Proceed with the USB driver installation by clicking Next.

b) Once the USB driver files have been installed, click Finished.

c) Once the USB driver installation is complete, start the TalkSwitch management software.

d) When the Connection window appears, select USB, and then click Connect. The Data 
LED on the TalkSwitch unit will blink when the connection is successful. 

Port Purpose

MUSIC The music connector is a 1/8” (3.5mm) mono phono jack used as an audio 
input for music on hold.

PA The PA (public address) connector is a 1/8” (3.5mm) mono phono jack used 
as an audio output for overhead paging, voicemail screening and music 
on hold.

LAN The LAN connector is an RJ-45 jack used for connection to a PC, connection 
of IP extensions, connection of VoIP lines, and unit-unit networking.

There are three green LEDs on the right of the LAN port. The top LED 
indicates network synchronization (connection), the middle LED indicates 
data Rx (receiving data), and the bottom LED indicates data Tx 
(transmitting data).

E1–E8 The extension connectors are RJ-11 jacks for analogue extensions. 

L1–L8 The line connectors are RJ-11 jacks for telephones lines.

USB The USB connector is a B jack for connecting to a PC.

MEMORY SLOT The memory slot on the side of the enclosure is a socket used with 
TalkSwitch memory cards. Memory cards are not available in some markets.

POWER The power connector is a receptacle rated at 16 VAC/2.0 A for connecting 
the supplied AC adapter input line.

The latest version of the TalkSwitch software can be downloaded from the support section 
at http://global.talkswitch.com.
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If you prefer to use Windows Explorer or if the install process does not launch automatically:

1. Double-click the My Computer icon.

2. Double-click the CD-ROM/DVD drive.

3. Double-click the Startscreen.exe icon and follow the instructions. After you click the 
Finish button, you will see the TalkSwitch icon on your desktop. This means you have 
successfully installed the TalkSwitch management software. 

Upgrading the TalkSwitch software and firmware

We are continually looking for ways to enhance your communications capabilities. When new 
features are added, we provide our users with immediate access to an update directly from 
Windows Start menu. 

1. Click Start > Programs > TalkSwitch 6.11 > TalkSwitch Auto Update.

If your TalkSwitch management software is due for an update, a window informs you of the 
status of your software version. If you need an update, you have the option to download 
the update.

2. Click the Download button to download the update. After the file is downloaded, the Auto 
Update program prompts you to install the update.

3. Click Yes to install the update. You can also install the update later from C:\Program 
Files\TalkSwitch\TalkSwitch Configuration 6.11.

The TalkSwitch management software must be closed in order to install the update.
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Alternatively, you can check the versions you are running once the system is connected by 
following the three steps below.

Step 1 — Check current version

To identify the appropriate update file, you must determine your TalkSwitch software and 
firmware versions. To find your TalkSwitch software version number, choose Help > About 
TalkSwitch Management Software.   

Write down the software number. Go to the support section of the TalkSwitch website at http://
global.talkswitch.com. The instructions help you select and download the appropriate upgrade.

Step 2 — Download new software and firmware

When you double-click on the appropriate version for downloading, a window displays, asks you 
to enter a filename and select a folder for the download. We suggest leaving the filename as it is 
and saving it to your PC in C:\Program Files\TalkSwitch\TalkSwitch Configuration 6.11. 
Once the download is complete, begin your upgrade by double-clicking on the install file or 
using the Run command on the Windows Start menu. A series of windows will guide you 
through the installation process.

This process updates your TalkSwitch management software to a newer version. You still need to 
update the firmware to take advantage of new features. The new firmware file is placed in the 
TalkSwitch directory after running the install program.

Step 3 — Updating the firmware

The last step is to update the firmware. Make sure your TalkSwitch is connected to your PC.

1. Open the TalkSwitch management software.

2. Choose Tools > Update Firmware.

The instructions on our website take precedence over any instructions in this user guide.
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The update time varies depending on the connection type, how many files are needed and how 
many units are updated. On average the process takes between 1 and 5 minutes. The LED lights 
on the TalkSwitch front panel show diagnostic indicators for the update. See What the flashing 
lights mean on page 2. When the update is completed, you are prompted to reboot TalkSwitch. 
In the window, click the Proceed button.

Should the firmware update fail, please repeat the update process above. If the problem persists, 
contact your reseller or TalkSwitch.

Most firmware updates do not alter your system configuration. In certain circumstances, during 
a major system update, the configuration file may get reset to default values.

When you configure a unit for the first time and every time you modify the configuration, we 
recommend you save your configuration file to your PC and preferably to removable media (3.5" 
Floppy, CD-ROM disc or Flash stick) as a back-up. This avoids having to reconfigure the entire 
system in case of a hardware failure.

INITIAL CONFIGURATION

Once your software is installed and your TalkSwitch is connected directly to a PC or via a switch/
hub to the LAN, you can customize the TalkSwitch system with the TalkSwitch 
management software. 

If you connect TalkSwitch to your telephone lines, it will do the following:

• An incoming call on any line will ring all local extensions.

• A receptionist can manually transfer calls to local extensions or voicemail.

• Every local extension will have a voice mailbox. 

If you have to replace your computer, please download the latest install file from our website 
and follow steps 2 and 3 above. Run the install program. In case of a major system update, 
copy the back-up of your configuration file to
C:\Program Files\TalkSwitch\TalkSwitch Configuration 6.11.

Recommendation: To minimize the disruption time of your telephone lines during the 
system setup, we recommend you configure the unit before you connect all the local 
extensions and telephone lines to the TalkSwitch unit. 
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SELECT LOCATION FOR INSTALLATION

Select a suitable location for installation of TalkSwitch. 

TalkSwitch can be installed on a desktop or mounted on a wall. It can be installed in a office or 
communications or utility room. 

Choose a location that meets the following requirements:

• Ambient temperature between 0–35°C. 

• Away from heat sources and direct sun light.

• Avoid rooms with excessive humidity or dust.

• Within 1.5m of a power socket.

• Close to telephone company demarcation point for telephone lines, or sockets, and any in-
building telephone wiring connection point.

• Away from any electronic devices that emit radio signals.

• Away from hazardous or explosive materials.

When installing multiple TalkSwitch units, do not stack units on top of each other.

If TalkSwitch has been exposed to low temperatures prior to installation, wait until the system 
has reached room temperature before connecting the power cord to avoid damage due 
to condensation.

CONNECT TALKSWITCH TO A NETWORK OR A PC

Connect the AC adapter provided with TalkSwitch from an electrical outlet to the TalkSwitch 
unit. Never use a power adapter other than the one that came in the TalkSwitch package.

To configure the TalkSwitch unit, connect the unit via ethernet, USB or Internet to the PC with 
the TalkSwitch management software installed.

Caution: Use only the power adapter and power cord supplied with your TalkSwitch. Check 
the supply voltage matches the rating on the power adapter label. If your supply voltage does 
not match the power adapter rating, please consult your reseller. For safe operation, the 
TalkSwitch power adapter must be connected to a power supply socket with a third pin 
(ground/earth).

Caution: Surge protection devices are recommended to protect TalkSwitch in areas subject to 
lightning or power surges. Please consult your reseller for recommended surge 
protection devices.

The computer connection is only needed to change the configuration settings. It can remain 
disconnected at other times. If you encounter difficulties opening the TalkSwitch 
management software, check that all your wires and plugs are securely connected.
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Ethernet connection

An Ethernet cable is supplied with specific unit models. This 
connection requires a LAN and a PC on the same switch. Any PC on 
the LAN can configure the unit.

The top LED on the back panel beside the LAN port indicates a connection has 
been established with a switch or hub.

A PC can connect directly to the TalkSwitch LAN port using a ‘cross-over’ cable 
equipped with RJ-45 connectors.

You can use a PC that has a wireless connection to the LAN. If the router has uPNP enabled, the 
TalkSwitch management software can auto-discover and connect to the TalkSwitch unit. If the 
router does not have uPNP enabled, the TalkSwitch management software cannot auto-discover 
the TalkSwitch unit. However the software can connect to the TalkSwitch unit if you specify its 
IP address after starting the software. 

1. Connect your PC to the hub or switch using an Ethernet cable.

2. Connect the TalkSwitch unit to your hub or switch using the supplied Ethernet cable.

Figure 6: Ethernet connection

USB connection

A USB cable is supplied with specific models. The PC and TalkSwitch unit 
must be in close proximity. 

1. Connect the cable to a USB port on your PC and to the USB port on the back of TalkSwitch.

Sharing computer data and TalkSwitch voice data, on the same hub can cause voice 
degradation during high traffic periods. For best results, place TalkSwitch units on a switch, or 
on their own hub.
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Internet connection

An Ethernet cable is supplied with specific unit models.

The top LED on the back panel beside the LAN port indicates a connection has been established 
with a switch or hub.

1. Connect the TalkSwitch unit to your hub or switch using the supplied Ethernet cable.

2. To support remote management over IP, map the TCP/IP 9393 port from your firewall to 
TalkSwitch. Please refer to the manual for your router/firewall to activate port forwarding.

CONNECTING TELEPHONE LINES

The TalkSwitch unit will perform call handling, and will route all incoming calls to the 
extensions. Call handling includes call forwarding, transferring, voicemail, etc. Telephone lines 
are not directly connected to any of the local extensions. The TalkSwitch configuration 
determines how calls are routed to local extensions.

1. Connect the TalkSwitch unit to the telephone company’s line sockets using the 2-wire 
single-line telephone cables provided, beginning with L1. Take note of which telephone line 
is connected to each line port. This information will be used in the configuration section.

If you have two telephone lines out of one phone jack, you will require a dual-to-two-
single-line adapter or replace the two-line cord with two single-line cords.In cases where 
the telephone company lines are terminated on a Connection Box with IDC or screw 
terminals, it is recommended that RJ-11 wiring-tails are used. These are single or multi-pair 
cables with 0.5 mm solid core wire and one end terminated in an RJ-11 connector(s). These 
RJ-11 wiring tails may be available where you purchased your system or provided by 
your installer. 

CONNECTING LOCAL EXTENSIONS

A local extension is an analogue extension, IP extension or external IP extension. An analogue 
extension is a device (standard phone, cordless phone, fax machine or modem) connected to 
extension jack E1–E8. An IP extension is an IP phone connected via LAN. An external IP 
extension is an IP phone connected via the Internet, and requires the TalkSwitch unit to have 
VoIP capability.

Connect a single-line device to an extension jack the same way you would plug it into a 
standard telephone wall jack.

In cases where extensions will be wired through in-building wiring and a connection box with 
IDC or screw terminals, it is recommended that RJ-11 wiring-tails are used. These are single or 
multi-pair cables with 0.5 mm solid core wire and one end terminated in an RJ-11 connector(s). 
These may be available from your TalkSwitch reseller or provided by your installer.

Advisory: In order to minimize disruption to your business, you may want to configure 
TalkSwitch before connecting it to your telephone lines and local extensions.

Caution: The TalkSwitch line jacks are sensitive to high-voltage spikes from lightning. If you 
live in an area where electrical storms occur regularly, we recommend you protect TalkSwitch 
by plugging the telephone cords coming from the TalkSwitch line jacks to a surge protection 
device connected to the telephone lines. 
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To connect telephones with BT style plugs it is recommended that extensions are wired through 
a master socket or an in-line adapters with a capacitor. This also ensures compatibility with 
some telephones that require 3-wire connections for the telephone to ring.Connect a standard 
phone that does not require external power to extension jack E4 to ensure communications 
during a power failure. In the event of a power failure or loss of power to TalkSwitch, the phone 
on extension jack E4 is able to receive and make calls on line L1.

Connecting a single-line analogue phone

This is the basic, simple set-up. All functionality including transferring calls, forwarding calls 
and voicemail, is handled by the unit. Even the most basic of phones, once connected, will 
inherit these functions.

Each phone is connected to an extension jack. Calls on extension 111 ring the phone connected 
to jack E1. Calls on extension 112 ring the phone connected to jack E2 and so on.

Figure 7: Single-line phones

Connecting a two-line analogue phone

You can plug a two-line phone into two extension jacks of the TalkSwitch unit. You can then 
configure each telephone line to ring a specific extension. For example, line 1 can ring 
extension 111, which will show Line 1 as active. Line 2 can ring extension 112, which will show 
Line 2 as active and so on.

Figure 8 shows extensions 111 and 112 connected to a two-line phone that uses separate jacks 
for each line. 

Figure 8: Two-line phone
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If your two-line phone does not have separate jacks, you can use a splitter to join the two lines 
as shown in Figure 9. 

Figure 9: Two-line phone on splitter

A four-line phone can use two splitters to join the four lines as shown in Figure 10. 

Figure 10: Four-line phone on two splitters

Connecting an IP phone

Plug the IP phone into your switch/hub and configure it as described in Adding IP phoneS on 
page 81. If you are using an unsupported IP phone, refer to its user guide for 
configuration instructions.

Connecting a modem

Plug the modem’s telephone cable into a unit extension jack. Your modem is now an extension 
that can access all lines and take advantage of call routing features.

If you don’t want to change your dial-up settings for the modem, enable Direct Line Access for 
the extension associated to the modem. For more information, see Direct line access on page 62.

A modem connected to a TalkSwitch unit operates at up to 28 kbps. 
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Connecting a fax machine

If you are connecting a fax machine to a TalkSwitch unit, plug it into an extension jack.

TalkSwitch provides you with three options to configure your fax machine. Choose the best 
option for your office.

Option 1 — Dedicated fax line

You may already have an incoming dedicated fax line. You can leave this line directly connected 
to your fax machine. Connect the remaining telephone lines to your unit. Telephone lines will be 
handled by the unit and your fax will work the way it has always worked.

Figure 11: Dedicated fax line

Advantages: It’s easy to set up and you don’t need to change the way your fax handles calls.

Disadvantages: The dedicated fax line cannot be shared with the other phone devices (i.e. you 
cannot make an outbound voice call on your fax line). The dedicated fax line costs money, and 
may not be used as frequently as it could be.

Option 2 — Distinctive ring

Distinctive ring is a service provided by your phone company. A second phone number is added 
to a telephone line. A call to either phone number will ring the same line, but with different 
ring patterns. You can use one ring pattern to indicate a fax.

Figure 12: Distinctive ring

Advantages: This option does not require a second physical line for faxes. More telephone lines 
can be added as you grow. You can keep the same fax arrangement.

Disadvantages: Your phone company may charge a fee for the distinctive ring. If you choose 
this option, you will require the distinctive ring service from your telephone company.
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Option 3 — Automatic fax detection via the auto attendant

The auto attendant can detect incoming fax calls and route them accordingly. To enable this, an 
auto attendant must answer all incoming calls. It will listen for a fax tone (CNG) to determine if 
the call is an incoming fax. If so, the call is routed to the fax machine. You must create an auto 
attendant to use this method.

Figure 13: Automatic fax detection via auto attendant 

Advantages: Calls are automatically handled for you. Distinctive ring service is not required. 
Any telephone line can receive a fax or a call, making better use of your resources.

Disadvantages: Some older fax machines do not emit a fax tone (CNG). Therefore, the auto 
attendant cannot detect incoming faxes from those devices. If your auto attendant volume is set 
too high or if your telephone lines are noisy, the auto attendant may have difficulty detecting 
the incoming fax tone and therefore not route the call to the fax machine. You can solve this 
problem by adjusting the volume. For more information, see Telephone Lines > Audio on 
page 177.

CONNECTING TO THE PA (PUBLIC ADDRESS) JACK

The PA jack can be connected to a PA system for overhead paging, screening voicemail and 
playing music on hold. The PA jack requires a 1/8" (3.5 mm) mono phono connector. If your 
system has multiple TalkSwitch units, use a splitter to connect each TalkSwitch unit to the 
PA system.

SETTING UP MUSIC ON HOLD

Callers tend to react more positively to waits or transfers if they hear music. You can also play an 
advertisement or provide information about your company.

External audio source

The MUSIC jack is designed to support an external audio source like a CD player, tape player or 
PC media player.

Advantages: The length of the recording is not limited by the amount of memory in the 
TalkSwitch units. All of the TalkSwitch memory is available for voicemail and auto attendants. 
Different TalkSwitch units can have different music on hold.

Disadvantages: Extra dedicated equipment must be connected and running constantly. A 
separate sound source is required for each unit.
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1. Connect the audio source via its headphone output to the MUSIC jack. Use a cable with a
1/8" (3.5 mm) mono phono connector.

2. If your system has multiple TalkSwitch units, either use a different audio source for each 
unit, or use a splitter to connect the one audio source to each unit.

Internal audio file

You can load an audio .wav file into the TalkSwitch unit. If you have more than one unit 
connected by LAN, the .wav file is automatically copied to each unit.

Advantages: No additional equipment is required. All units use the same file, which provides 
seamless music for calls transferred across the system.

Disadvantage: The length of the recording is limited by the amount of memory in the 
TalkSwitch units. Less time is available for voicemail and auto attendants.

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

NETWORKING TALKSWITCH UNITS ON A LAN

Up to four units can be networked together over a LAN to increase the number of telephone 
lines and extensions in your phone system.

Connecting TalkSwitch units to a LAN

You can plug your unit(s) into your existing LAN or operate it on its own LAN with an Ethernet 
switch. Ensure the firmware on all units is updated before adding them to the LAN.

Check the support section at http://global.talkswitch.com for the latest updates.

Ethernet switch

An Ethernet switch provides direct communication between units, thus keeping the voice-over-
LAN data isolated from other data on the network.

1. Connect up to four units to an Ethernet switch.

2. Connect a computer to the Ethernet switch. 

3. Power up and configure the units.

4. After configuring the units, connect the IP extensions to the Ethernet switch.

TalkSwitch unit enclosures are not designed for stacking. We recommend wall-mounting units 
to maximize airflow and keep the units from overheating.
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It is important that you place the IP extensions on the same subnet as TalkSwitch. For example, 
if your TalkSwitch unit has the IP address 192.168.1.200, your IP extensions should use IP 
addresses in the range 192.168.1.xxx that do not conflict with other IP addresses.

Figure 14: Three units connected via an Ethernet switch

Power up all the TalkSwitch units

Connect the provided AC adapters to each unit and plug the adapters into available power 
outlets. Turn the units on by pressing the Power button on the front of each unit. The lights on 
the front panels of the units will flash. This means they are powered up and connected to the 
LAN, but their ID numbers are not set.

Setting or changing the unit ID

Units are shipped from the manufacturer with unit ID 1. If two or more units are placed on the 
same LAN with the same unit ID number, it causes a conflict. The four line lights on the front 
panel of each unit will start flashing. You have to assign a different unit ID to each unit.

1. Connect an analogue phone to one of the extension jacks on the unit.

2. Press # to enter command mode.

3. Dial the system password + #.

4. Now, you have the following options:

The system indicates the update was successful and the front panel lights stop flashing after a 
few seconds. When the front panel Data light is on solid, the units are ready for network use.

How unit IDs affect system extension numbers

After successfully changing each unit ID to a unique number, it can be identified by the 
network. More importantly, each local extension, remote extension, and voice mailbox has a 
unique number. Note that dialling 101–108 will ring local extensions 111–118. 

Keys Result

00 + # Responds with the unit ID number of that particular unit.

01 + # Sets the unit ID to 1.

02 + # Sets the unit ID to 2.

03 + # Sets the unit ID to 3.

04 + # Sets the unit ID to 4.

LANMUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB POWER

L4L3

L1

PF

LANMUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB POWER

L4L3

L1

PF

LANMUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB POWER

L4L3

L1

PF

1Internet 2 3 4 POWER

Reset
T A L K S W I T C H  I N S T A L L A T I O N 17



Keep track of the lines and extensions

To keep track of the extensions and telephone lines connected to each unit, label each unit with 
its unit ID. It simplifies matters when you need to add or remove extensions and lines.

Optimizing the system for networked use

TalkSwitch units have been designed to operate optimally when in a networked state. Below are 
a few items that have been designed for better network use.

Configuration settings

All units are cloned with identical settings. If a unit has disappeared off the network (adapter 
unplugged, LAN disconnected, LAN failure, etc.), the system can still handle the calls since it 
retains the configuration settings of the missing unit. If an extension or a voice mailbox cannot 
be reached, the caller hears a system prompt: “The extension you are trying to reach is currently 
unavailable, please try again later.”

Outgoing line hunt groups

When two or more units are on a LAN, the system tries placing calls out on the same unit the 
call originates from. This avoids using a line across the LAN on another unit, which helps to 
minimize the LAN traffic and optimizes the opportunity for all inbound calls to connect across 
the LAN if required. 

Auto attendants

There are a total of nine auto attendants that are shared by all units on the LAN. When an auto 
attendant is recorded on any unit, it is automatically copied to all other units on the LAN. This 
design minimizes LAN traffic and provides functionality back-up in case a unit or units have 
disappeared off the network (adapter unplugged, LAN disconnected, LAN failure, etc.). In this 
event, all units can still answer inbound calls with the same auto attendant messages.

Voicemail

All local extension and remote extension voicemail data is stored on the unit the extension is 
connected to. For example, all greetings, dial-by-name directory names and voicemail messages 
for extensions 121–128, 161–168, 220–229 and mailboxes 420–429 are stored on unit 2. If a 
unit is completely filled with voicemail messages, the system will not accept any more messages 
for its extensions. However the other units will accept messages for their extensions. If you need 
more memory, TalkSwitch memory cards can be purchased from your reseller. To view the 
memory usage of each TalkSwitch unit and each mailbox, choose Tools > Memory Usage or 
choose Tools > Voicemail Manager > Mailbox Status.

Unit ID 1 Unit ID 2 Unit ID 3 Unit ID 4

Local extensions
(analogue/IP)

111–118 121–128 131–138 141–148

Local extensions (IP only) 151–158 161–168 171–178 181–188

Remote extensions 210–219 220–229 230–239 240–249

Local mailboxes 111–118
151–158

121–128
161–168

131–138
171–178

141–148
181–188

Remote mailboxes 210–219 220–229 230–239 240–249

General mailboxes 410–419 420–429 430–439 440–449
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Special considerations when connecting multiple units to a LAN     

Multiple TalkSwitch units on a LAN will function as a single phone system. Some features are 
expanded as you add units, and other features are not.

As you add more units, the number of telephone lines, local extensions, VoIP lines, remote 
extensions and voice mailboxes will increase.

For example, if you have a 480vs and a 244vs connected on the same LAN, the system can 
support 6 telephone lines, 32 local extensions, 4 VoIP lines, 20 remote extensions, 32 local voice 
mailboxes, 20 remote voice mailboxes, and 20 general voice mailboxes.

The features listed below are not affected by the number of units on the LAN, so capacity will 
not increase as you add units.  

INCREASING MEMORY CAPACITY

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards. Contact your 
reseller to purchase memory upgrades.

TalkSwitch memory cards

TalkSwitch memory cards are specifically formatted for use with TalkSwitch units. They allow 
you to add additional voicemail message capacity to your unit. Voicemail memory is used to 
store greetings and messages left in voice mailboxes. It is also used to store music on hold, auto 
attendant greetings and announcements.

Figure 15: Memory card 

Installing a memory card

1. Insert the memory card into the memory slot with the gold contact face down and the “This 
side up” label showing. You don’t have to turn the unit off or disconnect any of 
the telephones.

Feature Description
Auto Attendant There are nine auto attendants.
Ring Groups There are ten ring groups (300–309).
Park Orbits There are ten park orbits (500–509).
Music on Hold You can add music on hold to your system by loading an internal music file. 

The music file is copied to each TalkSwitch unit, so the music on hold will be 
the same for each line of each unit.

Public Address 
(PA)

Each unit has a PA output for connection to a public address system. The PA 
output for a TalkSwitch unit is only accessible from extensions connected to 
that unit. To connect all outputs to a single amplifier, you will require 
an adapter.
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2. Ensure the Total Unit Time has increased in the Mailbox Data window. See Memory Usage on 
page 161.

Figure 16: Memory card slot

UPGRADING TALKSWITCH UNITS

As your business grows, your TalkSwitch unit(s) may need upgrading. You have the option of 
upgrading your units to VoIP, as well as adding telephone lines and extension jacks. The upgrade 
kit consists of a top board you add to your existing TalkSwitch unit, as well as a guide 
containing detailed, step-by-step instructions for the upgrade procedure.

Purchase VoIP modules and upgrade boards at your reseller or visit the TalkSwitch website for 
more details.

Note that in some cases it may be easier and more cost effective to buy another TalkSwitch unit 
than to upgrade an existing unit.

Upgrade TalkSwitch unit Board TalkSwitch 
equivalent

Add four VoIP lines 240vs
280vs
480vs
840vs
48-CA

4plus 244vs
284vs
484vs
844vs
48-CVA

Add eight VoIP lines 240vs
280vs
480vs
840vs
48-CA

8plus 248vs
288vs
488vs
848vs
48-CVAv2

Add six telephone lines 240vs
244vs
248vs

600plus 840vs
844vs
848vs

Add four extension jacks 240vs
244vs
284vs

40plus 280vs
284vs
288vs

Add two telephone lines 
and four extension jacks

240vs
244vs
248vs
24-CA

240plus

24-CA to 48-CA top 
board

480vs
484vs
488vs
48-CA
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ENABLING LICENSED ADD-ONS

It is possible to enable the following features on your TalkSwitch:

• Attendant Console software

• Call Reporting software

For instructions on enabling TalkSwitch licensed add-ons, see Licensed Add-Ons on page 57.

VERIFYING THE CONNECTIONS

If you are having problems, they could be due to loose cables. Check the following:

1. Are your telephone cables connected to a wall jack at one end and the unit at the other? 
Ensure the devices you are using as extensions (telephones, faxes, etc.) are plugged into the 
extension jacks located on the back panel of the unit. Do not plug your extensions directly 
into a wall jack unless that jack is wired to a unit extension jack.

2. Check the USB or LAN connection between TalkSwitch and your PC. 

3. Ensure the unit AC adapter is plugged into a working power outlet and the unit is turned on. 
Make sure you are using the AC adapter supplied with your unit. This adapter cannot be 
substituted with any other adapter. If your adapter appears to be defective, please contact 
your TalkSwitch dealer to order the proper replacement.

If networked, ensure you have the latest firmware loaded on all units.

CONNECTING A TALKSWITCH UNIT TO A PBX

Connecting a TalkSwitch unit to a PBX allows the TalkSwitch unit to answer calls with an auto 
attendant. The caller can dial 7 followed by an extension number to reach an extension on 
the PBX.

1. Connect one or more PBX extensions to the TalkSwitch telephone line jacks (one PBX 
extension per line).

2. Configure the PBX to route incoming calls to the PBX extensions that are connected to the 
telephone line jacks of the TalkSwitch unit.

3. Configure the auto attendant to answer after a specified number of rings.

4. Record the auto attendant messages. They should list the extensions with the digit 7 in 
front of them.

5. Set the PBX extension length. See From auto attendant tab on page 169.

For example, if you have chosen the PBX extension length to be 3 digits and John Smith’s 
extension is 111 on the PBX, the auto attendant should say: “To speak with John Smith, dial 
7111.” When the caller dials 7111, the TalkSwitch unit puts the caller on hold and transfers 
them to extension 111 on the PBX.

This feature only works with PBXs that use hook flash as a transfer method. Please contact 
your PBX manufacturer for transfer details.
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C H A P T E R  2
Ch ap ter  2 :  Ta lk Sw itch  Con fi g u ra t i on

TALKSWITCH CONFIGURATION

INTRODUCTION

This chapter contains detailed information about all the features in the TalkSwitch management 
software, with step-by-step instructions on how to customize these features to best suit 
your needs.

STARTING THE TALKSWITCH MANAGEMENT SOFTWARE      

1. Press the Power button to turn on your TalkSwitch unit.

2. Turn on your computer.

When a unit is being configured, it is locked to prevent other computers or persons using a 
phone from configuring changes at the same time. If you leave the software open for longer 
than one hour, the unit unlocks itself to allow configuration changes.
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3. Double-click the TalkSwitch icon on your desktop to open the TalkSwitch management 
software. You can also click Start > Programs > TalkSwitch 6.11 > TalkSwitch 
Configuration 6.11. The Configuration Selection page appears, and the software attempts 
to detect your TalkSwitch unit.

4. Select your language. You can select English, Français or Español.

5. Once the software detects your TalkSwitch unit, click Configure Auto-Detected TalkSwitch 
System. The software loads the configuration from the TalkSwitch unit, and the About 
page appears.

6. If the software was unable to detect your TalkSwitch unit, check that all your wires and 
plugs are securely connected, and then click Retry Auto-Discovery. The software loads the 
configuration from the TalkSwitch unit, and the About page appears.

7. If auto-detection does not work:

a) Click Connect to Different System. The Connect Via IP window appears.

b) Enter the URL / IP address and Port of the TalkSwitch unit, and then click OK. This is the 
public IP address or FQDN of the TalkSwitch system. The software loads the configuration 
from the TalkSwitch unit, and the About page appears.
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8. To open a configuration file:

a) Click Open a Configuration File or Template. The Open File or Template 
window appears.

b) Click Open a File. The Configuration File window appears.

c) Browse to the .tsd file, and then click Open. The software opens the configuration file.
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ABOUT

The About page displays and allows you to change system information.

1. Select the About page.

The System Information area shows:

• The current time and date programmed into the TalkSwitch system. Clicking the System 
time link displays the TalkSwitch Date and Time Properties window. It allows you to 
change the date, time, time zone, and NTP server programmed into the TalkSwitch system. 
See System time on page 31.

• The current mode. A mode is a period of time when the TalkSwitch system uses a particular 
call handling setup for incoming calls. Mode 1 is typically office hours, and Mode 2 is 
typically evening and weekend hours. Holiday Mode is when your office is closed for a 
statutory holiday or shutdown. Clicking the Current mode link displays the Change Mode 
window. It allows you to change the mode of the TalkSwitch system. See Change mode on 
page 30.
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• The model numbers of the TalkSwitch units in the TalkSwitch system. Clicking the My 
TalkSwitch system link displays the Talkswitch Network window. It shows the MAC 
address, IP address, model number, firmware version, and length of operation for each 
TalkSwitch unit.

To identify a TalkSwitch unit, click the Identify button. The Identify button will change to 
a Stop button. All the lights on the front panel will start flashing. Click the Stop button to 
end the flashing.

• The number of new voicemail messages in the TalkSwitch system, and the total number of 
voicemail messages. Clicking the Voicemail messages link displays the Voicemail Memory 
Usage window. It shows message statistics for each voice mailbox. See View mailbox data on 
page 111.

• The version number of the TalkSwitch management software.

• When the configuration was last saved to the TalkSwitch system.

• The type of connection to the TalkSwitch system.

• The region of the TalkSwitch system.
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ADMINISTRATION

The Administration page allows you to set up the system name, system password, region, 
language, and how to route the call if a user dials 0.

1. Select the Administration page.

Administration

The Administration area allows you to set up the system name and system password.

1. Optionally enter the System name. This should be the company name, or a shortened form 
suitable for use as caller ID during VoIP calls. If you enter a system name, you will require it 
when logging in through a browser for status or call detail record (CDR) information. If you 
omit the system name, you can enter talkswitch when logging in through a browser.

2. Enter the System password. It has to be a 4- to 8-digit numeric password, so you can also 
enter it on a touchtone phone.

The system password allows access to the configuration. It is entered when you start the 
TalkSwitch management software, and when you access the configuration through a local 
extension or outside phone.

CAUTION: Use a system password, otherwise the system will be vulnerable to configuration 
changes, misuse and/or lock-out by callers or users. If the router has port 9393 mapped to the 
TalkSwitch unit for remote configuration, the system will also be vulnerable to anyone on 
the Internet.

Change the system password frequently to prevent unauthorized users from making calls or 
changing the configuration.
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Region selection

The Region Selection area allows you to select the country where your TalkSwitch unit will 
operate.

1. Select the country where your TalkSwitch unit will operate.

Language

The Language area displays the language loaded into the TalkSwitch system, and allows you to 
load and remove language files.

1. To change the language files loaded into the TalkSwitch system, click Edit. The Language 
File Management window appears, listing loaded language files.

a) To load a language file, click Add, and then select the language file.

b) To remove a language file, select the language, and then click Remove.

2. Select the default language for prompts heard by callers and users in the Default language 
for system prompts to callers list.

Dial 0 routing

The Dial 0 routing area allows you to select how the system will route the call if a user dials 0. 
For example, you can configure the system to connect the user to the receptionist at 
extension 114.

1. Select the action in the Connect to list. Choices are:

• perform no action — Does not connect to a resource.

• go to voicemail — Connects to the selected voicemail.

• go to local extension — Connects to the selected local extension.

• go to remote extension — Connects to the selected remote extension.

• go to ring group — Connects to the selected ring group.

• play announcement — Plays the selected announcement.

• go to auto attendant — Connects to the selected auto attendant.

• queue at ring group — Connects to the call queue of the selected ring group.

• lookup name directory — Accesses the dial-by-name directory.

• go to VoIP location — Connects to the selected VoIP number within the TalkSwitch 
VoIP network.

2. Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.
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SCHEDULING

A mode is a period of time when the TalkSwitch system uses a particular call handling setup for 
incoming calls. Mode 1 is typically office hours, and Mode 2 is typically evening and weekend 
hours. Holiday Mode is when your office is closed for a statutory holiday or shutdown.

The TalkSwitch system can use a different call handling setup for each mode, and can 
automatically change mode with the time of day, day of week and on holidays. This way it can 
handle calls in different ways according to a schedule.

The Scheduling page allows you to set up Mode 1, Mode 2 and Holiday Mode. You can also adjust 
the time and date, and can switch modes manually.

1. Select the Scheduling page.

Modes

The Modes area allows you to enable, name and switch modes, and displays the current mode.

1. Enter the Mode 1 label and the Mode 2 label. Note that Mode 1 and Mode 2 are always 
available, so you cannot disable the Enable Mode 1 and Enable Mode 2 check boxes.

2. Set up Holiday Mode to handle incoming calls differently during a holiday:

a) Select the Enable holiday mode check box to enable Holiday Mode. The window enables 
the Settings button.

Ensure the TalkSwitch management software is closed during automatic mode switching, or if 
an administrator is manually switching modes using a phone. In these cases the mode cannot 
switch while the TalkSwitch management software is open.

Note that the mode can switch while the TalkSwitch management software is open, if the user 
is manually switching modes using the software, as described later.
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b) Enter the Holiday Mode label.

c) Click Settings. The Holiday Settings window appears. The calendar shows the current 
date in green.

d) Select your country in the Populate calendar with holidays observed in list, and then 
click Populate. The calendar will show your country’s statutory holidays in grey.

e) Using the calendar, select the month and then click the date of the holiday. The date is 
added to the Selected Dates area, and the calendar will show the date in blue. Click the 
date again to remove it.

f) Repeat Step e until all required holidays have been added.

g) Select the mode in the Use the following call cascade settings for Holiday Mode. Choices 
are Mode 1 and Mode 2. This setting determines whether extensions will use their Mode 1 
or Mode 2 call cascades during Holiday Mode.

Change mode

The Modes area displays the current mode.

1. To change mode, click Change Mode. The Change Mode window appears.
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2. Select the mode. The new mode immediately takes effect. You do not have to save 
the configuration.

You can also change the mode by phone.

1. Ensure the TalkSwitch management software is closed.

2. Pick up a local extension, or remotely call the TalkSwitch system.

3. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

4. Enter the system password, followed by #.

5. Enter one of the following commands:

• 30 + #  to hear the current mode.

• 31 + #  to enable Mode 1.

• 32 + #  to enable Mode 2.

• 33 + #  to enable Holiday Mode.

6. Press * to exit command mode.

Scheduling

The Scheduling area allows you to specify when the TalkSwitch system will change modes.

1. Select the Use automatic mode switching check box to enable the modes. The window enables 
the Scheduling area.

2. Select the day.

3. Select whether to use one mode or multiple modes during that day:

• Select Continuously run to use the selected mode the whole day.

• Select Switch modes depending on time to switch between Mode 1, Mode 2 and Holiday 
Mode during the day. The window enables the schedule controls.

4. If you selected Continuously run, select Mode 1, Mode 2 or Holiday Mode.

5. If you selected Switch modes depending on time, set when the mode should change. The 
default settings are:

• Mode 1 at 9:00 AM on Monday to Friday.

• Mode 2 at 5:00 PM on Monday to Friday.

• Mode 2 continuously on Saturday and Sunday.

System time

The Scheduling area shows the date and time programmed into the TalkSwitch system. Clicking 
the Adjust button displays the TalkSwitch Date and Time Properties window. It allows you to 
change the date, time, time zone, and NTP server programmed into the TalkSwitch system.

NOTE: You can configure the TalkSwitch system to get the time and date (but not the year or 
time zone) from caller ID. See Clock Preferences on page 172.
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1. Click Adjust. You can also choose Options > Set Date & Time. The TalkSwitch Date and 
Time Properties window appears.

Date & time

The Date & Time area allows you to set the date and time programmed into the 
TalkSwitch system.

1. Select the month and date for the TalkSwitch system.

2. Set the time for the TalkSwitch system.

Time zone

The Time Zone area allows you to set the time zone for the TalkSwitch system, and whether 
daylight savings time is used in your region.

1. Select the time zone for the TalkSwitch system.

2. If your region uses daylight savings time, select the Automatically adjust clock for daylight 
saving changes check box.
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NTP server

The NTP Server area allows you to set the NTP (Network Time Protocol) server for the TalkSwitch 
system. It provides the same time to the TalkSwitch units and to the external IP extensions.

1. Select the NTP Server tab.

2. Enter the NTP server. 
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IP CONFIGURATION

The IP Configuration page allows you to set up the TalkSwitch system for Internet 
communications. The Internet can be used for external IP extensions, a TalkSwitch VoIP 
network, a subscription to a VoIP service, and remote configuration.

1. Select the IP Configuration page.

System IP settings

The System IP Settings area shows IP addresses. By default, Obtain IP and DNS information 
automatically is selected and the area shows IP addresses from the router. 

1. Change Obtain IP and DNS information automatically to Use configured IP and DNS 
information in order to lock in the IP addresses.

2. In some cases, the System IP Settings area may be blank because your router has not 
delivered the IP addresses. If so, enter the following IP addresses from your 
LAN administrator:

a) Enter a static IP address for each TalkSwitch unit in the Unit IP address boxes.

b) Enter the Subnet mask for the LAN. This address determines the subnet the unit IP 
addresses belong to.

c) Enter the IP address of the Default gateway on your network. A gateway is a hardware 
device that connects the office network to the Internet. The router may act as 
default gateway.

d) Enter the IP address of the Preferred DNS server. DNS is a service used to resolve a domain 
name to an IP address. The router may act as DNS server.

e) If applicable, enter the IP address of the Alternate DNS server.
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TalkSwitch proxy

If your TalkSwitch system has multiple TalkSwitch units, the TalkSwitch Proxy area displays and 
allows you to change the unit acting as local proxy. The local proxy handles Internet 
communications for the TalkSwitch system. It establishes connections across the Internet, and 
then routes Internet data to and from each TalkSwitch unit. The lowest numbered TalkSwitch 
unit acts as local proxy by default.

The router must map the SIP, TFTP and HTTP ports to the local proxy. See Router port forwarding 
on page 36.

1. If necessary, click the Change Proxy button. The Change Proxy window appears.

2. Select the TalkSwitch unit.

Public IP address

The Public IP address section allows you to set up Internet parameters so the TalkSwitch system 
can communicate with other locations over the Internet.

1. Set the Type of public address. Choices are:

• Dynamic public IP address — This is the default setting. Your ISP (Internet Service 
Provider) will assign different public IP addresses to your location. The TalkSwitch 
system will check its public IP address every five minutes. When the public IP address 
changes, the TalkSwitch system will automatically use the new one. This allows it to 
manage VoIP calls properly.

If Dynamic public IP address is selected, the window completes the Current public IP 
address, and sets Public IP address-checker server name to checkip.talkswitch.com. This 
server runs an IP checker application that provides public IP addresses to TalkSwitch 
systems. You cannot change these items.

• Static public IP address — A static IP address is fixed. Your ISP assigns the static IP 
address. If this location will have the SIP server for a TalkSwitch VoIP network, we 
recommend using a static IP address.

If Static public IP address is selected, the window allows you to enter the Current public 
IP address, and disables the Public IP address-checker server name box.

2. If you selected Dynamic public IP address, enter the Fully qualified domain name (FQDN). Get 
the FQDN from your ISP. The FQDN is only required if this location is the SIP server for a 
TalkSwitch VoIP network, or has external IP extensions.

A DDNS (Dynamic Domain Name Service) provider such as www.dyndns.com matches your 
dynamic IP addresses to your FQDN, so your TalkSwitch VoIP network or external IP phones 
will continue to work when the IP address changes.

If you are using DDNS, ensure your router supports your DDNS service, and configure it to 
update the DNS servers.
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If your router does not support DDNS, download one of the applications specified on 
www.dyndns.com. To update the DNS servers, the application needs to run on a PC 
connected to the same LAN as the TalkSwitch system.

3. If you selected Static public IP address, enter the Current public IP address from your ISP. 
Leave the Fully qualified domain name box blank.

If the TalkSwitch unit is not behind a router, or if a private virtual network is used, the 
public IP address should be set to the local IP address of the TalkSwitch unit acting as 
local proxy.

Note that it will take up to one minute for the new static public IP address to take effect.

Router port forwarding

The Router Port Forwarding area displays the type of gateway device (i.e. the type of router), the 
IP address of the gateway (i.e. router), and whether router configuration is required.

A router is a gateway between the local area network and the Internet. Most routers have a 
firewall to block unwanted data from the Internet. For voice data to reach the TalkSwitch system 
through the firewall, port forwarding is required. Port forwarding allows the router to map ports 
to the IP addresses of the TalkSwitch units. Valid Internet data will use the ports to go through 
the firewall to the TalkSwitch units.

If you are setting up external IP extensions, a TalkSwitch VoIP network, or a VoIP service that 
doesn’t handle port forwarding, port forwarding is required.

If port forwarding is required, and your router supports uPNP (Universal Plug and Play), ensure 
uPNP is enabled. The TalkSwitch system will use uPNP to automatically set up port forwarding, 
and the Automatic (uPNP Enabled) link will appear. No router configuration is required.

If port forwarding is required but your router doesn’t support uPNP, or automatic port 
forwarding doesn’t work, the Manual Port Mapping Required link will appear. You will need to 
configure the router as described below.

1. If required, click the Manual Port Mapping Required link. The Manual Port Mapping 
window appears. It lists the packet type, port number, IP address and protocol of each 
required port.
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2. To access the router configuration:

a) Click the link containing the IP address of the gateway. The default browser starts, and 
prompts you for the router’s user name and password.

b) Enter the router’s user name and password. The browser shows a setup screen.

c) Navigate to the screen used to set up port forwarding. See your router documentation.

d) Set up port forwarding using the information from the Manual Port Mapping window. 
See your router documentation for instructions on how to map ports. For information on 
configuring routers and mapping ports, visit http://www.portforward.com/english/
routers/port_forwarding/routerindex.htm.

3. To check the status of each port through the firewall, click Check Firewall. The Test 
Firewall window appears.

4. Select the services you want to check.

5. Click Test Ports. The system will check the ports of the selected services.

Configuring the router manually

If you cannot access the router configuration through the IP Configuration page, configure the 
router manually.

1. Open the router configuration and navigate to the screen used to set up port forwarding. 
See your router documentation.

2. Map port 5060 (Type: UDP) to the TalkSwitch unit acting as local proxy. Port 5060 is the 
default port for forwarding SIP signaling data to the TalkSwitch system.

If required, you can map a different port. In this case, enter the port in the SIP signalling 
port box of the VoIP Settings window.

3. Map the following ports (Type: UDP) to the TalkSwitch units. These RTP ports forward voice 
traffic to the TalkSwitch system by default. 

VoIP Lines/Unit Unit 1 Unit 2 Unit 3 Unit 4
4 6000–6006 6010–6016 6020–6026 6030–6036
8 6100–6114 6200–6214 6300–6314 6400–6414
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If required, you can map different ports. In this case enter the first port in the Starting RTP 
port box of the VoIP Settings window.

4. If you are setting up external IP extensions, map port 69 (Type: UDP) to the TalkSwitch unit 
acting as local proxy. Port 69 allows the TalkSwitch system to configure external 
IP extensions.

5. If you are setting up TalkSwitch IP phones as external IP extensions, map port 8484 (Type: 
TCP) to the TalkSwitch unit acting as local proxy. Port 8484 allows the TalkSwitch system to 
configure TalkSwitch IP phones as external IP extensions.

6. Map port 9393 (Type: TCP) to the TalkSwitch unit acting as local proxy. Port 9393 allows 
remote configuration of the TalkSwitch system.

7. If available, enable Quality of Service (QoS) to give voice traffic priority over data.

8. Save the configuration to the router.

ON-HOLD/RINGBACK

Music on hold plays when a caller is on hold, or is being transferred to an extension. The system 
plays a double beep tone or ringback tone by default, but you can have it play music or a 
recorded message instead.

The TalkSwitch system can play music on hold from an internal .wav file or from an external 
audio source. An external audio source is a CD player or MP3 player. It must be connected to the 
MUSIC jack on the back of each TalkSwitch unit. See Setting up music on hold on page 15.

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

The On-Hold/Ringback page allows you to set up music on hold.

1. Select the On-Hold/Ringback page.
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On-hold settings

The On-hold Settings area allows you to select the sound to play while the caller is on hold.

1. Select the sound to play while the caller is on hold. Choices are:

• Play “double beep” tones — Plays a “beep beep” sound.

• Play music whose source is connected to the MUSIC jack — Plays music from a CD player 
connected to the MUSIC jack. See Setting up music on hold on page 15.

• Play music from file loaded on TalkSwitch — Plays the .wav file loaded into the 
TalkSwitch system.

2. If you selected Play music from file loaded on TalkSwitch:

a) Obtain an 8 kHz, 8 bit, Mono, u-Law .wav file that contains the music or recorded 
message. You can download free music on hold from the mytalkswitch section of the 
TalkSwitch website.    

You can also convert .mp3 and other file formats to .wav with a utility like Audio 
Converter and Ripper from www.audioi.com.

b) Click Load Wav file. The Select Wav File window appears.

c) Click Browse to select a .wav file, and then click Select Wav File. The system will load 
the .wav file into the TalkSwitch unit(s), and will display the file size and date loaded.

3. Adjust the volume of music on hold.

a) Check the volume by placing a test call and going on hold.

b) Change the volume by setting the Playback volume for music file list. Choices are:

• Loudest

• Louder

• Default

• Quieter

• Quietest

c) Choose File > Save.

You must save the configuration for the volume setting to take effect.

d) Repeat Steps a to c.
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Transfer settings

The Transfer Settings area allows you to select the sound to play while the caller is being 
transferred from an auto attendant or to another extension.

1. Select the sound to play while the caller is being transferred. Choices are:

• Music — Plays music on hold as configured in the On-Hold Settings area.

• Ringback — Plays the ringback tone, which is the normal sound heard when the other 
person’s phone is ringing.

Deleting a music on hold file  

You can delete a music on hold file. This may be required if you need more space for voicemail 
messages. In this case you can use an external audio source for music on hold, or you can 
upgrade the memory capacity of the TalkSwitch units. See Increasing memory capacity on 
page 19.

1. Click Delete Wav File. The system deletes the .wav file from the TalkSwitch unit(s).

Playing music on hold on the PA system

You can play music on hold through the PA jack.

1. Dial *80 to play or stop playing music on hold through the PA jack.

If music on hold is playing through the PA jack, and a user dials *0 to make an overhead page, 
the overhead page will interrupt the music on hold. However, if the PA jack is configured for 
voicemail screening, and music on hold is playing, voicemail screening will not interrupt the 
music on hold. See PA Output on page 166.

EMAIL SERVICE

The TalkSwitch system can send an e-mail if a voicemail message has been left in a mailbox. The 
e-mail includes the caller ID, and can include the voicemail message as an attachment.

The e-mail can optionally include links to delete or save the voicemail message. If you delete the 
voicemail message, it will be removed from the TalkSwitch system. If you save the voicemail 
message, the system will change its status from “new” to “saved”. A voicemail message that is 
saved will no longer activate the new message indicator on the user’s extension.

The system can send notification to up to four e-mail addresses per mailbox. For example, if a 
caller leaves a message in the general mailbox for the sales group, the system can send an e-mail 
to four members of the sales group.

An e-mail address can be assigned to multiple mailboxes. For example, the system can send e-
mails to a user if callers leave messages in the user’s local extension mailbox, remote extension 
mailbox or a general mailbox.

The Email Service page allows you to maintain e-mail addresses, set up the e-mail server 
parameters, and test the e-mail server.
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1. Select the Email Service page.

Email notification settings

The Email Notification Settings area allows you to add up to 255 e-mail addresses.

1. Select a slot for the e-mail address.

2. Enter the recipient’s Full name.

3. Enter the recipient’s Email address.

4. Select the Notification option. Choices include:

• Include voice message as attachment — Attaches the voicemail message to the e-mail as 
a .wav file.

From: TalkSwitch Voicemail
Sent: April 18, 2008 2:53:30 PM
Subject: From: ext 112
Attachments: voice_message_111.wav (68 KB)
_____________________________________
Voice Mailbox 111

New message from ext 112
Received: Friday, April 18 at 2:52pm
Length: 6 seconds

Total un-reviewed messages: 5
Total saved messages: 0
____________________________________
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TalkSwitch Voicemail Management

Save message      Delete message
____________      ______________
Note: It may take up to 2 minutes for the message to be saved/
deleted from your mailbox.

• Email notification only (full length) — Does not attach the voicemail message to the e-
mail, but includes full details about the contents of the voice mailbox.

From: TalkSwitch Voicemail
Sent: April 18, 2008 2:53:30 PM
Subject: From: ext 112
_____________________________________
Voice Mailbox 111

New message from ext 112
Received: Friday, April 18 at 2:52pm
Length: 6 seconds

Total un-reviewed messages: 5
Total saved messages: 0
____________________________________

• Email notification only (SMS length) — Does not attach the voicemail message to the e-
mail, and sends minimum details about the message. The notification is less than 130 
characters, so is short enough to be sent in one e-mail to a cell phone.

From: TSvm
Sent: April 18, 2008 2:53:30 PM
Subject: New msg

Mbox 111
Msg from ext 112
Rcvd: Fri, Apr 18, 2:52pm
Lngth: 6s
New: 5
Saved: 0
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Import an email list

The Import an Email List area allows you to import e-mail addresses from a .csv file.

Each entry in the file must be formatted as follows: name,e-mail address. For example:

John Doe,john.doe@email.com
Jane Doe,jane.doe@email.com

1. Click Select File. The Import an Email List window appears.

2. Select the .csv file, and then click Open.

E-mail server settings

The Email Server Settings area allows you to set up the e-mail server parameters, include links to 
delete or save the voicemail message, and test the system’s ability to send e-mail.

Use e-mail account information from your Internet service provider (ISP) or administrator.

1. Enter an e-mail address in the Dedicated email address for sending/receiving emails box. 
When e-mail notifications arrive from the system, this e-mail address will show up in the 
From field.

2. Enter the name of the Outgoing mail server (SMTP).

3. To configure authentication and server port numbers, click More Settings. The Internet 
Email Settings window appears. See Outgoing server authentication on page 44 and Outgoing 
server port numbers on page 45.

4. To include links within the e-mail notification, select the Enable delete/save messages 
option check box. The links will allow the recipient to delete or save the voicemail message. 
The e-mail notification can only include the links if the voicemail message is attached.

Deleting the voicemail message will remove it from the TalkSwitch unit. Saving the 
voicemail message will change its status from “new” to “saved”. A voicemail message that is 
saved will no longer activate the new message indicator on the user’s extension.

Notification may not work properly if the SMTP server uses Microsoft Exchange Server, and 
certain security features are enabled.
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5. Enter the name of the Incoming mail server (POP3). The name will automatically appear in 
the My Outgoing Server (SMTP) Requires Authentication area.

6. To configure authentication, server port numbers and how often the TalkSwitch unit should 
check the POP3 server, click More Settings. The Internet email settings window appears. 
See Incoming server authentication on page 45, Incoming server port numbers on page 45 and 
Incoming mail server options on page 45.

Outgoing server authentication

The My Outgoing Server (SMTP) Requires Authentication area allows you to enter account 
information for the outgoing server. The outgoing server is also referred to as the SMTP server. It 
can have its own account information, or can use the account information from the incoming 
server. The incoming server is also referred to as the POP3 server.

1. If the outgoing server requires authentication, select the My Outgoing Server (SMTP) 
Requires Authentication check box.

2. Choose the type of authentication used by the outgoing server:

• If the outgoing server uses its own logon information, and can send e-mail without first 
logging on to the incoming server:

i) Select This server requires SMTP logon information.

ii) Enter the User name of the account from the outgoing server.

iii) Enter the Password of the account from the outgoing server.

• If the outgoing server uses logon information from the incoming server, and must log on 
to the incoming server before sending e-mail:

i) Select This server requires logon to incoming mail server before sending mail.

ii) Enter the name of the Incoming mail server (POP3). The name will automatically 
appear in the Enable Delete/Save Messages Option area.

iii) Enter the User name of the account from the incoming server. The user name will 
automatically appear in the Incoming Server Authentication area.

iv) Enter the Password of the account from the incoming server. The password will 
automatically appear in the Incoming Server Authentication area.
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Outgoing server port numbers

The Server Port Numbers area allows you to enter a port number for the outgoing server. This is 
only required if the standard default port number cannot be used.

1. The default Outgoing mail server (SMTP) port is 25. If required, enter a different port number 
ranging from 0 to 65535.

Incoming server authentication

The Incoming Server Authentication area allows you to enter the user name and password of the 
account from the incoming server. The incoming server is also referred to as the POP3 server.

1. Enter the User name of the account from the incoming server. The user name will 
automatically appear in the My Outgoing Server (SMTP) Requires Authentication area.

2. Enter the Password of the account from the incoming server. The password will automatically 
appear in the My Outgoing Server (SMTP) Requires Authentication area.

Incoming server port numbers

The Server Port Numbers area allows you to enter a port number for the incoming server. This is 
only required if the standard default port number cannot be used.

1. The default Incoming mail server (POP3) port is 110. If required, enter a different port 
number ranging from 0 to 65535.

Incoming mail server options

The Incoming Mail Server Options area allows you to specify how often the TalkSwitch unit 
should check the incoming server for e-mail messages from users deleting and saving voicemail 
messages. The incoming server is also referred to as the POP3 server.

1. Select the Email request interval, ranging from 1 minute to 30 minutes.

2. To delete e-mail messages that aren’t from TalkSwitch users (i.e. spam), select the Delete any 
unrecognized inbound emails check box.
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Testing the e-mail server settings

1. Click Test Account Settings. A window appears, prompting you to save the configuration.

2. Click Save. The system saves the configuration, then the Test Account Settings 
window appears.

3. Enter an e-mail address in the Test email address box, and then click Start. The following 
window shows a successful result, with each task completed.

If a task fails, the TalkSwitch system is not able to send e-mail messages. Adjust the e-mail 
server parameters accordingly:

• If Find outgoing mail server (SMTP) fails, check the SMTP server name in the Outgoing 
mail server (SMTP) box.

• If Log onto outgoing mail server (SMTP) fails, check the SMTP server authentication 
parameters in the Internet Email Settings window.

4. Ensure the e-mail address has received the test e-mail. Note that the e-mail may have been 
routed to a junk or spam folder.
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Managing voicemail messages

If the Notification option is set to Include voice message as attachment, the recipient can play, 
save or delete the voicemail message.

1. To play the voicemail message, the recipient double-clicks the attachment. The default .wav 
player opens the voicemail message.

2. To save the voicemail message, the recipient clicks Save message. The e-mail program 
creates a new e-mail message with the To and Subject fields completed. The recipient sends 
this e-mail message. Upon receiving the e-mail message, the TalkSwitch system will change 
the status of the voicemail message from “new” to “saved”, and the local extension will turn 
off the new message indicator. However the system will not delete the voicemail message.

Note that the system allows up to 99 voicemail messages per mailbox. Once a mailbox fills 
up, callers won’t be able to leave voicemail messages for that user. Therefore users should 
delete voicemail messages before the mailbox fills up.

3. To delete the voicemail message, the recipient clicks Delete message. The e-mail program 
creates a new e-mail message with the To and Subject fields completed. The recipient sends 
this e-mail message. Upon receiving the e-mail message, the TalkSwitch unit will delete the 
voicemail message.

Setting up POP3 service with Microsoft Exchange

If your system uses Microsoft Exchange, and you wish to include voicemail messages as 
attachments within the notification emails, you must set up POP3 service.

For instructions on how to download, install and configure POP3 service, refer to the Microsoft 
documentation included with your version of Exchange. See http://technet.microsoft.com/en-
us/library/aa998454(EXCHG.65).aspx for more information.

Risks of enabling POP3 service 

• The default configuration does not use encryption when sending the username 
and password.

• Unauthorized clients can use the POP3 service.

• E-mails from users for saving and deleting voicemail messages are not stored on the 
Exchange server, but are pulled through to the client (i.e. the TalkSwitch system).

Security recommendations

1. Install the TalkSwitch system on the same LAN as the Exchange server.

2. Follow the Microsoft procedures for tightening security.

3. The POP3 service is a virtual server. You can use the following techniques to control 
incoming access to a virtual server. Refer to the Microsoft documentation included with your 
version of Exchange.

• Grant or deny access using IP addresses or Internet domain names.

• Require authentication for incoming connections.

• Restrict concurrent connections.

• Set connection time-out values.
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VOIP CONFIGURATION

The VoIP Configuration page allows you to set up the TalkSwitch profile for the SIP server or a 
SIP client, and up to four service provider profiles. You can also view registrar entries, view 
registration status, set codec options, and reserve VoIP lines for specific setups.

The VoIP Configuration page is only present with a VoIP-enabled TalkSwitch unit. The layout of 
the page depends on whether you are configuring a TalkSwitch profile or a service 
provider profile.

Setting up a TalkSwitch profile

You can set up a TalkSwitch profile for the SIP server or for a SIP client. The TalkSwitch profile 
contains registration details and authentication information. The information is from the 
TalkSwitch unit acting as the SIP server for a TalkSwitch VoIP network.

Any VoIP-enabled TalkSwitch unit can act as the SIP server. However a TalkSwitch VoIP network 
requires that one (and only one) TalkSwitch unit be configured to act as the SIP server. 
TalkSwitch systems at other locations are configured as SIP clients.

When the SIP server is enabled and SIP clients are registered with the SIP server, all VoIP calls 
within the TalkSwitch VoIP network contact the SIP server to resolve the destination location. 
Once the destination is resolved, the call goes directly from the source to the destination.

1. Select the VoIP Configuration page.

2. Select Profile TS, which is for configuring the TalkSwitch profile.
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Setting up a service provider profile

A service provider profile contains the registration details of the service provider’s SIP server.

If you are using a TalkSwitch-certified VoIP service provider, visit the support section at http://
global.talkswitch.com to access the service configuration guide for your VoIP service provider.

1. Select the VoIP Configuration page.

2. Select a Profile (SP 1 to SP 4), which are for configuring service provider profiles.

Activate profile

TalkSwitch profile

If setting up a TalkSwitch profile, the Activate Profile area indicates the Profile name is 
TalkSwitch. Leave the Disable public IP address substitution check box cleared.
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Service provider profile

If setting up a service provider profile, the Activate Profile area allows you to activate the profile, 
enter the profile name, set up public IP address substitution, and set up keep alive messages.

1. Select the Activate Profile check box.

2. Enter the Profile name. The default profile name is Service provider n (e.g. Service provider 1).

3. If your service provider requires you to register using your private IP address, select the 
Disable public IP address substitution check box.

For information on how to set this, see the service configuration guide for your VoIP 
service provider.

4. If your service provider requires you to set up keep alive messages, and if your router does 
not support uPNP, set up keep alive messages.

Keep alive messages maintain the connection from the TalkSwitch unit, through your router, 
to the service provider’s SIP server.

For information on configuring keep alive messages, see the service configuration guide for 
your VoIP service provider.

a) Select the Enable NAT keep alives check box.

b) Click Settings. The Keep Alive Settings window appears.

c) Select the type of ping. Choices are:

• Simple ping — A standard ping message that works with all SIP servers.

• Nortel ping — A longer but more reliable ping message that only works with specific 
Nortel SIP servers (e.g. Nortel MCS 5200).

d) If necessary, change the ping frequency. The default setting is 45 seconds.

Registration details

TalkSwitch SIP server profile

If the SIP server is at this location, the Registration Details area allows you to indicate this 
location has the SIP server. 

1. Select the This TalkSwitch location is the proxy/registrar check box. The page enables the 
Registrar authentication list and the View Registrar Entries button.

2. If the SIP server requires a non-default SIP server registration interval, SIP signalling port, 
or starting RTP port, enter the new values. See VoIP Trunking on page 171.
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a) Choose Options > VoIP Trunking. The VoIP Settings window appears.

b) Select the Re-registration interval.

c) Enter the SIP signalling port.

d) Enter the Starting RTP port.

e) Ensure the router is set up to perform port forwarding for the SIP signalling and RTP 
ports. See Router port forwarding on page 36.

TalkSwitch SIP client profile

If the SIP server is at another location, the Registration Details area allows you to enter the 
Proxy/registrar server name.

1. Leave the This TalkSwitch location is the proxy/registrar check box cleared. The page disables 
the Registrar authentication list and the View Registrar Entries button.

2. Enter the Current public IP address or Fully qualified domain name (FQDN) of the SIP server 
into the Proxy/registrar server name box.

3. If the SIP server requires a non-default SIP signalling port (i.e. if the SIP server cannot use 
5060 as the SIP signalling port), specify the port number after a colon at the end of the 
public IP address or FQDN (e.g. 123.45.67.89:3456).

4. Ensure the router is set up to perform port forwarding for the SIP signalling port. See Router 
port forwarding on page 36.

Service provider profile

If setting up a service provider profile, the Registration Details area allows you to enter the 
proxy server name, registrar server name, outbound proxy, and realm/domain, as provided by 
the service provider.

1. Enter the IP addresses or FQDNs, as provided by the service provider, into the following 
boxes. If the service provider does not specify a value, leave the box blank.

• Proxy server name

• Registrar server name

• Outbound proxy

• Realm/domain

For information on entering the registration details, see the service configuration guide for 
your VoIP service provider.
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Authentication

TalkSwitch SIP server profile

If the SIP server is at this location, the Authentication area allows you to set registrar 
authentication, and enter the user/account name and password for the TalkSwitch VoIP 
network. All TalkSwitch locations must use the user/account name and password from the 
SIP server.

1. Set Registrar authentication to Yes (digest). This restricts access and allows only authorized 
devices to connect.

Devices will require digest authentication to access the VoIP network. Digest authentication 
is a challenge/response protocol in which the server challenges the client, and the client 
responds by presenting its credentials. This method of authentication is very secure.

2. Enter the User/account name. All SIP clients must use this name.

3. Enter the Password. All SIP clients must use this password.

TalkSwitch SIP client profile

If the SIP server is at another location, the Authentication area allows you to enter the user/
account name and password from the SIP server. The Registrar authentication list is disabled.

1. Enter the User/Account name from the SIP server. All SIP clients must use this name.

2. Enter the Password from the SIP server. All SIP clients must use this password.

Service provider profile

If setting up a service provider profile, enter the authentication information for each VoIP 
number in the Username and Password area of the VoIP Numbers page.

VoIP caller ID

The VoIP Caller ID area allows you to set up the source for the caller ID name for outbound VoIP 
calls. The same setting is used for the TalkSwitch profile and all service provider profiles. 
Extension names are used by default.

1. Set the caller ID information for outgoing VoIP calls:

• To use the System name from the Administration page, select Use system name in caller 
ID information for all outgoing VoIP calls.

• To use the First name and Last name from the Local Extensions/Fax page, select Use 
extension names in caller ID information for all outgoing VoIP calls.

See Caller ID settings on page 65 to select the phone number that will appear on the 
other phone.
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Reserving VoIP lines

By default, all TalkSwitch VoIP lines are available for external IP extensions, TalkSwitch VoIP 
network calls, and/or service provider calls on a first-come first-served basis. You can also 
reserve VoIP lines for a specific use. For example, you can set aside two lines for external 
IP extensions.

Reserving VoIP lines guarantees resources for a specific network. Sharing VoIP lines uses them 
most efficiently.

When reserving VoIP lines for a service, the choice ranges from 1 to the number of unreserved 
VoIP lines at this location. Shared means do not reserve any VoIP lines for this service. Only 
unreserved lines will be available.

1. Click Reserve VoIP Lines. The VoIP Resource Reservation window appears.

2. Set the External IP extension calls list to the number of VoIP lines to reserve for external 
IP extensions.

3. Set the TalkSwitch VoIP network calls list to the number of VoIP lines to reserve for the 
TalkSwitch VoIP network.

4. Set the VoIP service provider calls lists to the number of VoIP lines to reserve for each of the 
VoIP service providers.
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Viewing registrar entries

If you are configuring the TalkSwitch profile for the SIP server, the window enables the View 
Registrar Entries button. Clicking the button shows the Registrar Entries window with a list 
of the VoIP numbers, their IP addresses and port numbers, and the number of seconds until their 
registrations with the SIP server will expire.

1. Click View Registrar Entries. The Registrar Entries window appears.

• Client lists the VoIP numbers set up within the TalkSwitch units.

• Contact lists the address information used by the SIP server to contact the client. It is 
comprised of the VoIP number, public IP address and port number.

• Expires is the amount of time, in seconds, until the client has to re-register with the 
SIP server.
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Viewing registration status

Clicking the View All Registrations button shows a window with a list of VoIP numbers, their 
registration status, and the number of seconds until their registrations with the SIP server will 
expire. This confirms the TalkSwitch system is registered with a SIP server.

1. Click View All Registrations. The Registration status window appears.

2. Choose All Registered Numbers or an active profile.

• Client lists the VoIP numbers set up within the TalkSwitch units.

• Status is the registration status (Registered or Not registered).

• Expires is the amount of time, in seconds, until the client has to re-register with the 
SIP server.
T A L K S W I T C H  C O N F I G U R A T I O N 55



Setting codec options

A codec is a method of compressing and decompressing audio signals for communication across 
a network. TalkSwitch supports the G.729, G.726 and G.711 (µ-law or A-law) codecs for VoIP 
calls. If your service provider or equipment requires specific codecs for VoIP or Fax over IP calls, 
you can restrict TalkSwitch to use the required codec.

The Codec Options window allows you to select the codecs your system can use, specify the 
preferred codec, and clear the unsupported codecs. You can specify the codecs for the 
TalkSwitch profile, and for each service provider profile. External IP extensions will use the 
preferred codec specified in the TalkSwitch profile. 

1. Click Codec Options. The Codec Options window appears.

2. Select the codecs your system can use, and clear the unsupported codecs. The following 
codecs are supported: 

• G.729 — This codec provides good quality. It requires the least bandwidth and 
accommodates the highest number of concurrent calls.

• G.726 — This codec provides better quality. It requires more bandwidth and 
accommodates fewer concurrent calls.

• G.711µ — This codec provides high quality and supports Fax over IP. It requires the most 
bandwidth and accommodates the fewest number of concurrent calls. G.711µ is used in 
North America and Japan.

• G.711A — This codec provides high quality and supports Fax over IP. It requires the most 
bandwidth and accommodates the fewest number of concurrent calls. G.711A is used 
worldwide outside North America and Japan.

3. Select the Preferred codec. G.729 is the default codec, which uses the least bandwidth and 
accommodates the highest number of concurrent calls.

4. Set Voice activity detection (VAD). Enabling VAD reduces voice bandwidth when no speech is 
detected, and reduces transmission of background noise. We recommend disabling VAD to 
keep bandwidth available for speech.
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LICENSED ADD-ONS

Attendant Console allows users to monitor telephone lines, VoIP lines and extensions, and to 
perform call handling on a PC.

Call Reporting polls the call detail record (CDR) output from the TalkSwitch unit, and writes the 
information to a database file. It then reads the database file, and generates reports.

An extended warranty covering TalkSwitch units is available in the United States and Canada.

The Licensed Add-Ons page allows you to try, buy and activate Attendant Console and Call 
Reporting, and to buy and activate an extended warranty.  

The Buy It button displays contact information according to the location of installation. 
Installers have the option to have their contact information display in this window by following 
these steps:

1. Copy the varinfo.html and logo.png files from the \Reseller Contact subdirectory to the 
TalkSwitch program directory (e.g. \TalkSwitch Configuration 6.11\). 

2. Edit the copied version of varinfo.html to contain the desired contact information.

3. If you want to also display your logo, edit the copied logo.png file to contain your logo.

Your contact information will display provided these new files are in the TalkSwitch program 
directory. 
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LOCAL EXTENSIONS/FAX

A local extension can either be an analogue extension or an IP extension.

An analogue extension is a device (standard phone, cordless phone, fax machine or modem) 
connected to an extension jack on the TalkSwitch unit.

An IP extension can be internal or external. An internal IP extension is an IP phone connected 
through the LAN to the TalkSwitch unit. An external IP extension is an IP phone located outside 
the office. It is connected to the TalkSwitch system through the Internet. External IP extensions 
require a VoIP-enabled TalkSwitch unit. See Adding IP phoneS on page 81 for more information.

Each TalkSwitch unit can have up to 16 local extensions. Either four or eight local extensions 
can be analogue or IP extensions, depending on the model of the TalkSwitch unit. The 
remaining twelve or eight local extensions can only be IP extensions.

All local extensions are active by default. If you plug a standard phone into an extension jack, it 
will be ready to make and receive calls. However configuration is required to set up an 
IP extension.

The first eight local extensions are numbered as follows:

• TalkSwitch Unit 1 — 111 to 118

• TalkSwitch Unit 2 — 121 to 128

• TalkSwitch Unit 3 — 131 to 138

• TalkSwitch Unit 4 — 141 to 148

The next eight local extensions can only be IP extensions, and are numbered as follows:

• TalkSwitch Unit 1 — 151 to 158

• TalkSwitch Unit 2 — 161 to 168

• TalkSwitch Unit 3 — 171 to 178

• TalkSwitch Unit 4 — 181 to 188

Note that dialling 101–108 will ring local extensions 111–118.

The Local Extensions/Fax page allows you to set up a local extension.

Extension tab

The Extension tab allows you to set up the extension type, user name, make and model, prompt 
language, IP extension details, programmable keys, direct line access, hotline, hunt group 
permissions, caller ID, and call cascade for each local extension.

1. Select the Local Extensions/Fax page.
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2. Select the Extension tab.

Activate extension

The Activate Extension area allows you to enter information about the user and the extension.

If you connected a TalkSwitch TS-9112i, TS-9133i or TS-480i IP phone to the LAN and used it to 
select an extension number, the Extension type and Type of phone for that extension will be 
complete. In this case, you will enter the First name and Last name, and will select the System 
prompt language.

1. Select the extension number.

2. If necessary, select the Activate Extension check box. All extensions are enabled by default.

3. Select the type of extension in the Extension type list. Choices are Regular phone or fax and 
IP extension. Regular phone or fax allows you to set up an analogue extension.

4. Enter the user’s First name and Last name. The names are used for caller ID, and appear 
within the configuration pages. The Last name is used with the dial-by-name directory.

5. Select the Type of phone. The TalkSwitch system uses this to configure the phone with 
supported features like intercom paging, group paging and the message waiting counter.

• If you set Extension type to Regular phone or fax, choices are Regular phone/fax, TS-80, 
TS-100, TS-200, TS-400 and TS-600.

• If you set Extension type to IP extension, you can choose the make and model. The 
models of IP phones that are available vary by market - see your reseller for details. 
Supported IP phones are:

• TalkSwitch — TS-9112i, TS-9133i and TS-480i

• Polycom — IP 301, IP 320, IP 430, IP 501, IP 550, IP 601 and IP 650

• Grandstream — GXP 2000 and GXP 2020
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• Counterpath — eyeBeam softphone

We strongly recommend you only use supported IP phones. However, if you have an 
unsupported IP phone, you can select Other IP phone. Other IP phones that support the 
G.711 codec (µ-law or A-law) may work with the system, but some features may not 
work. As TalkSwitch cannot enable special features, or customization of these IP phones, 
further configuration will be limited to the programmable options on the phone itself.

6. Select the language for prompts heard by the user of the extension in the System prompt 
language list.

7. Click Additional Settings to set up:

• Direct line access (see Direct line access on page 62)

• Hotline access (see Hotline access on page 63)

• Hunt group permissions (see Hunt group permissions on page 64)

• Caller ID settings (see Caller ID settings on page 65)

IP extension details

If you set Extension type to IP extension, the IP Extension Details area is enabled. The layout of 
the area depends on the type of phone. It allows you to set the location and identity of the IP 
phone, the time zone for an external IP extension, the programmable keys of a TalkSwitch TS-
9133i or TS-480i, and the handset ID of a TalkSwitch TS-850i.

Once you save the configuration and reboot the IP phone, the TalkSwitch system will configure 
the IP phone. Status will change to Registered, and the IP address of the phone will appear.

If you connected a TalkSwitch TS-9112i, TS-9133i or TS-480i IP phone to the LAN and used it to 
select an extension number, the Location and MAC address for that extension will be complete. 
In this case, you can configure the programmable keys of a TalkSwitch TS-9133i or TS-480i.

1. Set the Location of the phone. Choices are:

• Internal — An internal IP extension is located within the office, and is connected to the 
same LAN as the TalkSwitch unit.

• External — An external IP extension is located outside the office, and is connected to 
the TalkSwitch unit via Internet. A VoIP-enabled TalkSwitch unit is required.

• Both — The phone can be used as an internal or external IP extension. A VoIP-enabled 
TalkSwitch unit is required. This is available for the Counterpath eyeBeam 
softphone only.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
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2. If you set Location to External, select the Time zone of the external IP extension.

3. Use one of the procedures below to identify the IP phone, depending on the make 
and model.

TalkSwitch TS-9112i, TS-9133i or TS-480i

1. Set the MAC address of the phone:

• The MAC address will be complete, if you connected the phone to the LAN and used it to 
select the extension number. See Connecting the TalkSwitch IP phone to the network on 
page 81.

• You can enter the MAC address manually. The MAC address is printed on the bottom of 
the phone and on the phone’s shipping box.

• You can select the MAC address using the MAC Selection window. This method is 
available if you connected the phone to the LAN. It is also available if you programmed 
the phone as an external IP extension (see Programming the TalkSwitch IP phone as an 
external IP extension on page 88). To use the MAC Selection window:

i) Click Select. The MAC Selection window appears and lists TalkSwitch IP phones of 
the selected type. If a phone has already been assigned to an extension, Ext 
Assignment shows the extension number, first name and last name. If a phone can be 
assigned to the extension, Ext Assignment shows Available.   

ii) Select an available IP phone for the extension, and then click Select.

2. If the Type of phone is TalkSwitch TS-9133i or TS-480i, click Configure Keys to set up the 
programmable keys. See Programming TS-9133i function keys on page 85 or Programming TS-
480i softkeys on page 86.

Polycom or Grandstream

1. Enter the MAC address. The MAC address is printed on the bottom of the phone or on the 
phone’s shipping box.

Counterpath or Other IP phone

1. Enter the Username and Password. The default settings are user[extension number] and 
pass[extension number]. These are used to manage calls between TalkSwitch and the IP 
extension and must match the username and password of the IP phone. Change only 
if required.
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Direct line access

The Direct Line Access area allows you to select the hunt group that the local extension will use 
automatically. When an analogue phone goes off-hook or a number is dialled on an IP phone, 
the TalkSwitch unit will automatically find an available line within that hunt group.

Example: You have a fax machine connected to the local extension and don‘t want to reprogram 
the speed dial numbers with hunt group numbers. Enable direct line access and select the hunt 
group. As soon as the fax goes off-hook, it finds an available line within the line hunt group.

1. Click Additional Settings. The Additional Settings window appears.

2. Select the Direct Line Access tab.

3. Select the Use direct line access on check box. The window enables the list of line 
hunt groups.

4. Select the hunt group.

Note: When using direct line access, you hear the telephone company dial tone when you pick 
up the handset. You do not hear the internal dial tone. The following features are only 
available from the internal dial tone:

• Intercom calls

• System speed dial numbers

• Calling the receptionist

• Attaching an account code

• Intercom paging

• Group paging

• Overhead paging

• Hunt groups

• Stutter dial tone for new voicemail

• Voicemail retrieval/access

• Entering command mode

• Call pickup 

• Retrieving a parked call

• Do Not Disturb functions

To obtain an internal dial tone on an analogue extension that is set for direct line access, pick 
up the handset, and then press Recall. On an IP extension, press **, and then dial the 
number or function.
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Hotline access

The Hotline Access area allows you to select the resource that the extension will connect to. This 
restricts the extension to one special task, and you cannot use the extension for any 
other purpose.

An analogue extension will automatically connect to the resource when you lift the handset. A 
TS-9133i will connect to the resource when you press the top programmable function key. A TS-
480i will connect to the resource when you press the HotLine softkey. Other IP phones do not 
support hotline access.

1. Click Additional Settings. The Additional Settings window appears.

2. Select the Hotline Access tab.

3. Select the action in the Connect to the following resource list. Choices are:

• perform no action — Does not automatically connect to a resource.

• go to voicemail — Connects to the selected voicemail.

• go to local extension — Connects to the selected local extension.

• go to remote extension — Connects to the selected remote extension.

• go to ring group — Connects to the selected ring group.

• go to auto attendant — Connects to the selected auto attendant.

• go to VoIP location — Connects to the selected VoIP number within the TalkSwitch 
VoIP network.

4. Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
auto attendants, or VoIP numbers within the TalkSwitch VoIP network.
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Hunt group permissions

The Hunt Group Permissions area allows you to select the hunt groups that the extension can 
use. You can restrict an extension’s access to specific hunt groups. Each extension has access to 
all hunt groups by default.

1. Click Additional Settings. The Additional Settings window appears.

2. Select the Hunt Group Permissions tab.

3. Set the check boxes in the Hunt Group Permissions area to control access to the hunt groups. 
Select a check box to grant access to the hunt group, or clear the check box to remove 
access.

4. If 3-Way Calling/Conference is selected in the Telephone Lines page, you can select the 
Allow the use of same line connect (by dialing 80) check box. If this is selected, the user can 
transfer a call to a remote extension using the same telephone line that the caller is on. The 
user dials Recall, remote extension, and then Recall 4. The telephone company puts the 
caller on hold, and the TalkSwitch system uses the same telephone line to try the remote 
extension.
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Caller ID settings

The Caller ID Settings area allows you to select the phone number that will appear on the other 
phone when the local extension is used to make a VoIP call.

1. Click Additional Settings. The Additional Settings window appears.

2. Select the Caller ID Settings tab.

3. Set the Phone number used for TalkSwitch VoIP caller ID list to the phone number that should 
be displayed during a call on the TalkSwitch VoIP network.

4. Set each Caller ID used for service provider list to the phone number that should be displayed 
during a call through the VoIP service provider.

Choices include Default VoIP number, and the VoIP numbers set up in the VoIP Numbers page. If 
Default VoIP number is selected, the phone number associated with the VoIP line is used. This 
selection makes the most sense if your VoIP numbers have been configured to handle all 
inbound calls the same way.

See VoIP caller ID on page 52 to select the name that will appear on the other phone.

About call cascades

The Call Handling area allows you to set up call cascades for the local extension. A call cascade 
routes an incoming call, depending upon whether the local extension is busy, unanswered, 
answered, or in Do Not Disturb mode. You can set up different call cascades for Mode 1 and Mode 
2. When the system is in Holiday Mode, all the local extensions will either use their Mode 1 call 
cascades or their Mode 2 call cascades.

For example, if a call reaches your desk and you are away, the call can be transferred to another 
local extension. If that extension is not answered, the call can be routed to your cell phone. If 
you do not answer your cell phone, the call can be transferred to your voice mailbox.

Note that the system can be configured to ignore the call cascade for an unanswered intercom 
call, or for an unanswered transferred call.

How call cascades work

A call interacts with an extension’s call cascade in three phases: the call enters the call cascade, 
is routed by the call cascade, and then exits the call cascade.
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Entering the call cascade

First, a call enters the extension’s call cascade. This occurs when:

• The caller dials the extension.

• The caller selects an auto attendant option that transfers the call to the extension.

• The caller leaves a message in a voice mailbox or listens to an announcement, and then 
presses the 0 option to route the call to an extension.

• A user manually transfers the call to the extension.

Being routed by the call cascade

Second, the call cascade routes the call. It can try up to three routing alternatives. If the 
extension is not available, the call cascade tries the first alternative. If that is not available, it 
tries the second. If the second alternative is not available, it goes to the third. To route the call, 
the call cascade can:

• Attempt to transfer the call to a local extension, remote extension or ring group. Note that 
the other extension’s call cascade is ignored.

• Attempt to transfer the call to a VoIP number within the TalkSwitch VoIP network.

• Transfer the call to a voice mailbox, allowing the caller to leave a message. The call can be 
transferred to a local extension, remote extension or general voice mailbox. The system 
hangs up after the caller leaves a message.

• Play an announcement. The system hangs up after playing the announcement.

• Route the call to an auto attendant.

• Transfer the call to the call queue if the local extension or ring group is busy. The call is 
placed on hold. The TalkSwitch system will ring the local extension when it 
becomes available.

• Play a call waiting tone on the user’s phone if the extension is busy.

• Play a busy tone on the caller’s phone if the extension is busy.

• Keep ringing the extension.

• Hang up.

Exiting the call cascade

Third, the call exits the call cascade. This occurs when:

• A user answers the call, or accepts it as a screened transfer.

• The call cascade transfers the call to a voice mailbox or announcement, and the caller 
presses the 0 option to route the call to an extension, voice mailbox, announcement or 
auto attendant.

• The call cascade routes the call to an auto attendant.

• The call cascade transfers the call to the call queue of a local extension or ring group.
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Setting up a call cascade

Busy call cascade

The busy call cascade is used when the extension is busy.

1. Select the Mode 1 tab or the Mode 2 tab.

2. Select the Busy tab.

3. Set up the first alternative.

a) Select the action in the If extension is busy list. Choices are:

• go to voicemail — Transfers the call to the selected voicemail.

• go to local extension — Attempts to transfer the call to the selected local extension.

• go to remote extension — Attempts to transfer the call to the selected 
remote extension.

• go to ring group — Attempts to transfer the call to the selected ring group.

• play announcement — Plays the selected announcement.

• invoke call waiting — Notifies the user that a caller is attempting to reach them.

• go to auto attendant — Routes the call to the selected auto attendant.

• queue at extension — Transfers the call to the local extension’s call queue.

• play busy tone — Plays a busy tone in the caller’s phone.

• hang up — Disconnects the telephone line.

• go to VoIP location — Attempts to transfer the call to the selected VoIP number 
within the TalkSwitch VoIP network.

b) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

c) If you selected queue at extension, the caller will hear a prompt each time the reminder 
timer expires. The prompt says “If you wish to continue holding, please remain on the 
line. To leave a voicemail message, press 1”. You can set the duration of the reminder 
timer, to control how often the caller hears the prompt. See Call Reminders on page 170.
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i) Choose Options > Call Reminders. The Call Reminder Timers window appears.

ii) Set the Queue options reminder timer.

4. If you selected an extension in the first alternative, set up the second alternative.

a) Set the If busy or not answered after list to the number of rings to try the first 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to local extension 

• go to remote extension

• go to ring group 

• play announcement 

• go to auto attendant

• hang up

• go to VoIP location

c) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

5. If you selected an extension in the second alternative, set up the third alternative.

a) Set the If busy or not answered list to the number of rings to try the second alternative. 
Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to auto attendant

• hang up

• play announcement

c) Select the resource. Depending on the action, resources are voice mailboxes, 
announcements, or auto attendants.
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No answer call cascade

The no answer call cascade is used when the extension is not answered.

1. Select the Mode 1 tab or the Mode 2 tab.

2. Select the No Answer tab.

3. Set up the first alternative.

a) Set the If this extension is not answered after list to the number of rings to try the 
extension. Choices range from 1 to 9.

b) Select the action. Choices are:

• go to voicemail

• go to local extension

• go to remote extension

• go to ring group

• play announcement

• go to auto attendant

• keep ringing

• hang up

• go to VoIP location

c) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

4. If you selected an extension in the first alternative, set up the second alternative.

a) Set the If busy or not answered after list to the number of rings to try the first 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to local extension 

• go to remote extension

• go to ring group 

• play announcement 
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• go to auto attendant

• hang up

• go to VoIP location

c) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

5. If you selected an extension in the second alternative, set up the third alternative.

a) Set the If busy or not answered after list to the number of rings to try the second 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to auto attendant

• hang up

• play announcement

c) Select the resource. Depending on the action, resources are voice mailboxes, 
announcements, or auto attendants.

Answered call cascade

The answered call cascade is used when the extension is answered.

1. Select the Mode 1 tab or the Mode 2 tab.

2. Select the Answered tab.

3. Set the When a call is answered list. Choices are:

• stay connected — Transfers the call to the extension. This option disables the remaining 
controls in the tab.

• play caller’s name first — Performs a screened transfer. The caller is prompted to state 
their name. When the user answers the phone, the system plays the caller’s name, and 
then prompts the user to accept the call. If the user accepts the call by pressing #, it is 
routed to the extension. If the user rejects the call by pressing * or hanging up, the call 
is routed to the first alternative.

4. Set up the first alternative.

a) Set the If a call is rejected from this extension list to the action. Choices are:

• go to voicemail
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• go to local extension

• go to remote extension

• go to ring group

• play announcement

• go to auto attendant

• hang up

• go to VoIP location

b) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

5. If you selected an extension in the first alternative, set up the second alternative.

a) Set the If busy or not answered after list to the number of rings to try the first 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to local extension 

• go to remote extension

• go to ring group 

• play announcement 

• go to auto attendant

• hang up

• go to VoIP location

c) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

6. If you selected an extension in the second alternative, set up the third alternative.

a) Set the If busy or not answered after list to the number of rings to try the second 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to auto attendant

• hang up

• play announcement

c) Select the resource. Depending on the action, resources are voice mailboxes, 
announcements, or auto attendants.
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Do not disturb cascade

The do not disturb call cascade is used when the extension is in Do Not Disturb mode.

1. Select the Mode 1 tab or the Mode 2 tab.

2. Select the Do Not Disturb tab.

3. Set up the first alternative.

a) Set the If do not disturb is on for this extension list. Choices are:

• go to voicemail

• go to local extension

• go to remote extension

• go to ring group

• play announcement

• go to auto attendant

• hang up

• go to VoIP location

b) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

4. If you selected an extension in the first alternative, set up the second alternative.

a) Set the If busy or not answered after list to the number of rings to try the first 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to local extension 

• go to remote extension

• go to ring group 

• play announcement 

• go to auto attendant

• hang up

• go to VoIP location
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c) Select the resource. Depending on the action, resources are voice mailboxes, extensions, 
announcements, auto attendants, or VoIP numbers within the TalkSwitch VoIP network.

5. If you selected an extension in the second alternative, set up the third alternative.

a) Set the If busy or not answered after list to the number of rings to try the second 
alternative. Choices range from 1 to 9.

b) Set the action. Choices are:

• go to voicemail

• go to auto attendant

• hang up

• play announcement

c) Select the resource. Depending on the action, resources are voice mailboxes, 
announcements, or auto attendants.

Setting do not disturb mode

The user can toggle Do Not Disturb mode by dialing *62 on their local extension.

The administrator can enable or disable Do Not Disturb mode for a local extension by phone.

1. Pick up a local extension, or remotely call the TalkSwitch system.

2. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

3. Enter the system password, followed by #.

4. Enter one of the following commands:

• [Local extension] 60# to disable Do Not Disturb mode for the local extension.

• [Local extension] 61# to enable Do Not Disturb mode for the local extension.

5. Press * to exit command mode.

Ignoring call cascades for unanswered intercom calls   

An intercom call is an internal call from a local extension to another local extension, remote 
extension or ring group. If the call is unanswered, the call follows that extension’s call cascade 
by default. However you can configure the system to ignore call cascades for unanswered 
intercom calls. See Internal Calls on page 172.

1. Choose Options > Internal Calls. The Intercom Calls Options window appears.

2. To have the system ignore call cascades for unanswered intercom calls, clear the Intercom 
calls follow cascade settings check box.

• If the extension is busy, the caller will hear a busy tone.
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• If the extension is not answered, it will continue to ring.

• If a local extension has call screening enabled, the caller won’t be prompted for their 
name. However, if a remote extension or ring group has call screening enabled, call 
screening will occur. If the call is rejected, the system will follow the call cascade.

• If a local extension has do not disturb mode enabled, it won’t ring, and the caller will 
hear “I’m sorry, that extension is unavailable at this time. Do not disturb on. Please try 
again later”. If all the local extensions in a ring group have do not disturb mode 
enabled, the caller will hear a busy tone.

Ignoring call cascades for calls transferred from local extensions   

A user at a local extension can transfer a call to another local extension, remote extension or 
ring group. If the call is unanswered, the call follows that extension’s call cascade by default. 
However you can configure the local extensions, remote extensions and/or ring groups to ignore 
their call cascades for calls that are transferred from a local extension but unanswered. In this 
case, the system will ring back the local extension that transferred the call, reconnecting the 
user with the caller they transferred.

1. Choose Options > Transfer Preferences. The Transfer Preferences window appears.

2. Select the appropriate tab.

• To configure call handling for calls transferred to local extensions, select the To Local 
Extension tab (see To local extension tab on page 167).

• To configure call handling for calls transferred to remote extensions, select the To 
Remote Extension tab (see To remote extension tab on page 167).

• To configure call handling for calls transferred to ring groups, select the To Ring Group 
tab (see To ring group tab on page 169).

3. Select the call handling setup for calls transferred from a local extension but unanswered:

• To have the system ring back the local extension that transferred the call, select Ring 
back the extension that transferred the call.

• To use the Busy call cascade, select Perform the Busy action.

• To use the No Answer call cascade, select Perform the No Answer action.
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Voicemail tab

The Voicemail tab allows you to activate the voice mailbox or announcement, load the greeting, 
set the action to perform if the caller dials 0, and set up voicemail notification.

By default, each local extension mailbox is activated.

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

Note that the system allows up to 99 voicemail messages per mailbox. Once a mailbox fills up, 
callers won’t be able to leave voicemail messages for that user. Therefore users should delete 
voicemail messages before the mailbox fills up.

1. Select the Local Extensions/Fax page.

2. Select the Voicemail tab.

3. If necessary, select the Activate Voicemail check box.
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Mailbox greeting

The Mailbox Greeting area allows you to load a greeting, and configure the voice mailbox as a 
mailbox or announcement. Note that you can also record a greeting using a local extension 
connected to the TalkSwitch unit.

The greeting should tell the caller to dial 0 to perform the action selected in Caller options, if 
you will configure these options.

1. To record a greeting:

a) Pick up a local extension connected to the TalkSwitch unit.

b) Press ** <extension number>, and then follow the prompts to record a greeting.

2. To load a greeting:

a) Obtain an 8 kHz, 8 bit, Mono, u-Law .wav file that contains the greeting.

b) Click Load Greeting. The Load Greeting window appears.

c) Click Browse to select a .wav file, click Load Greeting, and then click Load. The system 
will load the .wav file into the TalkSwitch unit.

3. To configure the voice mailbox as a mailbox, leave the Play announcement only check box 
cleared. The TalkSwitch unit activates the greeting and the mailbox, and enables all the 
controls on the page. The caller will hear a greeting, and will be able to leave a message in 
the mailbox.

4. To configure the voice mailbox as an announcement, select the Play announcement only 
check box. The TalkSwitch unit activates the greeting, disables the ability to leave a 
message, and disables the Notification Settings area. The caller will hear a greeting, but will 
not be able to leave a message.

Caller options

The Caller Options area sets the action to perform if the caller dials 0 during the voicemail 
greeting. You can set up different actions for Mode 1 and Mode 2.

1. For each mode, select the action to perform if a caller dials 0. Choices are:

• go to voicemail

• go to local extension

• go to remote extension

• go to ring group

• play announcement

• go to auto attendant
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• perform no action

2. Depending on the action, enter the extension number or auto attendant.

Notification settings

The Notification Settings area allows you to set up voicemail notification, which tells the user if 
a caller leaves a message. The TalkSwitch system can:

• Notify up to four users by e-mail, with the voicemail message included as an attachment.

• Notify a user by phone and/or pager.

• Activate the message waiting light and stutter dial tone on one or more local extensions.

• Perform voicemail screening by routing audio to the PA jack.

Setting up notification by e-mail

Note that e-mail notifications might be routed to the user’s junk or spam folder. Advise each 
user to set up their e-mail accounts to allow e-mail notifications to go to their inboxes.

1. Set up the e-mail addresses. See Email Service on page 40.

2. Select the Email Notification tab.

3. Select the Enable email notification check box.

4. Click Edit. The Email Addresses window appears.

5. Select up to four e-mail addresses.
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Setting up notification by phone

1. Select the Cell/Pager Notification tab.

2. Select the Enable remote phone notification check box.

3. Enter the Phone number. Enter the number as you would normally dial it (i.e. without the 
hunt group number). You can enter digits 0–9, space, dash, comma, # and *. A comma 
pauses dialling for two seconds.

4. Click Notification Settings. The Notification Settings window appears.

5. Select the notification setting. Choices are:

• Select the first option to have TalkSwitch play the notification message once, when the 
phone is answered. TalkSwitch will then consider notification to be successful. Note that 
if there is any answer other than a busy tone, (e.g. voicemail, “subscriber not available” 
message, etc.) TalkSwitch will consider notification to be successful.

• Select the second option to have TalkSwitch repeat notification until the user either 
dials * to skip the message, or dials # to play the message. TalkSwitch will only consider 
notification to be successful once the user acknowledges notification by dialling a key. 
This is useful for cell phones where the telephone company plays a “subscriber not 
available” message instead of a busy tone.
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Setting up notification by pager

1. Select the Cell/Pager Notification tab.

2. Select the Enable pager notification check box.

3. Enter the Pager number. Enter the number as you would normally dial it (i.e. without the 
hunt group number). You can enter digits 0–9, space, dash, comma, # and *. A comma 
pauses dialling for two seconds.

4. Enter the Numeric message that will appear on the user’s pager.

Setting up the notification options

1. Click Configure Notification Options. The Configure Notification Options 
window appears.

2. Select the hunt group the TalkSwitch system will use to phone or page the user.

3. Select the number of times the TalkSwitch system will ring the number before aborting each 
attempt, ranging from 1 time to 10 times.

4. Select the number of additional attempts the TalkSwitch system should make, ranging from 
never to 10 times.

5. Select the interval between attempts, ranging from 1 minute to 60 minutes.

6. Select the modes when the TalkSwitch system will perform notification. Choices include 
Mode 1, Mode 2, Holiday Mode and All Modes.

Setting up message waiting light activation

If a local extension has a new message in its voice mailbox, the TalkSwitch system activates 
notification on that extension, by default. The user hears a stutter dial tone when they pick up 
the handset (not applicable to the TS-850i). If the extension supports an FSK message waiting 
indicator (not applicable to IP phones), the message waiting light flashes. The TS-80, TS-200, 
TS-400 and TS-600 extensions support a message waiting counter. The display on the extension 
shows the number of new messages stored in the mailbox(es) associated with that extension. 
This feature works with FSK MWI message compatible telephone sets. Stuttered dial tone is also 
provided.

You can also have the TalkSwitch system activate notification on a local extension if a message 
is received in any other local extension, remote extension, or general mailbox.
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1. Select the Message Waiting Light tab.

2. Click the Edit button. The Message Waiting Indication window appears.

3. Select the extensions.

Voicemail screening  

The system can be configured to perform voicemail screening in addition to overhead paging. In 
this case it will route audio to the PA jack when a caller leaves a voicemail message or a user 
accesses a voice mailbox. See PA Output on page 166.

NOTE: If a user has dialed *80 to route music on hold through the PA jack, voicemail screening 
will not interrupt music on hold.

1. Choose Options > PA Output. The Audio Control Options window appears. The PA output 
option is set to PA Announcements by default, which allows overhead paging but not 
voicemail screening.

2. To enable voicemail screening, select Voicemail screening. The system will continue to allow 
overhead paging, but will also perform voicemail screening.
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ADDING IP PHONES  

This section describes how to configure an IP phone as a local extension. An IP phone can be 
internal (located in the office) or external (located outside the office).

We recommend TalkSwitch IP phones and supported third-party IP phones for ease of 
configuration. TalkSwitch currently supports the following IP phones:

• TalkSwitch 9112i, 9133i and 480i. See Adding TalkSwitch IP Phones on page 81.

• Polycom IP 301, IP 320, IP 330, IP 430, IP 501, IP 550, IP 601 and IP 650. See Adding 
Polycom IP Phones on page 89.

• Grandstream GXP2000 and GXP2020. See Adding Grandstream IP phones on page 93.

• Counterpath eyeBeam softphone. See Adding Counterpath IP phones on page 97.

Visit http://global.talkswitch.com for information on which models are available in your 
region and useful resources such as quick reference cards, user guides and firmware files. To 
access the IP phone guides, choose Start > Programs > TalkSwitch 6.11 > Documentation > IP 
Phone Guides.

Refer to Adding Other IP Phones on page 101 for configuration information of non-supported 
IP phones.

ADDING TALKSWITCH IP PHONES      

Use the procedures in this section for adding the TS-9112i, TS-9133i and TS-480i. 

To add a TalkSwitch IP phone within your office, connect the phone to the network and follow 
the prompts on the phone to set the extension number. The phone will work right away. Later 
you can complete the configuration in the TalkSwitch management software.

Alternatively, you can connect the phone to the network, skip setting the extension number 
and then do the configuration using the TalkSwitch management software.

External IP extensions must be configured using the TalkSwitch management software. Connect 
the phone to the network and skip setting the extension number using the phone. Additional 
steps are required. See Configuring the system for external IP extensions on page 88 and 
Programming the TalkSwitch IP phone as an external IP extension on page 88.

Connecting the TalkSwitch IP phone to the network

1. If you will select the extension using the phone itself, ensure the TalkSwitch management 
software is closed.

2. Connect a network cable between the LAN port on the phone (marked ) and your network 
(i.e. router or LAN connection). The TalkSwitch 9133i and 480i IP phones also have a PC 
port. The PC port can be used to connect the PC to the network if only one network 
connection is available.

3. Connect power to the phone, either using the power adapter, or an 802.3af Power-Over-
Ethernet (POE) source (9133i or 480i). The phone reboots.

If the phone is connected to a different network than the TalkSwitch system, the phone will 
display the default time and date of Sat, Jan 1 12:00 am.
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If the phone is connected to the same network as the TalkSwitch system, and an extension 
has been configured with the phone’s MAC address, the system will automatically register 
and configure the phone. When complete, the phone will display the extension name and 
extension number.

If the phone is connected to the same network as the TalkSwitch system, but no extension 
has been configured with the phone’s MAC address, the following prompt appears on the 
phone display.

4. If you will select the phone’s MAC address later, and do not want to select the extension 
using the phone itself, press the up arrow key on the TS-9112i or TS-9133i, or press the No 
softkey on the TS-480i.

5. To select the extension using the phone itself:

a) Press the down arrow key on the TS-9112i or TS-9133i, or press the Yes softkey on the 
TS-480i. The phone displays the following prompt.

b) Use the phone to enter a valid available extension number.

c) Press the down arrow key on the TS-9112i or TS-9133i, or press the Enter softkey on the 
TS-480i. The phone displays the following prompt.

If you have not entered a valid available extension number, the phone returns to step a.

d) Press the down arrow key on the TS-9112i or TS-9133i, or press the Reboot softkey on 
the TS-480i. The phone reboots, and then displays the date, time, extension number, and 
number of voicemails (if any). The phone is available for use, but you can configure 
additional features with the TalkSwitch management software.

Adding the extension to the TalkSwitch system

1. Launch the TalkSwitch management software.

2. Select the Local Extensions/Fax page.

3. Select the Extension tab.

4. Select the extension number.

TS-9112i TS-9133i TS-480i

Ext Setup?

^=Cancel v=Enter

Ext Setup?

^=Cancel v=Enter

Extension Setup?

TS-9112i TS-9133i TS-480i

Ext Number?
_
^=Cancel v=Enter

Ext Number?
_
^=Cancel v=Enter

Extension 
Number?

TS-9112i TS-9133i TS-480i

Done! Reboot Now

^=Cancel v=Enter

Done! Reboot Now

^=Cancel v=Enter

Success!
Reboot the phone
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Activate extension area

If you connected a TalkSwitch TS-9112i, TS-9133i or TS-480i IP phone to the LAN and used it to 
select an extension number, the Extension type and Type of phone will be selected. In this case, 
you will enter the First name and Last name, and will select the System prompt language.

1. Ensure the Activate extension check box is selected.

2. If necessary, set the Extension type to IP extension.

3. Enter the user’s First name and Last name. The names are used for caller ID, and appear 
within other pages of the TalkSwitch management software. The Last name is used with the 
dial-by-name directory.

4. If necessary, select TalkSwitch as the Type of phone, and then select the model. Choices are 
TalkSwitch 9112i, TalkSwitch 9133i and TalkSwitch 480i.

5. Select the language for prompts heard by the user of the extension in the System prompt 
language list.

6. Click the Additional Settings button to set up:

• Direct line access (see Direct line access on page 62)

• Hotline access (see Hotline access on page 63)

• Hunt group permissions (see Hunt group permissions on page 64)

• Caller ID settings (see Caller ID settings on page 65)

IP extension details area

If you connected a TalkSwitch TS-9112i, TS-9133i or TS-480i IP phone to the LAN and used it to 
select an extension number, the IP Extension Details area for that extension will be complete.

If necessary, perform the following steps:

1. Set the Location. Choices are:

• Internal — The phone is an internal IP extension located within the office, and is 
connected to the same LAN as the TalkSwitch unit.
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• External — The phone is an external IP extension located outside the office, and is 
connected to the TalkSwitch unit over the internet. A VoIP-enabled TalkSwitch unit 
is required.

2. If you are setting up an external IP extension, select the Time Zone of the IP phone.

3. Ensure the Phone MAC Address is complete:

• The Phone MAC Address will be complete, if you connected the phone to the LAN and 
used it to select the extension number.

• You can select the Phone MAC Address using the MAC Assignment window, if you 
connected the phone to the LAN, but did not use the phone to select the extension 
number. To use the MAC Assignment window:

i) Click MAC Assignment. The MAC Assignment window appears and lists TalkSwitch 
IP phones of the selected type that are connected to the LAN.

ii) Select the MAC address of the IP phone for the current extension, and then 
click Select.

• You can enter the Phone MAC Address manually, if you did not use the phone to select 
the extension number. This is required if you are setting up an external IP extension. 
The MAC Address is a 12-digit alphanumeric string located in the barcode on the box the 
phone came in. It allows the TalkSwitch unit to connect to the IP phone and 
automatically configure it.

4. See Programming TS-9133i function keys on page 85 or Programming TS-480i softkeys on 
page 86 for instructions on setting up the programmable keys.

5. See Setting up a call cascade on page 67 and Voicemail tab on page 75 for instructions on 
configuring call handling and voicemail.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
T A L K S W I T C H  C O N F I G U R A T I O N 84



6. Choose File > Save. The system will create a configuration file that the phone will download 
when the phone is restarted.

Programming TS-9133i function keys

The TS-9133i has seven programmable function keys. The keys allow the user to access 
TalkSwitch features, and to monitor and engage lines, extensions and queued calls (i.e. 
line appearance).

Note that the keys cannot be programmed if the extension has hot line access enabled. In this 
case, pressing the top function key of the TS-9133i connects to the resource.

1. Click Configure Keys. This button is enabled if the IP Extension Details area is complete. The 
TalkSwitch 9133i window appears.

2. For each key, select the Function and the Resource (if applicable). The following Functions 
are available.

• None — The key is not programmed.

• Line appearance — Select a telephone line or VoIP number as the resource. The LED will 
be off if the line is available; flashing if the line is ringing an extension; and on solid if 
the line is being used. Press the key to immediately connect the extension to the line. 
You do not have to dial the hunt group number.

• Extension appearance — Select a local extension as the resource. The LED will be off if 
the extension is on-hook; flashing if the extension is ringing or on hold; and on solid if 
the extension is being used. Press the key to ring the extension.

• Queue appearance — Select a local extension as the resource. The LED will be off if the 
extension has no calls queued, and flashing if the extension has one or more calls 
queued. Press the key to connect with the oldest queued call.

• Voicemail — Do not select a resource. The LED is unused. Press the key to access the 
voice mailbox of the local extension. If the Voicemail key is not programmed, press 
**#.

• DND — Do not select a resource. The LED is unused. Press the key to toggle Do Not 
Disturb mode. If the DND key is not programmed, press *62#.

• Intercom — Do not select a resource. The LED is unused. Press the key, dial an extension, 
and then press # to page the extension in Intercom mode. If the Intercom key is not 
programmed, press *84, dial an extension, and then press U Dial. The Intercom 
function can only page TalkSwitch phones.
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• Park — Do not select a resource. The LED is unused. Press the key to put the call on hold 
in the next available park orbit. The system will respond with the park orbit number 
(500 to 509). If the Park key is not programmed, press k, *510#.

• Un-park — Do not select a resource. The LED is unused. While the phone is on-hook, 
press the key, dial the park orbit number (500 to 509), and then press # to retrieve the 
call. If the Unpark key is not programmed, lift the handset, press **, dial the park orbit 
number, and then press #.

• Pickup any — Do not select a resource. The LED is unused. Press the key to answer a call 
from an outside number ringing any extension. If the Pickup Any key is not 
programmed, press *9#.

• Pickup ext — Do not select a resource. The LED is unused. Press the key, dial an 
extension, and then dial # to answer a call from an outside number or extension ringing 
the extension. If the Pickup Ext key is not programmed, press *7, dial the extension, 
and then press #.

• Overhead page — Do not select a resource. The LED is unused. Press the key to page the 
office. If the Overhead Page key is not programmed, press *0#.

Programming TS-480i softkeys

The TS-480i has 14 programmable softkeys. The keys allow the user to access TalkSwitch 
features, and to monitor and engage lines, extensions and queued calls (i.e. line appearance).

Note that the keys cannot be programmed if the extension has hot line access enabled. In this 
case, pressing the HotLine softkey of the TS-480i connects to the resource.

1. Click Configure Keys. This button is enabled if the IP Extension Details area is complete. The 
TalkSwitch 480i window appears.

2. Select up to 14 softkey options. For each option, select the Function and the Resource (if 
applicable). The following Functions are available.
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• None — The softkey is not programmed.

• Line appearance — Select a telephone line or VoIP number as the resource. A status icon 
and line ID will appear beside the softkey. The On-Hook icon appears if the line is 
available. The Ring icon appears if the line is ringing an extension. The Off-Hook icon 
appears if the line is being used. Press the softkey to immediately connect the extension 
to the line. You do not have to dial the hunt group number.

• Extension appearance — Select a local extension as the resource. A status icon and caller 
ID will appear beside the softkey. The On-Hook icon appears if the extension is available. 
The Ring icon appears if the extension is ringing or on hold. The Off-Hook icon appears 
if the extension is being used. Press the softkey to ring the extension.

• Queue appearance — Select a local extension as the resource. A status icon, extension 
number and “Q” will appear beside the softkey. The On-Hook icon appears if the 
extension has no calls queued. The Ring icon appears if the extension has one or more 
calls queued. Press the softkey to connect with the oldest queued call.

• Voicemail — Do not select a resource. Press the Voice Mail softkey to access the voice 
mailbox of the local extension. If the Voice Mail softkey is not programmed, press **#.

• DND — Do not select a resource. Press the DND softkey to toggle Do Not Disturb mode, 
and then press DND ON or DND OFF. If the DND softkey is not programmed, press *62#.

• Park — Do not select a resource. Press the Park softkey to put the call on hold in the 
next available park orbit. The system will respond with the park orbit number (500 to 
509). If the Park softkey is not programmed, press k, *510#.

• Un-park — Do not select a resource. Press the Unpark softkey, select the park orbit 
number (500 to 509), and then press Unpark to retrieve the call. Note that caller ID 
appears beside the park orbit number. If the Unpark softkey is not programmed, press 
**, dial the park orbit number, and then press #.

• Pickup any — Do not select a resource. Press the Pickup Any softkey to answer a call 
from an outside number ringing any extension. If the Pickup Any softkey is not 
programmed, press *9#.

• Pickup ext — Do not select a resource. Press the Pickup Ext softkey, dial an extension, 
and then press Pickup to answer a call from an outside number or extension ringing the 
extension. If the Pickup Ext softkey is not programmed, press *7, dial the extension, 
and then press #.

• Queue (show list) — Do not select a resource. Press the Queue softkey, select a queued 
call, and then press Retrieve to connect with the selected call. If the Queue softkey is 
not programmed, this functionality is not otherwise available.

• Overhead page — Do not select a resource. Press the Ovrhd Page softkey to page the 
office. If the Ovrhd Page softkey is not programmed, press *0#.

The Intercom function cannot be programmed as a softkey. It is always available by pressing the 
Icom key. You can also press *84, dial the extension, and then press #. The Intercom function 
can only page TalkSwitch phones.
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Saving a key assignment template

You can use the template file as a starting point for the key assignments for another extension.

1. After setting up the key assignments, click Save Template As to save the key assignments 
to a template file. The Save Template As window appears.

2. Enter the filename of the template file, and then click Save.

Using a key assignment template

1. To display the key assignments from a template file, click Open Template. The Open 
Template window appears.

2. Select the template file, and then click Open Template.

Configuring the system for external IP extensions

If you are setting up an external IP extension:

1. Ensure your TalkSwitch system is connected to a network. See Connecting to a network on 
page 211.

2. Ensure that you have set up a public IP address for the TalkSwitch system. See Public IP 
address on page 35.

3. Ensure the router is configured at the TalkSwitch location. There should be no need to make 
any adjustments to the firewall at the remote location. See Router port forwarding on page 
36.

4. All VoIP lines are shared by default. You can also reserve VoIP lines for external IP 
extensions. See Reserving VoIP lines on page 53.

5. External IP extensions will use the preferred codec selected for the TalkSwitch profile. The 
default preferred codec is G.729. You can select a different preferred codec for the 
TalkSwitch profile. See Setting codec options on page 56.

Programming the TalkSwitch IP phone as an external IP extension

If you are setting up an external IP extension, program the following settings into the phone. 
On the phone:

1. Press the Options key.

2. Use the cursor keys to navigate to the Network Settings menu, and then press Enter 
or Show.

3. Enter the password. By default this is 22222. When the TalkSwitch unit configures the 
phone, it changes the password to 23646 (which spells “admin” on the telephone keypad).

4. Use the cursor keys to navigate to the TFTP Settings menu, and then press Enter or Show.

5. Select Primary TFTP, and then press Enter or Show.

6. Use the keypad to enter the public IP address or FQDN of the TalkSwitch system, and then 
press Set or Done.

7. Reboot the phone. After a short delay, the phone will indicate it is initializing the network, 
checking for firmware updates, and following automatic programming steps. During this 
process the phone contacts the TalkSwitch unit, which automatically registers and 
configures the phone. When complete, the phone will display the extension name and 
extension number. The phone is now ready for use.
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If registration does not work

If the IP phone is not successfully registered and configured, perform the following steps. On 
the phone:

1. Press the Options key.

2. Use the cursor keys to navigate to the Phone Status menu, and then press Enter or Show.

3. Use the cursor keys to navigate to the Restore Defaults menu, and then press Enter 
or Show.

4. Enter the password. By default this is 22222. When the TalkSwitch unit configures the 
phone, it changes the password to 23646 (which spells “admin” on the telephone keypad).

5. Use the cursor keys to navigate to the Factory Defaults menu, and then press Enter 
or Show.

6. Select All Defaults, and then press Enter or Show.

7. If setting up an external IP extension, follow the steps in Programming the TalkSwitch IP 
phone as an external IP extension on page 88 after the phone reboots.

8. Contact your reseller or TalkSwitch Customer Support if registration is still unsuccessful.

For more information, refer to the Troubleshooting section in your phone user guide. Contact 
your reseller or TalkSwitch Customer Support if you require further assistance with special ports 
or network settings.

ADDING POLYCOM IP PHONES   

Adding the extension to the TalkSwitch system

1. Launch the TalkSwitch management software.

2. Select the Local Extension/Fax page.

3. Select the Extension tab.

4. Select an available extension number.

Activate extension area

1. Select the Activate Extension check box.

2. Set the Extension type to IP extension.

3. Enter the user’s First name and Last name. The names are used for caller ID, and appear 
within other pages of the TalkSwitch management software. The Last name is used with the 
dial-by-name directory.

4. Select Polycom as the Type of phone, and then select the model. Choices are Polycom 301, 
Polycom 320, Polycom 430, Polycom 501, Polycom 550, Polycom 601 and Polycom 650.
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5. Select the language for prompts heard by the user of the extension in the System prompt 
language list.

6. Click the Additional Settings button to set up:

• Direct line access (see Direct line access on page 62)

• Hunt group permissions (see Hunt group permissions on page 64)

• Caller ID settings (see Caller ID settings on page 65)

IP extension details area

1. Set the Location. Choices are:

• Internal — The phone is an internal IP extension located within the office, and is 
connected to the same LAN as the TalkSwitch unit.

• External — The phone is an external IP extension located outside the office, and is 
connected to the TalkSwitch unit over the internet. A VoIP-enabled TalkSwitch unit 
is required.

2. If you are setting up an external IP extension, select the Time Zone of the IP phone.

3. Enter the Phone MAC Address. This is a 12-digit alphanumeric string located in the barcode. 
The MAC address allows the TalkSwitch unit to connect to the IP phone and automatically 
configure it.

4. See Setting up a call cascade on page 67 and Voicemail tab on page 75 for instructions on 
configuring call handling and voicemail.

5. Choose File > Save. The system will create a configuration file that the phone will download 
when the phone is restarted.

Configuring the system for external IP extensions

If you are setting up an external IP extension:

1. Ensure your TalkSwitch system is connected to a network. See Connecting to a network on 
page 211.

2. Ensure that you have set up a public IP address for the TalkSwitch system. See Public IP 
address on page 35.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
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3. Ensure the router is configured at the TalkSwitch location. There should be no need to make 
any adjustments to the firewall at the remote location. See Router port forwarding on page 
36.

4. All VoIP lines are shared by default. You can also reserve VoIP lines for external IP 
extensions. See Reserving VoIP lines on page 53.

5. External IP extensions will use the preferred codec selected for the TalkSwitch profile. The 
default preferred codec is G.729. You can select a different preferred codec for the 
TalkSwitch profile. See Setting codec options on page 56.

Connecting the Polycom phone to the network

1. Connect a network cable between your router and the port marked LAN on the back of the 
phone. The PC port on the phone can be used to connect the PC if only one LAN port 
is available.

2. Connect the power adapter to the phone.

Confirming the Polycom firmware version

The TalkSwitch system requires the IP phone to have a specific firmware version.

1. Check the required firmware version in the support section at  http://
global.talkswitch.com.

2. Confirm the firmware version currently installed the IP phone. On the phone:

a) Press the Menu key and select Status > Platform > Application > Main.

b) Compare Version to the required firmware version. If the firmware version is the same, 
proceed to Programming the Polycom IP phone on page 91. If not, follow the instructions 
in Updating the Polycom firmware on page 92. 

Programming the Polycom IP phone

The TalkSwitch system automatically configures the necessary parameters required for the 
proper operation of the Polycom phone with TalkSwitch. On the phone:

1. Press the Menu key and select Settings > Advanced.

2. Enter the password, and then press the Enter key. By default this is 456. When the 
TalkSwitch unit configures the phone, it changes the password to 23646 (which spells 
“admin” on the telephone keypad).

3. Select Admin Settings > Network Configuration.

4. Select Server Menu and change ServerType to TrivialFTP.

5. Select Server Address and press the Edit key. Press the 1/A/a key. If you are setting up an 
internal IP extension, enter the IP address of the TalkSwitch unit acting as local proxy. If 
you are setting up an external IP extension, enter the public IP address or FQDN of the 
TalkSwitch system. Use the * key to enter decimal points.

6. Press the Exit button three times. Advanced appears at the top of the menu.

7. Select Restart Phone and confirm by selecting Yes.

The phone connects to the TalkSwitch local proxy and downloads the configuration file. If the 
configuration is successful, the phone will reboot and show the time, date and extension 
number. To ensure full functionality, dial another extension and check the audio transmission in 
both directions.
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Updating the Polycom firmware

This procedure is only required if you need to update the Polycom firmware. To update 
the firmware:

• Install a TFTP application.

• Download and extract firmware files.

• Configure the phone to point to the firmware files.

Installing a TFTP application

You require a TFTP server application to update the phone firmware. One such free TFTP utility 
can be downloaded from Solarwinds at the following URL:

http://support.solarwinds.net/updates/New-customerFree.cfm?ProdId=52

1. Download and install the TFTP program.

2. Take note of the location of the TFTP program root directory location. The phone firmware 
files are extracted to this directory in the next section. (i.e. for Solarwinds TFTP, the root 
directory is C:\TFTP-Root).

Downloading and extracting firmware files

Firmware files for supported IP phones can be found in the support section at http://
global.talkswitch.com.

1. Download the firmware file required for your phone from the URL above. The files are 
contained in ZIP archives.

2. Extract the firmware files into the TFTP program root directory location.

Configuring the phone to point to the firmware files

Changing the phone Server Address setting to the IP address of the PC with the TFTP program 
and the firmware files enables the update process. On the phone:

1. Press the Menu key and select Settings > Advanced.

2. Enter the password, and then press the Enter key. By default this is 456. When the 
TalkSwitch unit configures the phone, it changes the password to 23646 (which spells 
“admin” on the telephone keypad).

3. Select Admin Settings > Network Settings.

4. Select Server Menu and change ServerType to TrivialFTP.

5. Select Server Address and press the Edit key. Press the 1/A/a key and enter the IP address 
of the PC running the TFTP server, using the * key to enter decimal points.

6. Press the Exit button three times. Advanced appears at the top of the menu.

7. Press 3 for Restart Phone and confirm by pressing the Yes button.

8. Once the firmware is updated, reconfigure the phone according to Programming the Polycom 
IP phone on page 91. Note that some errors will occur for files not found. These are expected 
and can be ignored.

For more information, refer to the Troubleshooting section in your phone user guide.
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ADDING GRANDSTREAM IP PHONES

Adding the extension to the TalkSwitch system

1. Launch the TalkSwitch management software.

2. Select the Local Extension/Fax page.

3. Select the Extension tab.

4. Select an available extension number.

Activate extension area

1. Select the Activate Extension check box.

2. Set the Extension type to IP extension.

3. Enter the user’s First name and Last name. The names are used for caller ID, and appear 
within other pages of the TalkSwitch management software. The Last name is used with the 
dial-by-name directory.

4. Select Grandstream as the Type of phone, and then select Grandstream GXP-2000/2020.

5. Select the language for prompts heard by the user of the extension in the System prompt 
language list.

6. Click the Additional Settings button to set up:

• Direct line access (see Direct line access on page 62)

• Hunt group permissions (see Hunt group permissions on page 64)

• Caller ID settings (see Caller ID settings on page 65)

IP extension details area

1. Set the Location. Choices are:

• Internal — The phone is an internal IP extension located within the office, and is 
connected to the same LAN as the TalkSwitch unit.
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• External — The phone is an external IP extension located outside the office, and is 
connected to the TalkSwitch unit over the internet. A VoIP-enabled TalkSwitch unit 
is required.

2. If you are setting up an external IP extension, select the Time Zone of the IP phone.

3. Enter the Phone MAC Address. This is a 12-digit alphanumeric string located below the 
second barcode. The barcode label is on the bottom of the phone. The MAC address allows the 
TalkSwitch unit to connect to the IP phone and then automatically configure it.

4. See Setting up a call cascade on page 67 and Voicemail tab on page 75 for instructions on 
configuring call handling and voicemail.

5. Choose File > Save. The system will create a configuration file that the phone will download 
when the phone is restarted.

Configuring the system for external IP extensions

If you are setting up an external IP extension:

1. Ensure your TalkSwitch system is connected to a network. See Connecting to a network on 
page 211.

2. Ensure that you have set up a public IP address for the TalkSwitch system. See Public IP 
address on page 35.

3. Ensure the router is configured at the TalkSwitch location. There should be no need to make 
any adjustments to the firewall at the remote location. See Router port forwarding on page 
36.

4. All VoIP lines are shared by default. You can also reserve VoIP lines for external IP 
extensions. See Reserving VoIP lines on page 53.

5. External IP extensions will use the preferred codec selected for the TalkSwitch profile. The 
default preferred codec is G.729. You can select a different preferred codec for the 
TalkSwitch profile. See Setting codec options on page 56.

Connecting the Grandstream phone to the network

1. Connect a network cable between your router and the port marked LAN on the back of the 
phone. The PC port on the phone can be used to connect the PC if only one LAN port 
is available.

2. Connect the power adapter to the phone.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
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3. Once the phone boots up, it will attempt to obtain an IP address from a router DHCP server. 

Confirming the Grandstream firmware version

The TalkSwitch system requires the IP phone to have a certain firmware version.

1. Check the required firmware version in the support section at  http://
global.talkswitch.com. 

2. Confirm the firmware version currently installed the IP phone. On the phone:

a) Press the round key (surrounded by four arrow keys) to access the menu.

b) Select Status and press the round key again.

c) Scroll down until you see Prog.

d) Compare Prog to the required firmware version. If the firmware version is the same, 
proceed to Programming a Grandstream IP phone on page 95. If not, follow the 
instructions in Updating the Grandstream firmware on page 96.

Programming a Grandstream IP phone

1. Note the IP address that appears on the screen of the Grandstream phone.

2. In a web browser, enter the IP address in the Address field.

3. Enter the password. By default this is admin. When the TalkSwitch unit configures the 
phone, it changes the password to 23646 (which spells “admin” on the telephone keypad). 
The Grandstream Device Configuration page appears.

4. On the Grandstream Device Configuration page, click Advanced.

5. In the section for Firmware Upgrade and Provisioning, set Upgrade Via to TFTP.

6. If you are setting up an internal IP extension, set Config Server Path to the IP address of the 
TalkSwitch unit acting as local proxy. If you are setting up an external IP extension, set 
Config Server Path to the public IP address or FQDN of the TalkSwitch system.

7. Scroll to the bottom of the page and click the Update button to save the settings.

8. On the following screen, click the Reboot button to apply the settings.

Note: The reboot process will be completed when you see the extension number and IP 
address on the display of the phone. When the phone successfully registers, you will see the 
filled-in Ethernet icon.
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9. Test to ensure the phone is configured properly by dialing another local extension.

Updating the Grandstream firmware

This procedure is only required if you need to update the Grandstream firmware. To update 
the firmware:

• Install a TFTP application.

• Download and extract firmware files.

• Configure the phone to point to the firmware files.

Installing a TFTP application

You require a TFTP server application to update the phone firmware. One such free TFTP utility 
can be downloaded from Solarwinds at the following URL:

http://support.solarwinds.net/updates/New-customerFree.cfm?ProdId=52

1. Download and install the TFTP program.

2. Take note of the location of the TFTP program root directory location. The phone firmware 
files are extracted to this directory in the next section. (i.e. for Solarwinds TFTP, the root 
directory is C:\TFTP-Root).

Downloading and extracting firmware files

Firmware files for supported IP phones can be found in the support section at http://
global.talkswitch.com.

1. Download the firmware file required for your phone from the URL above. The files are 
contained in ZIP archives.

2. Extract the firmware files into the TFTP program root directory location.

Configuring the phone to point to the firmware files

Changing the phone Firmware Server Path setting to the IP address of the PC with the TFTP 
program and the firmware files enables the update process.

1. Note the IP address that appears on the screen of the Grandstream phone.

2. In a web browser, enter the IP address in the Address field.

3. Enter the password. By default this is admin. When the TalkSwitch unit configures the 
phone, it changes the password to 23646 (which spells “admin” on the telephone keypad). 
The Grandstream Device Configuration page appears.

4. On the Grandstream Device Configuration page, click Advanced.

5. In the section for Firmware Upgrade and Provisioning, set Upgrade Via to TFTP.
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6. Set Firmware Server Path to the IP address of the PC running the TFTP server.

7. Scroll to the bottom of the page and click the Update button to save the settings.

8. On the following screen, click the Reboot button to apply the settings.

ADDING COUNTERPATH IP PHONES

Adding the extension to the TalkSwitch system

1. Launch the TalkSwitch management software.

2. Select the Local Extension/Fax page.

3. Select the Extension tab.

4. Select an available extension number.

Activate extension area

1. Select the Activate Extension check box.

2. Set the Extension type to IP extension.

3. Enter the user’s First name and Last name. The names are used for caller ID, and appear 
within other pages of the TalkSwitch management software. The Last name is used with the 
dial-by-name directory.

4. Select Counterpath as the Type of phone, and then select Counterpath Eyebeam.

5. Select the language for prompts heard by the user of the extension in the System prompt 
language list.

6. Click the Additional Settings button to set up:

• Direct line access (see Direct line access on page 62)

• Hunt group permissions (see Hunt group permissions on page 64)

• Caller ID settings (see Caller ID settings on page 65)
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IP extension details area

1. Set the Location. Choices are:

• Internal — The phone is an internal IP extension located within the office, and is 
connected to the same LAN as the TalkSwitch unit.

• External — The phone is an external IP extension located outside the office, and is 
connected to the TalkSwitch unit over the internet. A VoIP-enabled TalkSwitch unit 
is required.

• Both — The phone can be used as an internal or external IP extension. A VoIP-enabled 
TalkSwitch unit is required.

2. If the phone can be used as an external IP extension, select the Time Zone of the IP phone.

3. Enter the Username and Password. The default settings are user[extension number] and 
pass[extension number].

4. See Setting up a call cascade on page 67 and Voicemail tab on page 75 for instructions on 
configuring call handling and voicemail.

5. Choose File > Save. The system will create a configuration file that the phone will download 
when the phone is restarted.

Configuring the system for external IP extensions

If you are setting up an external IP extension:

1. Ensure your TalkSwitch system is connected to a network. See Connecting to a network on 
page 211.

2. Ensure that you have set up a public IP address for the TalkSwitch system. See Public IP 
address on page 35.

3. Ensure the router is configured at the TalkSwitch location. There should be no need to make 
any adjustments to the firewall at the remote location. See Router port forwarding on page 
36.

4. All VoIP lines are shared by default. You can also reserve VoIP lines for external IP 
extensions. See Reserving VoIP lines on page 53.

5. External IP extensions will use the preferred codec selected for the TalkSwitch profile. The 
default preferred codec is G.729. You can select a different preferred codec for the 
TalkSwitch profile. See Setting codec options on page 56.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
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Configuring a new SIP account

The following procedure describes setting up the eyeBeam software to register on the network 
and to make itself available as a client for sending and receiving calls.

1. Install the eyeBeam software. The SIP Accounts window appears.

2. Click the Add button. The Properties of Account1 window appears.

3. Enter the User Details in the Account tab.

a) Set the Display Name to the name for Caller ID.

b) Set the User name to the local extension number.

c) Set the Password to the Password set up in step 3 of IP extension details area on page 98.

d) Set the Authorization user name to the Username set up in step 3 of IP extension details 
area on page 98.
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e) If setting up an internal IP extension, set Domain to the IP address of the TalkSwitch 
unit acting as local proxy. If setting up an external IP extension, set Domain to the 
public IP address or FQDN (Fully Qualified Domain Name) of the TalkSwitch system.

4. Set up the Domain Proxy area in the Account tab.

a) Select the Register with domain and receive incoming calls check box.

b) Select the target domain option.

5. Set up the Voicemail tab.

a) Select Check for voice mail.

b) Enter ** in the Number to dial for checking voicemail field.

c) Enter *<voicemail number> in the Number for sending calls to voicemail field.

6. Click OK to save settings and close the Properties of Account1 window.

7. Click Close to close the SIP Accounts window and enable the newly configured SIP account. 
Once closed, the phone display will show:

• Discovering network…

• Registering…

• Ready, Your username is: [local extension number].

Updating eyeBeam software

The latest release of eyeBeam can be found at www.counterpath.net/eyebeam.html.
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ADDING OTHER IP PHONES

Other IP phones with the G.711 codec may work with TalkSwitch but not all features may be 
supported. We strongly recommend you use only the IP phones supported by TalkSwitch.

If you connect an unsupported IP phone, select Other IP phone as the Type of phone. As 
TalkSwitch cannot enable features, or customizations of these phones, further configuration will 
be limited to the programmable options on the IP phone itself.

Refer to the specific IP phone user guide’s details for information on configuration.

REMOTE EXTENSIONS

A remote extension reaches an external phone by automatically selecting a line from a hunt 
group and dialling the phone number. For example, a remote extension could reach an 
employee’s cell phone or home phone, or a phone at a branch office.

A caller can connect to a remote extension through the auto attendant, or can be transferred to 
a remote extension by a call cascade. A user at a local extension can manually transfer a caller 
to a remote extension, or can dial a remote extension directly. If the remote extension is busy or 
unanswered, the system can route the call using the remote extension’s call cascade.

For example, a caller reaches the auto attendant and dials a local extension. The user is not 
there, so the call is unanswered. The call cascade of the local extension can be configured to 
transfer unanswered calls to a remote extension. The remote extension can be configured to dial 
the user’s cellular phone. This way the user is available outside the office.

There are three ways the TalkSwitch system can transfer calls to a remote extension:

• If the telephone line has the Transfer and Clear service available and activated, the 
TalkSwitch system can use the transfer and clear feature. When an outside caller is being 
routed to a remote extension, the TalkSwitch system directs the telephone company to put 
the caller on hold. It then uses the same line to reach the remote extension. The telephone 
company connects the outside caller to the remote extension, and then frees the line.

• If the telephone line has the 3-Way Calling/Conference service available and activated, the 
TalkSwitch system can use the same line connect feature. When an outside caller is being 
routed to a remote extension, the TalkSwitch system directs the telephone company to put 
the caller on hold. It then uses the same line to reach the remote extension. The telephone 
company connects the outside caller to the remote extension, but the line to the TalkSwitch 
unit remains occupied until the call is complete.

• If the telephone line doesn’t have these services, and an outside caller is being routed to a 
remote extension, the TalkSwitch system puts the caller on hold. It then uses a second line 
to reach the remote extension. Both lines remain occupied until the call is complete.
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If two lines are used to connect an outside caller to a remote extension, the user at the remote 
extension can:

• Place the call on hold by dialling **.

• Retrieve the call on hold by dialling **.

• Transfer the call by dialling ** + the extension number. The call can be transferred to a local 
extension, remote extension, ring group, or VoIP number within a TalkSwitch VoIP network.

• Transfer the call to a voice mailbox by dialling *** + the voice mailbox number.

The remote extensions can be configured to perform a blind transfer or a screened transfer. 
However a transfer to another remote extension is always a blind transfer to avoid tying up a 
third line.

If the system is configured to perform a blind transfer, it plays “Call transferred. Goodbye.” and 
then hangs up. The call is transferred to the dialled extension and follows its call cascade if busy 
or unanswered.

If the system is configured to perform a screened transfer, the user is connected to the other 
extension and asks whether they want the call. If so, the user dials ** + 4 to complete the 
transfer. If the other person doesn’t want the call, the user dials ** + 5 to cancel the transfer 
and return to the caller.

There are ten remote extensions per TalkSwitch unit, which are numbered as follows:

• TalkSwitch Unit 1 — 210 to 219

• TalkSwitch Unit 2 — 220 to 229

• TalkSwitch Unit 3 — 230 to 239

• TalkSwitch Unit 4 — 240 to 249

The Remote Extensions page allows you to set up a remote extension.

Extension tab

The Extension tab allows you to set the name, phone number, hunt group, language, same line 
connect feature, and call cascade for each remote extension.

1. Select the Remote Extensions page.

2. Select a slot for the remote extension.

Remote extensions are designed to operate with local major telephone service providers. The 
feature may not function correctly with some telephone and mobile operator’s networks, 
especially for international phone numbers and mobile phones roaming internationally.
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3. Select the Extension tab.

Activate extension

The Activate Extension area allows you to set the name, phone number, hunt group, language, 
and same line connect feature for each remote extension.

1. Select the Activate Extension check box.

2. Enter the user’s First name and Last name. The names appear within the configuration 
windows. The Last name is used with the dial-by-name directory.

3. Enter the Remote phone number. Enter the number as you would normally dial it (i.e. 
without the hunt group number). You can enter digits 0–9, space, dash, comma, # and *. A 
comma pauses dialling for two seconds.

An administrator can change the phone number by phone. Enter command mode by either 
pressing # on an analogue extension phone, or *55# on an IP phone. Dial the system 
password + #, the remote extension number, and then 8 + the new phone number + #.

4. Select the hunt group in the Connect using list. The TalkSwitch unit will use a line from this 
hunt group to connect with the remote extension. We recommend the default Hunt group 9 
unless you have set up a different hunt group for calling remote extensions.

An administrator can change the hunt group by phone. Enter command mode by either 
pressing # on an analogue extension phone, or *55# on an IP phone. Dial the system 
password + #, the remote extension number, and then 9 + the new hunt group + #.

5. Select the language heard by the user of the extension in the System prompt language for 
this extension. 

6. If you have the 3-Way Calling/Conference service from the telephone company, you can 
select the Use same line connect check box. The same line connect feature will direct the 
telephone company to put the caller on hold, and will then use the same line to try the 
remote extension. Because the same line is used, the hunt group setting from Step 4 
is ignored.
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If you do not select the Use same line connect check box, the TalkSwitch unit will put the 
caller on hold, and then use a second line to try the remote extension. The second line will 
be from the hunt group selected in Step 4.

If you enable the same line connect feature, the user at the remote extension will not be 
able to transfer the call to another extension.

When the same line connect feature is in use, the caller hears silence while they are on hold. 
This is because the caller is on hold at the telephone company and not at the TalkSwitch 
unit. If you want the caller to hear music on hold while their call is being forwarded to the 
remote extension, do not use the same line connect feature.

The same line connect feature is not compatible with some telephone company lines.

An administrator can change the Use same line connect setting by phone. Enter command 
mode by either pressing # on an analogue extension phone, or *55# on an IP phone. Dial 
the system password + #, the remote extension number, and then 9800# to turn off same 
line connect, or 9801# to turn on same line connect.

7. Set the type of transfer performed by users at remote extensions. This affects transfers to 
local extensions, ring groups, and VoIP numbers within a TalkSwitch VoIP network. Transfers 
to other remote extensions are always blind transfers. See To remote extension tab on 
page 167.

a) Choose Options > Transfer Preferences. The Transfer Preferences window appears.

b) Select the To Remote Extension tab.

• To allow screened transfers, select Allow screening of calls.

• To allow blind transfers, select Perform a blind transfer. This is the default selection.
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8. If you have the Transfer and Clear service from the telephone company, you can enable the 
transfer and clear feature. See To remote extension tab on page 167.

a) Choose Options > Transfer Preferences. The Transfer Preferences window appears.

b) Select the To Remote Extension tab.

c) To enable the transfer and clear feature, select the Clear telephone line after call 
transferred check box.

About call cascades

See About call cascades on page 65.

Setting up a call cascade

The procedure for setting up a call cascade is similar to that described in Local Extension with 
the differences described below. See Setting up a call cascade on page 67.

• The Remote Extensions page does not have the Do Not Disturb tab.

• The If Extension is busy list in the Busy tab does not have the invoke call waiting or queue at 
extension options.

• The When a call is answered list in the Answered tab has the play accept/reject prompt 
option, in addition to the stay connected and play caller’s name first options.

If play accept/reject prompt is selected, the system will place the caller on hold and will then 
call the remote extension. When the user answers, the system will say: “You have a 
forwarded call. To accept the call, press #. To reject the call, press *.” If the user accepts the 
call, the system will route the call to the remote extension. If the user rejects the call, the 
system will try the next alternative in the remote extension’s call cascade.

In the following circumstances, the system will start by saying “This is call cascade”, instead of 
“This is call forward” or “You have a forwarded call”.

• An extension’s call cascade uses play caller’s name first or play accept/reject prompt, and

• The previous user answered but rejected the call, and

• The extension’s call cascade is now attempting to transfer the call to a remote extension.

This notifies the user that the call was rejected. If the user also rejects the call, it will be routed 
according to the other extension’s call cascade.

Voicemail tab

The procedure for setting up voicemail is identical to that described in Local Extension/Fax. See 
Voicemail tab on page 75.

Mailbox greeting

The procedure for setting up the mailbox greeting is identical to that described in Local 
Extension/Fax. See Mailbox greeting on page 76.

When setting the number of rings to wait for a remote extension to connect, it is very 
important to allow enough time for the telephone network to connect to the phone. For 
example, a call to a cell phone or PDA may take 12 seconds (i.e. 2 rings) just to connect.
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Caller options

The procedure for setting up the caller options is identical to that described in Local Extension/
Fax. See Caller options on page 76.

Notification settings

The procedure for setting up the notification settings is identical to that described in Local 
Extension/Fax. See Notification settings on page 77.

Remote extensions and telephone company services

See Appendix B: TalkSwitch and Telephone Company Calling Services on page 245 for information 
about using the 3-Way Calling/Conference, Transfer and Clear, Prompted Ring Back, and 
Ringback Tones services with remote extensions.
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RING GROUPS

A ring group is a group of local extensions that ring in unison. Local extensions and auto 
attendants can dial a ring group.

There are ten ring groups in the TalkSwitch system, which are numbered 300 to 309. By default, 
300 is configured to ring all local extensions.

Ring groups have two main uses: 

• A ring group can reach a group of employees. For example, ring group 301 can ring the sales 
group at extensions 111, 112, 113, and 114. When a customer calls the sales group, the first 
available salesperson answers for the group.

• A ring group with a different ring pattern can differentiate callers. For example, the 
president doesn’t want to answer calls from the general public, but wants to be alerted when 
important colleagues are on the line. His local extension is 111, but you can configure ring 
group 305 to ring his phone with a different ring pattern. The president tells his colleagues 
to reach him at extension 305, which is his private extension. He can tell by the ring 
pattern if the caller dialed extension 111 or 305, and can react accordingly.

The Ring Groups page allows you to set up the name, ring pattern, local extensions, and call 
cascade for each ring group.

1. Select the Ring Groups page.

2. Select a slot for the ring group. 

Activate ring group

The Activate Ring Group area allows you to set up the name, ring pattern, and local extensions 
for each ring group.

1. Select the Activate Ring Group check box.

2. Enter the Ring group name. The name appears within the configuration windows.
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3. Select a Ring pattern to indicate the call is for the ring group. Choices are Regular, and 
Alternate 1 to Alternate 5.

4. Click the Edit button. The Set Ring Group Extensions window appears.

5. Select the local extensions you want to ring in unison.

About call cascades

See About call cascades on page 65.

Setting up a call cascade

The procedure for setting up a call cascade is similar to that described in Local Extension/Fax 
with the differences described below. See Setting up a call cascade on page 67.

• The Ring Groups page does not have the Do Not Disturb tab.

• The If Extension is busy list in the Busy tab does not have the invoke call waiting option.

• The queue at ring group option replaces queue call, and places the call in the ring group’s 
call queue.

Ring group options

The Ring Group Options area allows you to set up the system so users will know the caller is 
trying to contact the ring group, and not them personally. 

1. Select the Include ring group number check box to display the ring group number with the 
caller ID information. For example, if John Smith is calling ring group 300, each extension 
in ring group 300 will show “300 - John Smith”. 
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GENERAL VOICE MAILBOXES

General voicemail is not associated with any extension, but is for general use or for a group. By 
default, general voicemail is deactivated.

There are ten general voice mailboxes per TalkSwitch unit, which are numbered as follows:

• TalkSwitch Unit 1 — 410 to 419

• TalkSwitch Unit 2 — 420 to 429

• TalkSwitch Unit 3 — 430 to 439

• TalkSwitch Unit 4 — 440 to 449

The procedure for setting up general voicemail is similar to that described in Local Extension/
Fax, except each general voice mailbox is deactivated by default. See Voicemail tab on page 75.

The General Voice Mailboxes page allows you to set up general voicemail.

1. Select the General Voice Mailboxes page.

Mailbox greeting

The procedure for setting up the mailbox greeting is identical to that described in Local 
Extension/Fax. See Mailbox greeting on page 76.

Caller options

The procedure for setting up the caller options is identical to that described in Local Extension/
Fax. See Caller options on page 76.

Notification settings

The procedure for setting up the notification settings is identical to that described in Local 
Extension/Fax. See Notification settings on page 77.
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VOICEMAIL PREFERENCES

The Voicemail Preferences page allows you to set up the global message waiting indicator light 
and the voice mailbox settings. Any changes entered on this window affect all mailboxes. You 
can also view mailbox data, reset mailboxes and delete the password for a mailbox.

1. Select the Voicemail Preferences page.

Global message waiting indicator

The Global Message Waiting Indicator area allows you to have the Power/Data light on the 
TalkSwitch unit flash when there is a voicemail message in any mailbox.

1. Select the Slowly pulse the Power/Data light to indicate new messages check box to have the 
Power/Data light on the TalkSwitch unit flash when voicemail is present.

Mailbox setting

The Mailbox Setting area allows you to set up general mailbox settings.

1. Set the When listening to voicemail messages, always start with list to which message should 
be played first. Choices are Newest message or Oldest message.

2. Set the Notify the pager/remote phone after receiving list to how often the system should 
send notification. Choices are Every new message or Only 1st new message.

3. Set the Maximum recording length for each message list to how long a message can be. 
Choices range from 1 minute to 8 minutes.

4. Select the Remove blank messages and hang up automatically check box, if you want the 
TalkSwitch system to delete blank messages. A blank message occurs when the caller hangs 
up upon reaching your voicemail. If you have the caller ID service from your telephone 
company and choose to keep blank messages, you will be able to check the caller’s number 
when they leave a blank message.
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5. If you selected the Remove blank messages and hang up automatically check box, set the 
Only remove messages shorter than list. The TalkSwitch system will automatically remove 
messages that are shorter than the selected length. Choices range from 1 second to 
5 seconds.

Voicemail management

The Voicemail Management area has buttons that allow you to view mailbox data, reset voice 
mailboxes, and delete the password for a mailbox.

View mailbox data

The Voicemail Memory Usage window shows how much recording time is taken up by voicemail 
greetings and messages.

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

Note that the system allows up to 99 voicemail messages per mailbox. Once a mailbox fills up, 
callers won’t be able to leave voicemail messages for that user. Therefore users should delete 
voicemail messages before the mailbox fills up.

1. Click View Mailbox Data. The Voicemail Memory Usage window appears.

Alternatively, you can choose Tools > Voicemail Manager > Mailbox Status.

2. Select Active mailboxes only to conceal the deactivated mailboxes, or select All mailboxes to 
show the deactivated mailboxes as well.

Reset mailboxes

Resetting mailboxes deletes greetings, messages and passwords from the selected local 
extension, remote extension and general mailboxes. You can optionally delete the names 
recorded for the dial-by-name directory from these mailboxes as well.

1. Click Reset Mailboxes. The Reset Mailboxes window appears.
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Alternatively, you can choose Tools > Voicemail Manager > Reset Mailboxes.

2. Select one or more mailboxes to delete their greetings, messages and passwords.

3. Select the Delete name from dial-by-name directory check box to delete the names recorded 
for the dial-by-name directory from these mailboxes.

4. Click Reset Mailboxes. The greetings, messages and passwords (and optionally names for 
the dial-by-name directory) are deleted from the selected mailboxes.

Delete password

You can delete the password from the selected local extension, remote extension or 
general mailbox.

1. Click Delete Password. The Delete Password window appears.

Alternatively, you can choose Tools > Voicemail Manager > Delete Mailbox Password. 

2. Select the mailbox to delete its password.
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PERMISSIONS

A local extension can be restricted. If so, it will require an access code before an outside phone 
number can be dialled. For example, you can configure the lobby phone to require an access 
code. The receptionist can provide an access code to visitors, as required. However an access 
code is not required to answer a call, dial an emergency service number or place an intercom 
call.

To use an access code, pick up a local extension and dial the hunt group. If an access code is 
required, the TalkSwitch system will prompt you for the access code. Enter the access code, 
followed by #. If the access code is accepted, the TalkSwitch unit makes a telephone 
line available.

The Permissions page allows you to set up access codes for up to 150 people. You can restrict 
local extensions, by selecting those that require an access code to make an outside call.

1. Select the Permissions page.

Activate access codes

The Activate Access Codes for Outgoing Calls area allows you to enable the access code feature. 
You can then set up access codes for up to 150 people. You can also restrict local extensions, by 
selecting those that require an access code to make an outside call.

1. Select the Activate Access Codes for Outgoing Calls check box. The Permissions page allows 
you to enter access codes and restrict local extensions.

Access code configuration

The Access Code Configuration area allows you to add and remove access codes.

Enable password protection when access codes are used. Change the system password 
frequently to prevent unauthorized users from making calls or changing the configuration. 
See Administration on page 27.
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Adding an access code

1. Select a code.

2. Enter a Code name. This is typically the name of the user, or the name of the office where 
the extension is located. 

Alternatively, you can click the Browse button to display the Browse for Extension 
window. It allows you to select an extension number and the associated first name and last 
name as the code name.

If a call is made from a restricted local extension, the call detail record (CDR) will display 
the code name associated with the access code, and not the access code itself.

3. Enter an Access code. This is a numeric code that can be dialled using a telephone keypad. 
Each access code works with all restricted extensions.

Removing an access code

1. Select the access code.

2. Click Clear Code.

Extensions requiring an access code

The Extensions Requiring an Access Code area allows you to restrict selected extensions, or clear 
all restrictions. Restricted local extensions will require an access code to make an outgoing call.

Restricting extensions

1. Select the check boxes of the local extensions to restrict them.

Clearing restrictions

1. Click Clear All Extensions to make all local extensions unrestricted.
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SYSTEM SPEED DIALS

System speed dials allow the user to quickly dial an outside phone number from any local 
extension by dialling a speed dial number ranging from *300 to *399. Because the speed dial 
numbers are maintained within the TalkSwitch system, they don’t need to be programmed into 
each individual phone. If a new client is added or an existing client’s phone number changes, 
you can add or modify the speed dial number, and all users will have immediate access to the 
new phone number.

The System Speed Dials page allows you to define up to 100 speed dial numbers. Each speed 
dial number includes the first name, last name, phone number and hunt group. You can create a 
.csv file that contains speed dial numbers, and then import them into the system. You can also 
export the speed dial numbers to a .csv file. Caller ID name tagging can be enabled, which will 
substitute the caller ID name with the system speed dial name.

1. Select the System Speed Dials page.

Activate speed dial

The Activate Speed Dial area allows you to define up to 100 speed dial numbers. Each speed dial 
number includes the first name, last name, phone number and hunt group.

If the user dials an inactive speed dial number, they will hear an error message.

1. Select a speed dial number.

2. Select the Activate Speed Dial check box.

3. Enter the First name.

4. Enter the Last name.

5. Enter the Phone number. Valid characters are 0–9, -, , (pauses dialling for two seconds), w 
(pauses dialling until a dial tone is detected), * and #. The phone number can be up to 19 
characters long.
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The phone number can be a regular phone number or a VoIP number from a service provider. 

If the phone number is a regular phone number, it can optionally include a pause followed 
by an extension number. For example, the phone number is 555-1212 and the desired 
extension is 123. The Phone number can be set to 555-1212,123.

NOTE: The phone number cannot include an extension number if it is a VoIP number from a 
service provider.

If auto route selection blocks the phone number, the phone number will not be blocked if a 
user dials the speed dial number.

6. Select the hunt group. Choices are the active hunt groups.

If auto route selection or permissions block the hunt group, the hunt group will not be 
blocked if a user dials the speed dial number.

If all lines in the hunt group are busy, but an overflow hunt group is set up, the system will 
try the overflow hunt group.

Creating a speed dial list

A speed dial list is a .csv file that contains speed dial numbers. You can create the speed dial list 
using a text editor like Microsoft Notepad, or with a spreadsheet program like Microsoft Excel. 
You can then import the speed dial list into the TalkSwitch system.

Including the speed dial number

Each entry in the file can include the speed dial number. It requires the following information: 
*speed dial number, first name, last name, and phone number. When you import the file, and an 
entry has the same speed dial number as an existing speed dial number, the entry will override 
and replace the existing speed dial number. 

If using a text editor (e.g. Microsoft Notepad), surround each item with quotes. For example:

"*300","John","Doe","1235551212"
"*301","Jane","Doe","1235551313"

If using a spreadsheet program (e.g. Microsoft Excel), omit the quotes. For example:

Omitting the speed dial number

Each entry in the file can omit the speed dial number. It requires the following information: first 
name, last name, and phone number. When you import the file, the system will automatically 
add the entries to the unused speed dial numbers, starting from the last provisioned speed 
dial number.

If using a text editor (e.g. Microsoft Notepad), surround each item with quotes. For example:

"John","Doe","1235551212"
"Jane","Doe","1235551313"
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If using a spreadsheet program (e.g. Microsoft Excel), omit the quotes. For example:

Import system speed dial list

The Import System Speed Dial List area allows you to import speed dial numbers from a .csv file. 
The imported speed dial numbers will override or be added to the existing speed dial numbers. 
Imported speed dial numbers will use the first available hunt group (i.e. 9).

1. Click Select File. The Import System Speed Dial List window appears.

2. Select the .csv file, and then click Open. A progress bar appears.

3. Click Close.

4. Choose File > Save to save the imported speed dial list to the TalkSwitch unit.

Export system speed dial list

The Export System Speed Dial List area allows you to export the speed dial numbers to a .csv file. 
You can then share the .csv file as required, or print it for your users. The first line of the file is 
a title line, and subsequent lines contain entries. Each entry in the file has the following 
information: *speed dial number, first name, last name, and phone number.
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If you open the .csv file in a text editor (e.g. Microsoft Notepad), each item will be surrounded 
by quotes. For example:

“SSD”,”FIRST NAME”,”LAST NAME”,”PHONE NUMBER”
“*300”,”John”,”Doe”,”1235551212”
“*301”,”Jane”,”Doe”,”1235551313”

If you open the .csv file in a spreadsheet program (e.g. Microsoft Excel), the quotes will be 
omitted. For example: 

NOTE: If the phone number has more than 15 digits and does not have any special characters (-
, ,, w, * or #), Microsoft Excel will convert it to scientific notation. Do not attempt to import a 
.csv file that contains a phone number in scientific notation.

1. Click Export. The Export System Speed Dial List window appears.

2. Enter the name of the .csv file, and then click Save. A progress bar appears.

3. Click Close.

Caller ID name tagging

The Caller ID Name Tagging area allows you to enable the substitution of the caller ID name with 
the name from the System Speed Dials page.

Caller ID name tagging compares the phone number from the caller ID of an incoming call with 
the phone numbers from the System Speed Dials page. If a matching phone number is present, 
the system will replace the name from the caller ID with the first name and last name from the 
System Speed Dials page. These names will appear on the extension instead of the caller 
ID name.
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For more information, see Caller ID Based Routing on page 128.

1. To enable caller ID name tagging of the entries within the System Speed Dials page, select 
the Use the first and last names specified above to replace the incoming Caller ID names 
check box.

2. Select the order for the names. Choices are First name followed by Last name, and Last name 
followed by First name.

TELEPHONE LINES

The Telephone Lines page allows you to set up the telephone numbers, telephone company 
services, and call handling for each telephone line. You can also calibrate the TalkSwitch unit to 
match the telephone lines.

1. Select the Telephone Lines page.

Activate line

The Activate Line area allows you to activate a telephone line. All telephone lines are activated 
by default.

“Line detected at initialization: Yes” appears if the telephone line was connected when you 
started the TalkSwitch management software. “Line detected at initialization: No” appears if the 
telephone line was not connected.

1. Select a telephone line.

2. If necessary, select the Activate line check box.
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Phone numbers

The Phone Numbers area allows you to enter the main and distinctive ring phone numbers.

The Distinctive Ring service provides one or two additional phone numbers to ring the same 
telephone line. Each phone number has a different ring pattern. You can set up separate call 
handling for the main number, distinctive ring 1 number, and distinctive ring 2 number.

• Main number corresponds to the normal ring pattern.

• Distinctive ring 1 corresponds to a double ring pattern.

• Distinctive ring 2 corresponds to a triple ring pattern.

1. Enter the phone number of the telephone line in the Main number box.

2. If the telephone line has the Distinctive Ring service, and you want to set up different call 
handling for the distinctive ring numbers:

a) Select the Distinctive ring 1 and Distinctive ring 2 check boxes. 

b) Enter the distinctive ring numbers.

3. If the telephone line has the Distinctive Ring service, but you want the same call handling 
for each distinctive ring number, clear the Distinctive ring 1 and Distinctive ring 2 
check boxes.

Phone line services

The Phone Line Services area allows you to select the telephone company services that are active 
on the telephone line. See Appendix B: TalkSwitch and Telephone Company Calling Services on 
page 245 for a description of these services and how the TalkSwitch unit uses them.

• Transfer and Clear allows the TalkSwitch unit to release the line after transferring a call from 
an outside caller to a remote extension. You can enable this feature if the Transfer and Clear 
service will allow a call to remain in progress between the outside caller and the remote 
extension, after the TalkSwitch unit hangs up. Enabling this feature without the service will 
result in the caller being disconnected when their call is transferred to a remote extension. 
To enable the feature, select the Clear telephone line after call transferred check box in the 
Transfer Preferences window. See To remote extension tab on page 167.

• 3-Way Calling/Conference allows the same line connect feature to work with the line’s 3-Way 
Calling/Conference service for call bridge (DISA) calls, and with incoming calls that are 
routed to remote extensions.

• Hunt/Rollover/Busy Forwarding indicates the line has a hunting facility or call forward on 
busy service. If an incoming call reaches a busy line, it will automatically try another line.

• Caller ID allows the TalkSwitch unit to forward caller ID information to the local extensions. 
The TalkSwitch unit can also use the time information provided by caller ID to update its 
internal clock.

• Call Waiting sounds a tone if an incoming call reaches a busy line. Call waiting is not 
recommended, since the TalkSwitch system cannot answer the second call. If your 
installation has more than one line consider using the telephone company’s Hunt/Rollover 
service. The TalkSwitch system has call waiting built-in, and does not require the Call 
Waiting service from the telephone company.
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• Line Reversal is used in some regions to exchange signals between the telephone company 
and your telephone equipment. If you select the Line Reversal check box, click the Line 
Reversal Settings button to select the reversal patterns used by your telephone company.

Note that line reversal configuration is not offered in the United States or Canada.

Line reversal settings

Line reversal is used in some regions to exchange signals between the telephone company and 
your telephone equipment. Line reversal can improve performance and lower costs on busy 
telephone lines. Check with your telephone company to see whether line reversal is used, and 
when. For example, the TalkSwitch unit can send a signal when it:

• Seizes the line. The TalkSwitch unit seizes a line when a user dials a hunt group number.

• Answers the line.

• Releases the line. The TalkSwitch unit releases the line when the user hangs up.

Note that line reversal configuration is not offered in the United States or Canada.

1. If line reversal is used, click Line Reversal Settings. The Line Reversal Settings 
window appears.

2. Select the reversal patterns specified by your telephone company for incoming and outgoing 
calls. The reversal patterns include:

• Ignore reversal — Do not send or respond to line reversal signals.

• Seizure and release — Send a signal when a line is seized, and again when the line 
is released.

• Seizure and answer — Send a signal when a line is seized, and again when the line 
is answered.

• Answer and release — Send a signal when a line is answered, and again when the line 
is released.

Call handling

The Call Handling area allows you to set up call handling for each telephone number of each 
telephone line for Mode 1, Mode 2 and Holiday Mode. The telephone line can ring selected local 
extensions in sequence, and then play an auto attendant or go to a voice mailbox. Alternatively, 
it can immediately play an auto attendant or go to a voice mailbox without ringing 
the extensions.
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For example, the system can ring the receptionist when Mode 1 is active during the day. If the 
receptionist doesn’t answer, it can start ringing other users as well. If there is still no answer, it 
can play an auto attendant. The auto attendant provides the dial-by-name directory, and allows 
the caller to dial an extension. A voice mailbox can immediately answer the telephone line when 
Mode 2 is active at night or on weekends. Another auto attendant can immediately route the 
call to a remote extension during Holiday Mode.

1. Select a telephone number tab. Choices are Main number, Distinctive Ring 1 and Distinctive 
Ring 2.

2. Select the mode tab. Choices are Mode 1, Mode 2 and Holiday Mode.

3. Set up the ring sequence. The ring sequence determines when each local extension will start 
ringing. The extensions will not use their call cascades during the ring sequence. The system 
transfers the call to the first extension that is answered.

a) Click Edit. The Ring Sequence window appears.

b) Select the local extensions to ring. All extensions are selected by default.

c) For each selected extension, set when the local extension will start ringing. All 
extensions ring after the first ring by default.

If you assign a different value to each extension, the extension with the lowest number 
of rings will ring first. The other extensions will start ringing as the number of rings 
goes up. For example, the system can ring the receptionist first, and then ring other 
users if the receptionist doesn’t answer.

4. Set up call handling to route an unanswered call to an auto attendant or voicemail.

a) Select the call handling action. Choices are:

• perform no action — The system continues to ring the extensions. A generic auto 
attendant answers after 15 rings. It allows an authorized caller to make 
configuration changes, access voicemail or dial extensions.

• go to auto attendant — Plays the selected auto attendant.

• go to voicemail — Accesses the selected voice mailbox.

• play announcement — Plays the selected announcement.
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b) If you selected go to auto attendant, select the auto attendant you wish to play in the 
selected mode. You can assign the same auto attendant to multiple telephone lines. 
Alternatively, if different organizations share the TalkSwitch system, a different auto 
attendant can be assigned to each telephone line.

c) If you selected go to voicemail or play announcement, select the voice mailbox. You can 
select a local extension mailbox, remote extension mailbox, or general voice mailbox.

d) Select when the system will perform call handling. Choices are:

• immediately — The system will immediately perform call handling without using the 
ring sequence. Selecting immediately will disable the Edit button and the other ring 
sequence controls.

• after 1 ring to after 9 rings — The system will follow the ring sequence first, and 
then perform call handling if no one answers.

Line optimization

The Line Optimization area allows you to calibrate the TalkSwitch unit to match the telephone 
lines. Calibration optimizes transmission for the type of telephone line or equipment connected 
to the TalkSwitch unit by setting the far end impedance. Calibration improves performance for 
call bridge (DISA) and call forwarding.

You should calibrate the lines:

• After adding or changing a telephone line.

• After connecting a line to equipment other than a telephone company line.

• If poor audio performance is encountered.

1. Click Calibrate Lines. The Calibrate Lines window appears.

2. Select the line(s) to calibrate, and then click Run Calibration.
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VOIP NUMBERS

A VoIP number is like a telephone number. It allows a caller to dial a TalkSwitch system across 
the TalkSwitch VoIP network or through a VoIP service provider.

A VoIP number can be three or more digits long. Each VoIP number must be unique (i.e. only 
used at one location). The administrator for all locations needs to assign and keep track of the 
VoIP numbers within the TalkSwitch VoIP network.

VoIP numbers 250 to 299 permit direct dialing from any extension, auto attendant or call 
cascade to any extension, auto attendant, announcement or voice mailbox in the TalkSwitch 
VoIP network. No hunt group is required. Longer VoIP numbers can also be used, but the user 
must first dial a hunt group number.

You can set up unique call handling for each VoIP number. Call handling for VoIP numbers is 
identical to call handling for telephone numbers. You can set up call handling for Mode 1, Mode 
2 and Holiday Mode.

If a VoIP number is called, the system can ring selected local extensions in sequence, and then 
play an auto attendant or announcement, or go to a voice mailbox. Alternatively, it can 
immediately play an auto attendant or announcement, or go to a voice mailbox without ringing 
the extensions. For example, you can set up a general VoIP number that reaches the main auto 
attendant, and other VoIP numbers that are routed to specific extensions.

If you are using a TalkSwitch-certified VoIP service provider, visit the support section at  http:/
/global.talkswitch.com to access the service configuration guide for your VoIP service provider.

The VoIP Numbers page allows you to set up VoIP numbers. It is only present with a VoIP-
enabled TalkSwitch unit.

1. Select the VoIP Numbers page.
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Activate VoIP number

The Activate VoIP Number area allows you to activate a VoIP number and select its profile.

1. Select a VoIP number.

2. Select the Activate VoIP Number check box.

3. Select the profile for the VoIP number. Choices are:

• TalkSwitch — The VoIP number will use the TalkSwitch VoIP network. The Phone Number 
area will contain the Phone number box.

• Service provider (1 to 4) — The VoIP number will use the service provider. The Phone 
Number area will contain the Country Code box, City or Area Code box and Number box, 
and the User Name and Password area will be enabled.

Phone number

The Phone Number area allows you to enter the VoIP number.

TalkSwitch profile

If the TalkSwitch profile is used, a VoIP number can be three or more digits long. Each VoIP 
number must be unique (i.e. only used at one location).

VoIP numbers 250 to 299 permit direct dialing from any extension, auto attendant or call 
cascade to any extension, auto attendant, announcement or voice mailbox in the TalkSwitch 
VoIP network. Longer VoIP numbers can also be used, but the user must prefix them with a hunt 
group number.

1. Enter the VoIP number into the Phone number box.

Service provider profile

If a service provider profile is used, use the country code, area code and phone number, as 
provided by the service provider.

1. Enter the Country Code, if required.

2. Enter the City or Area Code.

3. Enter the Number.
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Username and password

If a service provider profile is used, the Username and Password area allows you to enter the 
authentication information required to access the service provider’s SIP server.

1. Enter the User/Account, as provided by the service provider.

2. Enter the Password, as provided by the service provider.

Registration status

See Viewing registration status on page 55.

Call handling

The Call Handling area allows you to set up call handling for each VoIP number for Mode 1, Mode 
2 and Holiday Mode. The VoIP number can ring selected local extensions in sequence, and then 
play an auto attendant or announcement, or go to a voice mailbox. Alternatively, it can 
immediately play an auto attendant or announcement, or go to a voice mailbox without ringing 
the extensions.

For example, the system can ring the receptionist when Mode 1 is active during the day. If the 
receptionist doesn’t answer, it can start ringing other users as well. If there is still no answer, it 
can play an auto attendant. The auto attendant provides the dial-by-name directory, and allows 
the caller to dial an extension. A voice mailbox can immediately answer the VoIP number when 
Mode 2 is active at night or on weekends. Another auto attendant can immediately route the 
call to a remote extension during Holiday Mode.

1. Select the Mode tab. Choices are Mode 1, Mode 2 and Holiday Mode.

2. Set up the ring sequence. The ring sequence determines when each local extension will start 
ringing. The extensions will not use their call cascades during the ring sequence. The system 
transfers the call to the first extension that is answered.

a) Click Edit. The Ring Sequence window appears.

b) Select the local extensions to ring. All extensions are selected by default.

c) For each selected extension, set when the local extension will start ringing. All 
extensions ring after the first ring by default.
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If you assign a different value to each extension, the extension with the lowest number 
of rings will ring first. The other extensions will start ringing as the number of rings 
goes up. For example, the system can ring the receptionist first, and then ring other 
users if the receptionist doesn’t answer.

3. Set up call handling to route an unanswered call to an auto attendant or voicemail.

a) Select the call handling action. Choices are:

• perform no action — The system continues to ring the extensions. A generic auto 
attendant answers after 15 rings. It allows an authorized caller to make 
configuration changes, access voicemail or dial extensions.

• go to auto attendant — Plays the selected auto attendant.

• go to voicemail — Accesses the selected voice mailbox.

• play announcement — Plays the selected announcement.

b) If you selected go to auto attendant, select the auto attendant. You can assign the same 
auto attendant to multiple VoIP numbers, or a different auto attendant to each 
VoIP number.

c) If you selected go to voicemail or play announcement, select the voice mailbox. You can 
select a local extension mailbox, remote extension mailbox, or general voice mailbox.

d) Select when the system will perform call handling. Choices are:

• immediately — The system will immediately perform call handling without using the 
ring sequence. The window will disable the Edit button and the other ring 
sequence controls.

• after 1 ring to after 9 rings — The system will follow the ring sequence first, and 
then perform call handling if no one answers. The window enables the Edit button 
and the other ring sequence controls.
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CALLER ID BASED ROUTING

Incoming calls include caller ID information. The caller ID includes the phone number and 
perhaps the name of the caller. The Caller ID Based Routing page allows you to set up call 
handling based on the caller ID information. The system will check the caller ID of each 
incoming call. If the caller ID matches a caller ID entry, the system will route the 
call accordingly.

For example, if the call is from an important client, the call can be routed directly to the 
president’s extension. If no caller ID is present, the call can be routed to voicemail.

You can define up to 200 caller ID entries. Each caller ID entry has an optional name, a phone 
number and a routing assignment. The routing assignment can use call handling set up for a 
group, or can display an alternate name on the user’s extension, instead of the name from the 
caller ID.

If caller ID entries have phone numbers with overlapping digits, the system will use the best 
(longest) match to route the call. For example, the first entry routes calls from phone numbers 
that start with 5551. The second entry routes calls from phone numbers that start with 555. If 
the incoming call is from 555-1234, both entries match. However the system will use the first 
entry because it is a better match with a longer set of matching digits.

You can set up call handling for up to ten groups for Mode 1, Mode 2 and Holiday Mode. Call 
handling for a group is identical to call handling for telephone numbers, except you can set the 
ring pattern for each group. Depending on the caller ID, an incoming call can ring selected local 
extensions in sequence, and then play an auto attendant or announcement, or go to a voice 
mailbox. Alternatively, it can immediately play an auto attendant or announcement, or go to a 
voice mailbox, without ringing the extensions.

1. Select the Caller ID Based Routing page.
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Caller ID lookup list

The Caller ID lookup list area allows you to define up to 200 caller ID entries. Each entry has an 
optional name, a phone number and a routing assignment. The routing assignment can use call 
handling set up for a group, or can display an alternate name on the user’s extension, instead of 
the name from the caller ID.

1. Optionally, enter the name in the Replace Caller ID name with box. The extension will 
display this alternate name, instead of the name from the caller ID.

2. Select the Caller ID type to match. Choices are:

• Private/blocked — Defines an entry for incoming calls that have caller ID blocked for 
privacy reasons.

• Long distance/unknown — Defines an entry for incoming calls that don’t have caller ID.

• Phone number ends with — Defines an entry for an incoming call from a phone number 
that ends with the specified digits. For example, you can enter an important client’s 
phone number if you want to route their calls directly to the president’s extension.

All incoming calls from phone numbers with ending digits that match the specified 
digits will be routed the same way. For example, the specified digits are 5551212. The 
system will use the same routing if the phone number is 555-1212, 613-555-1212 or 416-
555-1212.

• Phone number starts with — Defines an entry for an incoming call from a phone number 
that starts with the specified digits. For example, you can enter an area code if you want 
to route long distance calls to a particular extension for faster processing, or if you want 
to route telemarketers with 1-800 numbers directly to voicemail.

All incoming calls from phone numbers with starting digits that match the specified 
digits will be routed the same way. For example, the specified digits are 1800. The 
system will use the same routing if the phone number is 180-0121, 1-800-123-4567 or 1-
800-555-1234.

3. If you selected Phone number ends with or Phone number starts with, enter the digits.

4. Select the routing in the When matched, perform the following list. Choices are:

• use original Caller ID — The caller ID will not affect call routing.

• Replace Caller ID name — The caller ID will not affect call routing, but the extension will 
display the alternate name, instead of the name from the caller ID.

• Route using Group [1–10] — The caller ID is used to route the call according to the 
specified group. The extension will display the alternate name, instead of the name from 
the caller ID.

Caller ID routing groups

The Caller ID routing groups area allows you to set up call handling for up to ten groups for Mode 
1, Mode 2 and Holiday Mode. Call handling for a group is identical to call handling for telephone 
numbers, except you can set the ring pattern for each group. Depending on the caller ID, an 
incoming call can ring selected local extensions in sequence, and then play an auto attendant or 
announcement, or go to a voice mailbox. Alternatively, it can immediately play an auto 
attendant or announcement, or go to a voice mailbox, without ringing the extensions.
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For example, assume an important client is calling. The system can ring the president when 
Mode 1 is active during the day. If the president doesn’t answer, the call can be routed to 
voicemail. A voice mailbox can immediately answer the call when Mode 2 is active at night or on 
weekends. An auto attendant can immediately route the call to the president’s remote extension 
during Holiday Mode.

1. Enter the Group label to name the group.

2. Select the Mode tab. Choices are Mode 1, Mode 2 and Holiday Mode.

3. Set up the ring sequence. The ring sequence determines when each local extension will start 
ringing. The extensions will not use their call cascades during the ring sequence. The system 
transfers the call to the first extension that is answered.

a) Click Edit. The Ring Sequence window appears.

b) Select the local extensions to ring. All extensions are selected by default.

c) For each selected extension, set when the local extension will start ringing. All 
extensions ring after the first ring by default.

If you assign a different value to each extension, the extension with the lowest number 
of rings will ring first. The other extensions will start ringing as the number of rings 
goes up. For example, the system can ring the receptionist first, and then ring other 
users if the receptionist doesn’t answer.

d) Select the Ring pattern. Choices are Regular and Alternate 1 to Alternate 5. This allows 
you to set up distinctive ring based on the caller ID.

4. Set up call handling to route an unanswered call.

a) Select the call handling action. Choices are:

• perform no action — The system continues to ring the extensions. A generic auto 
attendant answers after 15 rings. It allows an authorized caller to make 
configuration changes, access voicemail or dial extensions.

• go to auto attendant — Plays the selected auto attendant.

• play announcement — Plays the selected announcement.

• go to voicemail — Accesses the selected voice mailbox.
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b) If you selected go to auto attendant, select the auto attendant. You can assign the same 
auto attendant to multiple groups, or a different auto attendant to each group.

c) If you selected play announcement, select the announcement. 

d) If you selected go to voicemail, select the voice mailbox. You can select a local extension 
mailbox, remote extension mailbox, or general voice mailbox.

e) Select when the system will perform call handling. Choices are:

• immediately — The system will immediately perform call handling without using the 
ring sequence. The window will disable the Edit button and the other ring 
sequence controls.

• after 1 ring to after 9 rings — The system will follow the ring sequence first, and 
then perform call handling if no one answers. The window enables the Edit button 
and the other ring sequence controls.

Setting up caller ID routing with an extension

A user can set up caller ID routing with their extension, once the call is terminated. For 
example, a telemarketer can be added to a group that routes calls directly to an announcement.

1. To add the caller to a group, dial *81 [group number 1–10] #. The system adds the caller 
ID entry to the Caller ID lookup list. Future calls will be routed according to the group.

2. To display the alternate name instead of the caller ID name, dial *810#. The system adds 
the caller ID entry to the Caller ID lookup list. Future calls will display the name from the 
Replace Caller ID name with box.

3. To delete the caller ID entry from the Caller ID lookup list, dial *81255#. The system will no 
longer use the caller ID to route the call or display the alternate name.
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LINE HUNT GROUPS

A line hunt group is a set of lines that are available for making an outbound call. It can use 
selected telephone lines, all VoIP lines associated with the TalkSwitch VoIP network, or all VoIP 
lines associated with a service provider VoIP network.

When placing an outbound call, the user first dials the hunt group number. The TalkSwitch 
system selects an available line from the group. However the user does not have to dial a hunt 
group before VoIP numbers 250–299: these automatically use the TalkSwitch VoIP network. Nor 
does the user have to dial a hunt group before remote extension numbers 210–249: these 
automatically use the hunt group configured for the remote extension.

You can set the hunt order for telephone lines, but the system automatically determines the 
hunt order for VoIP lines.

You can set up nine different hunt groups. If a VoIP-enabled TalkSwitch unit is present, hunt 
group 88 uses the TalkSwitch VoIP network by default, and the other hunt groups use telephone 
lines. You can modify these default settings as required. If you are using multiple service 
provider VoIP networks, set up a hunt group for each service provider.

A local extension can be restricted to a set of hunt groups, in order to reserve telephone lines 
for high-priority users, or to control access to VoIP networks. See Hunt group permissions on 
page 64.

The TalkSwitch unit uses a hunt group when placing a call from a local extension, to a remote 
extension, or with the call bridge (DISA) feature. The hunt groups do not affect incoming calls.

The TalkSwitch system has the following hunt groups by default. If default settings are used, the 
system will first search the higher line numbers (e.g. line 4) for outgoing calls, since the lower 
line numbers are more heavily used for incoming calls. You can modify the default hunt groups 
as required. 

The Line Hunt Groups page allows you to set up the name, line type, set of telephone lines, 
hunting order, overflow hunt group and overflow notification for each hunt group.

IMPORTANT: Ensure that hunt group 9 or 0 is assigned to the group of telephone lines or VoIP 
trunks used for calls to emergency services.

Hunt Group 9 Selects line 4, line 3, line 2, then line 1.

Hunt Group 81 Selects line 1.

Hunt Group 82 Selects line 2.

Hunt Group 83 Selects line 3.

Hunt Group 84 Selects line 4.

Hunt Group 85–87 No lines are assigned.

Hunt Group 88 If a VoIP-enabled TalkSwitch unit is present, selects an available 
VoIP line from those associated with the TalkSwitch VoIP 
network. If no VoIP-enabled TalkSwitch unit is present, no lines 
are assigned.
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1. Select the Line Hunt Groups page.

Activate hunt group

The Activate Hunt Group area allows you to activate and name a hunt group.

1. Select a hunt group.

2. If necessary, select the Activate Hunt Group check box. All hunt groups are active by default.

3. Enter a name in the Hunt group name box. The name will identify the hunt group elsewhere 
in the TalkSwitch management software.

Hunt group line assignments

The Hunt Group Line Assignments area allows you to set up a hunt group for telephone lines or 
VoIP lines.

1. Set the Line type. Choices are:

• Phone lines — Allows you to select telephone lines.

• TalkSwitch VoIP — Uses the TalkSwitch VoIP network lines in the hunt group.

• SPn VoIP Service — Uses the service provider VoIP lines in the hunt group.
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2. If you set Line type to Phone lines:

a) Click Add/Remove Lines. The Add/Remove Telephone Lines window appears.

b) Select the telephone lines for the hunt group, and then click OK.

c) Change the order of the lines by selecting a line, and then clicking Move Up and 
Move Down.

If you set Line type to TalkSwitch VoIP or SPn VoIP Service, VoIP lines are 
selected automatically.

Hunting order for outgoing calls

The Hunting order for outgoing calls area allows you to specify how the system will hunt for an 
available line within the hunt group.

1. Set the Hunt lines in the following order list. Choices are:

• Order specified above — The system will start with the first line in the hunt group.

• Search lines on same unit first — The system will hunt for lines on the TalkSwitch unit 
that the extension is connected to, before hunting on the other units. This minimizes 
network traffic between TalkSwitch units.

• Uniform distribution (Circular) — The system will start with the line after the last 
hunted line in the hunt group. This way telephone lines are used more evenly for 
outbound calls.

For example, the hunt group has lines 1, 2, 3 and 4. The last call with the hunt group 
used line 2. The system will first check line 3 for availability.

The circular hunt mode can reduce costs if the line toll increases after utilization 
exceeds a threshold. For example, assume each line costs 5¢ per minute for the first 100 
minutes, and then costs 10¢ per minute. The circular hunt mode makes it more likely 
users will finish the first 100 minutes on each line before the thresholds are exceeded 
and higher charges are incurred.
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Hunt group busy overflow for outgoing calls

The Hunt group busy overflow for outgoing calls area allows you to select an overflow hunt group. 
If the user dials a hunt group, but there are no lines available, the system will play a warning 
tone while hunting for a free line in the overflow hunt group. The warning tone indicates the 
call may be more expensive or of different quality than expected. The user can then remain on 
the line, or hang up and wait for a line to become available in the original hunt group.

If the dialled hunt group and the overflow hunt group are both busy, the user will hear the 
busy tone.

A hunt group that contains telephone lines can have an overflow hunt group that contains 
telephone lines or VoIP lines. Similarly, a hunt group that contains VoIP lines can have an 
overflow hunt group that contains telephone lines or VoIP lines.

The overflow hunt group must contain different lines than the original hunt group, but these 
lines must support the same dialled number structure.

For example, assume the original hunt group contains telephone lines and the overflow hunt 
group contains VoIP lines. If the lines within the original hunt group require you to dial 1 before 
the area code and phone number (e.g. 1 613 555 1212), the lines within the overflow hunt 
group cannot require you to omit the 1 (e.g. 613 555 1212). 

1. Select the overflow hunt group in the If all lines are busy in this hunt group list. Choices are 
no overflow and the activated hunt groups.

Overflow tone notification

The Overflow tone notification area allows you to disable the warning tone that sounds when an 
overflow hunt group is being used. The warning tone sounds by default.

1. To disable the warning tone, clear the Play notification tone when overflowing to another hunt 
group check box.
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AUTO ATTENDANTS (MENUS)

An auto attendant can answer a telephone line or VoIP number, and can be included in the call 
cascade of a local extension, remote extension or ring group.

An auto attendant can answer a call if the receptionist is away or if you don’t have a 
receptionist. Each auto attendant has a message and up to six options. The message tells the 
caller what the options are. You can load a professionally pre-recorded message, or can record a 
message using a handset. The caller selects an option by dialling 0, 1, 2, 3, 4 or 5. The auto 
attendant then performs the action programmed for the option. The auto attendant can:

• Transfer the call to a local extension, remote extension or ring group. The call then follows 
the extension’s call cascade.

• Transfer the call to the call queue of a ring group. The call is placed on hold. The TalkSwitch 
system will ring the next available local extension in the ring group.

• Transfer the call to a voice mailbox, allowing the caller to leave a message. The call can be 
transferred to a local extension, remote extension or general voice mailbox. Pressing * 
during the greeting returns to the auto attendant. If the 0 option is programmed, pressing 0 
during the greeting can route the call to an extension, voice mailbox, announcement or 
auto attendant. An authorized caller can retrieve messages and perform other voicemail 
activities by pressing 8 during the greeting. If no digit is pressed during the greeting, the 
system hangs up after the caller leaves a message.

• Play an announcement with directions, business hours, etc. The announcement can have the 
0 option programmed to route the call to an extension, voice mailbox, announcement or 
auto attendant. The system hangs up after the announcement if no digit is dialled. Pressing 
* returns to the auto attendant.

• Access the dial-by-name directory so the caller can find a user’s extension number. The dial-
by-name directory prompts the caller to enter the first three letters of the user’s last name. 
Pressing * returns to the auto attendant. See Setting up the dial-by-name directory on page 
141.

• Route the call to another auto attendant, which allows actions to be nested into a powerful 
call routing system. For example, the main auto attendant can say “Press one for English. 
Oprima dos para Español.” Option 1 goes to the English auto attendant and option 2 goes to 
the Spanish auto attendant.

In addition to the six auto attendant options, the caller can:

• Reach an extension by dialling an extension number.

• Access voicemail by pressing ** then the mailbox number.

• Access call back by dialling 6.

• Access call bridge/DISA by dialling a hunt group number.

• Enter command mode by pressing #.

The caller is able to dial an extension, even if the first number of the extension is the same as 
an auto attendant option. For example, the caller can dial 111 even though the first “1” is the 
same as auto attendant option 1. This is because the TalkSwitch system waits after the caller 
dials a digit, before following the action for that digit. The default wait time is 1.5 seconds, and 
is set with the Single digit fall through time list in the Auto Attendants window.
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The TalkSwitch system automatically copies the auto attendants to each TalkSwitch unit on the 
network. This reduces network traffic and allows the system to continue functioning even if a 
unit loses power or is disconnected from the LAN.

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

The Auto Attendants (Menus) page allows you to set up the nine different auto attendants for 
the TalkSwitch system.

1. Select the Auto Attendant (Menus) page.

Activate auto attendant

The Activate Auto Attendant area allows you to activate an auto attendant. All auto attendants 
are activated by default.

1. Select an auto attendant.

2. If necessary, select the Activate Auto Attendant check box.

3. Enter the Auto attendant label. The name will identify the auto attendant elsewhere in the 
TalkSwitch management software.

Actions during auto attendant playback

The Actions During Auto Attendant Playback area allows you to configure the auto attendant 
with up to six options, associated with the caller pressing 0, 1, 2, 3, 4 or 5.

1. Select the Action. Choices are:

• go to voicemail — Accesses the selected voice mailbox.

• go to local extension — Transfers the call to the selected local extension. 

• go to remote extension — Transfers the call to the selected remote extension. 
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• go to ring group — Transfers the call to the selected ring group. 

• play announcement — Plays the selected announcement.

• go to auto attendant — Routes the call to the selected auto attendant.

• queue at ring group — Transfers the call to the call queue of the selected ring group.

• lookup name directory — Accesses the dial-by-name directory. See Setting up the dial-by-
name directory on page 141.

• perform no action — The option is unused.

• go to VoIP location — Routes the call to the selected VoIP number within the TalkSwitch 
VoIP network.

2. Select the Resource. Depending on the action selected in Step 1, resources are voice 
mailboxes, extensions, announcements, auto attendants, or VoIP numbers within the 
TalkSwitch VoIP network.

3. Select the language in the Language of system prompts list. If the caller selects this option, 
they will hear all subsequent prompts in the selected language.

4. Select the action If a fax call is detected. The TalkSwitch system can automatically detect a 
fax machine that plays a CNG tone. Choices are:

• go to local extension 

• go to remote extension

• perform no action 

• hang up

5. Depending on the action selected in Step 4, select the extension the fax machine is 
connected to.

6. If the caller dials an option that causes the auto attendant to transfer their call, the system 
will play the “One moment please” prompt by default. You can disable the prompt. See From 
auto attendant tab on page 169.

a) Choose Options > Transfer Preferences. The Transfer Preferences window appears.

b) Select the From Auto Attendant tab.

c) To disable the prompt, select the Disable playing of transfer prompts check box.
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Action performed after auto attendant playback

The Action Performed After Auto Attendant Playback area allows you to set up how the system 
will react if the user makes no selection. This can occur if the caller does not understand the 
prompts, does not have tone dialling on their phone, or prefers to speak with a person.

1. Select the time limit, ranging from 0 seconds to 30 seconds.

2. Select the action. Choices include:

• go to voicemail

• go to local extension

• go to remote extension

• go to ring group

• play announcement

• go to auto attendant

• queue at ring group

• lookup name directory — See Setting up the dial-by-name directory on page 141.

• hang up

3. Depending on the action selected in Step 2, select the voice mailbox, extension, 
announcement, or auto attendant.

Working with auto attendant messages

You can record a new message, load a professionally recorded message, or erase a message from 
the TalkSwitch system.

Recording a new message

You can record a new message using a local extension or remote phone.

1. Pick up a local extension, or dial into the TalkSwitch system from a remote phone. If you 
pick up a local extension, you will hear the dial tone. If you dial in from a remote phone, the 
auto attendant will answer.

2. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

3. Enter the system password, followed by #.

4. Dial 4 [auto attendant number 1 - 9] # to record the message. For example, dial 41# to 
record the message for auto attendant 1.

5. Press # when you have completed saying the message.

6. Dial 5 [auto attendant number 1 - 9] # to listen to the message. For example, dial 51# to 
listen to the message for auto attendant 1.

If you don’t set up an auto attendant message, the TalkSwitch system will answer without 
playing a message. The caller will hear silence and might assume the call did not 
get connected.
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7. Repeat Steps 4 to 6 to re-record the message, or hang up to keep the message.

Loading a message

The Attendant Greetings area allows you to load the message for the auto attendant.

You can load an 8 kHz, 8 bit, Mono, u-Law .wav file that contains the auto attendant message. If 
using a professionally recorded message, ensure it is in this format.

1. Select an auto attendant.

2. Click Load Greeting. The Select Wav File window appears.

3. Click Browse to select the .wav file, and then click Select Wav File.

Erasing a message

You can erase a recorded or loaded message using a local extension or remote phone. Erase 
unused auto attendant messages to free up space for voicemail. 

1. Pick up a local extension, or dial into the TalkSwitch system from a remote phone. If you 
pick up a local extension, you will hear the dial tone. If you dial in from a remote phone, the 
auto attendant will answer.

2. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

3. Enter the system password followed by #.

4. Dial 04 [auto attendant number 1 - 9] # to erase the message. For example, dial 041 # to 
erase the message for auto attendant 1. 
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Example auto attendant

The following auto attendant answers incoming calls, and plays the following recorded message:

“Welcome to ABC Company. If you know your party’s three-digit extension, you may dial it now. To 
reach the receptionist, dial 0 or stay on the line. Dial 1 to find your party’s extension in our dial-
by-name directory. Dial 2 to hear our business hours and directions to our location. Dial 3 to talk 
to the next available customer support representative, or dial 4 to leave them a message.”

If the caller is a fax machine that plays the CNG tone, the TalkSwitch system will route the call 
to the fax machine at extension 118. If no selection is made, the call is routed to the 
receptionist at extension 114.

Setting up the dial-by-name directory   

The dial-by-name directory allows a caller to find a user’s extension number, and connect to 
their local extension or remote extension. This way the caller can reach their party without 
speaking to the receptionist.

When prompted by the auto attendant, the caller selects the dial-by-name directory, and then 
dials the first three letters of the user’s last name. Alternatively, the caller can dial only one or 
two letters. If a matching entry is found, the system will play the user’s name and extension 
number. The caller can then dial 1 to connect to the user’s extension. If there are multiple 
matches, the caller can dial 2 to hear the next matching name and extension number.

To make use of the dial-by-name directory:

1. Set up the local extensions (see Activate extension on page 59) and remote extensions (see 
Activate extension on page 103). The Last name from each extension will be used in the 
directory.
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2. Have each user set up their voice mailbox by dialing **# and then following the prompts. 
They will record their names for the dial-by-name directory. Alternatively, you can set up 
their voice mailboxes by dialing ** + voice mailbox number + # and then following the 
prompts. 

3. Configure the telephone line or VoIP number to be answered by an auto attendant. See Call 
handling on page 121.

4. Configure the auto attendant with an action to access the lookup name directory. See 
Actions during auto attendant playback on page 137.

5. Record an announcement for the auto attendant that tells the caller how to access the dial-
by-name directory. See Working with auto attendant messages on page 139.

6. To make the dial-by-name directory available to users as well as callers, configure the Dial 0 
Routing feature to connect with the lookup name directory. See Dial 0 routing on page 28.

You can delete the names recorded for the dial-by-name directory by resetting the voice 
mailbox. See Reset mailboxes on page 111.

 Setting the PBX extension length

You can configure a TalkSwitch unit with an auto attendant, and then connect the unit to 
another PBX. This way the TalkSwitch unit can route callers as requested. See Connecting a 
TalkSwitch unit to a PBX on page 21.

If you will connect the TalkSwitch unit to another PBX, set the extension length used by the 
other PBX. See From auto attendant tab on page 169.

1. Choose Options > Transfer Preferences. The Transfer Preferences window appears.

2. Select the From Auto Attendant tab.

3. Set the PBX extension length to the number of digits in an extension number on the 
other PBX.

The name must be recorded for the entry to be available.
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AUTO ROUTE SELECTION

Introduction

About automatic route selection

Automatic route selection (ARS) routes outgoing calls to a certain hunt group depending on the 
leading digits. It can also prefix phone numbers with certain carrier codes depending on the 
leading digits and time of day. This way calls can use specific telephone lines, alternative 
carriers, or VoIP lines, for least-cost routing. For example, ARS can route international calls to a 
VoIP service provider; national calls to an alternative carrier offering a discounted calling plan; 
and calls to cellular phones on a telephone line that is connected to a fixed wireless terminal for 
cellular-to-cellular calling.

If the user dials a hunt group number, ARS can override the selection and use a different hunt 
group depending on the leading digits.

About toll restriction

Toll restriction blocks outgoing calls based on the leading digits. For example, toll restriction 
can block calls to inappropriate or premium rate services (e.g. 1-900 numbers).

About leading digits

The leading digits are the first numbers dialed when placing a telephone call. The leading digits 
could be an international access code, country code, national code, STD code, area code, leading 
digits of premium rate service codes, or phone number. For example, “1900” are the leading 
digits of 1-900-555-1234.

The leading digits used in each country are subject to the national numbering plan. Your 
telephone directory will provide information on the numbers used.

Calls with leading digits that do not match the entries in the ARS table will be routed to the 
hunt group originally dialled by the caller.

ARS and toll restriction act on the longest leading digits entry matching the dialled number. For 
example, an entry in the ARS table blocks numbers with leading digit “1” to prevent long-
distance calls. However a second entry routes numbers with leading digits “1800” through a 
hunt group because they are toll-free. Because the second entry (1800) is longer than the first 
entry (1), the second entry has precedence. Therefore a call with leading digits “1800” is routed, 
even though leading digit “1” would otherwise cause it to be blocked. This technique can reduce 
the number of entries required in the ARS table; and can be used to restrict calls to all but 
specific area codes or countries.

• Leading digits can be 1–11 numbers in length. 

• Leading digits can include numbers 0–9.

• The leading digits exclude the hunt group number dialled by the user.

Enable password protection when ARS or toll restriction is used. Change the system password 
frequently to prevent unauthorized users from making calls or changing the configuration. 
See Administration on page 27.
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About carrier codes

A carrier code is prefixed to the phone number dialled by the user. It tells the telephone 
company to route the call to an alternative carrier. For example, the carrier code could be a 
calling card number and PIN number. ARS determines the carrier code based on the leading 
digits and the time of day.

• Carrier codes can be up to 1–24 characters in length.

• Carrier codes can include numbers 0–9, “*” (asterisk), “#” (pound), “,” (comma for 2-second 
pause), and “w” (for wait-for-dial-tone). A 2-second pause is automatically added after 
dialling a carrier code.

An entry in the ARS table can have one or two carrier codes. Carrier code 1 is either used all day, 
or from Start time 1 until Start time 2. Carrier code 2 is used from Start time 2 until Start time 1. 

Use of Carrier Selection Prefix and Carrier Codes may require a subscription to a carrier’s 
discount calling plan. This service may not be available in some countries and on some 
telephone companies’ telephone lines. Carrier Selection Prefix may not be required if a “Pre-
Selection” service is provided by the telephone company.

ARS and direct line access

When Direct Line Access is enabled on a local extension, the user does not have to dial a hunt 
group number. Calls placed from that local extension are automatically routed to a designated 
hunt group. If ARS is enabled on the designated hunt group, the calls are subject to ARS and 
toll restriction.

ARS and the 3-Way Calling/Conference service

The use of the telephone company‘s 3-Way Calling/Conference service is not recommended on 
telephone lines when ARS or toll restriction are used. The system’s ARS and toll restriction 
features do not have any control over the routing of calls through these telephone 
company services.

ARS and emergency service numbers

The telephone numbers in the Emergency Service Numbers area will not be blocked by toll 
restriction nor redirected by ARS. Calls to these telephone numbers will be routed through hunt 
group 9.

Planning automatic route selection and toll restriction

1. Identify the leading digits of calls to be blocked by toll restriction.

2. Identify the leading digits of calls to be routed by ARS.

3. Identify which telephone lines and VoIP lines are connected to different service providers.

4. Assign telephone lines and VoIP lines to different hunt groups, in order to provide separate 
access to each service provider.

5. Identify carrier codes, which leading digits they work with, and when they will be used.

6. Provide local extensions with access to specific hunt groups. This controls how local 
extensions have calls routed by ARS or blocked by toll restriction.

Enter any other local emergency service numbers into the ARS table to ensure calls are routed 
to a hunt group with telephone lines that provide access to emergency services.
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Setting up automatic route selection and toll restriction

The Auto Route Selection page allows you to set up automatic route selection (ARS) and 
toll restriction.

1. Configure the system password and hunt groups before setting up ARS and toll restriction.

2. Select the Auto Route Selection page.

Activate automatic route selection

The Activate Automatic Route Selection area allows you to activate automatic route selection, 
and list the leading digits of calls to be re-directed or blocked.

1. Select the Activate Automatic Route Selection check box. When activated, the dialled digits 
of all outgoing calls will be buffered and stored before being re-transmitted to the telephone 
line after detection of dial tone. This feature is useful in cases where extension users forget 
to wait for the telephone line dial-tone (secondary dial-tone) when making outgoing calls.

2. Select a free table entry to enter new leading digits, or edit an existing entry.

3. Enter the leading digits in the Leading digits box. Omit the hunt group number from the 
leading digits. The system will only block or redirect calls where there is a matching leading 
digit match and action; calls with leading digits not entered in the table will proceed 
without being re-directed or blocked.

4. Select the Action. Choices are:

• Hunt group (n) — Performs ARS by routing the call to the hunt group.

• Block calls — Performs toll restriction by blocking the call.

Notes: The system selects the required action by matching the longest leading digits in the ARS 
table to the digits dialled by the caller. Typical leading digits to enter in the table are 
international and trunk call prefixes, area codes, premium service codes, and mobile service 
provider codes.
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For example, assume there are entries with "00" with action "Block Calls" and "001" with action 
Hunt Group 81. A call with leading digits "0035" will be blocked; but a call with leading digits 
"001" will be routed to hunt group 81. The listed Emergency Service numbers cannot be blocked.

Carrier code prefixes

The Carrier Code Prefix area allows you to set up carrier codes the system will automatically use 
when the leading digits are dialled. A carrier code is prefixed to the phone number dialled by 
the user. It tells the telephone line service provider to route the call to an alternative carrier. For 
example, the carrier code could be a calling card number and PIN number. ARS determines the 
carrier code based on the leading digits and the time of day.

1. If the route requires one carrier code for the whole day:

a) Enter the carrier code in Carrier code 1.

b) Clear the Carrier code 2 check box.

2. If the route requires two carrier codes, one for each part of the day:

a) Enter the first carrier code in Carrier code 1.

b) Enter Start time 1.

c) Select the Carrier code 2 check box.

d) Enter the second carrier code in Carrier code 2.

e) Enter Start time 2.

Emergency service numbers

The Emergency Service Numbers area lists the emergency service numbers that cannot be blocked 
by toll restriction.

Auto route selection

The Auto Route Selection area allows you to set the inter-digit timeout (IDT), and to select the 
hunt groups that are subject to ARS.

1. Select the Inter-digit timeout (IDT). The default value is 5 seconds. Choices range from 3 
seconds to 18 seconds.

ARS and toll restriction are implemented on each call once the longest matching entry is 
found in the ARS table or after the IDT expires. If the user has dialled a number and it’s a 
possible match for an entry in the ARS table, the system will pause until the IDT expires. To 
complete a dialled number before the IDT expires, the user can press #.

For example, the ARS table has 12345. The user dials hunt group 88 to use the TalkSwitch 
VoIP network, and dials VoIP number 1234. This is a possible match for entry 12345, so 
system will pause until the IDT expires. The user can press # to complete the call. 

2. Select the hunt groups that are subject to ARS and toll restriction.
T A L K S W I T C H  C O N F I G U R A T I O N 146



a) Click ARS Hunt Groups. The ARS Hunt Groups window appears.

b) Select the Hunt group check boxes. The selected hunt groups will be subject to ARS and 
toll restriction.

c) If 3-Way Calling/Conference is selected in the Telephone Lines page, the Hunt group 80 
is used for same line connect check box is enabled. If the check box is selected, and a 
remote user enters hunt group 80 to activate call bridge, the same telephone line will be 
used to place the call (instead of a telephone line chosen by ARS). However toll 
restriction will still be used.

Restricting local extension access to specific hunt groups

By default, all local extensions have access to all hunt groups. As part of an ARS and toll 
restriction scheme you can restrict the hunt groups that a local extension can use.

1. Remove the local extension’s access to the hunt group. See Hunt group permissions on page 
64.

NOTE: If the local extension does not have access to a hunt group, but the user dials leading 
digits that select a hunt group, the hunt group is used anyway.

Allowing a local extension to bypass ARS and toll restriction

You can allow a local extension to select a hunt group that bypasses ARS and toll restriction. 
The user will be able to dial any phone number, and no carrier codes will be prefixed to the 
phone number.

1. Set up a hunt group with telephone lines or VoIP lines. See Line Hunt Groups on page 132.

2. Provide the local extension with access to the hunt group. See Hunt group permissions on 
page 64.

3. Select the Auto Route Selection page.

4. Click ARS Hunt Groups. The ARS Hunt Groups window appears.

5. Clear the associated Hunt group check box. The hunt group will not be subject to ARS and 
toll restriction.
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Regulatory advisory notice 

Call Redirection & Service Provider Billing Advisory

Use of the automatic route selection, toll restriction and call detail recording features does 
not imply any guarantee whatsoever by regulatory authorities, your telephone service 
provider(s), TalkSwitch or its distributors and resellers, with regard to the accuracy of these 
features and that the use of such a features may not be considered by a telephone company in 
any disputes which may arise regarding the accuracy of any subscriber's telephone account.
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CALL BRIDGE (DISA)

Call bridge lets a travelling user place a call through the TalkSwitch system using your 
company’s long-distance savings plan. This minimizes long-distance and hotel telephone costs. 
You can set up eight call bridge accounts for the system.

The Call Bridge (DISA) page allows you to set up the name, password and hunt groups for up to 
eight call bridge accounts. 

1. Select the Call Bridge (DISA) page.

Using call bridge

1. Call the TalkSwitch system, and let the auto attendant answer.

2. Dial a hunt group to get an outside line.

3. Enter the call bridge password + #.

4. Dial the phone number.

5. To complete the call, you can:

• Press #* to return to the auto attendant.

• Press ## to call another outside number using the same hunt group.

You may incur long-distance and hotel telephone charges each time you call the TalkSwitch 
system from a remote location.

Activate account

The Activate Account area allows you to activate and name a call bridge account.

1. Select an available call bridge account.

2. Select the Activate Account check box.
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3. Enter an Account name. This is typically the name of the user, or the name of a department 
whose members will share the call bridge account.

4. To prevent unauthorized use of the TalkSwitch system, enter a numeric Password. The user 
will be required to enter this password before dialling the phone number.

Hunt group access

The Hunt Group Access area allows you to select the hunt groups that can be used with the call 
bridge account.

1. Click Edit. The Hunt Group Access window appears.

2. Select the hunt groups that can be used with the call bridge account.

3. If 3-Way Calling/Conference is selected in the Telephone Lines page, the Hunt Group 
Access window enables the Allow the use of same line connect (by dialing 80) check box. 
Select the check box to enable hunt group 80.

If the user activates call bridge by dialling hunt group 80, the TalkSwitch system will use the 
same telephone line to call the third party. It will have the telephone company put the user 
on hold. It will then dial the third party’s phone number, using the same telephone line. 
Once the third party answers, the TalkSwitch system will connect the user and the 
third party.

AUTO CALL BACK

Auto call back lets a travelling user gain access to the TalkSwitch system without completing the 
call to the telephone line or VoIP number. This minimizes long-distance and hotel telephone 
costs. You can set up four auto call back accounts per TalkSwitch unit.

The Auto Call Back page allows you to set up auto call back accounts. You can set up four auto 
call back accounts per TalkSwitch unit. Each auto call back account includes the name, call back 
number, telephone line or VoIP number that will trigger auto call back, announced message, 
password, dialling prefix, and hunt groups.

You must ensure the auto attendant for the telephone line or VoIP number is set to answer 
after four rings. In order to trigger auto call back, the user must call the telephone line or 
VoIP number, and then hang up after two rings, but before the auto attendant answers.
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1. Select the Auto Call Back page.

Using auto call back

1. Call the telephone line or VoIP number, let it ring twice, and then hang up. The TalkSwitch 
unit will dial the call back number configured for that line.

2. Press # to accept the call back.

3. Enter the auto call back password + # to enter the system menu. From the system menu you 
can:

• Dial an extension. After you complete the call, you will be disconnected.

• Check your voicemail by dialling ** + extension. After you check your voicemail, press * 
to return to the system menu.

• Call an outside number by dialling 9 or 81–88 + phone number. To complete the call, 
press #* to return to the system menu. You can also press ## to call another outside 
number using the same hunt group.

• Configure the system by dialling #, entering the system password + #, and then entering 
the command.

When the system returns your call, it can play a default message that tells the recipient to press 
# to accept the auto call back. You can record and enable an announced message that will be 
played instead of the default message. For example, the announced message can tell the front 
desk at your hotel to transfer the call to your room. You can also disable the announced message 
to use the default message.

To configure auto call back, call the telephone line or VoIP number, and let the auto attendant 
answer. Dial 6, and then follow the prompts. You can change the call back number, change the 
announced message, enable/disable the announced message, and enable/disable the auto call 
back account.
T A L K S W I T C H  C O N F I G U R A T I O N 151



Activate auto call back

The Activate Auto Call Back area allows you to set up an auto call back account, with the name, 
call back number, and the telephone line or VoIP number that will trigger auto call back.

1. Select an available auto call back account.

2. Select the Activate Auto Call Back check box.

3. Enter the name of the auto call back account in the Label box.

4. Enter the call back number in the Number to call back box. This is the telephone number at 
the traveller’s destination. Do not enter a hunt group number. Note that the travelling user 
can change the call back number. The new call back number will replace that entered into 
the Auto Call Back page.

5. To have the TalkSwitch unit dial a number before the call back number, select the Use call 
back prefix check box, and then enter the prefix. The prefix can include numbers 0–9, *, #, 
and “,” (comma for 2-second pause). For example, you can enter a calling card number, a 
pause, a PIN number, and another pause.

6. Select the telephone line or VoIP number in the Number to trigger call back list. Each auto 
call back account can be associated with one telephone line or VoIP number. Calling this 
telephone line or VoIP number and then hanging up will trigger the call back.

7. After the TalkSwitch unit dials an auto call back number or the prompted call back number, 
it will wait for a configurable number of rings for someone to answer. By default, it will wait 
six rings before hanging up. You can change the number of rings. See Call Back on page 173.

a) Choose Options > Call Back. The Call Back Options window appears.

b) Select the number of rings the TalkSwitch unit should wait before hanging up.

Account options

The Account Options area allows you to set up the announced message, password and 
dialling prefix.

1. To have the TalkSwitch unit play a recorded message when the call back is answered, select 
the Use announced message check box. This is required if a receptionist will answer the 
phone after the TalkSwitch unit dials the call back number. For example, the announced 
message can tell the hotel front desk: “Please transfer this call to Bob in room 307”. You can 
record the announced message using a local extension connected to the TalkSwitch unit, or 
remotely by calling a telephone line connected to the TalkSwitch unit. See Recording an 
announced message on page 153.

2. To prevent unauthorized use of the TalkSwitch system, select the Use password check box, 
and then enter a numeric password. The user will be required to enter this password before 
configuring call back, and after answering call back.
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3. To select the hunt groups the user can dial, select the Allow access to hunt groups check box. 
This way the user can accept the call back, and then place an outbound call through the 
TalkSwitch system. The window enables the Edit button.

4. Click Edit. The Call Back Bridging Access window appears.

5. Select the hunt groups that can be used with the auto call back account.

6. If 3-Way Calling/Conference is selected in the Telephone Lines page, the Call Back Bridging 
Access window enables the Allow the use of same line connect (by dialing 80) check box. 
Select the check box to enable hunt group 80.

If the user dials hunt group 80, the TalkSwitch system will use the same telephone line to 
call the third party. It will have the telephone company put the user on hold. It will then 
dial the third party’s phone number, using the same telephone line. Once the third party 
answers, the TalkSwitch system will connect the user and the third party.

Recording an announced message

This procedure describes how to record the announced message played by the TalkSwitch unit 
when the call back is answered.

1. Pick up a local extension connected to the TalkSwitch unit, or remotely call a telephone line 
or VoIP number connected to the TalkSwitch unit. You must record the announced message 
on the same unit that has the auto call back account.

2. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

3. Enter the system password, followed by #.

4. Enter the command listed below, and follow the prompts. 

5. Press * to exit command mode.

You can also record, enable or disable an announced message after dialling 6 at the 
auto attendant.

Auto call back 
account number

Record 
message

Erase 
message

Play 
message

1 61 # 061 # 71 #

2 62 # 062 # 72 #

3 63 # 063 # 73 #

4 64 # 064 # 74 #
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PROMPTED CALL BACK

Prompted call back lets a travelling user gain access to the TalkSwitch system. This minimizes 
long-distance and hotel telephone costs. You can set up one prompted call back account for 
the system.

The Prompted Call Back page allows you to set up prompted call back for the TalkSwitch 
system, including the name, call back number, announced message, password, dialling prefix, 
and hunt groups.

1. Select the Prompted Call Back page.

Using prompted call back

1. Call the TalkSwitch system, and let the auto attendant answer.

2. Dial 61, and then hang up. The system will dial the call back number.

3. Press # to accept the call back.

4. Enter the prompted call back password + # to enter the system menu. From the system menu 
you can:

• Dial an extension. After you complete the call, you will be disconnected.

• Check your voicemail by dialling ** + extension. After you check your voicemail, press * 
to return to the system menu.

• Call an outside number by dialling 9 or 81–88 + phone number. To complete the call, 
press #* to return to the system menu. You can also press ## to call another outside 
number using the same hunt group.

You must ensure an auto attendant will answer. In order to trigger prompted call back, the 
user must call the system, wait for the auto attendant to answer, dial 61, and then hang up.
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• Configure the system by dialling #, entering the system password + #, and then entering 
the command.

When the system returns your call, it can play a default message that tells the recipient to press 
# to accept the prompted call back. You can record and enable an announced message that will 
be played instead of the default message. For example, the announced message can tell the front 
desk at your hotel to transfer the call to your room. You can also disable the announced message 
to use the default message.

To configure prompted call back, call the TalkSwitch system, and let the auto attendant answer. 
Dial 6, and then follow the prompts. You can change the call back number, change the 
announced message, and enable/disable the announced message.

You may incur long-distance and hotel telephone charges each time you access prompted call 
back from a remote location.

Activate prompted call back

The Activate Prompted Call Back area allows you to enter the name and call back number.

1. Select the Activate Prompted Call Back check box.

2. Enter the call back number in the Number to call back box. This is the telephone number at 
the traveller’s destination. Do not enter a hunt group number.

Note that the travelling user can change the call back number. The new call back number 
will replace that entered into the Prompted Call Back page.

3. To have the TalkSwitch unit dial a number before the call back number, select the Use call 
back prefix check box, and then enter the prefix. The prefix can include numbers 0–9, *, #, 
and “,” (comma for 2-second pause). For example, you can enter a calling card number, a 
pause, a PIN number, and another pause.

4. After the TalkSwitch unit dials an auto call back number or the prompted call back number, 
it will wait for a configurable number of rings for someone to answer. By default, it will wait 
six rings before hanging up. You can change the number of rings. See Call Back on page 173.

a) Choose Options > Call Back. The Call Back Options window appears.

b) Select the number of rings the TalkSwitch unit should wait before hanging up.

Account options

The Account Options area allows you to set up the announced message, password and 
dialling prefix.

1. To have the TalkSwitch unit play a recorded message when the call back is answered, select 
the Use announced message check box. This is required if a receptionist will answer the 
phone after the TalkSwitch unit dials the call back number. For example, the announced 
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message can tell the hotel front desk: “Please transfer this call to Bob in room 307”. You can 
record the announced message using a local extension connected to the TalkSwitch unit, or 
remotely by calling a telephone line connected to the TalkSwitch unit. See Recording an 
announced message on page 156.

2. To prevent unauthorized use of the TalkSwitch system, select the Use password check box, 
and then enter a numeric password. The user will be required to enter this password before 
configuring call back, and after answering call back.

3. To select the hunt groups the user can dial, select the Allow access to hunt groups check box. 
This way the user can receive the call back, and then place an outbound call through the 
TalkSwitch system. The window enables the Edit button.

4. Click Edit. The Call Back Bridging Access window appears.

5. Select the hunt groups that can be used with prompted call back.

6. If 3-Way Calling/Conference is selected in the Telephone Lines page, the Call Back Bridging 
Access window enables the Allow the use of same line connect (by dialing 80) check box. 
Select the check box to enable hunt group 80.

If the user dials hunt group 80, the TalkSwitch system will use the same telephone line to 
call the third party. It will have the telephone company put the user on hold. It will then 
dial the third party’s phone number, using the same telephone line. Once the third party 
answers, the TalkSwitch system will connect the user and the third party.

Recording an announced message

This procedure describes how to record the announced message played by the TalkSwitch unit 
when the call back is answered.

1. Pick up a local extension, or remotely call the TalkSwitch system.

2. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

3. Enter the system password, followed by #.

4. Enter 65# to record the message, 065# to erase the message, or 75# to play the message, 
and then follow the prompts.

5. Press * to exit command mode.

You can also record, enable or disable an announced message after dialling 6 at the 
auto attendant.
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FILE MENU

The File menu has commands for working with configuration files. A configuration file contains 
parameter settings for the TalkSwitch system and has the .tsd extension. The TalkSwitch unit 
uses parameter settings to control operation. The default location for storing configuration files 
is C:\Program Files\TalkSwitch\TalkSwitch Configuration 6.11\Config Files.

The commands available within the File menu change depending upon whether a configuration 
is open.

If no configuration is open, and the Configuration Selection page is displayed, you can:

• Create a new configuration file from the template, with default parameter settings for your 
TalkSwitch system. This way you can set up a configuration without a TalkSwitch unit.

• Open the configuration from a TalkSwitch unit.

• Open an existing configuration file.

If a configuration is open, you can:

• Save the configuration to a TalkSwitch unit. The TalkSwitch unit can be local or at a remote 
location. This is only available if you opened a configuration file. 

• Save a new configuration file.

• Save a configuration to an existing configuration file, overwriting it.

For more information about the Configuration Selection page, see Starting the TalkSwitch 
management software on page 22.

New Template

The New Template command creates a configuration file from the template, with default 
parameter settings for your TalkSwitch system. You can then modify the file using the 
TalkSwitch management software. 

1. Choose File > New Template. The Create a New Template File window appears.

Alternatively, you can click the Open a Configuration File or Template button in the 
Configuration Selection page, and then click the Create a Template File button.

2. Select the types of TalkSwitch units in your system.

3. Click the Browse button to select the location and name of the configuration file.

4. Click OK. The system creates the file, and opens it in the TalkSwitch management software.
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Open > TalkSwitch Location

The Open > TalkSwitch Location command connects to the selected TalkSwitch unit and 
retrieves the configuration. The TalkSwitch unit can be local or at a remote location. You can 
then modify the file using the TalkSwitch management software. The command is only available 
when no configuration is open. 

1. Choose File > Open > TalkSwitch Location. The Connect Via IP window appears.

Alternatively, you can also click the Connect to a Different System button or the Connect 
to a System Via IP button in the Configuration Selection page.

2. Enter the URL / IP Address of the TalkSwitch unit, and then click OK. You can also choose 
the TalkSwitch system from the address book.

Open > Configuration File

The Open > Configuration File command opens a saved configuration file. You can then use the 
TalkSwitch management software to modify the configuration. The command is only available 
when no configuration is open.

1. Choose File > Open > Configuration File. The Configuration File window appears.

Alternatively, you can also click the Open a Configuration File or Template button in the 
Configuration Selection page, and then click the Open a File button.

2. Choose the configuration file, and then click Open.
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Save

The Save command saves the configuration to the open configuration file or to the connected 
TalkSwitch unit. The TalkSwitch unit can be local or at a remote location.

NOTE: New settings must be saved to the TalkSwitch unit to take effect.

Save To > File

The Save To > File command saves the configuration to a new configuration file, or overwrites 
an existing configuration file. It does not save the parameter settings to the TalkSwitch unit.

1. Choose File > Save To > File. The File window appears.

2. Enter the name of the configuration file, and then click Save.

Save To > Location

The Save To > Location command saves the configuration from the open configuration file to 
the selected TalkSwitch system. The TalkSwitch system can be local or at a remote location. The 
command is only available if you opened a configuration file.

1. Choose File > Save To > Location. The Location window appears. If the TalkSwitch 
management software auto-discovered your local TalkSwitch system, the window shows the 
TalkSwitch unit configured as proxy. If the TalkSwitch unit is connected by Ethernet, the 
window shows its IP address. If the TalkSwitch unit is connected by USB, the window shows 
its MAC address.
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2. To save the configuration to the auto-discovered local TalkSwitch system, select the 
TalkSwitch unit configured as proxy, and then click OK.

3. To save the configuration to a remote TalkSwitch system:

a) Click Other TalkSwitch. The Connect Via IP window appears.

b) Enter the URL / IP address of the remote TalkSwitch system, and then click OK. You can 
also choose the TalkSwitch system from the address book.

Retrieve Settings

The Retrieve Settings command opens the configuration from the current TalkSwitch unit. You 
can then modify the configuration using the TalkSwitch management software.

Alternatively, you can also click the Configure Auto-Detected TalkSwitch System button or 
the Retry Auto Discovery button in the Configuration Selection page.

Close

The Close command closes the configuration, and returns to the Configuration Selection page.

Exit

The Exit command closes the TalkSwitch management software.
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TOOLS MENU

Memory Usage

1. Choose Tools > Memory Usage. The Memory Usage window appears. It shows the amount of 
time provided by the TalkSwitch units, and the amount of time used by voicemail and auto 
attendant messages. 

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

Voicemail Manager > Mailbox Status

See View mailbox data on page 111.

Voicemail Manager > Delete Mailbox Password

See Delete password on page 112.

Voicemail Manager > Reset Mailboxes

See Reset mailboxes on page 111.

Firmware Auto Update

The Firmware Auto Update command can be used by administrators of multiple TalkSwitch 
systems, such as resellers, distributors and integrators, to set up automatic updates of phone 
system firmware, prompts, and other essential files. Multiple TalkSwitch systems can 
automatically download new files simultaneously, then install the updates at a desired time. 
Syslog server logs confirm the success of each step of the update. Updated TalkSwitch systems 
can then be configured using the latest version of TalkSwitch Management Software. 

With the auto update feature enabled, a TalkSwitch system will check a designated TFTP server 
for new update files every hour. If new files are available, the system will download them, and 
then report the status of the download to designated syslog and/or TFTP servers. 

At a configured time the TalkSwitch system will update its firmware and reboot. The status of 
the update will be reported to the designated syslog and/or TFTP servers. 
T A L K S W I T C H  C O N F I G U R A T I O N 161



The steps required by the administrator to post the update files, and configure the TalkSwitch 
units, TFTP server, and Syslog server, are described in the sections below.

Posting firmware update files on your server

After initial set-up (see sections below), updates will occur automatically whenever the 
administrator posts new files on the TFTP server. To do so, follow these steps:

1. Download the latest firmware update compressed folder from the TalkSwitch website for 
your region. The filename indicates the firmware version number for easy reference (e.g. 
t611cv42_tftp.zip).

2. Extract the files in the folder to the appropriate directory or subdirectory on your TFTP 
server. The contents are as follows: 

• README.TXT — Describes how to set up and use the TFTP firmware update feature, lists 
the contents of the compressed file and provides instructions regarding how to edit the 
INDEX.XML file to suit your needs. 

• INDEX.XML — Lists information about the files in a format used by TalkSwitch systems 
to trigger and manage updates. 

• BBLOCK — The boot block is essential for proper startup of a TalkSwitch system. 

• FIRMWARE — The program that manages all TalkSwitch phone system features. 

• ADSI — Updates ADSI information on the TalkSwitch unit (this file rarely changes). 

• TALKSET — Contains firmware for the TalkSwitch TS-200 phone (this file rarely changes). 

• ENGLISH.TLP — American English prompt file.

• BRITISH.TLP — International English prompt file.

• FRENCH.TLP — French prompt file.

• SPANISH.TLP — Spanish prompt file.

Note: TalkSwitch units will only download prompt (.TLP) files for languages previously 
installed on the phone system. 

3. If you need to suppress distribution of certain files, and/or alter which standard reboot 
option the TalkSwitch unit will use after installing a firmware update, you will need to 
create a new version of the INDEX.XML file. To do this:

a) Make a backup copy of INDEX.XML and rename it INDEX.BAK. 

b) Edit INDEX.XML according to the instructions in the README.TXT file. When the edits are 
complete SAVE them. 

By default, TalkSwitch systems configured with the firmware auto update feature will 
automatically download new files within an hour. Updates to language prompts take effect 
immediately. If changes have been made to essential firmware, the unit(s) will reboot 
according to the settings in the INDEX.XML file (by default at 3:00 a.m. local time).
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Configuring TalkSwitch systems

To have TalkSwitch system(s) automatically download new update files, perform the following 
steps on each system:

1. Connect to the TalkSwitch system that you wish to automatically update using the 
TalkSwitch Management Software. Choose Tools > Firmware Auto Update. The Automatic 
Firmware Update window appears.  

2. Select Enable automatic update of firmware via TFTP. 

3. In the TFTP Settings > TFTP server location field, enter the IP address or FQDN of the TFTP 
server that has the firmware files. You can also specify a subdirectory after the address (e.g. 
123.45.67.89/subdirectory1). This way you can set up separate subdirectories to provide 
different firmware files to different clients. 

Instructions for setting up a TFTP server are listed below.

4. In the Syslog Settings > Syslog server location field, enter the IP address or FQDN of the 
syslog server that will log the status of TalkSwitch firmware updates. By default TalkSwitch 
uses port 514 to transmit Syslog events. If you wish to use an alternate port, you can specify 
it by appending a colon followed by the desired port number (e.g. 123.45.67.89:555).

Instructions for setting up a Syslog server are listed below.

5. By default the TalkSwitch system will check for updates every hour. To have the TalkSwitch 
system check for new updates immediately, click the Check manually for update button. 
Though no progress indication is provided by the TalkSwitch management software, update 
events will be reported on the syslog server.

Setting up a TFTP server

1. Download and install TFTP software to a server accessible by all TalkSwitch units that you 
will manage. Note the IP address or FQDN of the server: it will be needed to configure the 
TalkSwitch units you administer.

One TFTP application (free) that can support simultaneous (multi-thread) downloads can be 
found at Solarwinds www.solarwinds.com. For more information about TFTP servers, see 
http://autoupdate.talkswitch.com/01/Support/ThirdParty/EN/index.htm 

2. Configure the TFTP settings according to the documentation provided by the supplier of your 
TFTP software.

3. If needed, set up subdirectories for each set of clients who require different versions of 
firmware.
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4. If your TFTP server uses the Windows Vista operating system, you must configure the firewall 
by enabling port 69 as an exception. To do this follow these steps:

a) Right-click the Network icon on the desktop, and then select Properties. 

b) Select Windows Firewall. 

c) Select Change Settings. 

d) Select the Exceptions tab. 

e) If the TFTP server application has already added an exception to the list, select the 
exception. 

f) If the TFTP server application has not added an exception to the list, then add the TFTP 
port. Use TFTP as the name, 69 as the port and UDP as the protocol. 

g) Save the changes. 

5. Download new TalkSwitch update files and extract them to the appropriate directory on the 
TFTP server (typically the root directory). Edit the INDEX.XML file to suit your needs. See 
the section above for detailed instructions. By default, all TalkSwitch systems configured 
with the firmware auto update feature will automatically download the new firmware files 
within an hour. 

Setting up a syslog server

1. Download and install Syslog software to a server accessible by all TalkSwitch units that you 
will manage, preferably the same device hosting your TFTP server. Note the IP address or 
FQDN of the server: it will be needed to configure the TalkSwitch units you administer.

One Syslog application (free) can be found at Kiwi Enterprises www.kiwisyslog.com. For 
more information about syslog servers, see http://autoupdate.talkswitch.com/01/
Support/ThirdParty/EN/index.htm  

2. Configure the Syslog daemon settings according to the documentation provided by the 
supplier of your Syslog software. By default, TalkSwitch uses port 514 to transmit Syslog 
events.

Terminal Window (CLI)

The Terminal Window (CLI) command displays the TalkSwitch Command Console window. 
Use this as directed by TalkSwitch customer support.

Syslog Output

The Syslog Output command allows you to set up logging of system status information. Use this 
as directed by VoIP service providers.

Call Logging Output (CDR)

The Call Logging Output (CDR) command allows you to set up logging of call detail records. For 
information about call logging, see Chapter 4 of the TalkSwitch User Guide.

Defaults > Entire Configuration

The Defaults > Entire Configuration command resets the entire configuration to defaultvalues.
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Defaults > Current Page

The Defaults > Current Page command resets the current page of the configuration to 
default values.

Check for Updates

The Check for Updates command looks for updates to the firmware or TalkSwitch management 
software on the TalkSwitch website.

Update Firmware

The Update Firmware command shows the firmware version of the TalkSwitch units and the 
latest firmware version available with the TalkSwitch management software. It allows you to 
update the TalkSwitch units with a newer firmware version.

1. Choose Tools > Update Firmware. The TalkSwitch Firmware Update window appears.

2. If the Firmware detected is lower than the Firmware file:

a) Set the Auto-Reboot check box.

• Select Auto-Reboot to automatically reboot the TalkSwitch units once the firmware 
has been updated. This will cancel any calls in progress.

• Clear Auto-Reboot to prevent the TalkSwitch units from rebooting automatically. You 
will have to manually reboot the TalkSwitch units later, when there are no calls in 
progress. See Reboot TalkSwitch on page 165.

b) Click the Update button.

Reboot TalkSwitch

The Reboot TalkSwitch command reboots the TalkSwitch units at the specified time. This is 
required after updating the firmware, unless you selected the Auto-Reboot check box, and the 
TalkSwitch units rebooted automatically.
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1. Choose Tools > Reboot TalkSwitch. The Reboot System window appears.

2. Select when the TalkSwitch units should reboot. They can reboot immediately, when all calls 
are complete, once the system has been unused for a period of time, or once a certain 
time arrives.

3. Click Reboot.

OPTIONS MENU

The Options menu has commands for configuring the system.

PA Output

The PA Output command allows you to set the audio from the PA jack.

1. Choose Options > PA Output. The Audio Control Options window appears.

2. Select the audio that is output from the PA jack. Choices are:

• PA announcements — Routes a PA announcement to the PA jack when a user dials *0.

If a user has dialed *80 to route music on hold through the PA jack, and a user dials *0 
to make a PA announcement, the PA announcement will interrupt the music on hold.

• Voicemail screening — Routes a call to the PA jack if a caller reaches a voice mailbox, or 
if a user accesses a voice mailbox. In addition, the system will route a PA announcement 
to the PA jack if a user dials *0.

NOTE: Unlike a PA announcement, voicemail screening will not interrupt music on hold.

• Demo with router — Intended for TalkSwitch demonstration purposes only.

• Static VoIP demo — Intended for TalkSwitch demonstration purposes only.
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Transfer Preferences

The Transfer Preferences command allows you to set options for transferring callers. You can 
set options for calls transferred to local extensions, remote extensions and ring groups, and from 
auto attendants and home phones.

1. Choose Options > Transfer Preferences. The Transfer Preferences window appears.

To local extension tab

The To Local Extension tab allows you to set call handling for calls manually transferred to a 
local extension, if the extension is busy or unanswered.

1. Select the To Local Extension tab.

2. Select the option if the extension is busy:

• Ring back extension that transferred the call — If the extension is busy, transfer the call 
back to the source extension.

• Perform Busy at extension action — If the extension is busy, perform the target 
extension’s Busy call cascade.

3. Select the option if the extension is unanswered:

• Ring back extension that transferred the call — If the extension is unanswered, transfer 
the call back to the source extension.

• Perform No Answer at extension action — If the extension is unanswered, perform the 
target extension’s No Answer call cascade.

To remote extension tab

The To Remote Extension tab allows you to set call handling for calls manually transferred to a 
remote extension, if the extension is busy or unanswered. It also sets transfer and clear, and 
screened or blind transfer.
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1. Select the To Remote Extension tab.

2. Select the option if the remote extension is busy:

• Ring back extension that transferred the call — If the remote extension is busy, transfer 
the call back to the source extension.

• Perform Busy at extension action — If the remote extension is busy, perform the remote 
extension’s Busy call cascade.

3. Select the option if the remote extension is unanswered:

• Ring back extension that transferred the call — If the remote extension is unanswered, 
transfer the call back to the source extension.

• Perform No Answer at extension action — If the remote extension is unanswered, perform 
the remote extension’s No Answer call cascade.

4. Select the Clear telephone line after call transferred check box to clear the telephone line 
after the call is transferred to a remote extension. The telephone line must have the Transfer 
and Clear service available and selected on the Telephone Lines page. See Phone line 
services on page 120.

5. Select how the TalkSwitch system transfers calls from a remote extension to a local 
extension, ring group or VoIP number within a TalkSwitch VoIP network. Choices are:

• Allow screening of calls — When the user at a remote extension transfers a call, allows 
them to determine whether the other user wants it.

• Perform a blind transfer — When the user at a remote extension transfers a call, the 
system immediately connects the caller to the other user and releases the telephone line 
connected to the remote extension. 

Transferring a call from a remote extension requires telephone lines without the 3-Way 
Calling/Conference service or the Transfer and Clear service.

When a call is transferred from one remote extension to another remote extension, it is always 
a blind transfer to avoid tying up a third line.
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To ring group tab

The To Ring Group tab allows you to set call handling for calls manually transferred to a ring 
group, if all the extensions are busy or unanswered.

1. Select the To Ring Group tab.

2. Select the option if all the extensions are busy:

• Ring back extension that transferred the call — If all the extensions are busy, transfer the 
call back to the source extension.

• Perform Busy at extension action — If all the extensions are busy, perform the ring 
group’s Busy call cascade.

3. Select the option if all the extensions are unanswered:

• Ring back extension that transferred the call — If all the extensions are unanswered, 
transfer the call back to the source extension.

• Perform No Answer at extension action — If all the extensions are unanswered, perform 
the ring group’s No Answer call cascade.

From auto attendant tab

The From Auto Attendant tab allows you to set the PBX extension length and disable the 
transfer prompts.

1. Select the From Auto Attendant tab.

2. If the TalkSwitch system is used as an auto attendant for another PBX, set the PBX extension 
length to the number of digits the PBX uses for its extensions. When the caller dials 7 
followed by an extension number, the TalkSwitch unit will capture the extension number, 
flash the line and then dial the extension number to complete the transfer. Choices range 
from Not used to 7 digits.
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See Connecting a TalkSwitch unit to a PBX on page 21.

3. Select the Disable playing of transfer prompts check box to disable the “one moment please” 
prompt when transferring a call.

From home phone tab

The From Home Phone tab allows you to set the transfer prefix. Dialling the transfer prefix 
indicates you will manually transfer a call from a phone connected in parallel to the TalkSwitch 
unit, to an extension or voice mailbox within the TalkSwitch unit. It is equivalent to pressing 
Recall or Link on a local extension.

This is required if you have a phone connected to the same telephone line as the TalkSwitch 
unit, but the phone is not connected to the TalkSwitch unit itself (i.e. the phone and the 
TalkSwitch unit are connected in parallel to the telephone line).

For example, a home-based business has one telephone line. A home phone is connected to the 
line through a wall jack in the kitchen. The TalkSwitch unit is connected to the same line 
through a wall jack in the office. Therefore the home phone is connected in parallel to the 
TalkSwitch unit.

Remote extension 210 is set up to route calls to the owner’s cell phone. The owner lets the 
TalkSwitch unit answer the phone during the day, but answers the home phone at night and on 
weekends. If a family member answers the home phone at night while the owner is away, they 
can manually transfer a business call to the owner’s cell phone. To do this, they dial the transfer 
prefix (** or *#), wait for the double beep, dial the remote extension number (210), and then 
hang up. The TalkSwitch system then routes the call to the owner’s cell phone.

1. Select the From Home Phone tab.

2. Select the transfer prefix. Choices are:

• **
• *#

Call Reminders

The Call Reminders command allows you to set reminder timers. When a reminder timer 
expires, the phone rings indicating a caller is on hold or parked. In addition, a queued caller 
hears a prompt when the Queue options reminder timer expires.

This feature only works with PBXs that use hook flash as a transfer method. Please contact 
your PBX manufacturer for transfer details.
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1. Choose Options > Call Reminders. The Call Reminder Timers window appears.

2. Set the Hold ringback reminder timer to how often the phone should ring when a caller is 
on hold.

3. Set the Park ringback reminder timer to how often the phone should ring when a caller 
is parked.

4. Set the Queue options reminder timer to how often a queued caller should hear a prompt.

VoIP Trunking

The VoIP Trunking command allows you to set the SIP server registration message interval, the 
SIP server port, and the starting RTP port. These settings are used if this location is the SIP 
server for a TalkSwitch VoIP network.

1. Choose Options > VoIP Trunking. The VoIP Settings window appears.

SIP server registration

The SIP Server Registration area allows you to set the SIP server registration interval. This 
setting is used if this location is the SIP server for a TalkSwitch VoIP network.

1. Select the amount of time between registration messages from the SIP server. Use a higher 
number if you have a large TalkSwitch VoIP network. Choices range from 5 minutes to 60 
minutes. The default value is 60 minutes.

VoIP ports

The VoIP Ports area allows you to set the SIP server port, and the starting RTP port. These 
settings are used if this location is the SIP server for a TalkSwitch VoIP network.

1. The SIP signalling port box allows you to change the SIP server port. The default SIP server 
port is 5060. If required, enter a different port number ranging from 1024 to 65535.

If your SIP server is at another location, and the SIP server uses a SIP server port other than 
5060 (e.g. 5061), do not set SIP signalling port to that number. Instead, include the port 
number in the Proxy server box of the System Information > VoIP Configuration window 
(e.g. 222.234.432.234:5061).
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2. The default Starting RTP port is 6000. If required, enter a different port number ranging from 
1024 to 65535.

Each TalkSwitch unit with four VoIP lines requires four RTP ports. The RTP ports are evenly 
numbered from the starting port as follows:

• TalkSwitch unit 1 — 6000 to 6006

• TalkSwitch unit 2 — 6010 to 6016

• TalkSwitch unit 3 — 6020 to 6026

• TalkSwitch unit 4 — 6030 to 6036

Each TalkSwitch unit with eight VoIP lines requires eight RTP ports. The RTP ports are evenly 
numbered from the starting port as follows:

• TalkSwitch unit 1 — 6100 to 6114

• TalkSwitch unit 2 — 6200 to 6214

• TalkSwitch unit 3 — 6300 to 6314

• TalkSwitch unit 4 — 6400 to 6414

These are the RTP ports the TalkSwitch system listens to for audio. If these are not opened 
correctly, users will not hear their callers.

Clock Preferences

The Clock Preferences command allows you to have the TalkSwitch system get the time and 
date (but not the year or time zone) from caller ID. This allows the system to refresh the clock 
automatically. It is beneficial if your area has frequent power outages that cause the system 
time to become inaccurate. However it is not recommended if you have more than one telephone 
service (e.g. regular telephone and VoIP) because the telephone services could have 
conflicting times.

1. Choose Options > Clock Preferences. The Caller ID / Time Set Options window appears.

2. Select the Obtain system time from caller ID check box to have the TalkSwitch unit update 
its internal clock using the timestamp within caller ID. If it is not selected, set the time 
using the TalkSwitch Date and Time Properties window. See System time on page 31.

Internal Calls

The Internal Calls command allows you to set whether intercom calls use the call cascade of the 
dialled extension if the extension is busy, unanswered or in do not disturb mode. An intercom 
call is a call from a local extension to another local extension, remote extension or ring group.
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1. Choose Options > Internal Calls. The Intercom Calls Options window appears.

2. Select the Intercom calls follow cascade settings check box to have an intercom call use the 
call cascade of the dialled extension. Otherwise the intercom call will ring continuously.

Call Back

The Call Back command allows you to set the number of rings the TalkSwitch unit will allow 
before hanging up, during an auto call back or prompted call back.

1. Choose Options > Call Back. The Call Back Options window appears.

2. Select the number of rings the TalkSwitch unit will allow during a call back before hanging 
up. Choices range from 1 ring to 9 rings.

Set Date & Time

The Set Date & Time command allows you to set the time, date, time zone, and NTP server. See 
System time on page 31.

TROUBLESHOOTING MENU

The Troubleshooting menu has commands for setting system timing. 

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. The default settings provide correct operation with telephone lines and 
analogue extensions.

If your system does not appear to be functioning properly, ensure the region is set correctly 
(see below), and then click the Use Defaults button on this window. If this does not resolve 
the problem, please contact your local dealer or technical support centre for assistance.

To ensure the region is set correctly, check the country listed in the Region field of the About 
page. If it does not match the country where the TalkSwitch unit is operating, change it in the 
Region Selection area of the Administration page (if available).
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Auto Attendants

The Auto Attendants command allows you to set auto attendant timers.

1. Choose Troubleshooting > Auto Attendants. The Auto Attendants window appears.

2. The Single digit fall through time sets a time-out period at the auto attendant for detection 
of additional digits after the first digit — e.g. an extension number. Once the wait time 
elapses, the auto attendant processes the received digits. Selecting immediately limits each 
entry to a single number, and restricts callers from dialling extensions directly. The other 
options allow callers to enter extension and ring group numbers. If the caller dials three 
digits, the auto attendant immediately processes the entry.

3. The Minimum required time to detect a DTMF digit sets the minimum duration of a DTMF 
signal that will be accepted by the system when a caller presses a number key on their 
telephone key pad. If the system does not detect some digits, try reducing this setting by 5 
ms or 10 ms; otherwise check the telephone lines for excessive noise, or quiet audio levels. If 
the system falsely detects sounds, noise or echoes as digits, try increasing this setting.

4. The Minimum required time between DTMF digits sets the minimum acceptable duration 
between valid DTMF digits. If the system is misdirecting calls due to echoed digits from 
cellular phones (e.g. digits "115" are directed to extension 111), try a longer setting. If 
digits are being missed from auto-diallers or telephone sets with speed-call dialling, try a 
shorter setting.

Extensions > Regular Analogue Extensions

The Extensions > Regular Analogue Extensions command allows you to set timers and the 
volume level for analogue extensions.

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. The default settings provide correct operation with telephone lines and 
analogue extensions.

If your system does not appear to be functioning properly, ensure the region is set correctly 
(see below), and then click the Use Defaults button on this window. If this does not resolve 
the problem, please contact your local dealer or technical support centre for assistance.

To ensure the region is set correctly, check the country listed in the Region field of the About 
page. If it does not match the country where the TalkSwitch unit is operating, change it in the 
Region Selection area of the Administration page (if available).

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. The default settings provide correct operation with analogue extensions.

If your system does not appear to be functioning properly, ensure the region is set correctly 
(see below), and then click the Use Defaults button on this window. If this does not resolve 
the problem, please contact your local dealer or technical support centre for assistance.

To ensure the region is set correctly, check the country listed in the Region field of the About 
page. If it does not match the country where the TalkSwitch unit is operating, change it in the 
Region Selection area of the Administration page (if available).
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1. Choose Troubleshooting > Extensions > Regular Analogue Extensions. The Regular 
Analogue Extensions window appears.

2. The Minimum length sets the minimum accepted duration of a valid Recall signal from a local 
extension. If there are false ring backs after a call, try increasing the Minimum length. If the 
system ignores genuine Recall signals, try reducing the Minimum length. 

3. The Maximum length sets the maximum accepted duration of a valid Recall signal from a 
local extension. If the system ignores genuine Recall signals, try increasing the Maximum 
length. If some calls are placed on hold when the user hangs up and quickly places a 
subsequent call, try reducing the Maximum length. 

4. The Ignore flash/recall signals list is a timer to ignore false Recall signals before the end of a 
call. If extensions experience false ring backs after users hang up, try increasing the Ignore 
flash/recall signals. 

5. The Volume heard at local extensions list sets the inbound volume level for calls and system 
prompts heard on analogue extensions.

Extensions > IP Extensions

The Extensions > IP Extensions command allows you to set the amount of time between 
registration messages from IP extensions. You can also change the starting SIP, starting RTP and 
HTTP ports. 

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. If your system does not appear to be functioning correctly, please contact your local 
dealer or technical support centre for assistance.
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1. Choose Troubleshooting > Extensions > IP Extensions. The IP Extensions 
window appears.

2. Select the Internal IP extension registration interval, which is the interval for registration 
messages from IP extensions within the office. Choices range from 2 minutes to 60 minutes.

3. Select the External IP extension registration interval, which is the interval for registration 
messages from IP extensions that are remotely located outside the office. Choices range from 
15 seconds to 60 minutes.

4. The default Starting SIP port is 5000. If required, enter a different port ranging from 1024 
to 65535.

5. The default Starting RTP port is 4000. If required, enter a different port number ranging from 
1024 to 65535.

6. The default HTTP port is 8484. If required, enter a different port number ranging from 1024 
to 65535. If your system will use a TalkSwitch 9122i, 9133i or 480i as an external IP 
extension, ensure the router maps this port to the TalkSwitch unit acting as local proxy.

Fax Detection

The Fax Detection command allows you to set up detection of Fax Over IP and CNG tones. 

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. If your system does not appear to be functioning correctly, please contact your local 
dealer or technical support centre for assistance.
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1. Choose Troubleshooting > Fax Detection. The Fax Detection window appears.

2. Select the Automatically detect and switch to G.711 for fax over IP check box to have the 
TalkSwitch unit detect fax over IP and then switch to G.711.

3. Set the number of CNG tones the TalkSwitch unit must detect before the auto attendant 
routes the call to the fax machine. Choices are:

• Detect 1 tone — The auto attendant will route the call to the fax machine if the 
TalkSwitch unit detects one CNG tone. Select this if fax calls are not being routed to the 
fax machine.

• Detect 2 tones — The auto attendant will route the call to the fax machine if the 
TalkSwitch unit detects two CNG tones. Select this if regular calls are being routed to the 
fax machine.

Telephone Lines > Audio

The Telephone Lines > Audio command allows you to automatically calibrate the TalkSwitch 
unit to match the far end impedance of the telephone lines; to select the matching near end 
impedance of the telephone lines; and to select the transmit level to callers.

All controls on this page update the TalkSwitch unit in real time. This allows you to adjust levels 
without saving the configuration. 

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. If your system does not appear to be functioning correctly, please contact your local 
dealer or technical support centre for assistance.
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1. Choose Troubleshooting > Telephone Lines > Audio. The Telephone Lines - Audio 
window appears. 

2. Calibrate the TalkSwitch unit to match the far end impedance of the telephone lines:

a) Click Calibrate Lines. The Calibrate Lines window appears.

b) Select the line(s) to calibrate, and then click Run Calibration.

For more information on calibration, see Line optimization on page 123.

3. For each telephone line, set the transmit level to callers. This affects the volume for remote 
callers, not internal users. Choices are:

• Louder

• Default

• Quieter 

Telephone Lines > Detection and Timers

The Telephone Lines > Detection and Timers command allows you to set telephone line 
timers, and perform the ring pattern test.

CAUTION: Calibrating the telephone lines, and then overriding the outbound volume level can 
degrade system performance.

Do not adjust these settings unless advised to do so by your local dealer or technical support 
centre. The default settings provide correc operation with telephone lines and 
analogue extensions.

If your system does not appear to be functioning properly, ensure the region is set correctly 
(see below), and then click the Use Defaults button on this window. If this does not resolve 
the problem, please contact your local dealer or technical support centre for assistance.

To ensure the region is set correctly, check the country listed in the Region field of the About 
page. If it does not match the country where the TalkSwitch unit is operating, change it in the 
Region Selection area of the Administration page (if available).
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1. Choose Troubleshooting > Telephone Lines > Detection and Timers. The Telephone 
Lines - Detection and Timers window appears.

2. The Minimum required time to detect a DTMF digit list sets the minimum duration of a DTMF 
signal that will be accepted by the system when a caller presses a number key on their 
telephone keypad. If the system does not detect some digits, try reducing this setting by 5 
ms or 10 ms; otherwise check the telephone lines for excessive noise or quiet audio levels. If 
the system falsely detects sounds, noise or echoes as digits, try increasing this setting.

3. The Minimum required time between DTMF digits sets the minimum acceptable duration 
between valid DTMF digits. If the system is misdirecting calls due to echoed digits from 
cellular phones (e.g. digits “115” are directed to extension 111), try a longer setting. If 
digits are being missed from auto-diallers or telephone sets with speed-call dialling, try a 
shorter setting. 

4. The Line Disconnect timer controls the duration a telephone line may be disconnected before 
the system clears the telephone call. In some cases this may be used by the telephone 
network to indicate a calling party has hung-up and the call has ended (also known as 
Disconnect Clear, K-Clear or CPC signal). Incidents of disconnected calls may indicate a 
faulty telephone line, or may be resolved with a longer Line disconnect time setting.

5. The Telephone line flash/recall length sets the length of time required for a Recall signal to 
activate calling features on a telephone line.

6. The 3-way calling wait time sets the required delay after a Recall signal before the first digit 
of a telephone number is dialled. This setting may need to be increased if same-line-connect 
calls are misdirected and the initial digits are not detected by the telephone company. The 
same-line-connect feature may not be compatible with some telephone company's 3-way 
calling feature.

7. To test the ring pattern for incoming calls on telephone lines:

a) Click Ring Pattern Test. The Ring Pattern Test window appears.
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b) Click Test Ring Pattern. Call one of the telephone lines. After three rings the Ring 
Pattern Information window appears. The time is displayed in milliseconds.

VoIP

The Troubleshooting > VoIP command allows you to set the SIP server port, starting RTP port, 
and the SIP server registration message interval. See VoIP Trunking on page 171.

Test Firewall

The Troubleshooting > Test Firewall command allows you to test the status of each port 
through the firewall. See Router port forwarding on page 36.

1. Choose Troubleshooting > Test Firewall. The Test Firewall window appears.

2. Select the services you want to check.

3. Click Test Ports. The system will check the ports of the selected services.

Support

The Troubleshooting > Support command allows you to automatically e-mail log files to 
TalkSwitch Customer Support. Only use this command as directed, after receiving a Case ID from 
TalkSwitch Customer Support.

Automatically e-mailing log files requires Microsoft Outlook to be configured as your default e-
mail client. Note that the e-mail will only include information related to your 
TalkSwitch system.
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1. Choose Troubleshooting > Support. The Support window appears.

2. Enter the Case ID supplied by TalkSwitch Customer Support.

If you use a different e-mail client, or don’t have one configured (e.g. you use a web-based e-
mail service like Hotmail) you can manually e-mail the log files. Address the e-mail to 
support@talkswitch.com. Enter the Case ID in the Subject line. Attach the .zip file listed in the 
Support window.
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C H A P T E R  3
Ch ap ter  3 :  Usi ng  Ta l k Sw i tch

USING TALKSWITCH

RECEIVING CALLS

With the auto attendant

If you don’t have a receptionist, the auto attendant helps you handle all your inbound calls. 
Once an auto attendant has been configured and recorded, it will follow the instructions given 
in the configuration.

When calls are answered by an auto attendant, callers can: 

• Dial any local or remote extension

• Dial any VoIP number (250–299)

• Dial any ring group (300–309)

• Dial voicemail directly

• Use the dial-by-name directory

• Choose options 0, 1, 2, 3, 4, 5 (if configured to perform specific actions)

• Transmit a fax

• Go to a different auto attendant

• Remain on the line to follow an action programmed for that auto attendant

TalkSwitch users can access other options at the auto attendant:

• Call back or call bridge 

• Retrieve voicemail 

• Enter command mode to make system changes 

All these features can be password-protected to avoid unauthorized access.

TalkSwitch also provides the option of ringing specific extensions or ring groups prior to the 
engagement of an auto attendant. 

Without the auto attendant

If you do not use the auto attendant to answer calls, please note that the call cascade options 
for the local extensions are not engaged. For calls to go to an extension’s mailbox, the call must 
be transferred manually by someone in the office. Once calls have been answered at a local 
extension, they can be transferred to any extension or voice mailbox. 
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USING AN ANALOGUE EXTENSION

This section describes how to use a third party analogue phone with the TalkSwitch system. You 
can also use these procedures with the TalkSwitch TS-80, TS-200, TS-400, and TS-600 phones. 
However, these phones have additional keys that make it easier to access the functions. Refer to 
the user guide supplied with your TalkSwitch phone.

Making calls

Placing an intercom call

An intercom call is a call from a local extension to another local extension, remote extension or 
ring group.

1. Dial the extension number.

If the Intercom calls follow cascade settings check box is selected in the configuration, an 
intercom call will follow the call cascade of the dialled extension. Otherwise the intercom call 
will ring continuously.

The dialled extension rings as follows:

• A local extension uses two short rings to identify the intercom call.

• A remote extension rings normally.

• A ring group uses the ring pattern selected in the configuration. The ring group uses the 
same ring pattern for intercom calls and outside calls.

Overhead paging

Overhead paging is a call from a local extension through the optional PA amplifier connected to 
the TalkSwitch unit.

1. Dial *0.

Two-way paging

Two-way paging is a call from a local extension to another local extension that activates the 
speakerphone of the dialled extension. The user at the dialled extension can reply through the 
speakerphone. You can perform two-way paging from a local extension to a TalkSwitch analogue 
phone (TS-200, TS-400 or TS-600), or a TalkSwitch IP phone (TS-9112i, TS-9133i or TS-480i).

1. Dial *84.

2. Dial the extension number.

One-way group paging

One-way group paging is a call from a local extension to another local extension or to a ring 
group that activates the speakerphones of the dialled extensions. The users at the dialled 
extensions cannot reply through the speakerphone. You can perform one-way group paging from 
a local extension to a TalkSwitch analogue phone (TS-200, TS-400 or TS-600).

1. Dial *85.

2. Dial the extension or ring group number.
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Place out-of-office calls from a local extension 

1. Dial 9 or 81–88 to choose a hunt group. The hunt group gives you access to an available line 
to dial out.

2. If your system requires permissions for outgoing calls, enter your access code.

3. Dial the phone number. 

Extensions can be restricted to specific hunt groups, and can block certain outbound calls. See 
Hunt group permissions on page 64 and Auto Route Selection on page 143.

Your extension can also be configured with direct line access. When you pick up the handset, 
you hear the telephone company dial tone and can dial an outside number without dialing a 
hunt group number. See Direct line access on page 62.

If you dial your own extension you will be directed to your voicemail. If your voicemail is not 
set up, you will get a busy signal. 

Receiving calls 

The steps below apply when an analogue extension is ringing. If an auto attendant engages 
before you are able to pick up, the caller can select an option at the auto attendant.

For your local extension

You can answer a call that is ringing your local extension.

1. If the call went through the auto attendant and call screening is enabled:

• Press # to accept the call.

• Press * to reject and re-route the call to its extension‘s call cascade, and then hang up.

For any other local extension

You can intercept a call that is ringing another local extension. 

1. Press *9.

For a specific local extension

You can intercept a call that is ringing a specific extension.

1. Press *7.

2. Dial the extension number.

While you’re on a call

You can intercept a call while connected to another caller.

1. Press Recall to place the first call on hold.

2. Press *9, or *7 and the extension number to intercept the second call.

3. Once you are finished with the second call or would like to return to the first caller, press 
Recall 5.

If direct line access is enabled for a local extension, you need to press Recall before dialling 
any extensions or voice mailboxes.
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Placing calls on hold

1. Press Recall to place the call on hold.

2. Press Recall again to take the call off hold.

3. If you have multiple callers on hold or in queue at your extension, press Recall 7 to retrieve 
callers on a first in/first out basis.

If you put a caller on hold using the Hold button on some third party analogue phones, you 
won’t be able to access Talkswitch features while the caller is holding. If you have music on hold 
enabled, the caller will not hear music while on hold.

While a call is on hold, your phone will ring once each time the reminder timer expires. See Call 
Reminders on page 170.

Transferring calls to an extension

You can initiate a transfer from a local extension to another local extension, remote extension 
or ring group.

Unscreened transfer

1. Press Recall to put the caller on hold. 

2. Dial the extension you want to transfer to, and then hang up. The caller is taken off hold 
when the receiving extension answers. If the extension is busy or the call not answered, the 
system can either perform the call cascade’s Busy action or No Answer action, or can ring 
back the extension that transferred the call. See To local extension tab on page 167.

Screened transfer 

1. Press Recall to put the caller on hold.

2. Dial the extension number you want to transfer to, and wait for them to answer. 

• If the person at the receiving extension wishes to take the call, complete the transfer by 
hanging up or pressing Recall 4. The caller is immediately taken off hold and connected 
to the receiving extension. You hear an internal dial tone. 

• If the person at the receiving extension does not wish to take the call, return to the 
caller by pressing Recall 5. 

• If you dial an extension that is busy or not answered, you can complete the transfer by 
hanging up or pressing Recall 4. The call will be routed according to that extension’s 
call cascade settings. You hear an internal dial tone.

Transferring calls to an outside number

You can initiate a transfer from a local extension to an outside number.

If the telephone line has the 3-Way Calling/Conference service or the Transfer and Clear service, 
and the local extension has enabled Allow the use of same line connect (by dialing 80), the user 
can select hunt group 80 to dial the outside number on the same line the caller is on.

If you handle many calls, you may want to complete or cancel a transfer without hanging up. 
Recall 4 will complete the transfer and provide an internal dial tone. Recall 5 cancels the 
transfer and connects you back to the caller.
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Unscreened transfer

1. Press Recall to put the caller on hold.

2. Dial 9 or 81–88 to choose a hunt group.

3. Dial the outside phone number.

4. Press Recall 4 to complete the transfer. Do not hang up to complete the transfer, because 
this disconnects the call.

Screened transfer

Instead of completing the transfer once you have dialled the outside number, wait until the call 
is answered and ask the recipient if he or she wishes to take the call. If the recipient accepts the 
call, press Recall 4 to complete the transfer. If not, press Recall 5 to return to the caller.

Parking and retrieving calls

Call park is a feature for placing a call on hold and then retrieving it from another local 
extension. TalkSwitch has 10 park orbits (500–509).

Parking a call 

1. Press Recall to put the caller on hold.

2. Press *510. TalkSwitch selects the first available park orbit (500–509). If you use a TS-80, 
TS-200, TS-400 or TS-600 phone, press the Park button or softkey. You hear a confirmation 
indicating the caller has been parked successfully and into which park orbit.

3. Provide the park orbit to the person with the parked call (e.g. “Mary, there is a call parked 
for you in 500”).

While a call is parked, your phone will ring once each time the reminder timer expires. See Call 
Reminders on page 170.

Retrieving a parked call

1. If direct line access is enabled at your extension, press Recall to get an internal dial tone.

2. Press ** and the appropriate park orbit. If you use TS-80, TS-200, TS-400 or TS-600 phone, 
press the Un-park button or softkey and enter the park orbit.

Queuing and retrieving callers 

Call queue is a useful feature for placing multiple callers on hold at your extension while you are 
on an existing call. For details on configuring call queue, please refer to How call cascades work 
on page 65.

Queuing callers at a local extension

If an extension is busy and the Busy call cascade is set to queue at extension, incoming callers 
hear one of the prompts below, followed by music (if enabled) while they are on hold:

• If the call came from the auto attendant and the extension has a voice mailbox: “The 
extension you have reached is currently busy. If you wish to continue holding, please remain 
on the line. To leave a voicemail message, press 1, and to return to the main menu, 
press star.”
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• If the call came from the auto attendant and the extension has no voice mailbox: “The 
extension you have reached is currently busy. If you wish to continue holding, please remain 
on the line. To return to the main menu, press star.”

• If the call was transferred from another extension and the extension has a voice mailbox, 
but there is no auto attendant on this line with a main menu to return to: “The extension 
you have reached is currently busy. If you wish to continue holding, please remain on the line. 
To leave a voicemail message, press one.”

• If the call was transferred from another extension and the extension has no voice mailbox 
and there is no auto attendant on this line with a main menu to return to: “The extension 
you have reached is currently busy. If you wish to continue holding, please remain on 
the line.”

While the caller is on hold at your extension, you hear a call waiting beep every 75 seconds. If 
you want to rotate through queued callers, press Recall 7. The caller you are speaking to is 
placed on hold, and the first caller in the queue is retrieved. If you have multiple callers queued, 
press Recall 7 to retrieve callers on a first in/first out basis.

If an extension is busy and the Busy call cascade is set to invoke call waiting, callers hear ringing 
(or music if enabled) while the local extension hears a call waiting beep and receives the caller 
ID for the new call. To connect to the new caller, press Recall 7. To let the caller fall through to 
the next level of the cascade, ignore the beep.

Queuing callers at a ring group

If you want to queue callers at a ring group, configure this action using an auto attendant.

For example, configure auto attendant 1 to queue callers to ring group 301 for technical support 
if they have pressed 5. When a caller presses 5 for technical support, they enter the 
queue immediately.

Every 60 seconds (configurable) the caller hears the following prompt: “Your call is important to 
us. Please remain on the line. To return to the previous menu, press star.” Extensions that are 
part of the ring group and are available will start ringing within 10 seconds of hanging up the 
phone from a previous call. The delay allows time to make a new call or activate Do not Disturb 
as a log out option. After 5 extension rings, available phones will ring once every 16 seconds. 
When you pick up, you hear a prompt that provides the option to accept the queued call by 
pressing # or leave the caller in the queue by pressing * and returning to the dial tone to make 
a new call.

Using call waiting

The call waiting feature is activated by setting the If extension is busy list to invoke call waiting. 
This control is in the Busy tab of the Local Extensions/Fax page. When the dialled local 
extension is busy, the caller hears ringing or music depending on the settings. 

If the phone supports call waiting caller ID (type II signaling), you hear a beep followed by a 
short blip. Depending on your phone, you may hear something similar to a modem noise. This is 
normal. During this notification, the caller ID information is displayed on the phone. The caller 
does not hear the beep. The phone mutes the other side.

If the phone does not support call waiting and caller ID, you hear a beep. When the call waiting 
notification beep is heard, you can either press Recall 7 to put the current caller on hold and 
answer the new call, or press Recall 5 to terminate the current call and answer the new call. If 
you do not want to answer the new call, ignore the call waiting beeps. TalkSwitch will direct the 
caller to the next level of the call cascade for your extension (e.g. TalkSwitch will send the caller 
to your voice mailbox).
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Conference calling 

You can set up conference calling between three local extensions, two local extensions and one 
outside caller, or two outside callers and one local extension.

Two local TalkSwitch extensions and one outside caller

You do not require access to the telephone company’s 3-Way Calling/Conference service to use 
the TalkSwitch conference calling capabilities.

1. Establish a call with an outside party.

2. Press Recall to place the outside caller on hold.

3. Dial the number of the local extension you wish to conference with.

4. When the extension is picked up, press Recall 6 to establish the 3-way call.

Two outside callers and one local extension

There are two different methods for this type of conference call. The first method is similar to 
the one above, using only TalkSwitch for the conference function.

1. Establish a call with an outside party.

2. Press Recall to place the outside caller on hold.

3. Dial 9 or 81–88 to choose a hunt group.

4. Dial the number of the other outside party.

5. When the call is answered, press Recall 6 to establish the 3-way call.

The second method requires the same line connect feature and uses the telephone company’s 3-
Way Calling/Conference service.

1. Establish a call with an outside party.

2. Press Recall to place the outside caller on hold.

3. Dial 80 to choose the hunt group.

4. Dial the number of the other outside party.

5. When the call is answered, press Recall 6 to establish the 3-way call.

The conference initiator can disengage the second conferenced party at any time by pressing 
Recall 5.
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USING AN IP EXTENSION

This section describes how to use a third party IP phone with the TalkSwitch system. You can 
also use these procedures with the TalkSwitch TS-9112i, TS-9133i and TS-480i phones. However, 
these phones have additional keys that make it easier to access the functions. See Using 
programmable keys with TalkSwitch IP phones on page 194, and refer to the guide supplied with 
your TalkSwitch phone.

Making calls

Placing an intercom call

An intercom call is a call from a local extension to another local extension, remote extension or 
ring group.

1. Dial the extension number.

If the Intercom calls follow cascade settings check box is selected in the configuration, an 
intercom call will follow the call cascade of the dialled extension. Otherwise the intercom call 
will ring continuously.

The dialled extension rings as follows:

• A local extension uses two short rings to identify the intercom call. IP phones supported by 
TalkSwitch can identify intercom calls this way.

• A remote extension rings normally.

• A ring group uses the ring pattern selected in the configuration. The ring group uses the 
same ring pattern for intercom calls and outside calls.

Overhead paging

Overhead paging is a call from a local extension through the optional PA amplifier connected to 
the TalkSwitch unit.

1. Dial *0.

Two-way paging

Two-way paging is a call from a local extension to another local extension that activates the 
speakerphone of the dialled extension. The user at the dialled extension can reply through the 
speakerphone. You can perform two-way paging from a local extension to a TalkSwitch analogue 
phone (TS-200, TS-400 or TS-600), or a TalkSwitch IP phone (TS-9112i, TS-9133i or TS-480i).

1. Dial *84.

2. Dial the extension number.

One-way group paging

One-way group paging is a call from a local extension to another local extension or to a ring 
group that activates the speakerphones of the dialled extensions. The users at the dialled 
extensions cannot reply through the speakerphone. You can perform one-way group paging from 
a local extension to a TalkSwitch analogue phone (TS-200, TS-400 or TS-600).

1. Dial *85.

2. Dial the extension or ring group number.
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Place out-of-office calls from a local extension 

1. Dial 9 or 81–88 to choose a hunt group. The hunt group gives you access to an available line 
to dial out.

2. If your system requires permissions for outgoing calls, enter your access code.

3. Dial the phone number.

4. Depending on your IP phone, press Dial, Send or #. 

Extensions can be restricted to specific hunt groups, and can block certain outbound calls. See 
Hunt group permissions on page 64 and Auto Route Selection on page 143.

Your extension can also be configured with direct line access. When you pick up the handset, 
you hear the telephone company dial tone and can dial an outside number without dialing a 
hunt group number. See Direct line access on page 62.

Receiving calls

If an auto attendant engages before you are able to pick up, the caller can select an option at 
the auto attendant. The steps below apply when you pick up an extension that is ringing.

For your local extension

You can answer a call that is ringing your local extension.

1. If the call went through the auto attendant and call screening is enabled:

• Press #, then press Dial, Send or # to accept the call.

• Press *, then press Dial, Send or # to reject and re-route the call to its extension‘s call 
cascade.

For any other local extension

You can intercept a call that is ringing on any other local extension. 

1. Press *9, then press Dial, Send or #.

For a specific local extension

You can answer a call that is ringing at a specific extension.

1. Press *7.

2. Dial the extension, then press Dial, Send or #.

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.

If direct line access is enabled for a local IP extension, you need to press ** before dialling 
any extensions or voice mailboxes.
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While you’re on a call

You can intercept a call while connected to another caller.

1. Press Hold to place the first call on hold.

2. Press *9, or *7 and the extension number, then press Dial, Send or #. 

3. Once you are finished with the second call or would like to return to the first caller, 
press Cancel.

Placing calls on hold

1. Press Hold. 

2. If you have multiple callers on hold or in queue at your extension, you can retrieve them on 
a first in/first out basis. Depending on your phone, you can either:

• Press the flashing line key that corresponds to the caller on hold.

• Press Hold and 7, then press Dial, Send or #.

Transferring calls to an extension

Unscreened transfer 

1. Press Transfer or xfer to put the caller on hold. 

2. Dial the extension number.

3. Press Transfer or xfer. If the IP phone supports the hang-up transfer feature, hang up the 
phone. Please check the documentation of the IP phone to see if it supports this feature.

The caller is taken off hold when the receiving extension answers. If the extension is busy or the 
call not answered, the system can perform the call cascade’s Busy action or No Answer action, or 
can ring back the extension that transferred the call. See Transfer Preferences on page 167.

Screened transfer

To initiate a screened transfer from an IP extension to another local extension, remote 
extension or ring group:

1. Press Transfer or xfer to put the caller on hold. 

2. Dial the extension number. 

• If the person at the receiving extension wishes to take the call, press Transfer or xfer 
to complete the transfer. If the IP phone supports the hang-up transfer feature, hang up 
the phone. Please check the documentation of the IP phone to see if it supports this 
feature. The caller is immediately taken off hold and connected to the 
receiving extension.

• If the person at the receiving extension does not wish to take the call and you want to 
return to the caller, press Cancel. If this softkey is unavailable, press the flashing line 
button that corresponds to the caller on hold. You can also press Hold and 7, then press 
Dial, Send or #.

• If you dial an extension that is busy or not answered, you can complete the transfer. The 
caller will be directed according to that extension’s call cascade settings. 
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Transferring calls to an outside number

You can initiate a transfer from an IP extension to an outside number.

If the telephone line has the 3-Way Calling/Conference service or the Transfer and Clear service, 
and the local extension has enabled Allow the use of same line connect (by dialing 80), the user 
can select hunt group 80 to dial the outside number on the same line the caller is on.

Unscreened transfer

1. Press Transfer or xfer to put the caller on hold.

2. Dial 9 or 81–88 to choose a hunt group.

3. Dial the outside phone number.

4. Press Transfer or xfer to complete the transfer. Do not hang up to complete the transfer, 
because this disconnects the call. 

Screened transfer

Instead of completing the transfer once you have dialled the outside number, wait until the call 
is answered and ask the recipient if he or she wishes to take the call. If the recipient accepts the 
call, press Recall, Transfer or xfer to complete the transfer. If not, press Recall or Cancel to 
return to the caller. If this softkey is unavailable, press the flashing line button that 
corresponds to the caller on hold.

Call park — parking and retrieving callers 

Call park is a feature for placing a call on hold and then retrieving it from any other local 
extension. TalkSwitch has 10 park orbits, 500–509.

Parking a caller

1. Press Transfer or xfer to put the caller on hold.

2. Press *510, then press Dial, Send or #. TalkSwitch selects the first available park orbit 
(500–509). You hear a confirmation indicating the caller has been parked successfully and 
into which park orbit.

3. Provide the park orbit to the person with the parked call (e.g. “Mary, there is a call parked 
for you in 500”).

Retrieving a parked call

1. Press **, the park orbit, then press Dial, Send or #.

Queuing and retrieving callers

This feature is used the same way on analogue and IP extensions except for the slight 
differences outlined in the next paragraph.

Some IP extensions display a notification on the screen while the caller is on hold at your 
extension. If you want to rotate through queued callers while you are on the phone, dial 7 and 
press Dial, Send or #. The caller you are speaking to is placed on hold, and the first caller in the 
queue is retrieved. If several callers are queued, dial 7 and press Dial, Send or # to retrieve 
them on a first in/first out basis.
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Using call waiting

If the call waiting feature is activated as a Busy option in the call cascade routing for a local 
extension and the dialled extension is in use, the caller hears ringing or music depending on the 
music on hold settings. You hear the following:

• If the phone supports call waiting caller ID, you hear a beep followed by a short blip.

• If the phone does not support call waiting caller ID, you hear a beep. When the call waiting 
notification beep is heard, you can pick up another line and dial 7 and press Dial, Send or # 
to put the current caller on hold and answer the new caller. To return to the previous call, 
press the flashing line key that corresponds to the previous call. On most IP extensions, this 
will put the current call on hold and connect to the other caller.

• To terminate the current call and go back to the other caller on hold, hang up, then go off-
hook and press the button that corresponds to the flashing line of the caller on hold. If you 
do not want to take the new call, ignore the call waiting beeps. TalkSwitch will direct the 
caller to the next level of the call cascade for that extension (i.e. send the caller to the 
associated voice mailbox).

Conference calling with TalkSwitch

Two TalkSwitch local extensions and one outside caller

You do not require access to the telephone company’s 3-Way Calling/Conference service to use 
the TalkSwitch conference calling capabilities.

1. Establish a call with an outside party.

2. Press Conf or Hold to place the outside caller on hold.

3. Dial the local extension you wish to conference with.

4. When the extension answers, press Conf to establish the 3-way call.

Two outside callers and one local extension

There are two different methods for this type of conference call. The first method is similar to 
the one above, using only TalkSwitch for the conference function.

1. Establish a call with an outside party.

2. Press Conf or Hold to place the outside caller on hold.

3. Dial 9 or 81–88 to choose a hunt group.

4. Dial the number of the other outside party.

5. When the call is answered, press Conf to establish the 3-way call.

The second method uses the same line connect feature and the telephone company’s 3-Way 
Calling/Conference service.

1. Establish a call with an outside party.

2. Press Hold to place the outside caller on hold. 

Note: If you try to initiate a conference call with a TalkSwitch 9112i IP phone, but there is no 
line available, you will not hear a busy signal. You will instead be reconnected with the 
other caller.
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3. Dial 80 to choose the hunt group.

4. Dial the number of the other outside party and press Dial, Send or #.

5. When the call is answered, press Transfer to establish the 3-way call.

USING PROGRAMMABLE KEYS WITH TALKSWITCH IP PHONES

About programmable keys

The TS-9133i has seven programmable function keys, and the TS-480i has 14 programmable 
softkeys. The keys allow you to access TalkSwitch features, and to monitor and engage lines, 
extensions, and queued calls (i.e. line appearance).

TS-9133i function keys

The following function keys can be programmed on the TalkSwitch TS-9133i.

• None — The key is not programmed.

• Line Appearance — Shows the status of a telephone line or VoIP number, and allows you to 
access it. The LED will be off if the line is available; flashing if the line is ringing an 
extension; and on solid if the line is being used. Press the key to immediately connect the 
extension to the line. You do not have to dial the hunt group number.

• Extension Appearance — Shows the status of a local extension, and allows you to access it. 
The LED will be off if the extension is on-hook; flashing if the extension is ringing or on 
hold; and on solid if the extension is being used. Press the key to ring the extension.

• Queue Appearance — Shows the status of a local extension call queue, and allows you to 
connect with the oldest queued call. The LED will be off if the extension has no calls 
queued, and flashing if the extension has one or more calls queued. Press the key to connect 
with the oldest queued call.

• VoiceMail — Press the key to access the voice mailbox of the local extension. The LED is 
unused. If the Voicemail key is not programmed, press ** #.

• DND — Press the key to toggle Do Not Disturb mode. The LED is unused. If the DND key is 
not programmed, press *62#.

• Intercom — Press the key, dial an extension, and then press # to page the extension in 
Intercom mode. The LED is unused. If the Intercom key is not programmed, press *84, dial 
an extension, and then press U Dial. The Intercom function can only page 
TalkSwitch phones.

• Park — Press the key to put the call on hold in the next available park orbit. The system will 
respond with the park orbit number (500 to 509). The LED is unused. If the Park key is not 
programmed, press k, *510#.

• Un-park — While the phone is on-hook, press the key, dial the park orbit number (500 to 
509), and then press # to retrieve the call. The LED is unused. If the Unpark key is not 
programmed, lift the handset, press **, dial the park orbit number, and then press #.

• Pickup Any — Press the key to answer a call from an outside number ringing any extension. 
The LED is unused. If the Pickup Any key is not programmed, press *9#.

• Pickup Ext — Press the key, dial an extension, and then dial # to answer a call from an 
outside number or extension ringing the extension. The LED is unused. If the Pickup Ext 
key is not programmed, press *7, dial the extension, and then press #.
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• Overhead page — Press the key to page the office. The LED is unused. If the Overhead Page 
key is not programmed, press *0#.

TS-480i softkeys

The following softkeys can be programmed on the TalkSwitch TS-480i.

• None — The softkey is not programmed.

• Line Appearance — Shows the status of a telephone line or VoIP number, and allows you to 
access it. A status icon and line ID will appear beside the softkey. The On-Hook icon appears 
if the line is available. The Ring icon appears if the line is ringing an extension. The Off-
Hook icon appears if the line is being used. Press the softkey to immediately connect the 
extension to the line. You do not have to dial the hunt group number.

• Extension Appearance — Shows the status of a local extension, and allows you to access it. A 
status icon and caller ID will appear beside the softkey. The On-Hook icon appears if the 
extension is available. The Ring icon appears if the extension is ringing or on hold. The Off-
Hook icon appears if the extension is being used. Press the softkey to ring the extension.

• Queue Appearance — Shows the status of a local extension call queue, and allows you to 
connect with the oldest queued call. A status icon, extension number and “Q” will appear 
beside the softkey. The On-Hook icon appears if the extension has no calls queued. The Ring 
icon appears if the extension has one or more calls queued. Press the softkey to connect 
with the oldest queued call.

• VoiceMail — Press the Voice Mail softkey to access the voice mailbox of the local extension. 
If the Voice Mail softkey is not programmed, press **#.

• DND — Press the DND softkey to toggle Do Not Disturb mode, and then press DND ON or 
DND OFF. If the DND softkey is not programmed, press *62#.

• Park — Press the Park softkey to put the call on hold in the next available park orbit. The 
system will respond with the park orbit number (500 to 509). If the Park softkey is not 
programmed, press k, *510#.

• Un-park — Press the Unpark softkey, select the park orbit number (500 to 509), and then 
press Unpark to retrieve the call. Note that caller ID appears beside the park orbit number. 
If the Unpark softkey is not programmed, press **, dial the park orbit number, and then 
press #.

• Pickup Any — Press the Pickup Any softkey to answer a call from an outside number ringing 
any extension. If the Pickup Any softkey is not programmed, press *9#.

• Pickup Ext — Press the Pickup Ext softkey, dial an extension, and then press Pickup to 
answer a call from an outside number or extension ringing the extension. If the Pickup Ext 
softkey is not programmed, press *7, dial the extension, and then press #.

• Queue (Show List) — Press the Queue softkey, select a queued call, and then press Retrieve 
to connect with the selected call. If the Queue softkey is not programmed, this 
functionality is not otherwise available.

• Overhead page — Press the Ovrhd Page softkey to page the office. If the Ovrhd Page 
softkey is not programmed, press *0#.

The Intercom function cannot be programmed as a softkey. It is always available by pressing the 
Icom key. You can also press *84, dial the extension, and then press #. The Intercom function 
can only page TalkSwitch phones.
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USING VOIP

A TalkSwitch VoIP network provides inter-branch connectivity. It requires a VoIP-enabled 
TalkSwitch unit at each location. A TalkSwitch VoIP network has 50 VoIP numbers (250–299) 
that can be dialled from an extension or auto attendant. The TalkSwitch unit automatically 
finds the VoIP lines for placing these calls.

Other VoIP calls are made by dialling a hunt group. If a VoIP-enabled TalkSwitch unit is present, 
hunt group 88 provides access to the TalkSwitch VoIP network by default. Refer to the VoIP 
Network Configuration Guide. It tells you how to set up a TalkSwitch profile or service provider 
profile, set up VoIP numbers that use the profile, and set up the hunt group. Dialling the hunt 
group at the internal dial tone tells the TalkSwitch system to hunt for an available VoIP line.

A VoIP-enabled TalkSwitch unit is required for teleworkers to use external IP extensions. The 
external IP extensions are local extensions, and function like internal IP extensions at 
the office.

Example: You have three branch locations (San Francisco, New York, Miami).

Location 1: San Francisco
Twelve VoIP numbers (250–261) are assigned to four VoIP lines.

Location 2: New York
Four VoIP numbers (270–273) are assigned to four VoIP lines.

Location 3: Miami
Four VoIP numbers (280–283) are assigned to four VoIP lines.

If someone in the San Francisco office wants to reach someone in the New York office, they can 
dial one of the VoIP numbers associated with New York (270–273). TalkSwitch automatically 
finds an available VoIP line and connects to the New York location. The TalkSwitch unit at the 
New York location handles the call according to the configuration in the VoIP Numbers page.

USING A STANDARD PHONE CONNECTED IN PARALLEL TO TALKSWITCH 

A standard phone connected in parallel (not connected to TalkSwitch but connected to the same 
line) with TalkSwitch always rings at least once before TalkSwitch starts ringing its extensions or 
the auto attendant answers the call. TalkSwitch uses the first ring to identify the incoming ring 
pattern before passing it on to the extensions or the auto attendant (TalkSwitch determines if 
the call is a distinctive ring and detects any caller ID information). A parallel phone can 
interrupt a telephone call on any of the telephone lines.

Making and receiving calls

Make calls on parallel-connected extensions as if TalkSwitch were not sharing the telephone line 
with them.

If you answer on a parallel-connected phone before the auto attendant engages, TalkSwitch 
takes no further action. If a call is answered on a parallel-connected phone after the auto 
attendant engages, you can turn off the auto attendant message by pressing **0 at one of the 
TalkSwitch extensions, or let it time-out on its own, in which case you will hear: ”Good-bye”.
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Transferring calls

Calls answered on a parallel-connected phone can be transferred to any TalkSwitch extension or 
voice mailbox. To transfer the caller, press **. After you hear 2 beeps, dial the extension and 
hang up. You cannot announce a caller to the transferred extension but if you stay on the line, 
you are in a conference call state. You can hang up at any time. 

If you transfer a call from a parallel-connected phone and then hang up, the extension rings the 
number of times specified for that extension. If it is not answered within that number of rings, 
the call is handled according to that extension’s call cascade actions. 

When a phone in parallel with TalkSwitch is off-hook, you notice that the corresponding line 
light flickers to indicate the line is busy. TalkSwitch does not allow extensions to interfere on a 
call that has the line in use.

MODEMS AND TELEPHONE LINE ACCESS

If your modem is attached to TalkSwitch as an extension, you can configure it to access your 
telephone lines in one of two ways. 

1. Enable direct line access to one of your telephone lines. You don’t have to dial 9 or any 
other hunt group to access an outside line at the extension where your modem is connected. 
Your modem will work the same way it always has. You don’t have to change your dial-up 
settings for the modem.

2. If you use a telephone and modem on the same extension, do not enable direct line access. 
A TalkSwitch extension with direct line access immediately connects to one of your 
telephone lines when you pick up the telephone’s handset, preventing you from accessing 
other system features without first pressing Recall on an analogue extension or ** on a IP 
extension. 

You can have your modem access a specific telephone line using a hunt group. 

Change your modem’s dial properties to include the intended hunt group (9 or 81–88) 
followed by the letter w, before the dial-up networking phone number (e.g. 9w789-1234). 
The letter w after your dial-out access number tells your modem to dial the access number 9, 
wait until it detects a dial tone, and then dial your dial-up networking number. 

If your modem has problems dialling out, use a comma (,) to create a 2 second pause instead 
of the w (wait for dial tone).

FORWARDING CALLS OUT OF THE OFFICE

Automatic call forwarding

The auto attendant can forward an office call to a remote extension. Use the auto attendant 
message to prompt callers to select your remote extension number(s). (e.g. “To speak to John 
Smith, dial 211.”)

You can change the transfer prefix to *# if the default transfer prefix conflicts with another 
device or service. See From home phone tab on page 170.

Because TalkSwitch units are digital systems, modem calls will only operate at a maximum 
speed of approximately 28 Kbps.
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Manual call forwarding

If you have answered a call at a local extension, you can forward the call to a remote extension.

1. Put the call on hold at the local extension.

2. Dial the remote extension number (e.g. 211) to which you want the call forwarded.

3. Hang up an analogue extension or press Transfer or xfer on an IP extension. 

The call is handled according to the call cascade options of that remote extension.

Conditional call forwarding

If the auto attendant answers a call and the caller selects an extension or ring group number 
that is busy or is not answered, the auto attendant can forward the call to a remote extension. 
Conditional call forwarding is configured in the TalkSwitch software using the call cascade’s No 
answer or Busy settings for each local extension, remote extension and ring group.

Transferring calls from a remote extension

You can forward calls from a remote extension without using Centrex or 3-way calling services. 
Calls can be transferred to any local or remote extension, ring group or voice mailbox. This 
feature also applies to VoIP numbers.

1. Press ** to place a call on hold at a remote extension anytime during a conversation. You 
hear the same dial tone as at a local extension and have the following three possibilities:

• Press ** to retrieve the call placed on hold.

• Dial any local extension, remote extension, voice mailbox, VoIP location or ring group.

• If the system is configured to perform a blind transfer, the system plays “Call 
Transferred — Goodbye.” and then hangs up.

• If the system is configured to allow call screening, determine whether the other 
person wants the call, and then press **4 to complete the transfer or **5 to cancel 
the transfer and return to the caller.

Screening options for forwarded calls 

The screening options for call forwarding are configured in the TalkSwitch software using the 
Answered tab in the Remote Extensions page. 

Forwarding calls with screening
When play accept/reject prompt is configured in the Answered call cascade option in the Remote 
Extensions page, TalkSwitch plays a pre-recorded prompt to callers asking them to hold and 
then dials your call forwarding number. When you answer the forwarded call, you hear a prompt 
saying: “You have a forwarded call. To accept the call, press #. To reject the call, press *.” If you 
reject the call, it is routed according to the call cascade option specified next to If a call is 
rejected from this ext.

When play caller’s name first is configured in the Answered call cascade option, TalkSwitch plays 
a pre-recorded prompt to callers asking them to record their name at the sound of the tone. 
TalkSwitch asks the caller to hold and dials the call forwarding phone number. When you answer 
the forwarded call, TalkSwitch plays a pre-recorded prompt saying: “This is call forward, you 
have a call from...” and plays the recording of the caller’s name. To accept the forwarded call, 
press # on your telephone keypad, re-route the call to its call screening call cascade options by 
pressing *.
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When either screening option is used, music on hold is enabled and you are not using the 3-way 
calling feature (Same Line Connect) to forward calls, the caller hears music while TalkSwitch is 
waiting for the remote extension to accept the call. 

If a forwarded call is not answered or the line is busy, TalkSwitch performs the following, based 
on how the call was originally forwarded:

• If the call was automatically forwarded, it follows the remote extension’s No Answer or Busy 
call cascade action.

• If the call was manually forwarded, it follows the remote extension’s No Answer or Busy call 
cascade action. This action can be changed to ring the extension back to the person who 
performed the transfer.

• If the call was conditionally forwarded, it follows the call cascade action in the No Answer or 
Busy for the original extension selected.

CALLS OVER VOIP WITH IP EXTENSIONS AND GATEWAYS

If teleworkers are connected to the system via a certified compatible IP device (i.e. gateway or 
IP extension), there are several ways for them to interact with TalkSwitch.

Making calls

1. Ensure the VoIP number is programmed with an auto attendant.

2. Dial the VoIP number.

3. When the auto attendant answers, dial an extension, voice mailbox, VoIP number or hunt 
group.

Transferring calls

1. If the call is routed via TalkSwitch, you can transfer the caller dialling ** and any extension 
or voice mailbox.

2. If the call came directly from a IP gateway or phone, you can transfer the call if your phone 
or service provider supports this feature. 

USING THE VOICEMAIL SYSTEM

The recording time for internal music on hold, voicemail, and the auto attendants is shared on 
the TalkSwitch unit. You can expand the built-in memory using memory cards.

Note that the system allows up to 99 voicemail messages per mailbox. Once a mailbox fills up, 
callers won’t be able to leave voicemail messages for that user. Therefore users should delete 
voicemail messages before the mailbox fills up.

Activating voice mailboxes

You can activate voicemail with a mailbox, as an announcement, or you can deactivate it. There 
are three types of voice mailboxes:

• Local extension mailboxes are associated with local extensions. All local extensions are 
activated with a respective mailbox by default. 

• Remote extension mailboxes are associated with the remote extensions. If you activate a 
remote extension, the mailbox is activated by default.
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• General voice mailboxes are not associated with extensions.

Callers can reach voice mailboxes from a call cascade, be transferred from a local extension or 
have announcements played through the auto attendant.

If you want incoming calls to go straight to a voice mailbox after a specified number of rings, 
program an auto attendant to answer the line and then route the call to voicemail.

To leave a message from an analogue extension:

1. Press * and the mailbox number. 

To leave a message from an IP extension:

1. Press * and the mailbox number and press Dial, Send or #.

To transfer a caller directly to voicemail from an analogue extension:

1. Press Recall *, the mailbox number and hang up.

To transfer a call to a voice mailbox from an IP extension: 

1. Press Transfer or xfer *.

2. Enter the mailbox number.

3. Press Transfer or xfer to complete.

4. Press Dial, Send or #.

When a caller presses # after leaving a message or after 2 minutes have elapsed, TalkSwitch 
plays a prompt asking callers if they wish to keep the message, listen to the message or re-
record the message. Callers can dial 0 and the system directs the call according to the settings of 
that mailbox.

Retrieving messages and accessing a voice mailbox

The first time you access your voice mailbox, you are prompted to assign a password, record a 
greeting and record your name for the dial-by-name directory. 

For the general mailboxes, there are no directory listings and you are not prompted to record a 
name. If you wish to have your name in the company directory, use the mailbox associated with 
its extension, as the directory is related to the extension’s mailbox. When your mailbox has 
been set up, you access it through the prompt instructions.

If a new message is left in a local extension mailbox, TalkSwitch plays a stutter dial tone when 
the handset is picked up (not applicable to the TS-850i). If the extension supports a frequency-
shift keying (FSK) message waiting indicator (not applicable to IP extensions), the light flashes. 
The TS-80, TS-200, TS-400 and TS-600 extensions support a message waiting counter. The 
display on the extension shows the number of new messages stored in the mailbox(es) 
associated with that extension. 

1. If direct line access is enabled, be sure to press Recall before trying to access your mailbox. 
From a Grandstream or Polycom IP extension, press MSG or Messages button.

2. Press **# from a local extension or ** and the mailbox number at the auto attendant if you 
are dialling from an outside location. From an IP extension, press Dial, Send or #.

3. Dial 1 to listen to messages.
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By default, TalkSwitch starts with newest message before it plays the older ones. While the 
message is playing or after the message has finished, you can dial the following:  

4. Dial 2 to change greeting options.

This allows you to record a new personal voicemail greeting. The default greeting is: “The 
extension you have reached is unavailable at this time. Please leave a message after the tone”.

While recording your greeting or announcement, remember that callers can press * to return 
to the auto attendant, if the call came from the auto attendant. When they are done 
recording, they can press # for more options. You may want to give your callers these 
options for their convenience. In local extension mailbox options, 0 can be configured as an 
option for additional routing.

5. Dial 3 to change personal options.

• change your current password 

• turn the auto date and time stamp on/off 

• set up or change pager and remote phone notification 

By default, the auto date and time stamp is on. This information is played at the end of each 
message. If you have caller ID service, the phone number is displayed with the time 
and date.

6. Dial 4 to record your name for the dial-by-name directory.

If you haven’t recorded your name for the directory or if you wish to change the recording, 
dial 4. The dial-by-name directory is accessed at the auto attendant according to your 
configuration. Callers are directed to enter the first 3 letters of the employee’s last name. 
The system finds the exact or closest match and plays the recorded name with the extension 
number, giving callers the option to connect to that extension. 

7. You can transfer a caller to voicemail by pressing Recall ** and entering the mailbox 
number. From an IP extension, press Transfer or xfer + mailbox + Dial, Send or #.

1 to rewind 10 seconds

11 to rewind to beginning of the message 

3 to skip ahead 10 seconds

33 to skip to the end of the message

5 to listen to the time and date stamp

6 to forward the message

7 to delete a message

9 to save a message

* to back up one level

# to skip to next message, leaving new messages as new.

You must record your name in order for the extension to be included in the dial-by-
name directory.
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Recording an announcement on a local extension

An announcement is a recorded message providing information to callers. It can be recorded 
using your phone as a voicemail message or loaded as an audio file. The system hangs up after 
playing an announcement. Callers have the option of pressing * during an announcement to 
return to the auto attendant. Callers can also dial 0 to perform other actions if this is configured 
in the voicemail options.

You might include in the announcement a mention of the selections a caller may press and leave 
a section of silence at the end to give the caller time to make a selection.

To record an announcement, access a voice mailbox and select option 2 to change greeting 
options as described in Retrieving messages and accessing a voice mailbox on page 200.

Pager and cell phone notification

When a new message is left in a voice mailbox, it can notify a pager, cell phone or a 
remote number. 

You can configure the system to notify you for every new message or for only the first new 
message received since the last time you accessed new messages.

If you use remote phone notification, you can accept or reject the notification call when 
you answer. 

• Press # to listen to messages.

• Press * to postpone listening to messages.

MUSIC ON HOLD

TalkSwitch can play music to callers when they are on hold, parked or queued. The music played 
is provided by the source you have connected to the music jack or from a sound file (8 KHz, 8 
bit, mono, u-law, .wav format) stored on the unit(s). When a sound file is loaded on one of the 
TalkSwitch units, it is duplicated to all units on the LAN. 

Music on hold and call forwarding to remote extensions 

If you are using the telephone company’s 3-Way Calling/Conference service with the same line 
connect feature to activate the TalkSwitch call forwarding feature, callers do not hear music on 
hold while they are being forwarded to a remote extension. The caller is put on hold by the 
telephone company’s central office switch rather than by TalkSwitch, and the caller hears silence 
while being transferred.

A system prompt indicates that callers will hear silence while the system is locating their party. 
This prompt explains to callers why there is silence for an extended period of time before 
connecting to the remote extension. This prompt cannot be disabled. 

If you have two or more units on a LAN, we recommend that you use a .wav file. If you use an 
external audio source, connect it to each TalkSwitch unit. Use 1/8" audio splitters, which are 
available at most electronics stores. See Unit back panel on page 4 for more details.
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SWITCHING MODES

Switching modes manually

Use telephone keypad commands at a local extension or at the auto attendant to switch modes. 

1. Enter command mode by pressing # on an analogue extension phone, or *55# on an IP 
phone.

2. Enter the system password, followed by #.

3. Enter one of the following commands:

• 30# to check the current mode. 

• 31# to activate Mode 1.

• 32# to activate Mode 2.

• 33# to activate Holiday Mode.

Switching modes automatically

Use the TalkSwitch management software to set up automatic mode switching. See Scheduling 
on page 31.

If you switch modes manually, TalkSwitch will automatically switch modes during the next 
scheduled mode change.

USING CALL BRIDGE AND CALL BACK

Working together, call back and call bridge act as your personal long-distance operator. Whether 
you are across town or around the world, these two features allow you to place calls from your 
office telephone line.

You can make a call to TalkSwitch, access a telephone line connected to TalkSwitch and enter 
the number you want to dial. This is especially useful when you are out of the office with your 
cell phone and need to make a long-distance call. You can avoid the long-distance cell rates by 
making a local call to TalkSwitch and access your office savings plan through call bridge.

Using call bridge

1. Dial into a telephone line. 

2. When the auto attendant answers, select a hunt group (9, 81–88 or Same Line Connect 80). 

3. Enter your account password. If you are using Same Line Connect and your line supports the 
3-way calling/conference service, you are prompted to enter the phone number. 

4. When you have completed your call, do one of the following:

Ensure the TalkSwitch management software is closed during automatic mode switching, or if 
an administrator is switching modes remotely. In these cases, the mode cannot switch while 
the TalkSwitch management software is open.

Note that the mode can switch while the TalkSwitch management software is open, if you are 
switching modes using the software.
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a) Make another call by pressing ##.

TalkSwitch disconnects you from the call in progress. You can dial another number or redial 
the same number. 

b) Activate the auto attendant by pressing #*.

TalkSwitch ends the call bridge session and activates the auto attendant. When the auto 
attendant message begins to play, you have the following options:

• Press # to enter command mode

• Dial 6 to change/enter call back settings

• Dial a local or remote extension or a ring group. This option allows you to contact 
someone in your office, check your voicemail, etc.

c) End the call bridge session by hanging up. This disconnects you from TalkSwitch. To 
ensure TalkSwitch disconnects at the end of a call bridge session, press ## before 
hanging up.

The call bridge phone number you dial can be local, long-distance, toll free (800 and 888) or 
international. Enter the phone number as you would in your office. For long-distance calls, 
include the 1, country code and area code.

Using call back

The call back feature allows you to initiate TalkSwitch to call you at a specified phone number. 
This gives you access to the following:

• Call bridge

• Local extensions, remote extensions and ring groups

• Voicemail 

• Configuration settings

Using call back involves 3 steps:

1. Call your TalkSwitch phone number to activate call back.

2. Answer and accept call back. TalkSwitch calls you back within 30 seconds.

3. At the auto attendant you can choose to perform call bridge, dial an extension, access and 
retrieve voicemail or configure TalkSwitch.

Activating call back

There are two ways to activate call back from your out-of-office location.

Using prompted call back activation

1. Dial a TalkSwitch phone number. 

2. Let the line ring until the auto attendant answers.

3. To initiate call back at the current call back number, dial 61 on the telephone keypad, and 
then hang up. The system will call you back and then prompt you for your password.
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4. To initiate call back at a new call back number, dial 62 on the telephone keypad. The system 
will prompt you for your password. Enter your password and the new call back number, and 
then hang up. The system will call you back and then prompt you for your password.

Using auto call back activation

1. Dial one of the call back phone numbers that has been configured for auto call 
back activation.

2. Let the line ring at least once but no more than three times and hang up before the call 
is answered.

3. Within 20 seconds, TalkSwitch calls your auto call back number. 

Accepting the call back

There are two ways to accept a call back from TalkSwitch.

Directly answering the call back

1. Answer the call and press #.

If required, enter your password. This option is used when you have a direct line to your call 
back phone number.

Using the announced message option

The Use announced message option allows the call back from TalkSwitch to reach you when you 
are in a hotel or an office where calls are intercepted by a receptionist or switchboard operator. 
When the call back is answered, TalkSwitch begins playing your pre-recorded message (e.g. 
“Please forward this call to Bob Smith in room 312”). The message is repeated for 2 minutes.

1. When the call is forwarded to you, press # and enter your password on the telephone keypad 
to accept the call back. If the call back is not accepted within the initial 2-minute period, 
TalkSwitch disconnects the call back.

When you accept the call, you hear the auto attendant. You can select to check your voicemail, 
ring an extension, use call bridge or enter command mode.

For prompted call back, TalkSwitch always dials the last prompted call back number entered. If 
you do not have the auto attendant answer a line, a generic TalkSwitch auto attendant will 
answer after 15 rings. You can then dial 6 to access the call back settings.

It is important to remember that all call back settings must be configured to use auto call 
back. Please ensure the auto attendant for the line using call back does not answer before 
4 rings.
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C H A P T E R  4
Ch ap ter  4 :  Ca ll  D etai l  Record  (CD R )  Log gi ng

CALL  DETAIL  RECORD LOGGING

INTRODUCTION

This chapter covers the setup and retrieval of call detail records (CDRs), which are records 
generated by calls through the phone system.

The TalkSwitch unit can store the CDRs. The system can automatically e-mail the CDRs, or you 
can manually retrieve them with the Call Reporting licensed add-on application or a 
web browser.

If multiple units are networked on a LAN, the CDRs from all the units are stored on one unit. 
The TalkSwitch unit stores approximately 6000 records in a circular buffer. This means that after 
about 6000 calls, the oldest records will be deleted and new ones created. On a very busy 
system, 6000 records may only cover a couple of days, but on a system with less traffic, 6000 
records may cover more than a month.

The TalkSwitch unit can instead send the CDRs to a computer in real-time over the USB port. In 
this case the TalkSwitch unit does not store any CDRs.

ENABLING CALL DETAIL RECORD LOGGING

1. Choose Tools > Call Logging Output (CDR). The Call Logging window appears. 

2. Select how the TalkSwitch unit will process CDRs. Choices are:

• Deactivated — CDRs are neither stored nor sent to the computer.

• Real-time to Serial/USB port — CDRs are sent to the computer in real-time. Selecting this 
enables the TalkSwitch Unit area.

• Store to File on TalkSwitch — CDRs are stored in the TalkSwitch unit. Selecting this 
enables the TalkSwitch Unit area and the Email Log File area.
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TalkSwitch unit

The TalkSwitch Unit area allows you to select the TalkSwitch unit that will process the CDRs. It is 
enabled if you selected Real-time to Serial/USB port or Store to File on TalkSwitch.

1. Select the TalkSwitch unit that will process the CDRs. Only active units are available.

Email log file

The Email Log File area allows you to have the system regularly e-mail a log file containing the 
CDRs. It is enabled if you selected Store to File on TalkSwitch.

Note that if you want the system to e-mail a log file, you must configure the outgoing mail 
server (SMTP). See Email Service on page 40.

1. To have the system e-mail the log file, select the Enabled check box.

2. Enter the Email Address.

3. Select the Time to send.

4. Select the Days to send.

RETRIEVING CALL DATA RECORDS

There are two methods for retrieving CDRs:

• Call Reporting licensed add-on application

• Browser

Call reporting

The Call Reporting licensed add-on application automatically connects to the TalkSwitch unit, 
downloads the CDRs, and builds detailed reports of call activity. The application requires the 
Store to File on TalkSwitch setting in the Call Logging window. 

Browser

You can connect to the TalkSwitch unit and download the CDRs using a browser. Retrieving the 
CDRs using a browser requires the Store to File on TalkSwitch setting in the Call Logging window.

1. Select the IP Configuration page in the TalkSwitch management software, and note the 
Unit IP Address (e.g. 192.168.1.102).

2. Select the Administration page in the TalkSwitch management software, and note the 
System name. You will also require the System password.

3. Enter the following into the Address field of a web browser: http://, followed by the unit IP 
address, followed by :8484/ (e.g. http://192.168.1.102:8484/). The Log in 
window appears.
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4. Enter the system name in the User Name field of the Log in window, and the system 
password in the Password field. If the system name is blank, enter talkswitch. The browser 
shows the Welcome to TalkSwitch screen.

5. Click the Call Detail Record (CDR) Management link. The browser shows the Call Detail 
Record (CDR) Management screen.

6. Scroll down to the Download CDR section.

7. You can either right-click the Download CDR link to save the information to your PC, or can 
click the link to view the current information.

8. Once the CDR file has been downloaded, scroll down to the Clear CDR section.

ANALYZING THE DATA

The data can be viewed either through the web interface or downloaded into a spreadsheet (e.g. 
Excel) as a tab delimited text file. The log is divided into 13 columns identified by numbers:

Each column contains specific information related to the current state of the call. The following 
is a list of the columns with a description:

1. Type — This column can contain the following characters:

• I — Inbound call

We recommend that you clear the TalkSwitch unit immediately after downloading the CDRs. 
The unit will then start saving data to a new file. This allows easier viewing and analyzing of 
the captured information.

1. Type

2. Log

3. Event

4. Date

5. Time

6. Duration

7. Connection

8. Phone Number

9. Caller ID Name

10. Line

11. Account Number

12. User
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• T — Transfer state

• O — Outbound call

• B — Bridged call. For example, a call in on one line that is forwarded over another line. 
This can include calls forwarded to remote extensions.

• X — Blocked call

• A — Account number assigned to the call with the same log #.

2. Log — This column indicates log number for the call. For the duration of the call, the log 
number remains the same. The event number will increment with each change of state. The 
first digit of the log number indicates on which unit the event originated.

3. Event — This column tracks various state changes of the call. For example, when an auto 
attendant answers, the counter might be 1. When the caller selects an extension, the 
counter increments to 2, etc.

4. Date — This column shows the date of the call (MM/DD/YYYY).

5. Time — This column contains the time that the call entered a specific state. The time is 
displayed in 24-hour format (HH:MM).

6. Duration — This column indicates the total time the call was in this state/event. The time 
is displayed in 24-hour format (HH:MM:SS).

7. Connection — This column indicates where the call was for each event. This includes auto 
attendants, voicemail, extension ringing or queuing.

• Exxx = Connected to extension xxx (xxx = 111–148, 151–188)

• A00x = Connected to auto attendant x (x= 1 to 9)

• Rxxx = Ringing at extension xxx (xxx = 111–148, 151–188)

• RCO = Ringing at telephone line.

• Qxxx = Queued at extension xxx (xxx = 111–148, 151–188, 300–309)

• Hxxx = Call on hold at extension xxx (xxx = 111–148, 151–188)

• Mxxx = Connected to voice mailbox xxx (xxx = 111–148, 151–188, 211–248, 410–449)

• Cxyy = Forwarded out on unit x line yy. (See “10. Line” below for more details).

8. Phone Number — This column displays the phone number of the inbound or the outbound 
caller if available.

9. Caller ID Name — This column displays the name of the caller if available. 

10. Line — This column indicates on which unit and line the call came in or out. The format of 
this information is unit and line number. Lines 01–08 are telephone lines and 09–16 are 
VoIP lines. 

Example: 101 — unit 1, line 1
203 — unit 2, line 3
110 — unit 1, VoIP 2

11. Account Number — This column contains an account number that the user can assign after 
a call. This allows you to group calls together that may have been placed over time to 
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calculate the total amount of time spent with a particular customer. The account number 
can be a numerical code up to 15 digits long.

To assign an account number after a call has been completed, dial *88. When prompted, dial 
<Account Number> + #. 

If Direct Line Access is enabled on an extension: 

• Analog extension — press Flash, then dial *88. When prompted, dial <Account 
Number> + #.

• IP extension — press **, then dial *88. When prompted, dial <Account Number> + #.

12. User — If Permissions are enabled, this column shows the code name associated with the 
access code used to dial out.

The data can be imported into any call management software or an Excel spreadsheet as a tab 
delimited text file. After the import, the data can be grouped and tallied based on the criteria 
set forth. 

Example:

1. Total line usage for a day 4. Average call times

2. Number of inbound calls 5. Number of calls per line

3. Wait times
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C H A P T E R  5
Ch ap ter  5:  VoIP  In form a tio n

VOIP  INFORMATION

ABOUT VOIP

VoIP-enabled TalkSwitch units route VoIP calls over the Internet or private IP network, and 
other calls over the traditional telephone network.

VoIP-enabled TalkSwitch units uses the industry-standard Session Initiation Protocol (SIP) for 
VoIP calls. In this guide the term SIP is often used in place of VoIP.

There are three ways to use VoIP. A system can use one, two or all three methods.

• External IP extensions

• TalkSwitch VoIP network

• Service provider VoIP network

About SIP servers

A VoIP network requires a SIP server to manage calls across the network. The SIP server contains 
registration information for all SIP devices in the network. When making a VoIP call, a device 
will contact the SIP server to get contact information for the destination. The device will then 
establish a connection with the destination. The SIP server is also involved with 
call termination.

All VoIP-enabled TalkSwitch units have built-in SIP servers to manage a TalkSwitch VoIP 
network, but you must designate only one TalkSwitch unit as the SIP server. TalkSwitch systems 
at other locations are configured as SIP clients.

Note: For VoIP calls made through a VoIP service provider, the service provider is the SIP server.

Selecting a location for the SIP server

Any VoIP-enabled TalkSwitch unit on the network can be designated as the SIP server. 

To simplify network operation and reliability, we recommend you choose a location that has a 
static, rather than a dynamic, public IP address. A static public IP address does not change, 
providing a consistent connection address for each location to communicate with the SIP server. 
See Setting the public IP address on page 214.

CONNECTING TO A NETWORK

Each location requires a high-speed connection to the Internet or private IP network that is 
sufficient for VoIP calls. This is required for a location using an external IP extension, 
TalkSwitch VoIP network, or service provider VoIP network.
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Connecting to local and IP networks

Set up a LAN (local area network) with an Ethernet switch, router, and modem or gateway. The 
Ethernet switch can be integrated into the router. Connect a computer to the LAN for 
configuring the TalkSwitch unit and other equipment. Optional IP phones can be connected as 
well. Use the provided RJ-45 Ethernet cable to connect the TalkSwitch unit to the LAN. To 
ensure reliability, all equipment should be connected to a UPS (uninterrupted power supply).

Figure 17: Local and IP network setup

Connecting a VoIP gateway

In order to connect to a TalkSwitch VoIP network, a location can use a SIP-compatible VoIP 
gateway instead of a VoIP-enabled TalkSwitch unit. For example, the Mediatrix® 2102 is a 
TalkSwitch-certified third-party VoIP gateway that is suitable for small branch offices 
or teleworkers. 

Confirming network capacity

Ensure the LAN in each location has a reliable high-speed broadband connection to the Internet 
or private IP network. The quality of VoIP calls, especially on mixed voice and data networks, 
depends on high data-transfer rates across the network. The limiting factor is the upstream 
bandwidth to the ISP (Internet Service Provider). ‘Lite’ broadband connections (128 Kbps or less) 
are not suitable for simultaneous voice and data traffic.

To test the VoIP call capacity based on your Internet connection speed, perform the test found 
in the support section at http://global.talkswitch.com.

CONFIGURING IP ADDRESSES

Starting the TalkSwitch management software

1. Double-click the TalkSwitch Configuration 6.11 icon on your desktop. You can also select 
Start > Programs > TalkSwitch 6.11 > TalkSwitch Configuration 6.11. The TalkSwitch 
Management Software window appears, and the software attempts to detect your 
TalkSwitch unit.

2. Select your language. You can select English, Français or Español.

3. Once the software detects your TalkSwitch unit, click Configure Auto-Detected TalkSwitch 
System. The About page appears.
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Setting the system IP settings

Each TalkSwitch unit must be configured with a local IP address. These addresses are used to 
direct VoIP calls to the appropriate location.

1. Select the IP Configuration page. By default, Obtain IP and DNS information automatically 
is selected and the area shows IP addresses from the router.

2. Change Obtain IP and DNS information automatically to Use configured IP and DNS 
information in order to lock in the IP addresses.

3. In some cases, the System IP Settings area may be blank because your router has not 
delivered the IP addresses. If so, enter the following IP addresses from your 
LAN administrator:

a) Enter a static IP address for each TalkSwitch unit in the Unit IP address boxes.

b) Enter the Subnet mask for the LAN. This address determines the subnet that the unit IP 
addresses belong to.

c) Enter the IP address of the Default gateway on your network. A gateway is a hardware 
device that connects the office network to the Internet. The router may act as 
default gateway.

d) Enter the IP address of the Preferred DNS server. DNS is a service that is used to resolve a 
domain name to an IP address. The router may act as DNS server.

e) If applicable, enter the IP address of the Alternate DNS server.
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Setting the public IP address

If you are setting up an external IP extension, or the SIP server of a TalkSwitch VoIP network, 
you must configure a public IP address for the TalkSwitch system. Some service provider VoIP 
networks also require the TalkSwitch system to have a public IP address.

1. Set the Type of public address. Choices are:

• Dynamic public IP address — This is the default setting. Your ISP (Internet Service 
Provider) will assign different public IP addresses to your location. The TalkSwitch 
system will check its public IP address every few minutes. When the public IP address 
changes, the TalkSwitch system will automatically use the new one, in order to manage 
VoIP calls properly.

If Dynamic public IP address is selected, the window completes the Current public IP 
address, and sets Public IP address-checker server name to checkip.talkswitch.com. This 
server runs an IP checker application that provides public IP addresses to 
TalkSwitch systems.

• Static public IP address — A static IP address is fixed. Your Internet Service Provider 
assigns the static IP address. If this location will have the SIP server for a TalkSwitch 
VoIP network, we recommend using a static IP address.

If Static public IP address is selected, the window allows you to enter the Current public 
IP address, and disables the Public IP address-checker server name box.

2. If you selected Dynamic public IP address, enter the Fully qualified domain name (FQDN). Get 
the FQDN from your ISP. 

A DDNS (Dynamic Domain Name Service) provider such as www.dyndns.com matches your 
dynamic IP addresses to your FQDN, so your TalkSwitch VoIP network or external IP phones 
will continue to work when the IP address changes.
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If your router supports DDNS, ensure it supports your DDNS provider, and configure it to 
update the DNS servers.

If your router does not support DDNS, download one of the applications specified on 
www.dyndns.com. To update the DNS servers, the application needs to run on a PC 
connected to the same LAN as the TalkSwitch system.

3. If you selected Static public IP address, enter the Current public IP address from your 
Internet Service Provider. Leave the Fully qualified domain name box blank.

If the TalkSwitch unit is not behind a router, or if a private virtual network is used, the 
public IP address is the local IP address of the TalkSwitch unit acting as local proxy.

Note that it will take up to one minute for the new static public IP address to take effect.

4. Record the Current public IP address or the Fully qualified domain name.

If you are setting up an external IP extension, you will need the public IP address or FQDN of 
the TalkSwitch system.

If you are setting up a TalkSwitch VoIP network, the TalkSwitch profiles of the SIP clients 
must be configured with the public IP address or FQDN of the SIP server.

CONFIGURING THE ROUTER

The Router Port Forwarding area of the IP Configuration page displays the type of gateway 
device (i.e. the type of router), the IP address of the gateway (i.e. router), and whether router 
configuration is required.

A router is a gateway between the local area network and the Internet. Most routers have a 
firewall to block unwanted data from the Internet. For voice data to reach the TalkSwitch system 
through the firewall, port forwarding is required. Port forwarding allows the router to map ports 
to the IP addresses of the TalkSwitch units. Valid Internet data will use the ports to go through 
the firewall to the TalkSwitch units.

If you are setting up external IP extensions, a TalkSwitch VoIP network, or a VoIP service that 
doesn’t handle port forwarding, port forwarding is required.

If port forwarding is required, and your router supports uPNP (Universal Plug and Play), ensure 
uPNP is enabled. The TalkSwitch system will use uPNP to automatically set up port forwarding, 
and the Automatic (uPNP Enabled) link will appear. No router configuration is required.

If port forwarding is required but your router doesn’t support uPNP, or automatic port 
forwarding doesn’t work, the Manual Port Mapping Required link will appear. You will need to 
configure the router as described below.

1. Select the IP Configuration page.
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2. If required, click the Manual Port Mapping Required link. The Manual Port Mapping 
window appears. It lists the packet type, port number, IP address and protocol of each 
required port.

3. To access the router configuration:

a) Click the link containing the IP address of the gateway. The default browser starts, and 
prompts you for the router’s user name and password.

b) Enter the router’s user name and password. The browser shows a setup screen.

c) Navigate to the screen used to set up port forwarding. See your router documentation.

d) Set up port forwarding using the information from the Manual Port Mapping window. 
See your router documentation for instructions on how to map ports. For information on 
configuring routers and mapping ports, visit http://www.portforward.com/english/
routers/port_forwarding/routerindex.htm.

4. To check the status of each port through the firewall, click Check Firewall. The Test 
Firewall window appears.

5. Select the services you want to check.

6. Click Test Ports. The system will check the ports for the selected services.
V O I P  I N F O R M A T I O N 216

http://www.portforward.com/routers.htm
http://www.portforward.com/routers.htm
http://www.portforward.com/routers.htm


Configuring the router manually

If you cannot access the router configuration through the IP Configuration page, configure the 
router manually.

1. Open the router configuration and navigate to the screen used to set up port forwarding. 
See your router documentation.

2. Map port 5060 (Type: UDP) to the TalkSwitch unit acting as local proxy. Port 5060 is the 
default port for forwarding SIP signaling data to the TalkSwitch system.

If required, you can map a different port. In this case, enter the port in the SIP signalling 
port box of the VoIP Settings window.

3. Map the following ports (Type: UDP) to the TalkSwitch units. These RTP ports forward voice 
traffic to the TalkSwitch system by default. 

If required, you can map different ports. In this case enter the first port in the Starting RTP 
port box of the VoIP Settings window.

4. If you are setting up external IP extensions, map port 69 (Type: UDP) to the TalkSwitch unit 
acting as local proxy. Port 69 allows the TalkSwitch system to configure external 
IP extensions.

5. If you are setting up TalkSwitch IP phones as external IP extensions, map port 8484 (Type: 
TCP) to the TalkSwitch unit acting as local proxy. Port 8484 allows the TalkSwitch system to 
configure TalkSwitch IP phones as external IP extensions.

6. Map port 9393 (Type: TCP) to the TalkSwitch unit acting as local proxy. Port 9393 allows 
remote configuration of the TalkSwitch system.

7. If available, enable Quality of Service (QoS) to give voice traffic priority over data.

8. Save the configuration to the router.

EXTERNAL IP EXTENSIONS

An external IP extension is an IP phone located outside the office. It is configured as a local 
extension of a TalkSwitch system, but connects to the system over the Internet or private data 
network. A user can receive or place a call with their external IP extension through the 
TalkSwitch unit to the standard telephone network, or to a VoIP network. An external IP 
extension requires at least one VoIP-enabled TalkSwitch unit at the office.

VoIP Lines/Unit Unit 1 Unit 2 Unit 3 Unit 4
4 6000–6006 6010–6016 6020–6026 6030–6036
8 6100–6114 6200–6214 6300–6314 6400–6414

Warning: Using an external IP extension to call an emergency service number will not send 
the correct address to the emergency operator. We strongly recommend that you apply a 
warning label to any external IP extension stating:

If an emergency call is made from this phone, you must provide your address to the 
emergency operator.
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For example, the following illustration shows external IP extension 151 at a home office, and 
152 at a branch office. The external IP extensions connect to the TalkSwitch unit at the main 
office over the Internet. In this example, a user can receive or place a call with their external IP 
extension through the TalkSwitch unit to the standard telephone network.

Figure 18: External IP extensions

Before proceeding, ensure you have:

• Connected the TalkSwitch system at each location to a network (page 211).

• Configured local and public IP addresses (page 212).

• Configured the router (page 215).

To set up an external IP extension, use the following steps:

1. Add the external IP extension, as described in Adding IP phoneS on page 81. Procedures are 
available for adding TalkSwitch, Polycom, Grandstream, Counterpath and selected other 
phones (depending on the market).

2. Verify operation of the external IP extension:

a) Select the Local Extension/Fax page.

b) Select the external IP extension.

c) Confirm Registered is Yes, and the Phone’s IP address appears in the IP Extension 
Details area.  

3. Optionally, perform advanced VoIP configuration:

a) All VoIP lines are shared by default. You can reserve VoIP lines for the external IP 
extensions. See Reserving VoIP lines on page 229.

b) External IP extensions will use the preferred codec selected for the TalkSwitch profile. 
The default preferred codec is G.729. You can select the Preferred codec for the 
TalkSwitch profile. See Setting codec options on page 226.
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TALKSWITCH VOIP NETWORK

A TalkSwitch VoIP network has at least one SIP device at each location. A SIP device is a VoIP-
enabled TalkSwitch unit, IP telephone or SIP gateway. One TalkSwitch unit in the network acts 
as the SIP server. The other SIP devices are SIP clients.

A user, auto attendant or call cascade can dial a three-digit VoIP number (ranging from 250 to 
299) to reach an extension, auto attendant or voice mailbox at any location. 

For example, the following illustration shows a TalkSwitch VoIP network with two locations. Calls 
between the offices are routed over the Internet, and local calls are routed over the traditional 
telephone network.

Figure 19: TalkSwitch VoIP network

Five VoIP numbers are assigned to San Francisco (251 to 255), and nine are assigned to New York 
(261 to 269). These VoIP numbers can be dialed directly from any extension, auto attendant or 
call cascade in the network.

The TalkSwitch unit in the San Francisco office has a static public IP address, so is designated as 
the SIP server. The TalkSwitch unit in New York is a SIP client.

Before proceeding, ensure you have:

• Connected the TalkSwitch system at each location to a network (page 211).

• Configured local and public IP addresses (page 212).

• Configured the router (page 215).

SETTING UP A TALKSWITCH PROFILE FOR THE SIP SERVER

The TalkSwitch profile for the SIP server shows registration details and contains 
authentication information.

1. Start the TalkSwitch management software, and connect to the TalkSwitch system that will 
act as the SIP server.

2. Select the VoIP Configuration page.
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3. Select Profile TS, which is for configuring the TalkSwitch profile.

4. Select the This TalkSwitch location is the proxy/registrar check box.

5. Set Registrar authentication to Yes (digest). This restricts access and allows only authorized 
devices to connect.

6. Enter a User/account name. All SIP clients must use this name.

7. Enter a Password. All SIP clients must use this password.

8. If you configured the router with non-default ports:

a) Choose Options > VoIP Trunking. The VoIP Settings window appears.

b) Set the SIP Signalling Port and/or Starting RTP Port as required.

SETTING UP A TALKSWITCH PROFILE FOR A SIP CLIENT

The TalkSwitch profile for a SIP client contains registration details and 
authentication information.

1. Start the TalkSwitch management software, and connect to the TalkSwitch system that will 
act as the SIP client.

2. Select the VoIP Configuration page.
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3. Select Profile TS, which is for configuring the TalkSwitch profile.

4. Leave the This TalkSwitch location is the proxy/registrar check box cleared.

5. Enter the Current public IP address or Fully qualified domain name (FQDN) of the SIP server 
into the Proxy/registrar server name box.

If the SIP server is using a non-default SIP signalling port (i.e. if the SIP server is not using 
5060 as the SIP signalling port), specify the port number after a colon at the end of the 
public IP address or FQDN (e.g. 123.45.67.89:3456).

6. Enter the User/account name from the SIP server. All SIP clients must use this name.

7. Enter the Password from the SIP server. All SIP clients must use this password.

CONFIGURING VOIP NUMBERS FOR A TALKSWITCH VOIP NETWORK

A VoIP number is like a telephone number, and is used to dial a TalkSwitch system at a particular 
location. Each VoIP number must be unique (i.e. only used at one location).

VoIP numbers 250 to 299 permit direct dialing from any extension, auto attendant or call 
cascade to any extension, auto attendant or voice mailbox in the TalkSwitch VoIP network. No 
hunt group number is required. Longer VoIP numbers can also be used, but the user must first 
dial a hunt group number.

To assist in assigning VoIP numbers for your network, use the TalkSwitch VoIP network 
administration form on page 234. 
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1. Select the VoIP Numbers page.

2. Select a VoIP number slot.

3. Select the Activate VoIP Number check box.

4. Set the VoIP profile to TalkSwitch.

5. Enter the VoIP number into the Phone number box.

6. Set up call handling for the VoIP number. For more information, click the Help icon ( ) in 
the Call Handling area.

7. Repeat steps 2 to 6 for each additional VoIP number.

SETTING UP LINE HUNT GROUPS

If a VoIP-enabled TalkSwitch unit is present, hunt group 88 uses the TalkSwitch VoIP network by 
default, and the other hunt groups use telephone lines. You can modify these default settings as 
described on page 228.

Note that the user does not have to dial the hunt group number before VoIP numbers 250–299: 
these automatically use the TalkSwitch VoIP network.

If 50 VoIP numbers aren’t enough for the network, you can set up longer VoIP numbers. To reach 
a longer VoIP number, the user will first dial a hunt group number.

A local extension can be restricted to a set of hunt groups in order to control access to VoIP 
networks. See Hunt group permissions on page 64.

IMPORTANT: Ensure that hunt group 9 or 0 is assigned to the group of telephone lines or VoIP 
trunks used for calls to emergency services.
V O I P  I N F O R M A T I O N 222



ADVANCED VOIP CONFIGURATION

Optionally, perform advanced VoIP configuration.

1. The default preferred codec is G.729. You can select the Preferred codec for the TalkSwitch 
profile. All locations must use the same codec. See Setting codec options on page 226.

2. VoIP calls use extension names for caller ID by default. You can set the source for VoIP caller 
ID at each location. The same setting will be used by the TalkSwitch profile and all service 
provider profiles. See Setting up caller ID on page 229.

3. All VoIP lines are shared by default. You can reserve VoIP lines for the TalkSwitch profile at 
each location. See Reserving VoIP lines on page 229.

SAVING SETTINGS TO TALKSWITCH

To transfer settings from your computer to the TalkSwitch system, choose File > Save. A window 
appears indicating the configuration is being sent.

VERIFYING THE TALKSWITCH VOIP NETWORK

If you are configuring the TalkSwitch profile for the SIP server, the window enables the View 
Registrar Entries button. Clicking the button shows the Registrar Entries window with a list 
of VoIP numbers, their IP addresses and port numbers, and the number of seconds until their 
registrations with the SIP server will expire.

1. Select the VoIP Configuration page.

2. Select Profile TS, and then click View Registrar Entries. The Registrar Entries 
window appears.

SERVICE PROVIDER VOIP NETWORK

Using a service provider VoIP network requires at least one VoIP-enabled TalkSwitch unit. The 
service provider acts as the SIP server. The service provider assigns the VoIP numbers and VoIP 
configuration parameters.
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For example, the following illustration shows a service provider VoIP network.

Figure 20: Service provider VoIP network

To reach an outside party, the user dials the hunt group number associated with the service 
provider profile, and then dials the phone number. The TalkSwitch unit routes the call over the 
Internet to the service provider. If the outside party doesn’t use the same service provider, they 
are connected over the standard telephone network. If the outside party does use the same 
service provider, they are connected over the Internet.

To reach a local extension, an outside party dials the VoIP number that was assigned to the 
TalkSwitch system by the service provider. The call is routed through the telephone network to 
the service provider. The service provider routes the call over the Internet to the TalkSwitch 
system, which directs the call to the local extension.

Before proceeding, ensure you have:

• Connected the TalkSwitch system at each location to a network (page 211).

• Configured local IP addresses (page 212), and public IP addresses if required.

• Configured the router (page 215).

SETTING UP A SERVICE PROVIDER PROFILE

If you are using a TalkSwitch-certified VoIP service provider, visit the support section at http://
global.talkswitch.com to access the service configuration guide for your VoIP service provider. 
Otherwise use the procedures in this section.

A service provider profile contains the registration details for connecting to the service 
provider’s SIP server.

1. Start the TalkSwitch management software.

2. Select the VoIP Configuration page.
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3. Select a Profile (SP 1 to SP 4), which are for configuring service provider profiles.

4. Select the Activate Profile check box.

5. Enter the Profile name. The default profile name is Service provider n (e.g. Service provider 1).

6. If your service provider requires you to register using your private IP address, select the 
Disable public IP address substitution check box.

7. If your service provider requires you to set up keep alive messages, and if your router does 
not support uPNP, set up keep alive messages.

Keep alive messages maintain the connection from the TalkSwitch unit, through your router, 
to the service provider’s SIP server.

a) Select the Enable NAT keep alives check box.

b) Click Settings. The Keep Alive Settings window appears.

c) Select the type of ping, as directed by your service provider. Choices are:

• Simple ping — A standard ping message that works with all SIP servers.

• Nortel ping — A longer but more reliable ping message that only works with specific 
Nortel SIP servers (e.g. Nortel MCS 5200).

d) If necessary, change the ping frequency, as directed by your service provider. The default 
setting is 45 seconds.

8. Enter the IP addresses or FQDNs, as provided by the service provider, into the following 
boxes. If the service provider does not specify a value, leave the box blank.
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• Proxy server name
• Registrar server name
• Outbound proxy
• Realm/domain

SETTING CODEC OPTIONS

If you are using a TalkSwitch-certified VoIP service provider, visit the support section at http://
global.talkswitch.com to access the service configuration guide for your VoIP service provider. 
The service configuration guide lists the supported codecs.

A codec is a method of compressing and decompressing audio signals for communication across 
a network. TalkSwitch supports the G.729, G.726 and G.711 (µ-law or A-law) codecs for VoIP 
calls. If your service provider or equipment requires specific codecs for VoIP or Fax over IP calls, 
you can restrict TalkSwitch to use the required codec.

The Codec Options window allows you to select the codecs your system can use, specify the 
preferred codec, and clear the unsupported codecs. You can specify the codecs for the 
TalkSwitch profile, and for each service provider profile. External IP extensions will use the 
preferred codec specified in the TalkSwitch profile.

1. Select the VoIP Configuration page.

2. Click Codec Options. The Codec Options window appears.

3. Select the codecs your system can use, and clear the unsupported codecs. The following 
codecs are supported:

• G.729 — This codec provides good quality. It requires the least bandwidth and 
accommodates the highest number of concurrent calls.

• G.726 — This codec provides better quality. It requires more bandwidth and 
accommodates fewer concurrent calls.

• G.711µ and G.711A — This codec provides high quality and supports Fax over IP. It 
requires the most bandwidth and accommodates the fewest number of concurrent calls. 
G.711µ is used in North America and Japan. G.711A is used elsewhere.

4. Select the Preferred codec. G.729 is the default codec.

5. Set Voice activity detection (VAD). Enabling VAD reduces voice bandwidth when no speech is 
detected, and reduces transmission of background noise. We recommend disabling VAD to 
keep bandwidth available for speech.
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CONFIGURING VOIP NUMBERS FOR A SERVICE PROVIDER VOIP NETWORK

If you are using a TalkSwitch-certified VoIP service provider, visit the support section at http://
global.talkswitch.com to access the service configuration guide for your VoIP service provider. 
Otherwise use the procedures in this section.

A VoIP number is like a telephone number, and is used to dial a TalkSwitch system at a particular 
location. Your service provider will assign VoIP numbers for each location.

1. Select the VoIP Numbers page.

2. Select a VoIP number slot.

3. Select the Activate VoIP Number check box.

4. Set the VoIP profile to the service provider (e.g. My Service Provider).

5. Enter the Country Code (if required), the City or Area Code and the Number.

6. Enter the User/account and the Password (if required) for this number.

7. Set up call handling for the VoIP number. For more information, click the Help icon ( ) in 
the Call Handling area. 

8. Repeat steps 2 to 7 for each additional VoIP number.
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SETTING UP LINE HUNT GROUPS

A line hunt group is a set of lines that are available for making an outbound call. It can use 
selected telephone lines, all VoIP lines associated with the TalkSwitch VoIP network, or all VoIP 
lines associated with a service provider VoIP network.

The configuration has nine different hunt groups. If a VoIP-enabled TalkSwitch unit is present, 
hunt group 88 uses the TalkSwitch VoIP network by default, and the other hunt groups use 
telephone lines. You can modify these default settings as required. If you are using multiple 
service provider VoIP networks, set up a hunt group for each service provider.

A local extension can be restricted to a set of hunt groups in order to control access to VoIP 
networks. See Hunt group permissions on page 64.

1. Select the Line Hunt Groups page.

2. Select a hunt group slot.

3. If necessary, select Activate Hunt Group. All hunt groups are active by default.

4. Enter a Hunt Group name. 

5. Set Line type to TalkSwitch VoIP or SPn VoIP Service.

6. Select the overflow hunt group. Choices are no overflow and the other activated hunt groups. 
If you select an overflow hunt group, ensure it contains different lines than the original 
hunt group.

IMPORTANT: Ensure that hunt group 9 or 0 is assigned to the group of telephone lines or VoIP 
trunks used for calls to emergency services.
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ADVANCED VOIP CONFIGURATION

Optionally, perform advanced VoIP configuration.

Setting up caller ID

The VoIP Caller ID area allows you to set up the source for caller ID for outbound VoIP calls. The 
same setting is used for the TalkSwitch profile and all service provider profiles. Extension names 
are used by default.

1. Select the VoIP Configuration page.

2. Set the caller ID for outbound VoIP calls.

• To use the System name from the Administration page, select Use System Name in caller 
ID information for all outgoing VoIP calls.

• To use the First name and Last name from the Local Extension/Fax page set up for each 
extension, select Use Extension Names in caller ID information for all outgoing VoIP calls.

Reserving VoIP lines

By default, all TalkSwitch VoIP lines are available for external IP extensions, TalkSwitch VoIP 
network calls, and/or service provider calls on a first-come first-served basis. You can also 
reserve VoIP lines for a specific use. For example, you can set aside two lines for external 
IP extensions.

Reserving VoIP lines guarantees resources for a specific network. Sharing VoIP lines uses them 
most efficiently.

1. Select the VoIP Configuration page.

2. Click Reserve VoIP Lines. The VoIP Resource Reservation window appears.
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3. Select the number of VoIP lines to set aside for each service. Choices range from 1 to the 
number of unreserved VoIP lines at this location. Shared means no VoIP lines are reserved for 
this service. Only unreserved lines will be available.

SAVING SETTINGS TO TALKSWITCH

To transfer settings from your computer to the TalkSwitch system, choose File > Save. A window 
appears indicating the configuration is being sent.

VERIFYING REGISTRATION

Clicking the View All Registrations button shows a window with a list of VoIP numbers, their 
registration status, and the number of seconds until their registrations with the SIP server will 
expire. This confirms the TalkSwitch system is registered with a SIP server.

1. Select the VoIP Configuration page.

2. Click View All Registrations. The Registration status window appears.

3. Choose All Registered Numbers or an active profile.

FAQ

How does VoIP work?

Voice over IP (VoIP) sends calls over the Internet or any Internet Protocol (IP) network by 
converting voice traffic into data packets. These packets are routed over the IP network the 
same way as other data, reassembled at the point of arrival, and then converted back to voice.

Does a VoIP call sound like an analogue phone call?

Under the right conditions, VoIP calls sound as good or better than analogue phone calls. Voice 
quality is affected by numerous factors, including how it is compressed and decompressed for 
delivery over the Internet and how packets are processed. A few steps can help ensure 
call quality. 
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• Use high-speed connections on both ends of the call
VoIP requires a broadband connection to support simultaneous calls. Please visit the support 
section of our site at http://global.talkswitch.com to determine what your Internet 
connection can support. Good quality VoIP is not possible over a dial-up modem connection.

• Choose the right codec for your location

• The default codec is G.729 (8 Kbps), using approximately 25 Kbps bandwidth upstream 
and 25 Kbps bandwidth downstream for each call. G.729 provides very good call quality 
while minimizing bandwidth usage. 

• The G.726 (32 Kbps) codec is a better quality solution compared to the G.729 codec. 
However, it requires more bandwidth per call. A G.726 call typically requires 50 Kbps 
bandwidth upstream and 50 Kbps bandwidth downstream for each call. 

• The G.711 (64 Kbps) codec provides the best voice quality. The trade-off is the 
bandwidth requirement. G.711 calls typically require up to 100 Kbps bandwidth 
upstream and 100 Kbps bandwidth downstream. 

What happens if the power goes out or if the IP network to VoIP fails?

To ensure a reliable network connection, all elements of the VoIP network should be connected 
to back-up power supplies (UPS). These elements should include LAN switches, routers, firewalls, 
broadband connection devices (i.e. cable modems, DSL modems), and VoIP devices. If the power 
goes out at the Internet Service Provider, no VoIP calls can be made. Calls can still be placed over 
the telephone lines.

Can a firewall prevent VoIP calls from passing through?

The purpose of a firewall is to control what kind of traffic enters and leaves your network. The 
TalkSwitch unit is designed to allow VoIP calls to traverse firewalls properly. To allow VoIP calls 
to pass through your firewall, you may need to use the port forwarding feature on your firewall.

What is SIP?

The Session Initiation Protocol (SIP) is a signalling protocol used for establishing sessions in an 
IP network. A session could be a simple 2-way telephone call or it could be a collaborative multi-
media conference session. 

Over the last couple of years, the Voice over IP community has adopted SIP as its protocol of 
choice for signalling. SIP is an RFC standard (RFC 3261) from the Internet Engineering Task 
Force (IETF). This is the body responsible for administering and developing the mechanisms that 
comprise the Internet.

The IETF’s philosophy is simplicity: specify only what you need to specify. SIP just initiates, 
terminates and modifies sessions.

TalkSwitch phone systems use the Appello® SIP Stack for VoIP communications. The Appello® 
SIP Stack was developed by TalkSwitch, a division of Centrepoint Technologies Inc.

What is a VPN? 

VPN stands for Virtual Private Network. It is a means of having the advantages of a private 
network on a shared public infrastructure like the Internet. 
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Can a VPN help to carry data securely over the Internet?

A VPN provides security by using encryption/decryption. Using a process called tunneling, 
private data is encrypted and encapsulated before being sent across the network. The packets of 
information are sent to their destination. Only the ones with the correct protocol information 
can enter a company’s network.

A VPN is most useful for providing employees with remote access to the company network 
without compromising security. Encryption can have a negative impact on the call quality 
because of the increased overhead on the network connection. IPSec adds approximately 10% 
overhead to VPN traffic.

What’s the difference between a public IP address and a private IP address?

A public IP address is a globally unique number that identifies a device on the Internet. If you 
want someone on the Internet to connect to you, they must know your public address. This is 
also known as your real or external address.

A private IP address is typically assigned to a device on a Local Area Network (LAN) and cannot 
be routed outside the LAN. Private IP addresses are usually in the range 192.168.x.x, 172.16.x.x 
or 10.x.x.x. These IP addresses are used where you have multiple computers all sharing the same 
Internet connection. 

To access the Internet, a computer or VoIP device must have an IP address. So what do you do if 
your ISP (Internet Service Provider) has provided you with only one IP address but you have 
more than one device that requires Internet access? The solution is to give each of the devices 
on the LAN a private IP address. A router makes them work by performing Network Address 
Translation (NAT — See the next topic for details). 

Addresses of the form 192.168.x.x, 172.16.x.x or 10.x.x.x are not recognized on the Internet 
and can only be used for private networks. For example, if you tell someone on the Internet to 
connect to you using a 192.168.x.x address, it will not work. Instead, you must provide your 
real/public IP address.

What is NAT and how does it affect VoIP?

Network Address Translation (NAT) allows multiple devices to share the same external IP address 
to access resources on the Internet. NAT is typically used to allow all the devices in a 
subscriber’s local area network to access the Internet through a router with a single public IP 
address assigned by the Internet Service Provider.

If a VoIP device is sitting behind a router that performs NAT, the private IP address assigned to 
the VoIP device is not usable for communications with the entities outside the private network. 
The VoIP device must substitute the private IP address information with the proper external IP 
address/port in the mapping chosen by the underlying NAT to communicate with a particular 
public peer address/port. TalkSwitch can automatically check for the current public IP address 
and substitute the private IP address with the public address so that VoIP traffic is properly 
routed through NAT.

What’s the difference between a static IP address and a dynamic IP address and what effect
does this have on VoIP?

A static IP address is an address that is permanently assigned to a device. Typically, a static IP 
address has to be assigned by the network administrator or Internet Service Provider (ISP). 

A dynamic IP address is an address that is temporarily assigned to devices by a DHCP or PPP 
server that maintains and assigns a pool of IP addresses.
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When deploying VoIP devices, it’s best to have a static public IP address. This prevents 
destinations from becoming unreachable for periods of time when the IP address changes. But 
since this can be an expensive option, TalkSwitch supports the ability to handle dynamic public 
IP addresses for the Internet connection. TalkSwitch automatically checks for the current public 
IP address and substitutes the private IP address with the public address, so that VoIP traffic is 
properly routed through NAT.

What is a SIP server?

The basic IP architecture is client/server in nature. The main entities in the SIP server are the 
proxy, redirect server and the registrar.

Every TalkSwitch unit has a fully integrated SIP server for easy deployment and maintenance of 
your VoIP network. If you are deploying a multi-site configuration, one TalkSwitch unit will act 
as the SIP server for the entire VoIP network. The other IP end-points will register with the SIP 
server and all calls will be negotiated through the SIP server.

When you first set up your VoIP device (TalkSwitch unit, gateway or phone), it will register 
itself with the SIP server so calls can be directed to your location. 

When you initiate a VoIP call, your VoIP device will contact the SIP server in order to obtain the 
contact information for the destination you are trying to reach. Once the contact information is 
received, the call is established directly between your location and the destination. The SIP 
server is no longer involved in the call.

If the location of the SIP server has a dynamic IP address, you have to use the dynamic DNS 
since the location of the SIP server becomes unreachable as soon as the IP address changes.

What is dynamic DNS?

Dynamic DNS is a Domain Name Service used with dynamic IP addresses. DNS is used to allow 
devices to find other devices on the Internet by domain name rather than by IP address. 
Dynamic DNS allows you to use a Fully Qualified Domain Name (FQDN) to locate a device with a 
dynamic IP address. The FQDN does not change. There are companies on the Internet who can 
provide you with a domain name that will work even if your IP address changes. Such companies 
are www.dyndns.org, hn.org or www.no-ip.com. Please consult with them how to use their 
service. The basic idea is you will receive a domain name like myname.homeip.net, which will 
continue to point to your IP address as it changes. This is important for the location of the SIP 
server if the public IP address is dynamic. All other locations will point to the SIP server’s 
domain name instead of its IP address.

What is the drawback of using dynamic DNS?

If the IP address of the location of the SIP server changes, but the new IP address hasn’t been 
propagated, other devices will not be able to contact the SIP server in order to place VoIP calls. 

When DNS records are updated, they have to be sent all over the world so everyone will be aware 
of the changes. Basically, one DNS server connects to another and swaps information. In many 
cases, the DNS servers are updated very quickly. Updates should not take longer than 15 
minutes to propagate throughout the DNS system. It is possible propagation could take longer 
due to unforeseen traffic but it shouldn’t take much more than an hour at the most. 
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How often will my public IP address change?

This depends on the policies of your Internet Service Provider (ISP, the company that provides 
your Internet access). It can be a matter of days, weeks or even months before your IP address 
changes. A power loss or reboot to your cable or DSL modem usually results in the assignment of 
a new IP address. 

TalkSwitch has technology that helps keep this information up to date so the system can 
function properly after an IP address change has been detected and updated.

What is a port number?

In an IP address like 64.26.209.103:5060, the port number is 5060; it is the number after 
the colon. 

Port numbers are required so a computer or device can support multiple applications or streams 
of simultaneous data communication. Each stream or application uses a unique port number. 
You can think of it like mailing a letter to a friend in an apartment building at a specific 
address. You need to specify the apartment number as well as the address of the building, so the 
mail can reach the correct final destination.

TALKSWITCH VOIP NETWORK ADMINISTRATION FORM 

Use this form to keep track of VoIP numbers assigned to locations within a TalkSwitch 
VoIP network.

Location of the SIP server:__________________________________________

Equipment at the SIP server location:_________________________________

VoIP numbers assigned to the SIP server location:_______________________

VoIP numbers assigned to locations

Location name Equipment VoIP numbers
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C H A P T E R  6
Ch ap ter  6:  Trou bl esh oot ing  an d Sup p ort

TROUBLESHOOTING AND SUPPORT 

TROUBLESHOOTING

Solutions to the following problems are described in this chapter:

• Configuration

• Auto attendant

• Music on hold

• Call routing

• Answering and fax machines

• Local extensions

• Multiple TalkSwitch units

• VoIP

Some problems might be due to physical connections such as loose cables. Before you start to 
analyze possible configuration issues. See Verifying the connections on page 21.

Configuration

I am not able to retrieve settings from TalkSwitch

1. Reboot TalkSwitch. On the TalkSwitch front panel, turn the power button off and back on.

2. Make sure you do not have any communications programs running at the same time you are 
using the TalkSwitch management software. These can include Palm Pilot, Hot Sync, 
TalkWorks, digital camera software or others. These programs tend to occupy COM ports, 
making them unavailable for other programs.

I am unable to configure TalkSwitch using a touchtone phone 

1. You cannot configure TalkSwitch using a phone sharing the same line in parallel. You have 
to configure TalkSwitch using one of the extensions plugged into the back panel 
of TalkSwitch. 

2. You cannot configure TalkSwitch using touchtone keypad commands while the TalkSwitch 
management software is open. If the software is closed and you hear the prompt “I’m sorry, 
TalkSwitch is currently being configured”, reboot TalkSwitch by turning the power off and on. 
Wait until the lights stop flashing and the Data light is on solid. 

3. If you are using a local extension, check if the extension has direct line access to your 
telephone lines. If direct line access is enabled, press Recall on an analogue extension or ** 
on a IP extension to receive an internal dial tone. Press # to enter command mode. Enter the 
correct password, if you have password protection.
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4. From an out-of-office phone, call into TalkSwitch and wait for the auto attendant. Enter 
command mode by pressing # on an analogue extension phone, or *55# on an IP phone.. 
Enter the correct password, if you have password protection. 

Auto attendant

The auto attendant does not play when calls come in

1. Check if the line light on an incoming call is flickering while the phone is ringing. If not, 
replace the phone cord.

2. Make sure you have an auto attendant message recorded.

3. Ensure the system is running the correct mode. Open the TalkSwitch management software. 
Select Scheduling. Check the Current mode in the Modes area.

4. Ensure the telephone line has the correct auto attendant setup. Select Telephone Lines. 
Ensure the right auto attendant is selected for the mode, telephone number, and telephone 
line. Try setting the auto attendant to answer Immediately.

The auto attendant message is broken up or very faint

1. Open the TalkSwitch management software. Choose Troubleshooting > Telephone Lines > 
Audio. Adjust the Transmit levels volume setting.

2. The quality of the microphone in the telephone handset you used to record your auto 
attendant can affect the quality of your recording. Try recording the auto attendant from 
another extension/telephone.

The auto attendant answers calls before any of the extensions ring

If TalkSwitch users wish to have their local extensions ring before the auto attendant picks up 
incoming calls, do the following:

1. Open the TalkSwitch management software. Select Telephone Lines. Select the telephone 
line, telephone number, and mode. Click Edit. Increase the number of rings. 

The auto attendant is transferring calls to the wrong extension

1. Check if the extension jacks of your devices (phones, faxes) are plugged into the 
corresponding jacks on the TalkSwitch back panel (i.e. extension 111 is plugged into E1).

The auto attendant answers calls, but does not transfer them to the extensions

1. Make sure your extensions are plugged into the extension jacks on the back panel of 
TalkSwitch (instead of your telephone wall jacks).

2. Open the TalkSwitch management software. Expand Auto Attendants (Menus). In the 
Actions During Auto Attendant Playback area, check if the actions and resources point to the 
correct extensions.

Music on hold

Callers hear the “One moment please” message and then total silence when the auto
attendant transfers their call to an extension

1. There is a problem with the music source. Check all connections and the power.
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Callers hear only silence when put on hold at an extension

1. Make sure you use the Recall or Link button on an analogue extension, or the Hold button 
on an IP extension, to put callers on hold. If you use the Hold button on an analogue 
extension, callers will be placed on hold at the extension itself and not through TalkSwitch.

2. You have enabled the music on hold feature, but have not attached an audio device to the 
music jack on TalkSwitch.

3. You have enabled play the Play music from file feature but have not loaded a .wav music file 
to TalkSwitch.

Call routing 

Callers are disconnected when transferring calls from one extension to another

1. If you are using the hook switch rather than the Recall button to put callers on hold, you 
may be holding the hook switch down too long and disconnect.

I can’t use my conference/3-way calling feature from the phone company

1. You need to make sure you have checked the box indicating you have 3-Way Calling/
Conference service or the Transfer and Clear service on the appropriate lines in the 
Telephone Lines page.

I’m unable to place intercom calls from a local extension

1. If the local extension has been set up for direct line access to your telephone lines, you need 
to press Recall on an analogue extension, or ** on an IP extension, before intercom calling. 

Answering and fax machines

The answering machine and/or fax machine picks up calls before they can be answered
by telephone extensions

1. Check the ring sequence for the telephone line, telephone number and mode. Ensure the 
extension for your fax machine and/or answering machine is not set to answer calls at the 
same time as your telephone extensions. If necessary, remove the extension for the fax 
machine and/or answering machine from the list of extensions to ring on an incoming call. 

Incoming faxes are not automatically detected and routed to the fax machine

1. Ensure you selected the correct extension in the If a fax call is detected list in the Auto 
Attendants (Menus) page.

2. Not all fax machines emit a CNG tone that TalkSwitch can detect and route. Therefore, you 
may consider incorporating an additional method of fax routing. This could include the use 
of a dedicated fax line or a distinctive ring number.

3. Many fax machines/modems will time-out or disconnect after 25 seconds on average if they 
have not connected with another fax machine/modem. If you set up the Action Performed 
After Auto Attendant Playback area, the fax call may time-out before it reaches your fax 
extension. If you have a long auto attendant message, you may want to shorten it or use 
another fax routing option. 

4. The level of the auto attendant is too loud and is overpowering the CNG tone, affecting the 
detection. Try lowering the volume level of the auto attendant.
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Local extensions

I am unable to access TalkSwitch lines with a local extension

1. Check your direct line access setting in the Additional Settings window of the Local 
Extensions/Fax page. If a local extension has not been given direct line access to your 
telephone lines, you must dial 9 or 81–88 to access a line.

2. Check if Activate automatic route selection is enabled in the Auto Route Selection page. ARS 
can re-direct or block calls.

My PC (internal or external) modem cannot dial out

1. If direct line access to telephone lines is not enabled on the extension where your modem is 
connected, you will have to include a line hunt group prefix (9 or 81–88) before dialling the 
modem number. 

One of the local extensions (telephones) does not ring

1. Some telephones require more voltage in order to ring. These phones are usually the older 
‘Bell’ phones with mechanical ringers. These phones should not be used as 
TalkSwitch extensions.

2. Make sure the telephone cord you are using between the phone and TalkSwitch is 
working properly. 

3. Ensure the ringer is turned on.

Extension(s) ring, but there is no caller

This can occur when a caller hangs up after the auto attendant has begun to play. In some 
areas, the telephone company’s disconnect/clear signal is weak. The auto attendant may not be 
able to pick up the disconnect signal as soon as a caller hangs up. The auto attendant will not 
receive a response after playing its message and the call will fall through to your settings in the 
Action Performed After Auto Attendant Playback area in the Auto Attendants page.

When I try to access voicemail, I hear a busy tone

1. Check your direct line access settings in the Additional Settings window of the Local 
Extensions/Fax page in the TalkSwitch management software. If a local extension has been 
given direct line access to your telephone lines, you must first press Recall on an analogue 
extension, or ** on an IP extension, before dialling the mailbox. The same applies for 
dialling other extensions to initiate intercom calls.

Multiple TalkSwitch units

I can’t reach an extension across the LAN

1. Make sure the other unit is connected to the LAN and powered on.

2. Pick up a local extension belonging to the other unit. If you hear a dial tone, check your 
LAN connections. On the rear panel, the top LED of the three LEDs next to the LAN port 
should be on. If there is no dial tone, make sure the unit is powered on.

The configuration does not show the other TalkSwitch unit(s)

1. Check your LAN connections. Are you able to communicate with another extension on the 
other unit?
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2. Check the unit ID of each unit. If the lights on one or more units are flashing, there is a 
conflict with the unit ID numbers assigned to each TalkSwitch unit. Connect a phone to each 
TalkSwitch unit and lift the handset. It will tell you immediately if a unit ID number needs 
to be assigned. Follow the instructions. You can press #00# to check the unit ID of the unit 
you are connected to. 

After recording an auto attendant greeting, I can’t play it back

1. Try again in a few minutes. After recording an auto attendant on one of the TalkSwitch 
units, it will copy it to other TalkSwitch units on the LAN. During this process, you cannot 
listen to that particular auto attendant.

Calls are not always reaching my voicemail

When the system is in high use, all channels across the LAN might be in use, so calls cannot be 
transferred to extensions or voicemail. If this situation happens frequently, consider optimizing 
the way the system uses the lines.

1. In the Line Hunt Groups page, select the For all hunt groups, hunt lines on same unit first 
check box. This arrangement keeps most of the traffic on unit 1 and any outbound calls 
made from any extension will go out on the same unit the extension is connected to. This 
also applies for inbound calls that are forwarded to remote extensions. The call will be 
forwarded out on a line belonging to the same unit the call came in on. The call will only be 
forwarded on the other TalkSwitch unit if no telephone line on that first unit is available.

2. Ensure frequently used extensions are connected to units with enough lines out to reduce 
LAN traffic.

Example: You have two TalkSwitch units, six telephone lines and 12 employees. The six 
lines have the hunt/rollover service from the phone company. Suggested setup: Plug the 
four highest traffic lines into unit 1. Also, connect the eight highest phone usage employee 
extensions to unit 1. Connect the remaining lines and extensions to unit 2.

Calls across the LAN are lower in volume

1. Check the Telephone Lines - Audio page. You may need to change the transmit level or 
impedance matching on one or more lines to compensate for high loss lines. If these 
controls are set incorrectly and your lines are problematic, you may hear an echo when calls 
are made across the LAN.

 VoIP

I hear a re-order tone when I try to dial a VoIP location

1. Confirm the number dialled is actually part of the VoIP group (i.e. registered with the same 
proxy/registrar server as your TalkSwitch, IP gateway or IP extension is registered with.

2. Ensure TalkSwitch has all proper settings in the IP Configuration and VoIP 
Configuration pages.

3. Ensure the number you are dialling is registered with your TS proxy registrar. Go to the VoIP 
Configuration page and click the View Registrar Entries button.

Callers complain the sound is distorted or choppy

1. Your broadband connection may not have enough upstream bandwidth to support many 
simultaneous VoIP calls. In the Codec Options window, you may need to disable the G.711 
and G.726 codecs and only use G.729.
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2. You may have too much data traffic on your Internet connection at the same time you are 
trying to make voice calls. We suggest you use a router that supports QoS (Quality of 
Service) for VoIP. 

When I call someone or they call me, voice is only heard in one direction

1. The cause of this problem is usually a result of a router being misconfigured with respect to 
port mappings. Ensure all required VoIP ports are mapped to your TalkSwitch unit. Also, 
ensure you use a static private IP address when connected to your router as this can also 
affect port mappings from the firewall/router.

2. Use a router that supports uPnP.

For more VoIP information, see VoIP Information on page 211.

SUPPORT 

If you are having problems with the configuration or operation of TalkSwitch, please read this 
section. If you require further assistance, do one of the following: 

1. Contact your authorized TalkSwitch reseller.

2. Check the FAQ section located in the support area at our website at http://
global.talkswitch.com.

3. Contact our customer support department by e-mail: support@talkswitch.com.

We trust your TalkSwitch telephone system will provide exceptional features, performance 
and value to your business. Should you have any further questions, please contact your 
authorized TalkSwitch reseller. If you purchased directly from TalkSwitch, visit the support 
section at http://global.talkswitch.com.

We welcome your feedback, comments and suggestions. Please e-mail us at 
info@talkswitch.com or write us at TalkSwitch, 1545 Carling Avenue, Suite 510, Ottawa, 
ON Canada K1Z 8P9.

Thank you for choosing TalkSwitch.
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A pp e n di ce s
A pp e n di x  A :  Fun ct i o n s  an d  Co mm a nd s

A P P E N D I X  A

EXTENSION NUMBERS,  FUNCTIONS 
AND COMMANDS

The following tables list extension numbers, functions and commands you can enter with 
a phone.

EXTENSION NUMBERS

The following table lists the local extensions, remote extensions, general voice mailboxes, VoIP 
numbers, and ring groups. Note that dialling 101–108 will ring local extensions 111–118.

FUNCTIONS YOU CAN ENTER FROM LOCAL EXTENSIONS

The following table lists functions that can be entered from local extensions. On an analogue 
extension, press Recall. On an IP extension, press Hold.

Unit 1 Unit 2 Unit 3 Unit 4

Local extensions (analogue 
or IP)

111–118            121–128 131–138 141–148

Local extensions (IP only) 151–158 161–168 171–178 181–188

Remote extensions                      210–219 220–229 230–239 240–249

General voice mailboxes   410–419 420–429 430–439 440–449

VoIP numbers There are 50 VoIP numbers for a TalkSwitch VoIP network:
250–299.

Ring groups There are ten ring groups for the entire system: 300–309. 

Keys Function performed 

Recall/Hold If you are connected to a caller, Recall/Hold puts the call on hold 
and you hear the internal dial tone.

Recall/Hold Pressing Recall/Hold again at the internal dial tone retrieves the 
most recent call on hold. 

Recall/Hold at external 
dial tone

When you are connected to an outside line, pressing Recall/Hold 
switches you to the internal dial tone. 

* and mailbox number Dials into a local, remote or general voice mailbox to leave 
a message.

** and mailbox number Accesses a local, remote or general voice mailbox. You can retrieve 
messages, change greetings, password, etc.

** # Accesses the mailbox associated with your extension. 

Recall/Hold 4 Completes a transfer and returns to the internal dial tone.

On an analogue extension, press Recall 4. On an IP extension, press Hold 4 followed by Dial, 
Send or # to complete the transfer.
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0 Dials the receptionist.

*0 External PA access to make an announcement through the 
attached external PA system.

*300–399 Dials the system speed dial number.

Recall/Hold 5 Disconnects the current caller and reconnects to the last caller on 
hold. A conference-call initiator can disengage the second 
conferenced party by pressing Recall 5.

Recall/Hold 
*500–509

Press Recall/Hold to place a call on hold and then press *500–
509 to place the call in one of ten park orbits.

Recall/Hold *510 Press Recall/Hold to place a call on hold and then press *510 to 
place the call in the next available park orbit, starting at 500.

**500–509 Retrieves a parked call. 

Recall/Hold 6 Conference call for 3 parties. Press Recall to put the first caller on 
hold, dial another extension or external number and press 
Recall 6.

*56 TalkSwitch unit will announce its IP address.

*60

*61

*62

Disables Do Not Disturb at the current extension. Enables Do Not 
Disturb at the current extension. Toggles Do Not Disturb at the 
current extension.

*7 and extension Call pick-up at a specific extension. Dial from dial tone to pick up 
a call ringing at another extension.

Recall/Hold 7 Press Recall 7 to cycle through queued calls on a first in/first 
out basis.

80 Accesses Same Line Connect when transferring an outside caller to 
another outside number.

9, 81–88 Dial to access an outside line.

On an IP extension, press Dial, Send or # after your entry for the following options:

*80 Play music on hold from an internal .wav file or an external audio 
source through the PA jack. If music on hold is playing through 
the PA jack, and a user dials *0 to make an overhead page, the 
overhead page will interrupt the music on hold. However, if the 
PA jack is configured to perform voicemail screening, and a user 
or caller accesses a voice mailbox, music on hold will not 
be interrupted.  

*810# Display the alternate name instead of the caller ID name.

*81 [1–10] # Route future calls from the last caller according to the 
specified group.

*81255# Delete the last caller from the caller ID lookup list.

*84 and extension Hands-free intercom call to an extension, automatically answered 
in speaker mode, enabling instant hands-free 2-way 
communication (for supported sets). 

*85 and extension or ring 
group number

Page a phone at an extension or the phones of a ring group.

*88 and account code Attach account code to call detail record (CDR) for last call.

*9 Call pick-up of any ringing line.
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FUNCTIONS YOU CAN ENTER FROM OUTSIDE PHONES

The following table lists functions that can be entered from outside phones after the auto 
attendant answers.

FUNCTIONS YOU CAN ENTER IN COMMAND MODE

The following table lists functions you can enter in command mode from a local extension or an 
outside phone. Enter command mode by either pressing # on an analogue extension phone, or 
*55# on an IP phone. When prompted, enter the system password + #. You can then enter 
the command.

# on an analogue 
extension phone, or *55# 
on an IP phone.

Enters command mode.

Keys Function performed

0, 1, 2, 3, 4 and 5 Performs the action defined in the auto attendant configuration.

3-digit local extension Rings at the local extension (e.g. 111). 

3-digit remote extension Rings at the remote extension (e.g. 211). 

3-digit VoIP number Rings the VoIP number (e.g. 250). There are 50 VoIP numbers in a 
TalkSwitch VoIP network.

3-digit ring group Rings all the extensions in the ring group (e.g. 301). There are 
ten ring groups for the entire system.

61 Causes the system to call you back at the current prompted call 
back number, after you hang up.

62 Causes the system to prompt you for your password and then the 
new prompted call back number. After you hang up, the system 
calls you back.

7 and extension Transfers a caller on hold to another phone system used in 
conjunction with TalkSwitch. As soon as the call connects to the 
other system, it disconnects from TalkSwitch.

9 and 81–88 Accesses a hunt group for call bridge and is protected with the 
call bridge password.

80 Accesses call bridge using Same Line Connect. Requires 3–way 
calling/conference on the line.

* and mailbox number Dials into a local, remote or general voice mailbox to leave 
a message. 

** and mailbox number Accesses voicemail of a local, remote or general voice mailbox. 
You can retrieve messages, change greetings, password, etc.

Keys Function performed

00 + # TalkSwitch tell you the Unit ID of the unit you are connected to.

0 and ID number + # Assigns a Unit ID (1 to 4).

30 + # TalkSwitch tells you which mode it is currently using.

3 and mode number + # Switch modes (1 = mode 1, 2 = mode 2, 3 = holiday mode).

4 and auto attendant 
number + #

Record auto attendant message (1 to 9).
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04 and auto attendant 
number + #

Erase auto attendant message (1 to 9).

5 and auto attendant 
number + #

Play auto attendant message (1 to 9).

6 and auto call back 
number + #

Record auto call back announced message (1 to 4).

06 and auto call back 
number + #

Erase auto call back announced message (1 to 4).

7 and auto call back 
number + #

Play auto call back announced message (1 to 4).

65 + # Record prompted call back announced message.

065 + # Erase prompted call back announced message.

75 + # Play prompted call back announced message.

90 + # Play unit IP address.

Remote extension number, 
8, and phone number + #

Set a remote extension phone number.

Remote extension number, 
980, and 0 + #

Turn off Same Line Connect for a remote extension.

Remote extension number, 
980, and 1 + #

Turn on Same Line Connect for a remote extension.

Remote extension number, 
9, and hunt group + #

Set the hunt group for a remote extension.

Local extension number 
and 61 + #

Enable Do Not Disturb at the local extension.

Local extension number 
and 60 + #

Disable Do Not Disturb at the local extension.
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A P P E N D I X  B
A pp e n di x  B :  Tal k Sw i tch an d  Tel e p h o n e  Com pa ny  Call i ng  Ser vi ce s

TALKSWITCH AND TELEPHONE 
COMPANY SER VICES

Telephone companies offer a range of services on their telephone lines. The range of services 
varies by telephone company, and some services may not be available on all lines. Please consult 
your local telephone company for feature availability. Many of the services offered by your local 
telephone company are compatible with and enhanced by TalkSwitch’s capabilities.

Use of services may require a subscription or incur service charges.

CALLER ID

The Caller ID service displays the phone number and name associated with an incoming call. 
Caller ID is also referred to as Caller Identity, Call Display, Caller Display, Calling Number Display, 
or IdentiCall. 

The TalkSwitch unit can pass the caller ID to its local extensions when incoming calls are 
transferred by the auto attendant. If a local extension is configured to ring at least twice before 
the auto attendant answers, TalkSwitch will pass the caller ID to that extension. If a call is 
transferred from one extension to another, the caller ID will also be passed on. The TalkSwitch 
unit can use the time stamp from the caller ID to set its internal clock.

Subject to market model, TalkSwitch is compatible with telephone company FSK, DTMF and Dual 
Mode types of caller ID. Analogue extension telephone sets connected to TalkSwitch must 
support FSK type caller ID.

DISTINCTIVE RING

The Distinctive Ring service provides multiple phone numbers on one telephone line. Each phone 
number causes the phone to ring with a different ring pattern. The ring patterns have one, two, 
or three rings in each burst. The ring pattern identifies the number that was dialed. The service 
allows a different phone number for a fax machine or home-based business on one 
telephone line.

Distinctive ring is also referred to as Call Sign™, My Ring, Duet® - Phone and Fax Multiple 
Number, or Smart Ring.

An alternative version of this type of service provides different ring patterns based on who is 
calling (e.g. Smart Ring).

The TalkSwitch unit supports a main phone number and two distinctive ring phone numbers on 
each telephone line. It can detect the distinctive rings and use them for:

• Routing fax, modem and voice calls to a fax machine, modem or auto attendant.

• Separating home and office calls.

• Using auto call back.

TalkSwitch may or may not be compatible with more complex distinctive ring patterns used by 
some telephone companies.
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VOICEMAIL

The Voicemail service gives callers the opportunity to leave a message when your telephone line 
is busy or unanswered. Voicemail is also referred to as Call Answer. TalkSwitch can work in 
conjunction with your telephone company’s Voicemail service.

CALL WAITING

The Call Waiting service beeps when you have another call waiting to be answered. 

To talk to the other caller when you hear a call waiting beep, press the Recall button twice. To 
return to the other caller, press the Recall button twice again.

The Call Waiting service is not recommended, since TalkSwitch cannot answer the second call 
while the first call is already being routed by the auto attendant. You may want to consider 
adding the Hunt/Rollover service to your lines instead. 

3-WAY CALLING/CONFERENCE

The 3-Way Calling/Conference service allows you to add a third party to a call already in 
progress. It permits the Same Line Connect feature to be used with call forwarding, call back and 
call bridge (DISA), whether you have one or more telephone lines. With Same Line Connect, 
TalkSwitch can use the same telephone line to connect a second external caller.

If you are having difficulties with line volume levels when you forward calls to remote 
extensions or when you are using call bridge, forward calls using 3-Way Calling/Conference.

The 3-Way Calling/Conference service is not recommended with automatic route selection (ARS) 
or toll restriction. The TalkSwitch unit cannot route or block calls established through 3-Way 
Calling/Conference.

TalkSwitch is compatible with the 3-Way Calling/Conference services provided by the following 
telephone companies:

• BE: Belgacom

• CH: Swisscom

• MT: Maltacom

• UK: British Telecom

TalkSwitch may or may not be compatible with similar services provided by other telephone 
companies.

TRANSFER AND CLEAR

The Transfer and Clear service allows you to add a third party to a call already in progress. 
Transfer and Clear is similar to 3-Way Calling/Conference, but allows the two external parties to 
remain in conversation after you hang up. Transfer and Clear is also known as FeatureLine or 
Centrex/Plexar.

If you have the Transfer and Clear service, you must enable the Transfer and Clear feature. Select 
the Clear telephone line after call transferred check box in the To Remote Extensions tab of the 
Transfer Preferences window. You must also select the Transfer and clear check box in the 
Telephone Lines page.
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With Transfer and Clear, the TalkSwitch unit can release the telephone line after transferring a 
call to a remote extension. Otherwise the telephone line will remain occupied while the caller is 
connected to the remote extension.

If you don’t have the service but enable the feature, the caller will be disconnected when the 
unit attempts to forward their call to the remote extension.

The Transfer and Clear service may require the remote extension to be answered before it can 
transfer the call and clear the line. If so, select one of the screening options in the call cascade 
of the remote extension. See Remote Extensions on page 101.

HUNT/ROLLOVER

The Hunt/Rollover service hunts across a set of telephone lines to find a free line for an 
incoming call. Two or more lines are required. This allows an organization with multiple 
telephone lines to publish one phone number. Hunt/Rollover is also known as Hunt Group, Busy 
Rollover, Hunting Facility, or Call Forward On Busy.

There are two types of hunting — sequential and circular. Sequential hunting starts at the 
number dialed and ends with the last number in the assigned group. Circular hunting hunts all 
the lines in the hunting group, regardless of the starting point. Both types will only scan 
through the lines once before resulting in a busy signal.

The TalkSwitch unit uses hunt groups for outgoing calls. If you know the order that the 
telephone company hunts across telephone lines for incoming calls, reverse the order in the 
hunt groups to prevent congestion.

OTHER SERVICES

Services using call back

Services which result in a call back to the TalkSwitch unit are not recommended, unless careful 
consideration is given to how the incoming call will be handled.

Services using prompted call back

If you call a number and it’s busy, some telephone companies offer a prompted call back service 
that will notify you when the number is free. The use of this service is not recommended with 
TalkSwitch remote extensions.

If the service cannot be deactivated, set the When a call is answered list to play accept/reject 
prompt in the Answered tab of the remote extension’s call cascade. This setting allows the call to 
be handled correctly if the telephone company answers the call to the remote extension with a 
prompted call back message. 

Services and systems using Recall

Some services and systems require a Recall signal for activation. For example, a Key telephone 
system, PBX or telephone company service may require a Recall signal.

To generate a Recall signal for the service or system, press the Recall or Link button twice. 
Pressing the Recall button once will put the caller on hold, but the Recall signal will not be 
sent to the telephone line. This prevents the TalkSwitch system from hanging up on the caller. 
Pressing the Recall button a second time will send a Recall signal to the telephone line.
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If your telephone does not have a Recall or Link button, you can generate a Recall signal by 
quickly pressing and releasing the telephone’s hook switch.

If you need to send a Recall signal to the telephone line, press and release the hook switch 
once, count to two, and then press and release the hook switch a second time. If you initiate the 
second Recall signal too quickly, you will disconnect your caller.

Services using Ringback Tones

The Ringback Tones service allows the caller to hear a tune or announcement instead of the 
traditional ring back tone. This service is also known as Colour-Me Tones. The use of this service 
is not recommended with TalkSwitch remote extensions.

If the service cannot be deactivated, set the When a call is answered list to play accept/reject 
prompt in the Answered tab of the remote extension’s call cascade. This setting allows the call to 
be handled correctly if the telephone company plays a tune or announcement instead of a 
traditional ring back tone.

Services using line reversals

Some telephone companies will provide line reversals to improve the performance of busy 
telephone lines. Line reversals may be provided as a standard feature on some types of lines 
(e.g. business lines or where lines are part of a hunt group), they may only be provided by the 
telephone company if requested, or may not be available at all. In cases where there are 
frequent incidents of “glare” (new incoming calls collide with new outgoing calls) consult your 
dealer about the use and availability of line reversals to reduce “glare”. There are different types 
of line reversal schemes used by telephone companies. TalkSwitch has been set up to 
automatically work with the normal form of line reversal in the markets where it is used.

NOTES

BT Call Sign is a trademark of BT plc; Duet is a registered trademark of Telstra. Other service 
names may be trademarks of their respective owners in specific countries. 
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A P P E N D I X  C
A pp e n d i x  C :  Ta lk Sw itch  an d  Pow e r  I nter r up ti o n s

TALKSWITCH AND 
POWER INTERRUPTIONS

TalkSwitch settings and configurations
In the event of a power failure, your TalkSwitch settings and configuration will not be lost.

The TalkSwitch configuration is stored in non-volatile memory. Non-volatile memory means 
your feature settings (configuration) remain in the TalkSwitch memory despite interruptions in 
the power supply. 

Calling features
In the event of a power failure, TalkSwitch features or capabilities, including VoIP, will be 
unavailable except for extension jack E4. Calls can be made or received via a direct connection 
to Line 1 on the same unit. Since the connection is direct, calls must be dialled without a hunt 
group. When the power is restored, all features and capabilities will be re-established.

Mode scheduling and power interruptions 
When the power supply to TalkSwitch has been interrupted, TalkSwitch’s internal clock will 
continue to run for up to 12 hours. If you have enabled the automatic mode scheduling feature 
and it has been longer than 12 hours, TalkSwitch will not function properly until the internal 
clock is reset via a caller ID call or with the TalkSwitch management software. When power is 
restored to TalkSwitch, it will check the time and determine the mode it should be running 
according to the configuration and set itself to that mode.

To check the current mode of operation:

1. Enter command mode by either pressing # on an analogue extension phone, or *55# on an 
IP phone.

2. Dial the system password + #.

3. Dial 30#. TalkSwitch will report the current mode.



A P P E N D I X  D
A pp en di x  D :  Sa fet y  a n d Reg u lator y  In form ati on

SAFETY  AND 
REGULATOR Y INFORMATION

The following information applies to TalkSwitch units bearing the part number CT.TS001.1.

Safety Precautions
Before using TalkSwitch, please review and ensure the following safety instructions are 
adhered to:

1. Read, follow and retain instructions — All safety and operating instructions should be read, 
followed and retained for future reference before operating the equipment.

2. Heed warnings — All warnings on the equipment and in the operating instructions should 
be adhered to.

3. Temperature — Do not operate in environments where the temperature is below 0°C or 32°F. 
If the product was shipped in cold weather, please let the system warm up at room 
temperature for at least two hours before plugging it in to a power outlet.

4. Moisture — Do not place TalkSwitch in a high-humidity environment.

5. Heat — Never place TalkSwitch near heat sources such as radiators, floor registers or in 
direct sunlight. Do not stack units on top of each other.

6. Power supply — The equipment should only be connected to an approved power supply of 
the type described in the operating instructions or marked on the equipment. Use only the 
power adapter supplied with TalkSwitch.

7. Damage requiring service — Do not attempt to service the TalkSwitch yourself. Unplug 
TalkSwitch and refer servicing to a licensed technician when:

• The plug or power cord has been damaged.

• TalkSwitch has been exposed to moisture.

8. Emergency services — If you call an emergency service using an external IP extension, the 
TalkSwitch system will not send the address of your location. You must provide your address 
to the emergency operator.
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Important Notices 

CE Compliance
The product models listed below comply with the essential requirements of the European “Radio 
and Telecom Terminal Equipment” (R&TTE) directive 1999/5/EC, and are for connection to 
regular telephone lines (PSTN).This equipment has been tested and found to comply with the 
following standards:

EN55022:1998 + amendment A1:2000 + amendment A2:2003, Class B
EN55024:1998 + amendment A1:2001 + amendment A2:2003
EN60950–1:2001, first edition
EN61000–3-2:2000
EN61000–3-3:1995+ amendment A1:2001
CISPR22:1997 + amendment A1:2000 + amendment A2:2002

For Declaration of Conformity please contact local distributor or visit
http://global.talkswitch.com and select the required country. 

FCC and IC Warnings
This equipment complies with ACTA TIA/EIA/IS-968A and Part 68 of the Federal 
Communications Commission (FCC) rules in the United States. It also complies with regulations 
RSS210 and CS-03 of Industry Canada and Science Canada. This equipment also complies with 
Part 15 of the FCC Rules, as well as ICES003 of Industry Canada. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this 
device must accept any interference received, including interference that may cause undesired 
operation of the device. 

FCC Part 15
This equipment has been tested and found to comply with the limits for a “CLASS B” Digital 
Device pursuant to Part 15 of the FCC rules. These limits are designed to provide a reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy, and if not installed and used in accordance with 
these instructions, may cause harmful interference to radio communications. However, there is 
no guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

Call Redirection & Service Provider Billing Advisory

Use of the automatic route selection, toll restriction and Call Detail Recording features does 
not imply any guarantee whatsoever by regulatory authorities, your telephone service 
provider(s), TalkSwitch or its distributors and resellers, with regard to the accuracy of these 
features and that the use of such a features may not be considered by a telephone company 
in any disputes which may arise regarding the accuracy of any subscriber's 
telephone account.

This equipment is marked with the CE symbol, 
indicating compliance with CE standards.
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• Connect the equipment to an outlet on a circuit different to that which the receiver 
is connected.

• Consult the dealer or an experienced Radio/TV technician for help.       

ACTA TIA/EIA/IS-968A, FCC Part 68 and IC CS-03
Notice: The Industry Canada label identifies certified equipment. This certification means the 
equipment meets telecommunications network protective, operational and safety requirements 
as prescribed in the appropriate Terminal Equipment Technical Requirements document(s). The 
department does not guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure it is permissible to be connected to the 
facilities of the local telecommunications company. The equipment must also be installed using 
an acceptable method of connection. The customer should be aware that compliance with the 
above conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative designated by the 
supplier. Any repairs or alterations made by the user to this equipment, or equipment 
malfunctions, may give the telecommunications company cause to request the user to 
disconnect the equipment.

Users should ensure, for their own protection, that the electrical ground connections of the 
power utility, telephone lines and internal metallic water pipe system, if present, are connected 
together. This precaution may be particularly important in rural areas. 

A label is located on the underside of the base unit containing both the FCC registration 
number and Ringer Equivalency Number (REN) or the IC registration number and Load Number. 
You must, upon request, provide this information to your local telephone company.

The REN is used to determine the quantity of devices that may be connected to the telephone 
line. Excessive RENs on the telephone line may result in the devices not ringing in response to 
an incoming call. In most, but not all areas, the sum of RENs should not exceed five (5). To be 
certain of the number of devices that may be connected to a line, as determined by the total 
RENs, contact the local telephone company.

If the equipment is causing harm to the telephone network, the telephone company may 
request that you disconnect the equipment until the problem is corrected.

This equipment cannot be used on public coin telephone services provided by the telephone 
company. Connection to party line service is subject to state tariffs.

This CLASS B Digital apparatus meets all requirements of the Canadian interference-causing 
equipment regulations.

Changes or modifications not expressly approved by TalkSwitch could void the user’s 
authority to operate the equipment.

Caution: Users should not attempt to make such connections themselves, but 
should contact the appropriate electric inspection authority, or electrician, 
as appropriate.

This equipment is compatible with inductively-coupled hearing aids.
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The FCC requires that you connect your cordless telephone to the nation-wide telephone 
network through a modular telephone jack (USOC, RF11C, RJ11W, or RJ14).

Your telephone company may discontinue your service if your equipment causes harm to the 
telephone network. They will notify you in advance of disconnection, if possible. During 
notification, you will be informed of your right to file a complaint to the FCC.

Occasionally, your telephone company may make changes in its facilities, equipment, 
operation, or procedures that could affect the operation of your equipment. If so, you will be 
given advance notice of the change to give you an opportunity to maintain 
uninterrupted service.

Other Countries
For latest information on regulatory compliance in other markets see 
http://global.talkswitch.com and select required country.

RoHS Compliance
This equipment conforms with the Reduction of Hazardous Substances (RoHS) Directive 2002/
95/EC. The RoHS directive provides for restriction or elimination of the following substances: 

Lead, mercury, cadmium, hexavalent chromium, polybrominated biphenyls (PBB), and 
polybrominated diphenyl ether (PBDE).

RoHS and related legislations are initiatives to reduce the environmental issues related to the 
manufacture of electronic equipment.

Disposal
At the end of the product’s life, please ensure disposal is in compliance with 
local regulations for electrical and electronic waste.
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A P P E N D I X  E
A pp e n di x  E :  Tal k Sw i tch  O n e - y e ar  War r an ty  a n d Retu rn  Pol i cy

TALKSWITCH ONE-YEAR WARRANTY 
AND RETURN POLICY

TalkSwitch limited warranty

TalkSwitch, a division of Centrepoint Technologies Inc. (“TalkSwitch”) warrants to the original 
end-user customer (“Customer”) that each new TalkSwitch product shall be substantially free 
from defects in materials and workmanship under normal use for a period of one (1) year from 
the date of the original purchase (proof of purchase required). The exclusive remedy and entire 
liability under this warranty will be for repair or replacement on a like-for-like basis at 
TalkSwitch’s option. 

The above warranty shall not apply to product defects resulting from (a) improper maintenance 
or installation; (b) misuse, neglect or accident; (c) damage from moisture or corrosive 
environments; (d) use of the power adapter with supply voltages other than that for which it is 
specified; (e) high voltage surges; (f) electrostatic discharges; (g) operation outside the 
product’s specification; or (h) failure to follow product instructions.

The warranty is void where (a) the serial number has been altered, removed or effaced; or (b) 
the product has been used in an application, country, region, locality, or connected to any 
network, other than those for which the product was intended to operate.

TalkSwitch shall not have any obligation to repair or replace product until the Customer returns 
defective product to TalkSwitch. Any replacement product may be either new or like-new, and 
may contain remanufactured parts, equivalent to new in performance. 

EXCEPT FOR THE EXPRESS WARRANTIES SET FORTH ABOVE, AND TO THE EXTENT PERMITTED BY 
APPLICABLE LAW, THE PRODUCTS AND STORAGE MEDIA ARE SUPPLIED ON AN “AS IS” BASIS AND 
THERE ARE NO WARRANTIES, REPRESENTATIONS OR CONDITIONS WHETHER EXPRESSED OR 
IMPLIED, WRITTEN OR ORAL, ARISING BY STATUTE, OPERATION OF LAW, COURSE OF DEALING, 
USAGE OF TRADE OR OTHERWISE, WITH RESPECT TO THE PRODUCT. TALKSWITCH SPECIFICALLY 
DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY 
QUALITY, DURABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. 

IN NO EVENT SHALL TALKSWITCH BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS, LOST DATA, OR OTHER 
INCIDENTAL OR CONSEQUENTIAL OR PUNITIVE DAMAGES, WHETHER BASED ON CONTRACT, TORT 
(INCLUDING WITHOUT LIMITATION, NEGLIGENCE), OR ANY OTHER LEGAL THEORY, WHETHER OR 
NOT ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR WHETHER SUCH DAMAGES ARE 
FORSEEABLE. IN ANY EVENT, THE TOTAL AGGREGATE LIABILITY OF TALKSWITCH FOR DIRECT 
DAMAGES SHALL NOT EXCEED THE PURCHASE PRICE OF THE PRODUCT.

Condition: The original end-user customer acknowledges that he or she has read the limited 
One-Year Warranty and Warranty Disclaimers and understands the same and agrees to be 
bound by its terms and conditions.
T A L K S W I T C H  O N E - Y E A R  W A R R A N T Y  A N D  R E T U R N  P O L I C Y 254



This warranty gives specific rights, and Customer may have other rights subject to jurisdiction. 
To the extent any part of this limited warranty statement is inconsistent with such local law, 
that part shall be deemed modified to be consistent with such local law.

Warranty Service
To be eligible to obtain warranty service you must retain proof of purchase and contact your 
reseller for warranty details. If you fail to provide proof of purchase, your reseller and 
TalkSwitch, a division of Centrepoint Technologies Inc. (“TalkSwitch”) will not be able to 
provide you with any kind of warranty service.

To be eligible to obtain warranty service during the warranty period the Customer must provide 
proof of the date of purchase, serial number, and obtain warranty return instructions from the 
Authorized Reseller, or the TalkSwitch Technical Support Centre listed on 
global.talkswitch.com. To obtain warranty service the Customer is responsible for returning 
the TalkSwitch to the Authorized Reseller or the TalkSwitch Warranty Centre in suitable 
packaging. Any applicable duties or taxes for the return of repaired or replacement product are 
the responsibility of the Customer. Replacement or repaired product is returned free of charge 
(excluding duties and taxes) is warranted to be free from defects in material or workmanship 
for the remainder of the limited warranty period of the originally purchased Product.
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A P P E N D I X  F
A pp e n di x  F :  Spe ci f ic at i o n s

SPECIF ICATIONS

The following specifications apply to TalkSwitch units bearing the part number CT.TS001.1.

Interfaces 

Interface Specifications

240vs 248vs 480vs 488vs 840vs 848vs

Telephone lines (FXO) 2 2 4 4 8 8

Analogue extensions (FXS) 4 4 8 8 4 4

VoIP ports 0 8 0 8 0 8

VoIP numbers 0 24 0 24 0 24

Local extensions (Analogue 
and IP)

16 16 16 16 16 16

LAN interface RJ-45 Ethernet (10BaseT)

USB interface Standard USB Type B

Memory 2 hours internal

1–, 2–, 4.5– and 9–hour memory cards extend internal memory, 
but may not be available in all markets.

Music input Phono jack (1/8" mono) or stored .wav file

PA output Phono jack (1/8" mono)

Power source 220–240 V, 50/60 Hz, adapter supplied

Power-failure line to 
extension jacks

Extension 4 connects to Line 1.
S P E C I F I C A T I O N S 256



Analogue Extension Specifications

Telephone Line Specifications

Dimensions

Weight

Connector type RJ-11, 2-pin

Trunk type Loop start

Interface impedance BT SIN 315 for Terminal Impedance [UK]

ETSI TBR21 [Ireland]

Options for 600 Ω, 900 Ω, EU complex, AU complex, and BT 
complex (subject to market).

Loop range 0–600 Ω

Recall/Flash supported Yes

On-hook voltage 35 V

Off-hook loop 
voltage source

35 V

Off-hook loop current 23 mA to 40 mA

Dial tone level -2.4 dBm

Ringing voltage 90 V RMS

Ringing frequency 25 Hz – True sine wave

Total ringing load 5 REN

Connector type RJ-11, 2-pin

Trunk type Loop start

Interface impedance Configurable, 600 Ω, 600 complex, 900 Ω, 900 complex

Ringing impedance 3,900 Ω

Ringing sensitivity 45 V RMS @ 25 Hz

REN 0.7 B

Longitudinal balance 69 dB

Signal level -10 dB

Distinctive ring supported Yes

Caller ID support FSK, all lines

Metric (mm) 51.6 x 203.2 x 213.4

Imperial (inches) 2.03 x 8.0 x 8.4

240vs 244vs 248vs 280vs 284vs 288vs

Metric (kg) 0.65 0.67 0.67 0.72 0.74 0.74

Imperial (lbs) 1.43 1.46 1.46 1.58 1.62 1.62

480vs 484vs 488vs 840vs 844vs 848vs

Metric (kg) 0.79 0.81 0.81 0.89 0.91 0.91

Imperial (lbs) 1.74 1.77 1.77 1.96 1.99 1.99
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Regulatory Approvals

ACTA TIA/EIA/IS-968A and FCC Part 68, Industry Canada CS-03

FCC Part 15B, Industry Canada ICES-003

Power adapter complies with UL and CSA

Reduction of Hazardous Substances (RoHS) Directive 2002/95/EC

VoIP Features (models with VoIP lines only)

• Embedded SIP server and user agents

• Integrated registrar

• Fax tone detection

• RTP

• G.711µ-law/A-law, G.726 (32 Kbps), G.729a

• G.168 echo cancellation

• VAD, silence suppression

• Adaptive jitter buffer

• Packet loss concealment

• Can use external SIP servers as required
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A P P E N D I X  G
A pp en di x  G :  Copy r i gh t  a nd  L icen si ng  N oti ces

COPYRIGHT AND LICENSING NOTICES

TalkSwitch copyright © 2009 — All Rights reserved.
TalkSwitch is a division of Centrepoint Technologies Inc.
TalkSwitch software is protected under copyright law and international treaties. Unauthorized 
reproduction or distribution of TalkSwitch software, or any portion of it, in any form, may result 
in severe civil and criminal penalties, and will be prosecuted to the maximum extent of the law.

TalkSwitch phone systems use the Appello® SIP stack for VoIP communications. The Appello® 
SIP stack was developed by TalkSwitch — a division of Centrepoint Technologies Inc.

TalkSwitch and Appello are registered trademarks of Centrepoint Technologies Inc.

Elements of TalkSwitch software are protected under additional copyrights listed below, and 
subject to the terms and disclaimers listed below.

A) Copyright © 1998 by the Massachusetts Institute of Technology.
Permission to use, copy, modify, and distribute this software and its documentation for any 
purpose and without fee is hereby granted, provided that the above copyright notice appear in 
all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of MIT not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. MIT makes no 
representations about the suitability of this software for any purpose. It is provided “as is” 
without express or implied warranty.

B) Copyright © 2000–2003 Intel Corporation. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

• Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

• Neither name of Intel Corporation nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL INTEL OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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C) Copyright © 2001–2003 Swedish Institute of Computer Science. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

• The name of the author may not be used to endorse or promote products derived from this 
software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

D) Copyright © 1991–1992, RSA Data Security, Inc. Created 1991. All rights reserved.
License to copy and use this software is granted provided that it is identified as the “RSA Data 
Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this 
software or this function. License is also granted to make and use derivative works provided that 
such works are identified as “derived from the RSA Data Security, Inc. MD5 Message-Digest 
Algorithm” in all material mentioning or referencing the derived work. RSA Data Security, Inc. 
makes no representations concerning either the merchantability of this software or the 
suitability of this software for any particular purpose. It is provided “as is” without express or 
implied warranty of any kind. These notices must be retained in any copies of any part of this 
documentation and/or software.

E) Copyright © 2004 Magnus Damm <damm@opensource.se> All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the ‘Software’), to deal in the software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the software, and to permit persons to whom the software is 
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN 
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH 
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
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F) Copyright © 1991, 1999 Free Software Foundation, Inc. 
3rd-Party IP Phone configuration library. 
Copyright © 2006 Centrepoint Technologies, Inc.
This library is free software. You can redistribute it and/or modify it under the terms of the GNU 
Lesser General Public License as published by the Free Software Foundation, either version 2.1 of 
the License, or (at your option) any later version. This library is distributed in the hope that it 
will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public 
License for more details. You should have received a copy of the GNU Lesser General Public 
License along with this library. If not, write to the Free Software Foundation, Inc., 59 Temple 
Place, Suite 330, Boston, MA 02111–1307 USA.
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GLOSSAR Y

* Star/asterisk sign
The character at the bottom left of your touchtone telephone keypad.

# Number/hash sign
The character at the bottom right of your touchtone telephone keypad.

3-way calling/conference call
Connecting three parties together for one telephone conversation. TalkSwitch offers its own 3-
way conference feature the same as the 3-way conference service offered by 
telephone companies.

Analogue
Analogue devices transmit and receive sound in waves. Standard phones, cordless phones, 
answering machines, fax machines, modems, and the telephone lines in most homes are 
analogue.

Call back
If call back is activated, it instructs TalkSwitch to call you back at a preset out-of-office phone 
number. With call back you can access the TalkSwitch long-distance plan while you are away. 
TalkSwitch offers automatic call back and prompted call back.

Call bridge
Allows you to make long-distance calls from anywhere in the world over your PBX using an 
access number and an authorization code. Also known as DISA in some regions.

Call forward
Call forward is used to forward calls to one of the remote extensions.

Caller ID
A service provided by telephone companies, transmitting information about calls (caller’s name, 
phone number, time of call, etc.). 

Call waiting
Call waiting allows you to accept a second incoming call on a telephone line that is already in 
use. Call waiting allows you to toggle from one caller to the other. The TalkSwitch system has 
call waiting built-in. The Call Waiting service from the telephone company is not recommended, 
since the TalkSwitch system cannot answer the second call while the first call is being routed by 
the auto attendant.

Centrex/Plexar
Central office exchange service. The telephone company offers PBX features on a ‘pay-per-
service’ basis. This service may not be available from all telephone companies. Centrex/Plexar 
call switching happens at a local telephone company instead of your company’s premises. 

CNG
A tone emitted by most fax machines to initiate contact with another fax machine.

CO
Central office of a telephone company.
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Communications software
Software to send and receive data over telephone lines via modems.

Compression
Reduces the data size. It saves data storage space, bandwidth and transmission time. 

Conference call
Connecting three or more parties for one phone conversation. They can be internal or external 
TalkSwitch parties or remote callers.

Configuration
The way the system is set up. The management software defines the settings of the TalkSwitch 
system. These settings determine what each TalkSwitch feature will do and when and how it will 
do it. 

Connector
The end of a cable that plugs into a port or interface to connect one device to another. 

Digit
A whole number from 0 to 9. The numbers on your telephone keypad are digits.

Digital 
Digital devices convert analogue waves to digital signals for storage and transmission. The 
digital signal is converted back to analogue waves that you can hear, and for transmission over 
analogue lines.

DISA
Direct Inward System Access. Allows you to make long-distance calls from anywhere in the world 
over your PBX using an access number and an authorization code. Also known as call bridge in 
some regions.

Distinctive ring
A service provided by some telephone companies to distinguish two different phone numbers 
using the same telephone line (i.e. fax machine). TalkSwitch can detect one, two and three ring 
bursts per ringing cycle to provide different handling for incoming calls.

Driver
The software that controls a device (printer, disk drive, modem, etc.). The driver acts as a 
translator between the device and the programs that use it.

DTMF
Dual-tone Multi-frequency. It is the system used by touchtone telephones. DTMF assigns two 
specific frequencies (tones) to each key so that it can be identified by a microprocessor.

Dual-line telephone
A telephone allowing you to make and receive calls on two separate telephone lines.

Extension
See Local extension or Remote extension.

FCC
Federal Communications Commission. The FCC is the federal regulatory agency for the United 
States, responsible for the regulation of interstate and international communications by radio, 
television, wire, satellite and cable.
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Firmware
Firmware is a combination of software and hardware. Microchips that have data or programs 
recorded on them are called firmware.

Recall button
A button on your telephone. Pressing the Recall button has the same effect as pressing the 
Link button or pressing and releasing the hang-up hook on a telephone. All of these actions 
send a signal to TalkSwitch to put calls on/off hold.

Icon
A small picture representing a program, an action or a feature in the TalkSwitch management 
software. When you click on an icon, the program, action or feature is activated. 

IETF
Internet Engineering Task Force. Develops and promotes Internet standards like TCP/IP and 
SIP protocols. 

Intercom
A dedicated voice service within a specified user environment. TalkSwitch offers intercom 
capabilities between its local extensions.

Interface
Connects two separate entities. A user interface is the part of a program that you see on your 
computer screen and that connects you to the computer.

IP address
Internet Protocol. The standard protocol used by devices to communicate over a computer 
network. The IP address is a unique number or name that identifies the device. 

IP extension
An extension that has its own IP address utilizing the Internet protocol in connection with VoIP.

IP phone
See IP extension.

ISDN
Integrated Services Digital Network.

ISP
Internet Service Provider. Facilitates access to the Internet for end-users. Most ISPs are 
telephone companies. Their services include domain name registration, web hosting, leased line 
access, etc.

Keypad
The push buttons on a telephone.

Keypad commands
Combinations of digits used to configure TalkSwitch from a touchtone telephone.

LED
Light Emitting Diode. A device that lights up when electricity is passed through. TalkSwitch has 
five LEDs on its front panel letting you know which lines are in use and three on the back panel 
beside the LAN port. 
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Line 1, 2, 3, or 4
A jack or plug-in on the back panel of TalkSwitch which can accept an RJ-11 plug from a 
telephone line or PBX system. You can plug in a single-line telephone cable into this jack and it 
becomes a usable TalkSwitch line.

Link button
The Link button has the same effect as the Recall button or pressing and releasing the hang-up 
hook on most telephones. On some telephones, the function of the Link button is internal to 
the telephone and pressing it has no effect on TalkSwitch.

Local extension
A local extension is an analogue extension plugged into one of the extension jacks on the back 
panel of your TalkSwitch, or an IP extension connected to the TalkSwitch by LAN.

Modem
Acronym for MODulator-DEModulator. A modem is a device that converts digital information 
from a computer into analogue signals for transmission over telephone lines and vice-versa. 

Modes
TalkSwitch supports different time and day modes of operation, providing different call 
management depending on the current mode of operation.

Monitor (TalkSwitch monitor)
A feature included with the TalkSwitch management software. The monitor provides a graphical 
representation of telephone traffic as it flows through the system.

Network
A group of two or more computer systems linked together.

PBX
Private Branch eXchange. A PBX is a private telephone network used within an enterprise. The 
PBX controls access to telephone lines and services. It allows many users to share a smaller 
number of telephone lines using extensions and have access to additional call handling benefits 
(call hold, intercom calling, etc.). A TalkSwitch unit is a small PBX. 

Phone load
See Ringing equivalency.

POP3
Version 3 of the post office protocol (POP) is a standard Internet protocol for retrieving e-mail 
from a remote server. Most subscribers to an Internet service provider have e-mail accounts 
using POP3.

Prompt
Recorded instructions played to a caller by TalkSwitch. Prompts are also used to provide 
instructions when you configure TalkSwitch using a telephone keypad.

PSTN
Public Switched Telephone Network. Your telephone line is on a PSTN.

Registered jacks
Telephone and data plugs registered with the FCC.
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Remote extension
A call forwarding number that can be a phone number in any location, set up as a virtual 
extension of the TalkSwitch unit. The remote extension is assigned an extension number and 
has a voice mailbox.

REN
Ringer Equivalency Number. A number determined in accordance with the US code of federal 
regulations. It represents the ringer loading effect on a line. 

RJ-11
Registered jack 11 connects to a 2-wire telephone line. It is used with telephones, cordless 
phones, fax machines and modems.

RJ-14
Registered jack 14 connects to a 4-wire telephone line. It is used with two-line telephones.

RJ-45
Registered jack 45 connects to an 8-wire telephone line. It is generally used with 
networking applications.

RTP
Real-time Transport Protocol. It defines a format for delivering audio and video files over 
the Internet. 

Routing
Determining the path that a message or call has to take over circuits. TalkSwitch routes 
incoming calls according to the configuration. 

Serial communication
A type of electronic communication requiring data bits to be sent one after the other, unlike 
parallel communication. Modems rely on serial communication to send data over 
telephone lines.

Shortcut key
A key combination that causes a specific command to be executed. Shortcut keys combine the 
Ctrl or Alt keys with other keys. (e.g. Ctrl and C is the shortcut key to copy selected items). 

SIP
Session Initiation Protocol. A signaling protocol, developed by the Internet engineering task 
force (IETF). 

SIP server
A server using the SIP protocol to manage calls between SIP devices.

Serial port
Serial ports are physical plug-ins. They allow two devices to exchange data. 

SMTP
Simple Mail Transfer Protocol. The standard for e-mail transmission across the Internet. SMTP is 
a text-based protocol. 

Terminal adapter
A device that allows analogue devices to be used on digital lines (ISDN). Terminal adapters are 
similar to modems.
G L O S S A R Y 266



TX/RX
Transmit and receive data.

UDP
User Datagram Protocol. An Internet protocol which allows applications on a computer network 
to exchange short messages (datagrams).

uPnP
Universal Plug and Play. Allows networked devices to connect seamlessly in home and corporate 
environments using Internet-based communication standards. 

USB
Universal Serial Bus. USB connection supports more bandwidth than a serial or 
parallel connection.

Virtual
The term ‘virtual’ refers to something that is not physically plugged in. 

Voicemail (call answer)
A service provided by TalkSwitch or telephone companies giving callers the opportunity to leave 
a message when your phone is busy or unanswered. 

VoIP
Voice over IP. Sending voice over an Internet connection.

VPN
Virtual Private Network. A communication network used within a company or organization to 
communicate over a public network. VPN message traffic is carried on Internet infrastructure 
using standard protocols.
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Numerics
3-Way Calling / Centrex Transfer area 179
3-way calling wait time area 179
3-Way Calling/Conference check box 120
3-Way Calling/Conference service 144, 168
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9133i 194

A
About

Call cascade 65
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About page 25
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Adding 114
Removing 114

Access code box 114
Access Code Configuration area 113
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Account Options area 152, 155
Action list 137
Action Performed After Auto Attendant Playback area 139
Actions During Auto Attendant Playback area 137
Activate Access Codes for Outgoing Calls area 113
Activate Access Codes for Outgoing Calls check box 113
Activate Account area 149
Activate Account check box 149
Activate Auto Attendant area 137
Activate Auto Attendant check box 137
Activate Auto Call Back area 152
Activate Auto Call Back check box 152
Activate Automatic Route Selection area 145
Activate Automatic Route Selection check box 145
Activate Extension area 59, 103
Activate Extension check box 59, 103
Activate Hunt Group area 133
Activate Hunt Group check box 133
Activate Line area 119
Activate line check box 119
Activate Profile area 49
Activate Profile check box 50
Activate Prompted Call Back area 155
Activate Prompted Call Back check box 155
Activate Ring Group area 107
Activate Ring Group check box 107
Activate Speed Dial area 115
Activate Speed Dial check box 115
Activate Voicemail check box 75
Activate VoIP Number area 125
Activate VoIP Number check box 125
Active mailboxes only option 111
Add/Remove Lines button 134
Add/Remove Telephone Lines window 134
Adding

Access code 114
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Counterpath IP phone 97
Grandstream IP phone 93
IP phones 81
Polycom IP phone 89
TalkSwitch IP phone 81

Additional Settings button 62, 63, 64, 65
Additional Settings window 62, 63, 64, 65
Adjust button 31
Administration area 27
All mailboxes option 111
Allow access to hunt groups check box 153, 156
Allow screening of calls option 168
Allow the use of same line connect (by dialing 80) check box 64, 150, 153, 156
Alternate DNS server box 34, 213
Analog extension 58
Announcements

recording 202
Answered call cascade 70
Answered tab 70
ARS Hunt Groups button 147
ARS Hunt Groups window 147
Attendant Console 57
Attendant Greetings area 140
Audio area 175
Audio Control Options window 80, 166
Authentication area 52
Auto attendant

Receiving calls with 182
Receiving calls without 182
Troubleshooting 236

Auto attendant label box 137
Auto attendant message 139

Erasing 139
Loading 139
Recording 139

Auto Attendant Transfer Prompts area 170
Auto Attendants (Menus) page 137
Auto Attendants window 174
Auto call back

Recording announced message 153
Auto Call Back page 150, 151
Auto Route Selection area 146
Auto Route Selection page 145
Automatic Firmware Update window 163
Automatic route selection

Bypassing 147
Setting up 145

Automatically adjust clock for daylight saving changes check box 32
Automatically detect and switch to G.711 for fax over IP check box 177
Auto-Reboot check box 165

B
Browse button 39, 76, 140
Busy call cascade 67
Busy tab 67
Bypassing

Automatic route selection 147
Toll restriction 147
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Calibrate Lines button 123, 178
Calibrate Lines window 123
Calibrating

Telephone lines 123
Call Back

Recording an announcement 153
Call Back Bridging Access window 153, 156
Call Back Options window 173
Call back ring return area 173
Call Bridge (DISA) page 149
Call cascade

About 65
Ignoring for calls transferred from local extensions 74
Ignoring for unanswered intercom calls 73

Call conference 188
SIP extension 193

Call detail record (CDR) 206
enabling 206
retrieving data 207

Call forward 197
screening options 198
to remote extension (music on hold) 202

Call handling
local extension 184

Call Handling area 65, 121, 126
Call Logging window 206
Call queue

cycling through queued calls 242
queuing and retrieving 186
to an extension ring group 187

Call Reminder Timers window 171
Call Reporting 57
Call routing

troubleshooting 237
Call transfer

from an analog extension 185
screened transfer 185
troubleshooting 237
unscreened transfer 185

Call Waiting and other Flash based services area 179
Call Waiting check box 120
Caller ID / Time Set Options window 172
Caller ID Based Routing page 128
Caller ID check box 120
Caller ID lookup list area 129
Caller ID Name Tagging area 118
Caller ID routing groups area 129
Caller ID Settings area 65
Caller ID type to match list 129
Caller ID used for server provider list 65
Caller Options area 76
Carrier code 1 box 146
Carrier code 2 check box 146
Carrier Code Prefix area 146
Carrier codes 144
Case ID box 181
Cell/Pager Notification tab 78
Change Mode button 30
Change Mode window 30
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Change Proxy window 35
Changing

mode 30
Check manually for update button 163
City or area code box 125
Cleaning XVI
Clear All Extensions button 114
Clear Code button 114
Clear telephone line after call transferred check box 168
Clock setting area 172
CNG tones 177
Code name box 114
Codec options

Setting 56
Codec Options button 56
Codec Options window 56
Configuration File window 24, 158
Configuration Selection page 23
Configuration software

troubleshooting 235
Configure Auto-Detected TalkSwitch System button 23, 160
Configure Keys button 85, 86
Configure Notification Options window 79
Configure Notification Options... button 79
Configuring

Router 215
Connect to a Different System button 23, 158
Connect to list 28
Connect to the following resource list 63
Connect using list 103, 116
Connect Via IP window 23, 158, 160
Connecting

Extensions 11
Fax machine 11, 14
LAN 9
Local area network 9
Local extensions 11
modem 13
PA system 15
Phones 11
Single-line phone 12
TalkSwitch unit to a PBX 21
TalkSwitch unit to PC 6
Telephone lines 11
Two-line phone 12

Continuously run option 31
Counterpath 97
Country code box 125
Create a New Template File window 157
Create a Template File button 157
Current mode link 25
Current public IP address box 35

D
Date & Time area 32
Days to send area 207
Dedicated email address for sending/receiving emails box 43
Default gateway box 34, 213
Default language for system prompts to callers list 28
Delete any unrecognized inbound emails check box 45
Delete name from dial-by-name directory check box 112
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Delete Password button 112
Delete password for mailbox list 112
Delete Password window 112
Delete Wav File button 40
Deleting

Music on hold file 40
Password 112

Detect 1 tone option 177
Detect 2 tones option 177
Diagnostics 2
Dial 09 routing area 28
Dial notification phone number using list 79
Dial-by-name directory

Setting up 141
Direct line access 144
Direct Line Access area 62
Direct Line Access tab 62
Disable playing of transfer prompts to callers when redirecting from the auto attendant check 

box 170
Disable public IP address substitution check box 50
Distinctive ring 1 check box 120
Distinctive ring 2 check box 120
Do not disturb cascade 72
Do not disturb mode

setting 73
Do Not Disturb tab 72

E
Edit button 153, 156
Electrical shock XV
Email Address box 207
Email address box 41
Email Addresses window 77
Email log file area 207
E-mail notification 77
Email Notification Settings area 41
Email Notification tab 77
Email request interval list 45
E-mail server settings

Testing 46
Email Server Settings area 43
Email Service page 40
Emergency service numbers XV
Emergency Service Numbers area 144, 146
Enable automatic update of firmware via TFTP check box 163
Enable delete/save messages option check box 43
Enable email notification check box 77
Enable holiday mode check box 29
Enable NAT keep alives check box 50
Enable pager notification check box 79
Enable remote phone notification check box 78
Enabled check box 207
Ethernet connection 10
Exchange 47
Export list 118
Export System Speed Dial List area 117
Export System Speed Dial List window 118
Extension connectors 5
Extension ring groups

queuing callers to... 187
Extension tab 58
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Extension type list 59
Extensions

Connecting 11
Numbering convention 17

Extensions Requiring an Access Code area 114
External IP extension 58
External IP extension calls list 53
External IP extension registration interval list 176
External IP extensions 217
External Registration Interval area 176

F
Fax detection area 177
Fax Detection window 177
Fax machine

Connecting 11, 14
troubleshooting 237

Fax over IP area 177
File menu 157
File window 159
Firmware

Upgrading 6
Firmware detected 165
Firmware file 165
Firmware update files

Posting on your server 162
First name box 59, 103, 115
Flash key operation area 175
FQDN 35
From Auto Attendant tab 169
From Home Phone tab 170
Front panel 2
Full name box 41
Fully qualified domain name box 35
Function keys 85

Programming 85
Programming TS-9133i 85

Function list 85, 86

G
G.711 177
G.711 A-law check box 56
G.711 u-law check box 56
G.726 check box 56
G.729 check box 56
General Voice Mailboxes page 109
Glare 248
Global Message Waiting Indicator 2
Global Message Waiting Indicator area 110
Grandstream 93
Group label box 130

H
Help and troubleshooting 235–240

Auto attendant 236
call routing/transfer/intercom 237
configuration 235
contacting TalkSwitch 240
fax machines 237
local area network 238
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local extensions 238
music on hold 236

Hold ringback reminder timer list 171
Holiday Mode label box 30
Holiday Settings window 30
Hotline Access area 63
Hotline Access tab 63
HTTP port box 176
HTTP Ports area 176
Hunt Group 80 is used for same line connect check box 147
Hunt Group Access area 150
Hunt Group Access window 150
Hunt group busy overflow for outgoing calls area 135
Hunt group check box 147
Hunt Group Line Assignments area 133
Hunt group name box 133
Hunt Group Permissions area 64
Hunt lines in the following order list 134
Hunt/Rollover/Busy Forwarding check box 120
Hunting order for outgoing calls area 134

I
Identify button 26
If a call is rejected from this extension list 70
If a fax call is detected list 138
If all lines are busy in this hunt group list 135
If being used with another PBX area 169
If busy or not answered after list 68
If Do Not Disturb is on for this ext. list 72
If extension is busy list 67
If the Extension Does Not Answer area 167, 168, 169
If the Extension is Busy area 167, 168, 169
If this extension is not answered after list 69
Ignore flash signals detected if a hang-up follows the flash signal within list 175
Ignoring

Call cascades for calls transferred from local extensions 74
Call cascades for unanswered intercom calls 73

Import an Email List area 43
Import an Email List window 43
Import System Speed Dial List area 117
Import System Speed Dial List window 117
Include ring group number in Caller ID relayed to extensions check box 108
Incoming lines

call detail record 208
using phones connected in parallel 196

Incoming mail server (POP3) box 44, 45
Incoming Mail Server Options area 45
Incoming Server Authentication area 45
Increasing

Voicemail memory 19
Installing

Memory card 19
TalkSwitch management software 5

Intercom
troubleshooting 237

Intercom call 172
Intercom Calls area 173
Intercom calls area 173
Intercom calls follow cascade settings check box 173
Intercom Calls Options window 173
Inter-digit timeout (IDT) list 146
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Internal IP extension 58
Internal IP extension registration interval list 176
Internal Registration Interval area 176
Internet connection 11
Internet Email Settings window 43
Internet email settings window 44
Interval between attempts list 79
IP Configuration page 34
IP extension 58
IP Extension Details area 60
IP Extension VoIP Lines area 176
IP Extensions window 176
IP phones

Adding 81

K
Keep Alive Settings window 50
Key assignment template

Saving 88
Using 88

Keys 85

L
Label box 152
LAN

Connecting 9
Optimizing TalkSwitch system 18

LAN connector 5
Language area 28
Language File Management window 28
Language of system prompts list 138
Last name box 59, 103, 115
Leading digits 143
Leading digits box 145
Licensed Add-Ons page 57
Lights 2
Line Appearance

Using 194
Line appearance 85

About 194
TS-480i 195
TS-9133i 194

Line appearance on a TS-480i 195
Line appearance on a TS-9133i 194
Line connectors 5
Line Disconnect area 179
Line disconnect time list 179
Line hunt group

Restricting access by local extensions 147
Line Hunt Groups page 132
Line Optimization area 123
Line Reservation area 53
Line Reversal check box 121
Line Reversal Settings button 121
Line Reversal Settings window 121
Line type list 133
Load Greeting button 76, 140
Load Greeting window 76
Load Wav File button 39
Loading
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Auto attendant message
Erasing 139

Local area network
Connecting 9
Networking TalkSwitch units 16
Optimizing TalkSwitch system 18
troubleshooting 238

Local extension
Bypassing automatic route selection 147
Bypassing toll restriction 147
Restricting access to line hunt groups 147

Local Extension/Fax page 58
Local extensions

Connecting 11
troubleshooting 237, 238

Location list 60
Location window 159
Lookup name directory

Setting up 141

M
MAC address 61
MAC Assignment button 84
MAC Assignment window 84
MAC Selection window 61
Mailbox data

Viewing 111
Mailbox Greeting area 76
Mailbox Setting area 110
Mailboxes

Resetting 111
Main number box 120
Manual Port Mapping window 36, 216
Maximum length list 175
Maximum recording length for each message list 110
Memory capacity

Increasing 19
Memory card

Installing 19
Memory cards 19
Memory slot 5
Memory usage

Viewing 161
Memory Usage window 161
Message length

Viewing 161
Message Waiting Indication window 80
Message waiting light 79
Message Waiting Light tab 80
Microsoft Exchange 47
Minimum length list 175
Minimum required time between DTMF digits list 174, 179
Minimum required time to detect a DTMF digit list 174, 179
Mode

changing 30
Mode 1 label box 29
Mode 1 tab 67, 69, 70, 72
Mode 2 label box 29
Mode 2 tab 67, 69, 70, 72
Modem

Connecting 13
Modes area 29, 30
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More Settings button 43, 44
Move Down button 134
Move Up button 134
MUSIC connector 5
Music on hold

Deleting file 40
Playing on the PA system 40
Setting up 15
troubleshooting 236

My Outgoing Server (SMTP) Requires Authentication area 44
My Outgoing Server (SMTP) Requires Authentication check box 44
My TalkSwitch system link 26

N
Networking

TalkSwitch units 16
No answer call cascade 69
No Answer tab 69
Notification option list 41
Notification Settings area 77
Notification Settings button 78
Notification Settings window 78
Notify the pager/remote phone after receiving list 110
NTP server box 33
NTP Server tab 33
Number box 125
Number of attempts list 79
Number of rings between attempts list 79
Number to call back box 152, 155
Number to trigger call back list 152
Numbering convention of extensions 17
Numeric message box 79

O
Obtain system time from caller ID check box 172
On-hold Settings area 39
On-Hold/Ringback page 38
Only remove messages shorter than list 111
Open a Configuration File or Template button 24, 157, 158
Open a File button 24, 158
Open File or Template window 24
Open Template button 88
Open Template window 88
Optimizing

TalkSwitch system for network 18
Options menu 166
Other TalkSwitch button 160
Outbound proxy box 51
Outgoing mail server (SMTP) box 43, 45
Overflow tone notification area 135

P
PA connector 5
PA jack

Voicemail screening 80
PA output option list 80, 166
PA system

Connecting 15
Playing music on hold 40

Pager notification 79
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Pager number box 79
Park ringback reminder timer list 171
Password

Deleting 112
Password box 44, 45, 52, 61, 126, 150
PBX

Connecting to a TalkSwitch unit 21
PBX extension length

Setting 142
PBX extension length list 169
PBX fraud XV
PC

Connecting to a TalkSwitch unit 6
Perform a blind transfer option 168
Perform Busy at extension action option 167, 168, 169
Perform message notification for list 79
Perform No Answer at extension action option 167, 168, 169
Permissions page 113
Phantom rings area 175
Phone Line Services area 120
Phone notification 78
Phone Number area 125
Phone number box 78, 115, 125
Phone number used for TalkSwitch VoIP caller ID list 65
Phone Numbers area 120
Phones

Connecting 11
Play announcement only check box 76
Play notification tone when overflowing to another hunt group check box 135
Playback volume for music file list 39
Playing

Music on hold on the PA system 40
Polycom 89
POP3 service with Microsoft Exchange

Setting up 47
Populate calendar with holidays observed in list 30
Port box 23
Power and lightning surge protection XV
Power connector 5
Power failure XV
Preferred codec list 56
Preferred DNS server box 34, 213
Profile name box 49, 50
Programmable keys 85
Programming

TS-480i softkeys 86
TS-9133i function keys 85

Prompted Call Back 154
Prompted call back

Recording announced message 156
Prompted Call Back page 154
Proxy server name box 51
Proxy/registrar server name box 51, 221
Public IP address area 35
Public IP address-checker server name box 35

Q
queue at extension 186
Queue options reminder timer list 171
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Realm/domain box 51
Reboot button 166
Reboot System window 166
Recommended system specifications 1
Recording

Auto attendant message 139
Auto call back announced message 153
Prompted call back announced message 156

Region Selection area 28
Registrar authentication list 52
Registrar entries

Viewing 54
Registrar Entries window 54
Registrar server name box 51
Registration Details area 50
Registration status

Viewing 55
Registration Status area 126
Registration Status window 55
Regular Analog Extensions window 175
Remote Extension page 102
Remote phone number box 103
Remote Transfer area 168
Remove blank messages and hang up automatically check box 110
Removing

Access code 114
Replace Caller ID name with box 129, 131
Re-registration interval list 171, 173
Reserve VoIP Lines button 53
Reserving

VoIP lines 53
Reset Mailboxes button 111, 112
Reset Mailboxes window 111
Resetting

Mailboxes 111
Resource list 85, 86, 138
Restricting

Local extension access to line hunt groups 147
Retry Auto Discovery button 160
Retry Auto-Discovery button 23
Ring back extension that transferred the call option 167, 168, 169
Ring Detection area 179
Ring group name box 107
Ring Group Options area 108
Ring Groups page 107
Ring Pattern Information window 180
Ring pattern list 108, 130
Ring Pattern Test button 179
Ring Pattern Test window 179
Ring Sequence window 122, 126, 130
Router

Configuring 215
Router Port Forwarding area 36, 215
Run Calibration button 123

S
Save Template As button 88
Save Template As window 88
Saving
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Key assignment template 88
Scheduling area 31
Scheduling page 29
Select button 61
Select File button 43, 117
Select Wav File button 39, 140
Select Wav File window 39, 140
Selected Dates area 30
Server Port Numbers area 45
Service provider profile

Setting up 49
Service provider VoIP network 223
Set Ring Group Extensions window 108
Setting

Codec options 56
do not disturb mode 73
PBX extension length 142
Unit ID 17

Setting up
Automatic route selection 145
Dial-by-name directory 141
Music on hold 15
POP3 service with Microsoft Exchange 47
service provider profile 49
TalkSwitch profile 48
Toll restriction 145

Settings button 30, 50
Single digit fall through time list 174
Single-line phone 12

Connecting 12
SIP server 211
SIP Server Registration area 171
SIP signalling port box 171
Slowly pulse the Power/Data light to indicate new messages check box 110
Softkeys 85

Programming TS-480i 86
Start time 1 list 146
Start time 2 list 146
Starting

TalkSwitch management software 22
Starting RTP port box 172, 176
Starting SIP port box 176
Stop button 26
Subnet mask box 34, 213
Support window 181
Surge protection XV
Switch modes depending on time option 31
Syslog server

Setting up 164
System Information area 25
System IP Settings area 34
System name box 27
System password XV
System password box 27
System prompt language for this extension list 103
System prompt language list 60
System specifications

Recommended 1
System Speed Dials page 115
System time link 25
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TalkSwitch 480i window 86
TalkSwitch 9133i window 85
TalkSwitch Command Console window 164
TalkSwitch configuration software

Upgrading 6
TalkSwitch Date and Time Properties window 31
TalkSwitch Firmware Update window 165
TalkSwitch management software

Installing 5
Starting 22
Upgrading 6

TalkSwitch memory cards 19
Talkswitch Network window 26
TalkSwitch profile

Setting up 48
TalkSwitch Proxy area 35
TalkSwitch systems

Configuring 163
TalkSwitch TS-480i 195
TalkSwitch TS-9133i 194
TalkSwitch unit

Back panel connectors 2
Connecting to a PBX 21
Connecting to a PC 6
Front panel 2
Front panel lights 2
Setting unit ID 17

TalkSwitch Unit area 207
TalkSwitch units

Networking 16
Upgrading 20

TalkSwitch VoIP network 219
TalkSwitch VoIP network calls list 53
Telephone lines

Calibrating 123
Connecting 11
Precautions 11, 250

Telephone Lines - Audio window 178
Telephone Lines - Detection and Timers window 179
Telephone Lines page 119
Telephones

Single-line phone 12
Two-line phone 12

Test Account Settings button 46
Test Account Settings window 46
Test email address box 46
Test Firewall window 37, 180, 216
Test Ports button 37, 180, 216
Test Ring Pattern button 180
Testing

E-mail server settings 46
TFTP server

Setting up 163
TFTP server location box 163
This server requires logon to incoming mail server before sending mail option 44
This server requires SMTP logon information option 44
This TalkSwitch location is the proxy/registrar check box 50
Time to send box 207
Time Zone area 32
Time zone list 61
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To Local Extension tab 167
To Remote Extension tab 167
To Ring Group tab 169
Toll restriction 143

Bypassing 147
Setting up 145

Transfer and Clear area 168
Transfer and Clear check box 120
Transfer and Clear service 168
Transfer Preferences window 167
Transfer Prefix area 170
Transfer Settings area 40
TS-480i 81

Line appearance 195
Programming softkeys 86

TS-9112i 81
TS-9133i 81

Line appearance 194
Programming function keys 85

Two-line phone 12
Connecting 12

Type of phone list 59
Type of public address list 35

U
Unit ID

Setting 17
Unit IP address box 34, 213
Update button 165
Upgrading

Firmware 6
TalkSwitch configuration software 6
TalkSwitch management software 6
TalkSwitch units 20

URL / IP address box 23
USB connection 10
USB connector 5
Use announced message check box 152, 155
Use automatic mode switching check box 31
Use call back prefix check box 152, 155
Use configured IP and DNS information option 34, 213
Use direct line access on check box 62
Use extension names in caller ID information for all outgoing VoIP calls option 52
Use password check box 152, 156
Use same line connect check box 103
Use system name in caller ID information for all outgoing VoIP calls option 52
Use the first and last names specified above to replace the incoming Caller ID names check 

box 119
Use the following call cascade settings for Holiday Mode list 30
Use transfer prefix list 170
User name box 44, 45
User/account box 52, 126
Username and Password area 126
Username box 61
Using

Key assignment template 88
Line appearance 194
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Verifying the connections 21
View Mailbox Data button 111
View Registrar Entries button 54
View Registration Status button 55
Viewing

Mailbox data 111
memory usage 161
Message length 161
Registrar entries 54
Registration status 55

Voice activity detection (VAD) check box 56
Voicemail

E-mail notification 77
Message waiting light 79
Pager notification 79
Phone notification 78
Screening 80

Voicemail Management area 111
Voicemail memory

Increasing 19
Voicemail Memory Usage window 26, 111
Voicemail messages link 26
Voicemail Preferences page 110
Voicemail tab 75
VoIP

Setting up a service provider profile 49
VoIP Caller ID area 52
VoIP Configuration page 48, 49
VoIP Configuration-Reserving VoIP lines 53
VoIP FAQs 230
VoIP information 211
VoIP lines

Reserving 53
VoIP Network Administration Form 234
VoIP Numbers page 124
VoIP ports area 171
VoIP Resource Reservation window 53
VoIP service provider calls list 53
VoIP Settings window 171
Volume heard at local extensions list 175

W
When a call is answered list 70
When listening to voicemail messages, always start with list 110
When matched, perform the following list 129
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